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Leica Geosystems HDS LLC provides complete documentation in an accessible HTML-based 

help system. The help system includes information on all of Cyclone's tools, commands, and 

features.  

 

 

Leica HDS Technical Support 
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925-790-2300 

support@hds.leica-geosystems.com 
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Introduction 

Cyclone Software Introduction 

Most CAD and modeling programs construct geometry from only a few sample vertices and 

estimate the rest with design assumptions. Design or modeling packages aid the user in creating 

entirely novel models from a conceptual model or idea, often having little to do with reality. 

Cyclone provides a high-performance environment for manipulating point cloud data captured by 

High Definition Surveying (HDS™) systems. Cyclone enables the user to accurately visualize, 

navigate, measure, and model 3D objects and scenes. See the Quick Start chapter for an 

introduction to the major concepts of the Cyclone software system. 
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Installation 

Included Materials 

CD-ROM 

Cyclone 5.8 

Installer 

Program 

On-line help 

Documents 

System Requirements 

PROCESSOR                     

1.4 GHz Pentium M (Centrino), 2 GHz Pentium 4, or higher  

MEMORY                        

512 MB RAM, 1 GB recommended  

HARD DISK                      

10 GB Storage Space or more 

VIDEO                            

SVGA or OpenGL accelerated graphics card 

OPERATING SYSTEM         

Microsoft Windows XP (Professional or Home Edition, SP1 or higher), Windows 2000 (SP2 or 

higher) 

ACCESSORIES                   

Ethernet card (for licensing and communication with scanner) 
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Installing Cyclone 

� For Cyclone to install correctly under Windows 2000 or Windows XP, use an account with 

Administrator privileges or equivalent which allows certain system files be installed or 

updated. Otherwise, Cyclone may not install correctly.  

� Operation of Cyclone under Windows 95, Windows 98, Windows NT, or Windows ME is 

currently unsupported; if you are attempting to install Cyclone on a computer running 

Windows 95, Windows 98, Windows NT, or Windows ME, the installation will not proceed. 

To Install Cyclone: 

1. Insert the Cyclone CD into your CD drive. If AUTORUN is enabled, the installer runs 

automatically. Otherwise, open the Windows Start menu and select Run, then type the letter 

of your CD-ROM drive (for example, D) followed by :\  SETUP.EXE to run the installer. 

2. Follow the directions in each window to proceed with the installation. 

� Default installation parameters should be reasonable for most systems; advanced users may 

select different settings. 

� If you have an active firewall, you may see messages about programs attempting to access 

the network. For Cyclone to run properly, these executables, located in the Cyclone 

installation folder, should be permitted access to the network: Cyclone.exe, 

CyraLicense.exe, ptserv32.exe, update41.exe, and LRCServer.exe (located in the 

HDS4500 sub-folder). 

3. When the installation is complete, reboot your workstation if needed and proceed with 

obtaining a license to run Cyclone (see next section). 

Obtaining your Cyclone License 

When you install Cyclone for the first time, you must activate it with a license key. If you are 

installing over an existing Cyclone installation, it may not be necessary to re-install your license. 

� Your workstation must have an Ethernet card properly installed and activated for the licensing 

to work. 

To obtain your license: 

1. Before installing Cyclone, run the HostId.exe program from the Cyclone CD. 

2. Email the HostID.txt file to Leica Geosystems HDS at mailto:license@hds.leica-

geosystems.com to request a license for your workstation. 

3. Leica Geosystems HDS will create a license for all purchased components and return it to you 

by email. Save the entire email as “license.dat” in the installation directory (the rest of the 

email information will be ignored). If license.dat already exists, overwrite the existing file with 

the new file.  
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Uninstalling Cyclone 

To uninstall Cyclone properly: 

1. Open the Windows Control Panel. 

2. Run the Add/Remove Programs applet. A list of installed programs appears. 

3. Select Cyclone from the list. 

4. Click the Add/Remove button to uninstall Cyclone. 

 Note:  If a dialog appears asking to remove some components, it is best to leave them. They 

can be deleted later if they are truly unnecessary. 

� Although the files installed by the Cyclone installation program are removed from your 

computer, any Cyclone data files or work files created will remain. You may delete those files 

at your discretion. 

� If Cyclone does not appear in your Add/Remove Programs applet, re-run the original installer 

and choose the Remove option. 
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Quick Start 

Launching Cyclone 

When you launch the Cyclone application, the first window you see is the Navigator. The 

Navigator is the main window of the application and serves as a road map for navigating 

databases on your local machine and remote servers. The Navigator window is also used to 

connect to known scanners and to create objects such as Databases, Projects, ModelSpaces, 

ModelSpace Views, ScanWorlds, and Registrations. The Navigator window is used to manage 

and organize all of your data. It is also used to exit the application. 

To launch Cyclone: 

1. From the Windows desktop, click the Start button. 

2. Point to Programs, and then point to Leica HDS Cyclone 5.8, then select Cyclone. The 

Navigator window appears. 

User Configuration Management 

User Configuration Management helps keeps your Cyclone-related files organized. The first time 

you run Cyclone or CloudWorx, the Cyclone User Configuration Manager appears. Follow the 

prompts to specify the locations for your working, library, and log files. Each user account has its 

own personal configuration. 

The Cyclone User Configuration Manager can be run at any time, but you should first exit 

Cyclone and CloudWorx before launching the Cyclone User Configuration Manager. 

To launch Cyclone User Configuration Manager: 

1. From the Windows desktop, click the Start button. 

2. Point to Programs, and then point to Leica HDS Cyclone 5.8, then point to Utilities, then 

select Cyclone User Configuration Manager. The Cyclone User Configuration Manager 

appears. 

Preferences 

In each Cyclone window, the Preferences command in the Edit menu opens the Edit 

Preferences dialog, which is used to manage preferences throughout the system. Preferences 

can be edited for the current session only or for the current and all future sessions. 

SESSION 

These preferences are non-persistent preferences that last for the duration of the current 

execution of Cyclone only. 
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DEFAULT 

These preferences are persistent and applied to the current and all future sessions. 

� Several settings throughout Cyclone have a range of between 0.0 and 1.0. In these cases, 0.0 

denotes the lowest possible setting (none) and 1.0 denotes the highest possible setting. See 

the Preferences entry in the Commands chapter. 

The Navigator Window 

The Navigator window opens with three default folders - Servers, Shortcuts, and Scanners. 

Servers Folder 

The Servers folder maintains your list of database servers. You can add and remove servers to 

and from this folder. Your local machine is added as a server by default. 

To add a server: 

1. From the Configure menu, select Servers.... The Configure Servers dialog appears. 

2. Click Add. The Add Server dialog appears. 

3. In the Server Name field, type the Microsoft Network name for the server to be added, and 

then click Add. The Configure Servers dialog reappears and displays the newly added 

server. 

4. Click Close. The server is created. 

Scanners Folder 

The Scanners folder maintains a list of known scanners. Add a scanner by entering a name of 

your choice and a scanner address (IP address). Double-clicking the scanner icon opens a Scan 

Control window for that scanner. 

To add an HDS4500 scanner: 

1. From the Configure menu, select Scanners.... The Configure Scanners dialog appears. 

2. Click Add. The Add Scanner dialog appears. 

3. From the Scanner Model list, select the model name of the scanner that you are adding. For 

example, select HDS4500 if the scanner is an HDS4500. 

4. In the Scanner Name field, type a logical name for the scanner you are adding (e.g., 

“Scanner”, “My Scanner”, “Scanner 123”, etc.). 

5. The HDS4500 does not require an IP address, as it is using Firewire Technology. 

6. Click OK. The scanner is added. 

� To close the Configure Scanners dialog and return to the Navigator window, click Close. 

To add a ScanStation, ScanStation 2, HDS3000, or HDS6000 scanner: 

1. From the Configure menu, select Scanners.... The Configure Scanners dialog appears. 

2. Click Add. The Add Scanner dialog appears. 
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3. From the Scanner Model list, select the model name of the scanner that you are adding. For 

example, select HDS3000 if the scanner is a HDS3000, HDS6000 if the scanner is a 

HDS6000, ScanStation if the scanner is a ScanStation, or ScanStation 2 if the scanner is a 

ScanStation 2. 

4. In the Scanner Name field, type a logical name for the scanner you are adding (e.g., 

"Scanner", "My Scanner", "Scanner 123", etc.). 

5. In the IP Address field, enter the IP Address for the scanner you are adding. The IP address 

of the scanner is printed on the scanner’s housing (ScanStation, ScanStation 2, and 

HDS3000) or in the built-in console (HDS6000). 

6. Click OK. The scanner is added. 

� To close the Configure Scanners dialog and return to the Navigator window, click Close. 

Shortcuts Folder 

The Shortcuts folder maintains a list of shortcuts to objects that you frequently use. For instance, 

you may create a shortcut to a ModelSpace or a particular ModelSpace View that is several 

folders deep in the database, and thus, enable instant access without having to navigate down to 

the actual folder location in the database. 

To create a shortcut: 

1. In the Navigator window, select the object for which you need a shortcut. 

2. From the Create menu, select Shortcut. The shortcut is added to the Shortcuts folder. 

Using Links 

Links are provided to make navigation easier. They allow you to create a shortcut to any Project, 

ScanWorld, ModelSpace, or Image as well as allowing you to reference any object in multiple 

places in the same database. 

To create a link: 

1. Select the Project, ScanWorld, ModelSpace, or Image to which you want to link. 

2. From the Edit menu, select Copy. 

3. Select a location for the link. 

� Links can be pasted into ScanWorlds, Scans, ModelSpaces, and Projects that are located in 

the same database as the original. 

4. From the Edit menu, select Paste Link. The link appears in the selected location. 

� Links are identical to their source object; renaming a link also renames the source object. 

� Deleting a link does not delete the source object; deleting the source object does not delete 

any links to that object. Only when the source object and all links are deleted is the object 

removed from the database. 

Object Hierarchy 

In Cyclone, most objects "belong" to another object, depending on their positions in the hierarchy 

in the Navigator window.  
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� Servers contain Databases. 

� Databases contain Projects. 

� Projects contain ModelSpaces, ScanWorlds, Registrations, Images, imported files, and other 

(subordinate) Projects. 

� ModelSpaces contain ModelSpace Views. 

� By default, a ScanWorld contains a default ControlSpace and three folders – one each for 

ModelSpaces, Scans, and Images. Each of these folders may contain additional folders as 

 well. ScanWorlds can also contain Projects.  A ScanWorld may contain up to one frozen 

Registration. 

Creating a Database 

The first time you run Cyclone, you need to create a new database, or connect to an existing 

database, on the desired server. Databases can reside on your local server or any connected 

server across a network. A database stores all Cyclone data including Projects, ScanWorlds, 

ModelSpaces, etc.. 

� For details on using a database, see the Databases section chapter. 

To add a database: 

1. Select the server to which you want to add new or existing database. 

2. From the Configure menu, select Databases.... The Configure Databases dialog appears. 

3. Click Add. The Add Databases dialog appears. 

4. In the Database Name field, type a logical name as an identifier for your logical database. 

� The logical name is the name displayed in the Navigator window. 

5. In the Database Filename field, type a file name for your database. 

� The database filename is the name used for the database file, which is saved in the 

Cyclone/Databases directory by default. 

� If you leave the Database Filename field empty, Cyclone bases the file name on the logical 

name you entered in the Database Name field. 

� You may select a new location for the database file by clicking the Browse icon to the right of 

the Database Name field. 

6. Click OK. The database is created. 

7. Click Close to close the Configure Databases dialog. 

Scanning 

Scanning is the process of using the HDS system to “sample” (take measurements from) a scene 

in the real world. Each individual measurement results in a 3D point. An entire scan results in 

collections of these 3D points called “point clouds”. These point clouds provide the basis for 

surface reconstruction or modeling, which is the main application of Cyclone. 

 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Quick Start 

13 

 

The Scanning Process 

Scanning Overview 

1. From the Navigator window, add a scanner object to represent your scanner. 

2. Open a Scan Control window and connect to the scanner. 

3. Organize project folders for your scan data. 

4. Adjust settings and target your scan. 

5. Execute your scan. 

� For details on the scanning process, see the Scanning chapters. 

Preparing for Scanning 

The first time that you want to use a scanner, it is necessary to create a persistent entry for the 

scanner. Scanners are added from the Navigator window. 

To add a scanner: 

1. From the Configure menu, select Scanners.... The Configure Scanners dialog appears. 

2. Click Add. The Add Scanner dialog appears. 

3. From the Scanner Model list, select the model of the scanner that you are adding. 

4. In the Scanner Name field, type a logical name for the scanner you are adding. 

5. In the IP Address field, enter the IP address for the scanner you are adding. 

6. Click OK. The scanner is added. 

� To close the Configure Scanners dialog and return to the Navigator window, click Close. 

The Scan Control Window 

The Scan Control window is used to control the scanning process, adjust scan settings, specify 

scan targets, and organize the resulting scan data. Before scanning, it is necessary to connect to 

a known scanner (one that has been entered in the database) via the Scan Control window. 

To launch a Scan Control window: 

1. From the Navigator window, expand the Scanners folder. 

2. Double-click the scanner you want. The Scan Control window appears with the Select a 

Project dialog open. 

To connect to a scanner: 

1. From the Scanner menu in the Scan Control window, select Connect  or click the Connect 

icon. Connection progress is displayed in the Scanner Status bar at the bottom of the Scan 

Control window.  

� When a successful connection is made and the scanner is ready for commands from Cyclone, 

the Scanner Status bar at the bottom of the Scan Control window reads “Connected and 

Ready”. 
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Scanner Simulation 

Cyclone provides a scanner simulation for the purpose of familiarizing yourself with scan settings 

and procedures for the HDS2500. Any ModelSpace can be used to launch a Scan Control 

window for a scanner simulation, using the Create Simulated Scanner command. The 

ModelSpace from which the Scan Control window is launched serves as the scene to be 

scanned; the viewpoint in the ModelSpace is the initial viewpoint of the simulated scanner. The 

Scan Control window created by this command operates identically to a Scan Control window 

connected to a real scanner. 

Registration 

Registration is the process of integrating a project’s ScanWorlds into a single coordinate system 

as a registered ScanWorld. This integration is derived by a system of constraints, which are pairs 

of equivalent or overlapping objects that exist in two ScanWorlds. The objects involved in these 

constraints are maintained in a ControlSpace, where they can be reviewed, organized, and 

removed; they cannot be moved or resized in the ControlSpace. The Registration process 

computes the optimal overall alignment transformations for each component ScanWorld in the 

Registration such that the constraints are matched as closely as possible.  

The Registration Process 

Registration Overview 

1. From the Navigator window, create a Registration object in the project that you want to 

register. 

2. From the Registration window, add the ScanWorlds that you want to register. 

3. Add constraints between the component ScanWorlds. 

4. Register the ScanWorlds, and then check and adjust constraints as needed. 

5. From a successful registration, create a registered ScanWorld/Frozen Registration. 

6. Create ModelSpaces from the registered ScanWorld and begin modeling. 

� For details on the registration process, see the Registration chapter. 

The Registration Window 

The Registration window consists of a main pane divided into three tabs and two Constraint 

Viewer panes. The three tabs of the main pane are ScanWorlds’ Constraints, Constraints 

List, and ModelSpaces. 

Constraint Viewer Panes 

The Constraint Viewer panes are used to view constraints. The constraints are selected and 

centered in each pane. 

ScanWorlds' Constraints Tab 
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The ScanWorlds Constraints tab displays each ScanWorld in the registration. Beneath each 

ScanWorld, a pairing with every other ScanWorld in the Registration is displayed. After 

constraints have been added, constraints between each ScanWorld pair are displayed. From the 

ScanWorlds Constraints tab, you can: select and view constraints; enable, disable, and delete 

constraints; set the Home ScanWorld; adjust the weight of individual constraints; and view 

information for each constraint. 

Constraints List Tab 

The Constraints List tab lists each constraint in the registration and displays current information 

about each constraint. Constraint information is organized into columns. Each column can be 

sorted. From the Constraints tab, you can: select and view constraints; enable, disable, and 

delete constraints; set the Home ScanWorld; adjust the weight of individual constraints; and view 

information for each constraint. 

ModelSpaces Tab 

The ModelSpaces tab displays each component ScanWorld’s ModelSpace(s) and ControlSpace. 

The main applications of the ModelSpaces tab are viewing ModelSpaces and ControlSpaces 

and adding constraints. This tab can also be used to create a new ModelSpace using the objects 

from existing ModelSpaces after the registration has been frozen. 

Modeling 

Cyclone’s primary application is the conversion of point clouds to CAD object-based line and 

surface models. The various processes employed to this end are referred to collectively as 

“modeling” and are applied via the ModelSpace window. 

Modeling Terms 

Several modeling-related terms are very similar, so becoming familiar with the following terms 

here may avoid confusion: ModelSpace, ModelSpace View, ModelSpace Window, Viewpoint 

ModelSpace 

A ModelSpace is a collection of geometry and information about the organization of the geometry. 

A ModelSpace cannot be viewed directly. To interact with the objects in a ModelSpace, you must 

open an existing ModelSpace View, create a new ModelSpace View, or open a Temporary 

ModelSpace View. 

ModelSpace View 

A ModelSpace View is a collection of settings applied to the particular ModelSpace from which it 

was created. The settings controlled by the ModelSpace View include the initial viewing position 

and overriding settings for graphical viewing parameters, such as a user coordinate system. 

These settings are not shared among different ModelSpace Views. A ModelSpace View can be 

viewed and manipulated via a ModelSpace window.  
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     Changes to the geometry or the layer organization of the geometry in one ModelSpace View 

affect the ModelSpace from which it was created and all other ModelSpace Views derived from 

the same ModelSpace. 

� Multiple ModelSpace Views can be created from a single ModelSpace.  

MODELSPACE WINDOW 

A window that displays a ModelSpace View. 

VIEWPOINT 

A viewing position or “camera” that determines which part of the ModelSpace is displayed. 

Multiple viewpoints may be saved within a single ModelSpace View. 

The ModelSpace Window 

The ModelSpace window provides visual access to a ModelSpace View, primarily used to view, 

manipulate, and measure scan data or point clouds. ModelSpace tools allow you to segment the 

point clouds into smaller subsets, which can then be used to fit specific geometric shapes. 

Various geometric objects can also be inserted and manipulated. More complex shapes and text 

annotations can be added using the 2D drawing functions.  

The Status Bar at the bottom of the ModelSpace window displays information about the current 

ModelSpace, including counts of selected objects, the layer of the object selected last, the 

distance between the last two picks (if available), the angle between the last two picks (if 

appropriate), and the progress of the loading of objects.  

Basic Viewpoint Controls 

Cyclone provides controls in View mode that allow you to manually rotate, pan, and zoom the 

viewpoint using the mouse. The viewpoint rotates around and zooms in/out from a focal point. 

The focal point is a point that is a certain distance in front of the center of the viewpoint. The 

distance is controlled by zooming the viewpoint. The focal point can be reset via Seek mode, and 

can be moved by panning the viewpoint. 

� To rotate the viewpoint, drag around the focal point while in View mode. 

� To pan the viewpoint, right-drag (press and hold the right mouse button while moving the 

mouse) in the desired direction while in View mode. 

� To zoom the viewpoint, press and hold both mouse buttons and move the mouse down to 

zoom in and up to zoom out. 

See the Changing the Viewpoint section in ModelSpace Navigation for more detailed information. 
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Scanning with the HDS6000 and HDS4500 

The Scanning Process 

Scanning can be accomplished in a variety of ways, but all scanning operations generally are 

divided into the following basic groups: 

1. Creating a Scanner using the Navigator window. 

2. Organizing Scan Data by selecting Projects and ScanWorlds (Cyclone prompts you to do this 

automatically when you open the Scan Control window). 

3. Preparing to Scan by capturing a preview, targeting and adjusting scan settings. 

4. Executing the scan. 

Creating a Scanner 

The first time that you want to use a scanner, it is necessary to create a persistent entry for it. 

Scanners are added from the Navigator window. 

To add an HDS6000 or HDS4500 scanner: 

1. From the Configure menu, select Scanners.... The Configure Scanners dialog appears. 

2. Click Add. The Add Scanner dialog appears. 

3. From the Scanner Model list, select the model name of the scanner that you are adding. For 

example, select HDS4500 if the scanner is an HDS4500, or HDS6000 if the scanner is an 

HDS6000. 

4. In the Scanner Name field, type a logical name for the scanner you are adding (e.g., 

“Scanner”, “My Scanner”, “Scanner 123”, etc.). 

5. In the IP Address field, enter the IP Address for the scanner you are adding. The IP address 

of the scanner is displayed in the built-in console (HDS6000). The HDS4500 does not require 

an IP address, as it is using Firewire Technology. 

6. Click OK. The scanner is added. 

� To close the Configure Scanners dialog and return to the Navigator window, click Close. 

Organizing Scan Data 

Before scanning can take place, you must first select or create a Project folder to store scan 

data, and then select or create a ScanWorld within that project folder. Individual scans and 

images are saved in this destination ScanWorld. For example, all of the scans and images that 

are taken from one scanner position would go into one ScanWorld. The scans and images from 

another scanner position would go into another ScanWorld, possibly in another project. The 

organization of the scans is managed by the user. 
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To select a project for your scan data: 

1. When you open a Scan Control window, the Select a Project dialog appears. To select a 

different project when the Scan Control window is already open, from the Project Setup tab 

in the Scan Control window, select Select a Project.... 

� You can create a new project for your scan data by clicking Create, and then selecting the 

created project that appears. 

2. Navigate to an existing project, and then click OK. Your destination project is selected. 

� When the scanner is not busy, you can select a different destination for the next set of scan 

data. 

 Note:  If you choose a new project, a new ScanWorld is created and your previous ScanWorld 

is no longer the destination for subsequent scan data. 

To select a ScanWorld for your scans and images: 

1. From the Project Setup tab in the Scan Control window, select Select a ScanWorld. The 

Select a ScanWorld dialog appears. 

� You can create a new ScanWorld in the currently selected Project for your scan data by 

clicking Create, and then selecting the created ScanWorld that appears. 

2. Navigate to an existing ScanWorld, and then click OK. Your destination ScanWorld is 

selected. 

� When the scanner is not busy, you can select a different destination ScanWorld for the next 

set of scan data. Note that if the new destination ScanWorld is in another project, you must 

first select that project via the Select a Project dialog. 

Preparing to Scan 

Once the destination Project and ScanWorld folders are chosen, the next steps in a typical 

scanning process are: 

� Many of these steps are optional, depending upon the requirements of your specific project. 

1. Capturing a Preview Scan Image of your scanner’s field of view. 

2. Targeting within the scene to select areas of interest. 

3. Adjusting Scan Settings to specify the resolution, probe the range of your scan, and set scan 

filters. 

Tilt Sensor (HDS6000) 

The Leica HDS6000 supports a tilt sensor, which detects how much the scanner “tilts” from 

perfectly level. The tilt sensor does not automatically correct the data to be in a level coordinate 

system. By default, the tilt sensor is enabled. To toggle the tilt sensor, select Enable Tilt Sensor 

from the Scanner menu. You may wish to disable the tilt sensor in some situations, for example, 

when the scanner is on an unstable platform such as a moving ship. 

When enabled, the tilt sensor monitors the inclination of the scanner while the amount of tilt is 

within the sensor’s operating range. If the scanner tilts beyond the sensor’s operating range, the 

current scanner operation is automatically cancelled and you are informed that the HDS6000 
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must be re-levelled. You can also manually check or re-level the HDS6000 by selecting 

Check/Re-Level HDS6000 from the Scanner menu. 

If the tilt sensor state changes significantly (e.g., a large amount of drift, manual adjustment of the 

tribrach, or out-of-range), for data integrity, the current ScanWorld is automatically advanced to 

the next ScanWorld. You may re-select the previous ScanWorld for additional work, but be sure 

that the data are consistent. 

Capturing a Preview Scan 

Capturing a Preview Scan 

You can capture an Preview Scan of the scene from the point of view of the scanner and display 

it in the Scan Control window. This Preview is useful for determining the field of view of the 

scanner, as well as for targeting areas of the scene to be scanned. While it can be very helpful for 

a number of reasons, having a valid Preview Scan in the Scan Control window is not required for 

targeting the scanner. 

To capture a Preview Scan of the scanner’s current point of view: 

1. From the Scanner Control menu, click the Preview button. The scanner captures a Preview 

Scan corresponding to the scanner's view within the targeted region. The Preview Scan is 

optionally displayed in the Preview window via the Show ModelSpace command and is 

saved in the corresponding ModelSpace under the destination ScanWorld. 

� You can also capture Previews by selecting Get Preview from the Preview menu, or by 

clicking the Get Preview icon on the Scan Control toolbar. 

� If the position or orientation of the scanner has been changed, repeat step 1 to update the 

Previews. Also, a new ScanWorld should be selected for storing any new data. Use the New 

Scanner Position command to automatically create a new ScanWorld. 

Targeting 

With a valid Preview in the Scan Control window, you can decide which areas of the scene are 

of interest and how densely they should be sampled. 

� To target the entire scene in the Scan Control window, select Target All from the Scanner 

Control menu. The scan target appears in the Scan Control window.  

� To target only a portion of the scene, create a target region by dragging one of the Target 

cursors over the area in which you are interested. 

� A number of preset target modes can be selected from the Presets dropdown. The horizontal 

and vertical settings for the selected mode are displayed in the fields below. When you enter 

targeting settings manually, the setting automatically changes to Custom. 
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Resolution 

After determining the area of the scene that you want to scan, adjust the resolution for scanning. 

Four different Resolution settings are available to the HDS4500. The HDS6000 has an additional 

Resolution setting. 

Probe  

� To measure the range and horizontal and vertical direction from the scanner to a point, 

position the target cross-hair on the point and click the Probe button. 

Scan Filter 

Range and/or intensity parameters can be set via the Scan Filter control. Points sampled outside 

these parameters are discarded without being recorded to the database. 

Field Setup (HDS6000) 

The default scanner coordinate system is based on an origin point within the scanner. The Field 

Setup panel allows you to take advantage of the HDS6000’s tilt sensor and use conventional 

surveying techniques to establish a relationship between the scanner and a known or assumed 

coordinate system. The known or assumed coordinates are imported by the Import Coordinate 

List or Import Coordinate List (Leica System 1200) commands, or are added or replaced by 

the Add/Replace Coordinate command. See the corresponding entries in the Commands 

chapter for more information. Field Setup can also be used to establish the backsight and station 

position of a new Traverse (see below). 

Field Setup Methods 

Resection from two or more targets over known coordinates: 

 

 

 

 

Target over 

known point 

Target over 

known point Target over 

known point 

HDS6000 with tilt sensor enabled, over 

unknown point 
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Acquiring a target over a known coordinate from a scanner placed over a known coordinate: 

 

Entering an azimuth or bearing to a 3D point or in the direction that the scanner is facing: 

 

See the Field Setup entry in the Commands chapter for more information. 

Traverse (HDS6000) 

The default scanner coordinate system is based on an origin point within the scanner; the 

coordinates of the scanner in a global (known or assumed) coordinate system are not known. The 

Traverse control allows you to take advantage of the HDS6000’s tilt sensor to use conventional 

surveying techniques to perform a traverse, establishing relationships between successive 

scanner positions within a known or assumed coordinate system. Because the tilt sensor detects 

if the scanner is not level, the traverse procedure does not require as many targets as regular 

target-based registration. Cyclone supports a linear traverse, open or closed. A closed traverse 

loops back on itself, whereas an open traverse does not. 

A traverse starts with the scanner over a known point. The user acquires a backsight over a 

known point, and a foresight, which may be over an arbitrary point. The known or assumed 

coordinates are imported by the Import Coordinate List or Import Coordinate List (Leica 

System 1200) commands, or are added or replaced by the Add/Replace Coordinate command. 

See the corresponding entries in the Commands chapter for more information. 

HDS6000 with tilt sensor enabled, over 

known point 

3D point, or aimed 

direction 

Azimuth or bearing 

Target over 

known point 

HDS6000 with tilt sensor enabled, over 

known point 
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After the scan data for the current scanner position have been acquired, the user moves the 

scanner to the next position, over the same point as the previous foresight. 

 

The pattern is repeated. Each time, the scanner is moved to the foresight and the previous 

position becomes the new position’s backsight. The new position’s foresight is where the scanner 

will be positioned next. 

 

Eventually, the traverse can end when the foresight is over a known point. (Any foresight can be 

a known point without ending the traverse.) The traverse is a “closed traverse” if the foresight is 

the same as the original backsight. 
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The traverse workflow produces a Registration that tracks the backsight, station, and foresight of 

each scanner position (ScanWorld). This Registration can be frozen and used as-is, or may be 

supplemented with additional target and/or cloud constraints. 

See the Traverse entry in the Commands chapter for more information. 

Scanning 

After defining the target region and adjusting the scan settings, the next step is to begin the scan. 

In the Scan Control window, click the Scan button. The scan is saved in the Scans folder under 

the current ScanWorld. 

Using a Scanner Script 

It is often necessary to scan several areas within the same scene, each with different scanning 

parameters. In these cases it can be more efficient to use a scanner script. The scanner script 

functions allow you to queue up a “batch” of scans, and individually adjust targets and scan 

densities for each of the intended target areas before beginning the actual scans. This saves you 

the time it would otherwise take to wait for a scan to finish before setting up the next scan, or 

perform unattended scanning. 

� For instructions on using a script, see the Editor... entry in the Commands chapter. 

Importing HDS4500 and HDS6000 Scans 

When Cyclone completes the HDS4500 or HDS6000 scan, the scan data captured is written to a 

ZFS format file. This file is stored in the Database Project folder under the HDS4500/HDS6000 

Scan Directory.  

Note: The HDS4500/HDS6000 Scan Directory is the folder location where HDS4500 and 

HDS6000 scan files are stored. This folder location is specified in the 

HDS4500/HDS6000 Scan Directory setting in the Scan tab of the Edit Preferences 

dialog. 

For quick data verification and visualization in the field, use the Re-Import Scans command 

under the Tools menu in the Cyclone Navigator to import a reduced subsample of the total 

available ZFS point cloud data in the Cyclone database.  
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F 

G H 
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From the Sampling list, select the subsampling level (1/4 skips every two points, 1/9 skips every 

three points, 1/16 skips every four points etc) to import and create a reduced copy of the cloud in 

the ZFS file. All available point cloud data is imported by selecting 100% in the Sampling list. 

Note: To remove an HDS4500 or HDS6000 ZFS scan file from the list of available scans in 

the Re-Import Scans dialog, toggle ON Archive. The ZFS scan file is moved from the 

Database Project Folder in the HDS4500/HDS6000 Scan Directory to the Archive 

subdirectory. 

To make an Archived HDS4500 or HDS6000 scan available in the Re-Import Scans 

dialog, move the ZFS scan file from the Archive folder up into the parent Database 

Project Folder. 
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Scanning with the ScanStation, ScanStation 2, and 
HDS3000 

The Scanning Process 

Scanning can be accomplished in a variety of ways, but all scanning operations generally are 

divided into the following basic groups: 

1. Creating a Scanner using the Navigator window. 

2. Connecting to a scanner. 

3. Organizing Scan Data by selecting Projects and ScanWorlds (Cyclone prompts you to do this 

automatically when you open the Scan Control window). 

4. Preparing to Scan by capturing images, targeting and adjusting scan settings. 

5. Executing the scan. 

6. Merging sub-scans as necessary. 

Creating a Scanner 

The first time that you want to use a scanner, it is necessary to create a persistent entry for it in 

the Navigator window. Afterwards, the scanner is available each time you start Cyclone. 

To add a ScanStation, ScanStation 2, or HDS3000 scanner: 

1. From the Configure menu, select Scanners.... The Configure Scanners dialog appears. 

2. Click Add. The Add Scanner dialog appears. 

3. From the Scanner Model list, select the model name of the scanner that you are adding. For 

example, select HDS3000 if the scanner is a HDS3000, ScanStation if the scanner is a 

ScanStation, or ScanStation 2 if the scanner is a ScanStation 2. 

4. In the Scanner Name field, type a logical name for the scanner you are adding (e.g., 

"Scanner", "My Scanner", "Scanner 123", etc.). 

5. In the IP Address field, enter the IP Address for the scanner you are adding. The IP address 

of the scanner is printed on the scanner’s housing. 

6. Click OK. The scanner is added. 

� To close the Configure Scanners dialog and return to the Navigator window, click Close. 

Connecting to a Scanner 

Connecting to a known scanner (one that has been entered in the database) is done from a Scan 

Control window. 

To launch a Scan Control window: 

1. From the Navigator window, expand the Scanners folder. 

2. Double-click the scanner to which you want to connect. The Scan Control window appears. 

 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Scanning with the ScanStation, ScanStation 2, and HDS3000 

26 

To connect to a scanner: 

1. From the Scanner menu in the Scan Control window, select Connect  or click the Connect 

icon. Connection progress is displayed at the bottom of the Scan Control window.  

� A successful connection is made and the scanner is ready for commands from Cyclone when 

the Scanner Status box at the bottom of the Scan Control window reads “Connected and 

Ready”. 

Organizing Scan Data 

Before scanning can take place, you must first select or create a Project folder to store scan 

data, and then select or create a ScanWorld within that project folder. Individual scans and 

images are saved in this destination ScanWorld. For example, all of the scans and images that 

are taken from one scanner position would go into one ScanWorld. The scans and images from 

another scanner position would go into another ScanWorld, possibly in another project. The 

organization of the scans is managed by the user. 

To select a project for your scan data: 

1. When you open a Scan Control window, the Select a Project dialog appears. To select a 

different project when the Scan Control window is already open, from the Project Setup tab 

in the Scan Control window, select Select a Project.... 

� You can create a new project for your scan data by clicking Create, and then selecting the 

created project that appears. 

2. Navigate to an existing project, and then click OK. Your destination project is selected. 

� When the scanner is not busy, you can select a different destination for the next set of scan 

data. 

 Note:  If you choose a new project, a new ScanWorld is created and your previous ScanWorld 

is no longer the destination for subsequent scan data. 

To select a ScanWorld for your scans and images: 

1. From the Project Setup tab in the Scan Control window, select Select a ScanWorld. The 

Select a ScanWorld dialog appears. 

� You can create a new ScanWorld in the currently selected Project for your scan data by 

clicking Create, and then selecting the created ScanWorld that appears. 

2. Navigate to an existing ScanWorld, and then click OK. Your destination ScanWorld is 

selected. 

� When the scanner is not busy, you can select a different destination ScanWorld for the next 

set of scan data. Note that if the new destination ScanWorld is in another project, you must 

first select that project via the Select a Project dialog. 
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Preparing to Scan 

Once the destination Project and ScanWorld folders are chosen, the next steps in a typical 

scanning process described below. An alternate scanning method is described in the following 

QuickScan section. 

� Many of these steps are optional, depending upon the requirements of your specific project. 

1. Capturing an Image of your scanner’s field of view. 

2. Targeting within the scene to select areas of interest. 

3. Adjusting Scan Settings to specify the resolution, probe the range of your scan, set scan 

filters, and compensate for conditions in the atmosphere that may affect the results of your 

scan. 

4. Entering Station Data to locate your scan data in a known or assumed coordinate system. 

Dual-Axis Compensator (ScanStation, ScanStation 2) 

The Leica ScanStation/ScanStation 2 supports a dual-axis compensator, which automatically 

corrects scanner data for scanner “tilt” (from perfectly level). By default, the dual-axis 

compensator is enabled. To toggle the dual-axis compensator, select Enable Dual-Axis 

Compensator from the Scanner menu. You may wish to disable the dual-axis compensator in 

some situations, for example, when the scanner is on an unstable platform such as a moving 

ship. 

When enabled, the dual-axis compensator automatically corrects scanner data while the amount 

of tilt is within the compensator’s operating range. If the scanner tilts beyond the compensator’s 

operating range, the current scanner operation is automatically cancelled and you are informed 

that the ScanStation/ScanStation 2 must be re-levelled. You can also manually check or re-level 

the ScanStation/ScanStation 2 by selecting Check/Re-Level ScanStation from the Scanner 

menu. 

If the dual-axis compensator state changes significantly (e.g., a large amount of drift, manual 

adjustment of the tribrach, or out-of-range), for data integrity, the current ScanWorld is 

automatically advanced to the next ScanWorld. You may re-select the previous ScanWorld for 

additional work, but be sure that the data are consistent. 

Capturing an Image 

You can capture an image of the scene from the point of view of the scanner and display it in the 

Scan Control window. This image is useful for determining the field of view of the scanner, as 

well as for targeting areas of the scene to be scanned. While it can be very helpful for a number 

of reasons, having a valid image in the Scan Control window is not required for targeting the 

scanner or for actual scanning. Note that the colors in the acquired image are mapped to the 

point cloud upon creation, so it is necessary to acquire an image prior to scanning in order have 

this visualization option. 
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Targeting 

With a valid image in the Scan Control window, you can decide which areas of the scene are of 

interest and how densely they should be sampled. 

� To target the entire scene in the Scan Control window, select Target All from the Scanner 

Control menu. The scan target appears in the Scan Control window.  

� To target only a portion of the scene, create a target region by dragging one of the Target 

cursors over the area in which you are interested. 

� A number of preset target modes can be selected from the Presets dropdown. The horizontal 

and vertical settings for the selected mode are displayed in the fields below. When you enter 

targeting settings manually, the setting automatically changes to Custom. 

� To quickly and roughly target an area for image acquisition and subsequent scanning, click 

the QuickScan button. The QuickScan dialog prompts you to manually aim the scanner to 

establish left and right limits for scanning and image acquisition. You should aim the scanner 

by holding the plastic side covers; avoid touching the window area. Note that the top and 

bottom limits should be defined before acquiring images. 

Resolution 

After determining the area of the scene that you want to scan, adjust the range, sample spacing, 

and/or number of points. 

Probe  

� To measure the range and horizontal and vertical direction from the scanner to a point, 

position the target cross-hair on the point and click the Probe button. 

Scan Filter 

Range and/or intensity parameters can be set via the Scan Filter control. Points sampled outside 

these parameters are discarded without being recorded to the database. 

Atmosphere 

Environmental conditions (ambient temperature and atmospheric pressure) can affect the range 

computations by a small amount. Although any differences are minuscule over the ranges and 

environmental tolerances supported by the scanners, controls are provided to compensate for 

such atmospheric conditions. The default values should be acceptable to most users using the 

Atmosphere control. 

� To adjust the atmosphere, enter values for ambient temperature and atmospheric pressure in 

the appropriate fields in the Atmosphere tab. 
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Station Data (HDS3000) 

The default scanner coordinate system is based on an origin point within the scanner. The 

Station Data control allows you to enter known or assumed real-world coordinates to establish a 

relationship between the scanner and that coordinate system. See the Station Data tab entry in 

the Commands chapter for more information. 

Field Setup (ScanStation, ScanStation 2) 

The default scanner coordinate system is based on an origin point within the scanner. The Field 

Setup panel allows you to take advantage of the ScanStation’s/ScanStation 2’s dual-axis 

compensator and use conventional surveying techniques to establish a relationship between the 

scanner and a known or assumed coordinate system. The known or assumed coordinates are 

imported by the Import Coordinate List or Import Coordinate List (Leica System 1200) 

commands, or are added or replaced by the Add/Replace Coordinate command. See the 

corresponding entries in the Commands chapter for more information. Field Setup can also be 

used to establish the backsight and station position of a new Traverse (see below). 

Field Setup Methods 

Resection from two or more targets over known coordinates: 

 

Acquiring a target over a known coordinate from a scanner placed over a known coordinate: 
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known point 
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Entering an azimuth or bearing to a 3D point or in the direction that the scanner is facing: 

 

See the Field Setup entry in the Commands chapter for more information. 

Traverse (ScanStation, ScanStation 2) 

The default scanner coordinate system is based on an origin point within the scanner; the 

coordinates of the scanner in a global (known or assumed) coordinate system are not known. The 

Traverse control allows you to take advantage of the ScanStation’s/ScanStation 2’s dual-axis 

compensator to use conventional surveying techniques to perform a traverse, establishing 

relationships between successive scanner positions within a known or assumed coordinate 

system. Because the dual-axis compensator automatically corrects scan data for vertical, the 

traverse procedure does not require as many targets as regular target-based registration. 

Cyclone supports a linear traverse, open or closed. A closed traverse loops back on itself, 

whereas an open traverse does not. 

A traverse starts with the scanner over a known point. The user acquires a backsight over a 

known point, and a foresight, which may be over an arbitrary point. The known or assumed 

coordinates are imported by the Import Coordinate List or Import Coordinate List (Leica 

System 1200) commands, or are added or replaced by the Add/Replace Coordinate command. 

See the corresponding entries in the Commands chapter for more information. 
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After the scan data for the current scanner position have been acquired, the user moves the 

scanner to the next position, over the same point as the previous foresight. 

 

The pattern is repeated. Each time, the scanner is moved to the foresight and the previous 

position becomes the new position’s backsight. The new position’s foresight is where the scanner 

will be positioned next. 

 

Eventually, the traverse can end when the foresight is over a known point. (Any foresight can be 

a known point without ending the traverse.) The traverse is a “closed traverse” if the foresight is 

the same as the original backsight. 
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The traverse workflow produces a Registration that tracks the backsight, station, and foresight of 

each scanner position (ScanWorld). This Registration can be frozen and used as-is, or may be 

supplemented with additional target and/or cloud constraints. 

See the Traverse entry in the Commands chapter for more information. 

QuickScan 

QuickScan is a convenient way of quickly initiating a scan when your field of view settings do not 

need to be precise and your other Scan Control settings are already satisfactory. See the Field-

of-View Tab command for instructions. 

Scanning 

After defining the target region and adjusting the scan settings, the next step is to begin the scan. 

In the Scan Control window, click the Scan button. When a scan is complete, it is saved in the 

Scans folder under the current ScanWorld. During the scan, each increment of the number of 

points set via the Max # Points Per Sub-Scan preference in the Scan tab of the Edit 

Preferences dialog is saved as a new sub-scan. A sub-scan can be selected and manipulated 

while the scan continues. When the scan is complete, sub-scans should be merged via the 

Merge Sub-Scans command. With very large scans, this can be a time-consuming process. To 

save time, the previous sub-scans can be merged while subsequent scans are being captured. 

� If Cyclone or the scanner fails during a scan, the scan data captured prior to the crash can be 

recovered. By default, it is located in the directory in which Cyclone is installed in .\ 

Databases\ temp\ scanX.scan (in the actual file, the X is replaced by the date and time of the 

scan). To recover the data, import it using the Import command in the Navigator window. 

Data can be imported directly into a project as a new ScanWorld by selecting the Project and 

then using the Import command. It can also be imported into an existing ScanWorld to apply 

colors from the last multi-image under the ScanWorld by selecting the ScanWorld and then 

using the Import command. 

Note: Targets are useful as constraints in the registration process. If you are using either HDS 

Targets or spheres, a good time to acquire the targets is after the initial scan of the 

scene. Once acquired, targets are automatically added to the ControlSpace.  

Using a Scanner Script 

It is often necessary to scan several areas within the same scene, each with different scanning 

parameters. In these cases it can be more efficient to use a scanner script. The scanner script 

functions allow you to queue up a “batch” of scans, and individually adjust targets and scan 

densities for each of the intended target areas before beginning the actual scans. This saves you 

the time it would otherwise take to wait for a scan to finish before setting up the next scan, or 

perform unattended scanning. 

� For instructions on using a script, see the Editor... entry in the Commands chapter. 

 

 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Scanning with the ScanStation, ScanStation 2, and HDS3000 

33 

Merging Sub-Scans 

When creating a large scan, Cyclone creates a sub-scan each time it reaches a set increment of 

maximum cloud points per sub-scan (1.5 million points by default). This allows you to start 

manipulating point clouds efficiently as the remainder of the scan is being captured. After the full 

scan is complete, but before modeling or registration, the sub-scans should be merged. When 

working on a project that includes multiple large scans, it may be more efficient to merge sub-

scans while subsequent scans are being captured, taking advantage of processing power not 

needed to carry out the scan. 

� To merge sub-scans: In the Navigator window, select the appropriate ScanWorld. Then 

select Merge Sub-Scans from the Tools menu. All sub-scans within the selected ScanWorld 

are combined. 

� To adjust the increment above which new sub-scans are created, use the Max # Points Per 

Sub-Scan preference in the Scan tab of the Edit Preferences dialog. 
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Scanning with the HDS2500 

The Scanning Process 

Scanning can be accomplished in a variety of ways, but all scanning operations generally are 

divided into the following basic groups: 

1. Creating a Scanner using the Navigator window. 

2. Connecting to a scanner. 

3. Organizing Scan Data by selecting projects and ScanWorlds (Cyclone prompts you to do this 

automatically whenever you open the Scan Control window). 

4. Preparing to Scan by capturing images, targeting and adjusting scan settings. 

5. Executing the scan. 

Creating a Scanner 

The first time that you want to use a scanner, it is necessary to create a persistent entry for it. 

Scanners are added from the Navigator window. 

To add an HDS2500 scanner: 

1. From the Configure menu, select Scanners.... The Configure Scanners dialog appears. 

2. Click Add. The Add Scanner dialog appears. 

3. From the Scanner Model list, select the model name of the scanner that you are adding. For 

example, select HDS2500 if the scanner is a HDS2500. 

4. In the Scanner Name field, type a logical name for the scanner you are adding (e.g., 

“Scanner”, “My Scanner”, “Scanner 123”, etc.). 

5. In the IP Address field, enter the IP Address for the scanner you are adding. The IP address 

of the scanner is printed on the scanner’s case. 

6. Click OK. The scanner is added. 

� To close the Configure Scanners dialog and return to the Navigator window, click Close. 

Connecting to a Scanner 

Connecting to a known scanner (one that has been entered in the database) is done from a Scan 

Control window. 

To launch a Scan Control window: 

1. From the Navigator window, expand the Scanners folder. 

2. Double-click the scanner to which you want to connect. The Scan Control window appears. 

To connect to a scanner: 

1. From the Scanner menu in the Scan Control window, select Connect  or click the Connect 

icon. Connection progress is displayed at the bottom of the Scan Control window.  

� A successful connection is made and the scanner is ready for commands from Cyclone when 

the Scanner Status box at the bottom of the Scan Control window reads “Connected and 

Ready”. 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Scanning with the HDS2500 

36 

Organizing Scan Data 

Before scanning can take place, you must first select or create a Project folder to store scan 

data, and then select or create a ScanWorld within that project folder. Individual scans and 

images are saved in this destination ScanWorld. For example, all of the scans and images that 

are taken from one scanner position would go into one ScanWorld. The scans and images from 

another scanner position would go into another ScanWorld, possibly in another project. The 

organization of the scans is managed by the user. 

To select a project for your scan data: 

1. When you open a Scan Control window, the Select a Project dialog appears. To select a 

different project when the Scan Control window is already open, from the Project Setup tab 

in the Scan Control window, select Select a Project.... 

� You can create a new project for your scan data by clicking Create, and then selecting the 

created project that appears. 

2. Navigate to an existing project, and then click OK. Your destination project is selected. 

� When the scanner is not busy, you can select a different destination for the next set of scan 

data. 

 Note:  If you choose a new project, a new ScanWorld is created and your previous ScanWorld 

is no longer the destination for subsequent scan data. 

To select a ScanWorld for your scans and images: 

1. From the Project Setup tab in the Scan Control window, select Select a ScanWorld. The 

Select a ScanWorld dialog appears. 

� You can create a new ScanWorld in the currently selected Project for your scan data by 

clicking Create, and then selecting the created ScanWorld that appears. 

2. Navigate to an existing ScanWorld, and then click OK. Your destination ScanWorld is 

selected. 

� When the scanner is not busy, you can select a different destination ScanWorld for the next 

set of scan data. Note that if the new destination ScanWorld is in another project, you must 

first select that project via the Select a Project dialog. 

Preparing to Scan 

Once the destination project and ScanWorld folders are chosen, the next step is usually to 

capture an image of the scene from the point of view of the scanner and display it in the Scan 

Control window. This image is useful for determining the field of view of the scanner, as well as 

for specifying areas of the scene to be scanned. While it can be very helpful for a number of 

reasons, having a valid image in the Scan Control window is not required for targeting the 

scanner or actual scanning. Note that the colors in the acquired image are mapped to the point 

cloud upon creation, so it is necessary to acquire an image prior to scanning in order have this 

visualization option. 
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To capture an image of the scanner’s current point of view: 

1. From the Scanner Control menu, select Get Image, or click the Get Image icon . The image 

appears in the Scan Control window and is saved in the Images folder under the parent 

ScanWorld. Additionally, a link to the current image is created beneath the scan to help keep 

track of which images go with which scans. 

� The prevailing lighting conditions can greatly affect the quality and usability of the image. To 

compensate for the level of light in the scene, adjust the image exposure via the Adjust 

Image Exposure... command. 

� It may take the scanner several seconds to acquire and transfer the image before it is 

displayed. 

� If the position or orientation of the scanner is changed, select Get Image again to update the 

image. Also, a new ScanWorld should be selected for storing any new data. Use the New 

Scanner Position command to automatically create a new ScanWorld. 

Adjusting Scan Settings 

After determining the area of the scene that you want to scan, the range, sample spacing, and 

number of points settings can be adjusted. For an explanation of these settings, see the 

preceding Scan Settings section. 

Using Targets  

Targets are useful as constraints in the registration process. If you are using either HDS Targets 

or spheres, a good time to acquire the targets is after the initial scan of the scene. For target 

acquisition procedures, see the Acquire Targets command. 

� Once acquired, Targets are automatically added to the ControlSpace. 

Using a Scanner Script 

It is often necessary to scan several areas within the same scene, each with different scanning 

parameters. In these cases it can be more efficient to use a scanner script. The scanner script 

functions allow you to queue up a “batch” of scans, and individually adjust targets and scan 

densities for each of the intended target areas before beginning the actual scans. This saves you 

the time it would otherwise take to wait for a scan to finish before setting up the next scan, or 

perform unattended scanning. 

� For instructions on using a script, see the Editor... entry in the Commands chapter. 
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Camera Calibration 

Cyclone's camera calibration tool is used to calibrate the camera integrated with the HDS2500. 

Camera calibration provides the following benefits for HDS2500 users: 

� Correction of lens distortion of the image (i.e., straight lines in the scene now appear to be 

straight in the corrected image). 

� Improvement of the accuracy of scan targeting on the image (i.e., when you target on the 

image, you generally get a scan of what you targeted, versus the hit-or-miss targeting on an 

uncalibrated image). 

� Texture mapping of calibrated camera images on point clouds and meshes, providing clearer 

visualization and navigation. 

The following notes apply: 

� The HDS2500 requires at least one successful camera calibration before the additional 

camera functionality is enabled. The camera calibration may need to be re-calibrated 

periodically as well. See the Calibrate Camera entry in the Commands chapter for step-by-

step instructions. 

� After a camera has been successfully calibrated, point clouds and meshes can be texture 

mapped using the camera images associated with the source scan. Select the point cloud in 

the ModelSpace viewer, and then selecting Image Texture Map from the View Object As 

dialog. 

� The camera calibration parameters are specific to each HDS2500. The calibration parameters 

from one HDS2500 should not be used with data acquired with another HDS2500. 

Camera Calibration Process 

The HDS2500 camera calibration process requires HDS2500 firmware version 4 or later. The 

process requires either a dimly lit (or unlit) room large enough to place the scanner at roughly 3-5 

meters, then at roughly 6-10 meters from a wall (or ceiling), or an exterior wall against which you 

can calibrate at night. The view from the scanner to the wall should be unobstructed, and the wall 

should be a light, diffuse color (for example, white or beige); the process may not work with red, 

black, or shiny surfaces). Using a wall large enough to cover the entire scanner field of view at 

the second calibration distance (about 7 meters on each side if 10 meters is used for the second 

calibration distance, 4 meters on each side if 6 meters is used for the second calibration distance) 

is recommended. See the Calibrate Camera entry in the Commands chapter for step-by-step 

instructions. 

Troubleshooting Camera Calibration 

The HDS2500 provides a 480x480 pixel camera image, which is generally a lower resolution than 

most scans. The camera calibration accuracy is typically within 2 pixels; i.e., when texture 

mapped, a scan point is textured within 2 pixels of its ideal pixel. The combination of the image 

resolution and accuracy of camera calibration may result in slightly blurry texture maps. The 

accuracy of the calibration may be better near the center of the image than near the edges. 
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Parallax Errors 

The HDS2500 laser scanner and internal camera do not share the same optical axis, resulting in 

the phenomenon of "parallax" (where the scene from the laser scanner's viewpoint is different 

from the scene from the camera's point of view). The effects of parallax may manifest as a portion 

of the texture map that appears to be mapped incorrectly onto the points. This may be more 

pronounced when there is a significant distance between foreground and background objects. As 

the difference in distances increases, the effects of parallax on the texture mapping increases. 

Typically, the background texture is projected onto a foreground object, or vice-versa, depending 

on the arrangement of the objects in the scene. 

� When there is a mismatch of texture map and points, segment the point cloud into two pieces, 

separating the points that are incorrectly mapped from the points that are correctly mapped. 

Enable texture mapping only on the correctly mapped cloud. Depending on the severity of the 

mismatch due to parallax, this may or may not be necessary. 

Advanced Use of Camera Calibration 

When Cyclone captures an image from the HDS2500, the image is stored in uncorrected form. 

Images from a HDS2500 with a calibrated camera contain also the calibration parameters specific 

to that HDS2500. When the image is displayed, distortion correction is automatically applied (note 

that the Scan Control Show ModelSpace on Image command is incompatible with a calibrated 

image; selecting this option automatically hides the image). Cyclone supports the Import and 

Export of images and calibration parameters. 

� An image, its calibration parameters, and the point cloud or geometry, may each be exported 

and then converted for use in a third-party application that provides additional texture mapping 

capabilities. See the Export Calibration Info entry in the Commands chapter for instructions on 

exporting calibration parameters. See the Export Image entry in the Commands chapter for 

instructions on exporting an image. 

� The user can import an image and/or a set of calibration parameters and texture map the 

calibrated image on a point cloud or mesh. See the Import Calibration Info entry in the 

Commands chapter for step-by-step instructions. 
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Scanner Simulation 

Cyclone provides a scanner simulation for the purpose of familiarizing yourself with scan settings 

and procedures. Any ModelSpace can be used to launch a Scan Control window for a scanner 

simulation by using the Create Simulated Scanner command. The ModelSpace from which the 

Scan Control window is launched serves as the scene to be scanned; the viewpoint in the 

ModelSpace is the initial viewpoint of the simulated scanner. The Scan Control window created 

by this command operates identically to a Scan Control window connected to a real scanner. 

� To change the position of a simulated scanner to match the current viewpoint of the 

ModelSpace from which it was launched, use the Update Simulated Scanner Position 

command in the Scanner submenu of the original ModelSpace window. 

Note:  The original ModelSpace that serves as the scene to be scanned is not the same as 

the ModelSpace that can be opened from the Scan Control window in order to view the 

incoming points. 
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Registration 

Introduction 

Registration is the process of integrating a project's ScanWorlds into a single coordinate system, 

as a Registered ScanWorld. This integration is derived using a system of constraints, which are 

pairs of equivalent objects or overlapping point data that exist in two ScanWorlds. The objects 

involved in these constraints are maintained in a ControlSpace, where they can be reviewed, 

organized, and removed; they cannot be moved or resized in a ControlSpace (to ensure data 

integrity). The Registration process computes the optimal overall alignment transformations for 

each component ScanWorld in the Registration such that the constrained objects are aligned as 

closely as possible in the resulting ScanWorld. 

The Registration Process 

Registering a set of ScanWorlds can be accomplished in a variety of ways. The following series 

of steps represents a typical project. Your specific projects may be better suited to an order of 

operations that is slightly different from the following general guidelines: 

 Note: Before starting the Registration process, it is a good idea to check acquired targets for 

accuracy. It is also recommended that sub-scans are merged prior to registration (this 

applies to HDS3000, ScanStation, and ScanStation 2 data only). See the Merge Sub-

Scans command for details. 

1. From the Navigator window, create a Registration object in the project that you want to 

register. 

2. Open the Registration window, and add the ScanWorlds that you want to register to the 

Registration. 

3. Establish a Home ScanWorld containing a known coordinate system (if available). 

4. Add constraints between the component ScanWorlds. 

5. Register the ScanWorlds, and then check and adjust constraints as needed. 

6. From a successful registration, freeze the Registration and create a registered ScanWorld. 

7. Create ModelSpaces from the registered ScanWorld. 

Creating a Registration Object 

The first step in the registration process is to create a Registration object for the project that you 

want to register. This is done by selecting the desired project in the Navigator window, and then 

selecting the Registration command from the Create menu. The Registration object does not 

need to be created in the same project as the participating ScanWorlds, but must be in the same 

database. 

Adding ScanWorlds 

The next step in the Registration process is to add the ScanWorlds that you want to register to 

the Registration. After opening the Registration object, select participating (component) 

ScanWorlds via the Add ScanWorld command. 
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Using the ControlSpace 

A ControlSpace is similar to a ModelSpace View. It is used as a container for all objects attached 

to its parent ScanWorld that are designated as “constraint” objects or possible constraint objects. 

The ControlSpace is used to review, organize, or remove objects; it is also used to add 

constraints manually. However, objects in the ControlSpace cannot be moved or resized. When 

an object is removed from the ControlSpace, it cannot be used in subsequent registrations. 

     When a ScanWorld is created, a default ControlSpace is automatically created and placed 

within the ScanWorld in the Navigator window. It cannot be moved, copied, or deleted. When a 

ScanWorld is added to a Registration, a ControlSpace linked to that specific Registration is 

created beneath the default ControlSpace. In this manner, a ScanWorld may contain a separate 

ControlSpace for each Registration that involves that ScanWorld. Operations in a Registration 

(i.e., adding or deleting constraints) affect only the corresponding subordinate ControlSpace. 

Objects are generally added to a ControlSpace in one of four ways: 

� When HDS Target or sphere targets are acquired via the Scan Control window.  

� When a registration label is added to an object in a ModelSpace under the ControlSpace’s 

ScanWorld. 

� When the HDS Target or Sphere Target commands are used to manually fit a HDS Target or 

target sphere to a cloud. 

� 
When an object is copied to the ControlSpace directly from a ModelSpace using the Copy to 

ControlSpace command. The object in the ControlSpace is independent of the object in the 

ModelSpace from which it originated. 

Objects in a ControlSpace can be organized into layers or changed in appearance without 

affecting their counterparts in the ModelSpace. 

� 
To activate/deactivate a constraint object from within a ControlSpace, toggle the object’s 

visibility. (This can be done by placing the object in a layer and turning the layer’s visibility 

OFF.) Only visible objects in the ControlSpace are used in a Registration. 

 Hint:  For trial and error registration, it may be useful to keep several versions of a constraint 

object (organized by layers, for example) in the ControlSpace and hide all but one for a 

given trial. 

 Objects used as constraints in a frozen Registration may not be deleted from the 

ControlSpace until all constraints which use the object have first been deleted from the 

Registration. Note that constraints cannot be deleted if a Registration is frozen; unfreeze the 

Registration in order to delete constraints. 

 Note:  When using a database from an older version of Cyclone, running the Optimize 

command from the Navigator window on the database automatically creates a default 

ControlSpace for each ScanWorld. These ControlSpaces are populated with all known 

constraints and objects with registration labels. Also, a subordinate ControlSpace is 

created for each Registration that involves the ScanWorld. 

 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Registration 

43 

Establishing the Home ScanWorld 

The home ScanWorld defines the reference coordinate system for the ScanWorld created from a 

successful registration. By default, the first ScanWorld added to the Registration is set as the 

home ScanWorld. However, the home ScanWorld can be re-selected using the Set Home 

ScanWorld command. 

� The Home ScanWorld is displayed in bold face.  

� If you have a known coordinate system, set the ScanWorld containing that coordinate system 

as the Home ScanWorld. A known coordinate system can be established within a ScanWorld 

via the Set ScanWorld Coordinate System command or by creating a new ScanWorld and 

inserting known coordinates. 

Making a ScanWorld “Leveled” 

Depending on the source of the data in a ScanWorld, the ScanWorld may considered to be 

“leveled”. That is, the data are known to be in a coordinate system where “vertical” is “true 

vertical” and “up” is in the positive direction of elevation. A ScanWorld known to be “leveled” is 

registered such that its “up” vector remains the same. 

To manually toggle a ScanWorld’s “leveled” property, select Toggle ScanWorld Leveled from 

the ScanWorld menu. This command should be used with care, since an incorrect property may 

adversely affect the registration results. 

Adding Constraints 

Cyclone provides several methods for adding constraints. If you have modeled a sufficient 

number of objects that exist in multiple ScanWorlds, Cyclone can usually match the modeled 

objects to form your registration constraints without using registration labels or manually adding 

constraints, provided that you have added those objects to the ControlSpace for each ScanWorld. 

Auto-Add Constraints 

During the Auto-Add Constraints process, Cyclone first incorporates all previously added 

Registration pairs, and then searches for objects with matching Registration labels. Cyclone also 

searches the ControlSpaces for geometrically consistent objects that can be used in registration 

constraints (if the Auto-Add Constraint Tolerance is set at a value greater than zero in the 

Registration tab of the Edit Preferences dialog.   

 Note:   The search only looks through objects in the ScanWorld’s subordinate ControlSpace 

corresponding to the Registration.  

     Given that a large set of constraints is unlikely to occur randomly, the search picks the largest 

mutually consistent constraints from the possible constraints. If the Auto-Add Constraints 

command gives an incorrect result (this would usually be discovered during the actual 

Registration by a registration failure or by large errors), undo the last operation, manually add one 

or two constraints, and then try again. The Auto-Add Constraints process is performed from the 

Registration window using the Auto-Add Constraints command. 

� After using the Auto-Add Constraints command, it is recommended that you check to make 

sure that constraints have not been added between ScanWorlds known to not overlap. 
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Constraints occurring in this manner should be deleted.  

Matching Registration Labels 

When two ScanWorlds’ ControlSpaces contain objects with the same Registration label, a 

constraint is automatically created, relating each of these object pairs. In most cases, constraints 

that result from Registration labels come from HDS Targets that have been placed in overlapping 

areas of scans for the specific purpose of using them for Registration. Some HDS Targets may 

have been imported from a reference coordinate system (e.g., survey data). Registration labels 

are created during the modeling process via the Add/Edit Registration Label dialog in the 

ModelSpace window. 

Manually Adding Constraints 

Manually adding a constraint establishes that two objects are equivalent. For example, a 

constraint formed from two patches found in two different ScanWorlds declares that the patches 

should lie in the same plane after the two ScanWorlds have been registered.  

     Constraints are manually added using the Add Constraint command. The process involves 

viewing both ScanWorlds' ControlSpaces and selecting the objects to be used in the constraint. 

Note that both objects must be copied to their respective ControlSpaces before a constraint can 

be specified. 

     The types of geometry that can be used for constraints include: Patch, Line, Vertex, Sphere, 

Cylinder, and Steel Sections. 

Register 

After the constraints have been added, the next step is to register the ScanWorlds using the 

Register command in the Registration menu. The Registration command computes the optimal 

alignment transformations for each ScanWorld in the Registration so that all constrained objects 

are aligned as closely as possible. Statistics for the successful Registration can be viewed using 

the Registration Diagnostics command in the Registration menu. More constraints than are 

strictly required can be added and may improve results or be used to help check the registration 

(i.e., if the extra constraints are disabled, their errors are still computed; they should have a low 

error under a “good” registration, even if they were not used to compute the registration). 

Adjusting Constraints 

Fine-tuning a Registration for maximum accuracy is accomplished by reviewing and adjusting 

constraints. After a successful registration, the overall accuracy of the registration can be viewed 

from the Registration Diagnostics dialog, where the error of each constraint is displayed in the 

Constraints tab of the Registration window. The Error column displays the error for each 

constraint and can be used to sort constraints by error magnitude by clicking the column heading. 

     When a constraint is found with a larger than average error, there are several possible 

courses of action. First, the constraint can be visually checked using the Show Constraints 

command, which displays the two objects involved in the constraint in the Constraint viewers. 

When it is determined that a constraint’s error is unexpectedly high, it can be disabled (see the 

Disable entry in the Commands chapter) or deleted, or its influence can be decreased (see the 
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Set Weight entry in the Commands chapter). The constraint can also be disabled by making the 

constraint object invisible in the ControlSpace. Possible reasons for a high error include: incorrect 

constraint, poorly-fit objects, poorly-sampled objects, or some motion of the scanner during data 

acquisition. However, a correct constraint may have a high error if the registration favored other, 

incorrect constraints (e.g., if the incorrect constraints all somehow "agreed" with each other). 

Note:  The practice of decreasing the weight of all constraints with higher than average error 

is not recommended as it can lead to lower overall registration accuracy. Decreasing 

the weight of a constraint should only be done if you have reason to believe that the 

measurement of one or both of the objects in the constraint is less accurate than other 

measured objects. 

     If the Auto-Update command in the Registration menu is ON, the registration is updated 

after each change to the system of constraints. Otherwise, use the Register command in the 

Registration menu to update the registration when ready. 

Creating a Registered ScanWorld and Freezing the Registration 

After a successful registration, the Create ScanWorld/Freeze Registration command can be 

used to create a single ScanWorld that includes the registered (component) ScanWorlds in a 

unified (common) coordinate system. It also locks all constraints in place. At this point constraints 

can no longer be modified unless the Registration is unfrozen via the Unfreeze Registration 

command. The Registration object is relocated beneath the new ScanWorld. The new 

ScanWorld’s default ControlSpace consists of all of the objects in each ControlSpace linked to 

this Registration for each ScanWorld used in the Registration. 

Creating a ModelSpace from the Registration 

There are two ways to create a ModelSpace from a Registration, depending on the desired 

content of the resulting ModelSpace.  

A. The ModelSpace is created using the Create | ModelSpace command in the Navigator 

window. A ModelSpace created in this manner includes only the original scan data and target 

objects from all of the registration’s component ScanWorlds. The current preferences 

determine which objects are included. These settings are found in the ModelSpace tab of the 

Edit Preferences dialog. None of the modeling done in any of the component ScanWorlds’ 

individual ModelSpaces is included in the new ModelSpace. The same result is obtained by 

using the Create ModelSpace (or Create and Open ModelSpace) command under the 

Registration menu in the Registration window. 

B. The ModelSpace is created from the ModelSpaces tab of the Registration window by 

selecting all ModelSpaces containing objects you want to include in the resulting ModelSpace, 

and then using the Create ModelSpace command. The ModelSpace created in this manner 

includes ModelSpace data from each of the selected ModelSpaces. 

� In each case, individual scans can be added to the ModelSpace by dragging the desired scan 

onto the ModelSpace in the Navigator window. Scans may also be restored using the 

ScanWorld Explorer. 

� In a ModelSpace containing a registered set of scans and a large number of point clouds, 

performance is improved by the cloud unification process. See the Unify Clouds entry in the 

Command Reference chapter. 
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Checking the Registration 

Mistakes can still happen, even with acceptable registration metrics. When QC (quality control) 

points are available, the Elevation Check dialog can help discover mistakes by measuring the 

vertical deviation of each QC point from the registered cloud points in its neighborhood. The QC 

points are typically measured on arbitrarily-selected ground points with an independent survey 

instrument and placed in the same coordinate system as the Home ScanWorld. With a good 

registration, the QC points will be close in elevation to the registered point cloud. See the 

Elevation Check entry in the Command Reference chapter. 

Cloud Registration 

Cloud Registration supports the creation and management of cloud constraints between 

overlapping point clouds and meshes ("clouds" and "meshes" are used interchangeably in this 

topic), without the need for targets. The overall registration process remains the same (see the 

Registration topic in this chapter); the user may also create cloud constraints in addition to the 

geometric constraints between HDS Targets, spheres, cylinders, planes, etc. Cloud constraint 

commands are found in the Cloud Constraint menu of the Registration window. 

Cloud Constraints 

A cloud constraint is a user-defined constraint between two ScanWorlds, which indicates that the 

point clouds in the ControlSpace of the first ScanWorld overlap with the point clouds in the 

ControlSpace of the second ScanWorld. Just as an object-object constraint tells the registration 

to align the objects, a cloud constraint tells the registration to align the overlapping areas of two or 

more point clouds.  

     It is possible to register two ScanWorlds together with a single cloud constraint if the 

overlapping points constrains the registration in all six degrees of freedom (three translation 

directions and three rotation angles); e.g., if the overlap is in a corner. However, two scans may 

only overlap in a single plane; in this case, the cloud constraint behaves much like a plane-plane 

constraint, with the unconstrained degrees of freedom inherent in a plane-plane constraint. 

Creating a Cloud Constraint 

Cloud constraints do not differentiate between clouds and meshes. One ControlSpace can have a 

mesh while another has a cloud (or any combination thereof). This means you can use cloud 

constraints to align a cloud with a mesh model. For best results, the mesh should be sampled 

similarly to the density of the point cloud. The three methods of creating a cloud constraint are: 1. 

assisted creation via the Cloud Constraints Wizard; 2. manual creation via the Add Cloud 

Constraint command; and 3. addition of cloud constraints to an existing registration ("post 

registration") or to geo-referenced ScanWorlds using either the Add Cloud Constraint command 

or the Auto-Add Cloud Constraints command. 

Note:  Cloud constraints are not created by the Auto-Add Constraints command. 

 

This is the recommended method for creating cloud constraints. The Cloud Constraints Wizard 

guides you through the entire process of creating cloud constraints and can save considerable 

time compared to the other methods. First, specify which ScanWorld pairs are overlapping, and 
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then the Wizard steps through the process of creating a cloud constraint for each specified pair of 

ScanWorlds. See the Cloud Constraints Wizard entry in the Commands chapter for detailed 

instructions. The Cloud Constraints Wizard offers the following advantages: 

�   It automatically copies all scan clouds (except HDS Target clouds) into the ControlSpace for 

the selected ScanWorlds. 

�   It automatically opens the ControlSpaces side-by-side in the Constraint viewers, and advances 

to the next ScanWorld pair after the user has picked corresponding points and pushed the 

Cloud Constraints Wizard's Create Constraint button. 

�   It provides a quick way to check for overlap between two ScanWorlds. Pressing the eyeglass 

button in the Cloud Constraint Wizard's grid control displays the corresponding ScanWorlds' 

ControlSpaces in the Constraint viewers. 

Manual Creation 

The manual process is similar to creating a sphere-sphere constraint: 

1.  In the Constraint viewers in the Registration window, show two ModelSpaces or 

ControlSpaces that contain overlapping clouds. 

2.  Pick three or more matching points on the two clouds. (See below for hints on selecting these 

points.) 

3.  Select the Add Cloud Constraint command. 

�   If the picked points match closely enough, the cloud constraint is created and the selected 

clouds are copied as needed into their respective ControlSpaces. (See the Add Cloud 

Constraint entry in the Commands chapter for detailed instructions.) 

Post Registration: Adding Cloud Constraints to Improve an Existing Registration 

or Geo-referenced Registration 

If you have pre-aligned ScanWorlds (ScanWorlds that are already in the same coordinate system 

either through registration using objects or geo-referencing), you can add cloud constraints and 

re-register the ScanWorlds to optimize the registration results. Since the ScanWorlds have 

already been pre-aligned or registered, each cloud constraint added uses the existing registration 

to derive its initial alignment. This does not require you to open each ModelSpace to specify the 

initial alignment hints via pick points. 

There are two methods for adding cloud constraints to the registration in this case: 

1. Using the Add Cloud Constraint command: This process requires only that you select 

two ScanWorlds that share a common coordinate system and overlap, and then select 

the Add Cloud Constraint command. Note that you must ensure that the ControlSpaces 

of these ScanWorlds already contain the necessary point clouds. See the Copy to 

ControlSpace entry in the Commands chapter for detailed instructions. 

2. Using the Auto-Add Cloud Constraints command: This command will search all pairs of 

ScanWOrlds for overlapping point clouds. If overlap is found, a cloud constraint is created 

and the alignment is optimized. The user can reduce the number of ScanWorld pairs 

searched by selecting one or more ScanWorlds. If a selection exists, the command will 

create cloud constraints only for ScanWorlds that overlap the selected ScanWorlds.  
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In general, object-object constraints cover a limited area of the scene, while point cloud overlap 

may cover a far greater extent. Thus, adding a cloud constraint can improve a registration in 

regions where shared targets or objects do not exist but where overlap between different scans 

does exist. 

Picking Points for Initial Alignment Hints 

The initial alignment hint should be as accurate as possible to produce faster and more reliable 

Optimize Cloud Alignment results. The Optimize Cloud Alignment command can fail if the 

picked points do not provide good correspondences. When picking the minimum of three points, 

use the following guidelines: 

�    Pick points that are easily identified. Good choices include: corners, intensity markings (such 

as a painted sign on a wall), the top of a pole, and where a pole enters the ground. Bad 

choices include: the middle of a flat wall, and a smoothly curving surface without an 

identifiable feature.  

�    Pick points that match the pick points in the other ScanWorld as closely as possible. We 

recommend that your pick points in one cloud match their corresponding pick points in the 

other cloud within four inches, which is the default Cloud Reg Max Search Distance. You 

may increase this setting (see the Registration tab of the Preferences entry in the Commands 

chapter), but doing so may decrease the speed and reliability of the Optimize Cloud 

Alignment command. 

�    Avoid geometrically symmetric picks. The three points should not form a symmetric shape 

(such as a line, equilateral triangle, or isosceles triangle). In these cases, the initial alignment 

may rotate and still match the three points, producing unexpected results. In this case, add a 

geometrically suitable fourth point to eliminate the symmetry.  

�    Spatially distribute the picks over a large volume. Pick three or more points that form as large 

a triangle as possible. Look at the entire area of overlap in the two clouds and try to pick 

three points or more that cover as much of that area as possible (i.e., pick one point near the 

front of the overlap, one near the back of the overlap and one somewhere in between). This 

ensures that the initial alignment aligns all the overlapping areas as closely as possible. 

Note:  The order of the picks in each viewer does not matter, as long as there are at least 

three asymmetric picks. 

Using Cloud Constraints 

The optimal alignment of the two point clouds used in a cloud constraint must be determined 

before the cloud constraint can be used in global registration. When creating a cloud constraint, 

three or more matching pick points (called Initial Alignment Hints) on the clouds are specified in 

the Registration window. These hints are used to determine the initial alignment of the clouds 

and to create the cloud constraint. This initial alignment is used as a starting point for the optimal 

alignment. Note that if the initial alignment is not accurate enough (e.g., the initial alignment hints 

are not within the Cloud Reg Max Search Distance), the optimal alignment search may fail. 

Optimal alignment is computed by the Optimize Cloud Alignment command. (See the Optimize 

Cloud Alignment entry in the Commands chapter for details.) However, if you are confident that 

your cloud constraints are set up properly, you can immediately select the Register command. 

Any cloud constraints marked as not aligned are aligned before global registration is performed. 
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Optimize Cloud Alignment Parameters 

In the Registration tab of the Preferences dialog, the Cloud Reg Subsampling Percentage 

parameter specifies a speed-versus-accuracy trade-off in the performance of the Optimize Cloud 

Alignment command. The default is 3%, which is effective and efficient for typical scan cloud 

sizes (i.e., a point cloud with one million points). In general, a value of 100% may give results up 

to two times as accurate as a value of 3%, but may take approximately ten times as long. 

The recommended process is to: 

1.  Align all cloud constraints using the default 3% parameter and check that global registration 

gives a satisfactory result. 

2.  If you then desire more accuracy, change the parameter to 100% (or other value). Select all 

the cloud constraints, and then select the Optimize Cloud Alignment command. 

Cloud Constraint Status 

In the Constraint List tab of the Registration window, the Error Vector column for cloud 

constraints shows one of the three following values: 

Create Sections Dialog Options 

NOT ALIGNED 

The Optimize Cloud Alignment command has not been run successfully on the cloud 

constraint. 

ALIGNED 

The Optimize Cloud Alignment command has been executed satisfactorily, and the cloud 

constraint constrains all six degrees of freedom between the two ScanWorlds. 

ALIGNED/UNDERCONSTRAINED 

The Optimize Cloud Alignment command has been executed satisfactorily, but the geometry 

of the overlap area in the two clouds may not constrain all six degrees of freedom (e.g., if the 

overlap area is a flat plane, it would only constrain 1 translation and 1 rotation degree of 

freedom). In these cases, you may want to visually verify that it is indeed underconstrained or 

if the initial alignment guess was inaccurate. 

Cloud Alignment Accuracy 

Although there is no fail-safe method of determining if the cloud alignment result succeeded in 

finding the optimum alignment (within accuracy limits of the data), the following methods can be 

used to check for accuracy. 

ALIGNMENT RMS ERROR 

One of the first things to look at is the RMS (root mean square) error of the alignment (in the 

Error Vector column in the Constraint List tab). If the RMS error value is in the 1 cm range 

for HDS data, the alignment is likely to be good. HDS3000, ScanStation, and ScanStation 2 

data has an RMS of 6 mm in general, but since the overlap measurement is often imprecise, 
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the alignment RMS is generally above 6 mm depending on the geometry of the scene. For 

example, if the scene contains large smooth surfaces, the overlap measurement is very good, 

and the RMS may be 6mm or lower. However, for scans of more complex geometry such as a 

leafy tree or a field of grass, the RMS will be higher since the overlapping points may not 

always be from the same surface (e.g., a nearby leaf or blade of grass). 

ERROR HISTOGRAM 

The second thing to look at is the shape of the error histogram. When observing the histogram 

during the Optimize Cloud Alignment procedure, the histogram normally begins as a 

horizontal line, and then gradually tightens up to the shape of a vertical half-bell curve. The 

half-bell curve shape indicates that the alignment has been optimized properly. The width 

(one-sigma) of the half-bell curve should be approximately matching the accuracy of the 

scanner used to scan the cloud (6 mm for the HDS2500, HDS3000, ScanStation, and 

ScanStation 2). A histogram that remains flat indicates that the initial guess was too far away 

for the Optimize Cloud Alignment algorithm to align the clouds. 

VIEW THE ALIGNMENT 

Finally, viewing the results of the alignment will give you a good sense of the accuracy. Select 

a cloud constraint and then select the View Interim Results command to open a temporary 

ModelSpace containing the aligned objects and clouds from the ControlSpaces of the two 

ScanWorlds. Focus on corners and surfaces to check the alignment. If you see any gaps 

between surfaces that were stationary during the scans, you should use the Update Initial 

Cloud Alignment command and optimize again. The Show Overlapping Points function in 

the Show Diagnostics dialog is another tool for viewing the alignment. The Show 

Overlapping Points function creates a temporary ModelSpace containing four point sets: 

blue, dark blue, green, and dark green. The dark blue and dark green points are the points in 

ScanWorlds A and B respectively that are not found to be overlapping. The remaining colored 

points are the overlapping points. This gives you a better idea of what data the Optimize 

Cloud Alignment method is working with and what it considers overlapping. If you delete or 

hide the dark blue and dark green points, you are left with the overlapping regions of the two 

clouds. If you see that any obvious surfaces are missing from this overlap region, that may 

indicate that the initial alignment is inaccurate. 

Improving Initial Alignment Hints 

Select the cloud constraint you want to fix and then select Show Constraint from the Constraint 

menu. The ControlSpaces of the two ScanWorlds are shown and the Initial Alignment Hints pick 

points are shown as well. 

     At this time you can add or replace pick points, with the goal of improving initial alignment 

accuracy. If the initial alignment was satisfactory, but you want to improve it in a single region, 

add a pick point within that region in each Constraint viewer (hold SHIFT to retain the previous 

picks). To show the original picks again, double click the constraint in the Constraint List tab. 

When finished, select Update Initial Cloud Alignment. The constraint is reset to use the 

updated set of pick points and its status is set to "not aligned". 
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Max Iterations Warning 

When running the Optimize Cloud Alignment command, you may occasionally see the warning: 

"The following cloud constraint alignments were halted by the Cloud Reg Max Iterations limit." 

This indicates that the Optimize Cloud Alignment command did not arrive at a solution before 

reaching the Cloud Reg Max Iterations limit. 

This may be addressed by: 

1.    Repeating the Optimize Cloud Alignment command; this continues the optimization where 

it left off last. In general, you can run the Optimize Cloud Alignment command any number of 

times to improve the result, (if improvement is possible). 

2.   Increasing the Cloud Reg Max Iterations preference and repeating the Optimize Cloud 

Alignment command. 

3.  Improving your initial alignment hint as described above and repeating the Optimize Cloud 

Alignment command. 

Notes on Global Registration with Cloud Constraints 

In general, global registration treats cloud constraints just like any other type of constraint. 

Several items related to global registration deserve more explanation, described below: 

Cloud Constraint Registration Error 

In the Constraint List, the error column lists the error of each constraint after global registration. 

In general, this is the distance between two constraint objects after the optimal registration 

transform has been computed for their ScanWorlds. For cloud constraints, the error value 

indicates the increase in the error metric of the cloud alignment when offset by the global 

registration from the optimal pair-wise alignment (i.e., the alignment computed by the Optimize 

Cloud Alignment command). If you register two ScanWorlds using only a cloud constraint , the 

error for the cloud constraint will be 0. The reason is that since there is no other constraint in the 

registration, the global registration does not need to adjust the cloud alignment. If you then add a 

HDS Target constraint and Register, the global registration starts spreading the errors among the 

constraints and you should see a non-zero error for the cloud constraint. 

Underconstrained Constraints 

You will occasionally see constraints that generate a warning upon completing the Optimize 

Cloud Alignment command. As described above, these constraints are labeled 

"aligned/underconstrained" in the Error Vector column. This occurs when the overlap geometry 

of the clouds does not fully constrain the alignment in all six degrees of freedom. In such cases, 

an alignment was found, but that alignment can slide along or rotate around one or more 

dimensions without affecting the cloud alignment error. For example, although we can align two 

scans of a flat floor, we can also slide them around in the plane without affecting the alignment 

error. 

     In these cases, the cloud constraint does the right thing; it behaves (numerically) as a plane-

plane constraint and allows the global registration to slide the ScanWorlds relative to each other 
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as long as they stay in the same plane. Similarly, you could scan a large cylinder from two 

locations and the cloud constraint would be underconstrained, allowing the ScanWorlds to slide 

along and rotate around the cylinder's center axis. 

     When a cloud constraint is underconstrained, you may need additional constraints to lock 

down the registration of the two ScanWorlds. In the planar case, you may need two additional 

HDS Target constraints. In the linear case, two additional asymmetric HDS Targets would be 

sufficient to lock it down. 

Weights on Constraints 

Cloud constraints are created such that their error contribution to the global registration is scaled 

relative to the error contribution of HDS Target constraints with weights of 1.0. 

     When you create a registration with a combination of cloud constraints and HDS Target 

constraints, we recommend that you not adjust the weights of these constraints unless you have 

a specific reason, such as: 

� You know that a particular HDS Target (or other constraint object) is not as accurate as a 

standard HDS Target (roughly 3 mm accuracy) and you have a good estimate of how 

accurate your method for establishing the coordinate was. 

� You used a cloud in a cloud constraint that was acquired using a scanner that has a different 

per-sample accuracy. 

     In these cases, the weight should be proportional to the accuracy of your HDS Target or scan 

data. For example, if the HDS Target was 10 mm accurate, a good weight would be 0.3 = 3 mm / 

10 mm, where 3 mm is the rough accuracy of a HDS Target. If a scan cloud with 3 cm accuracy 

was used, the weight should be around 0.2 = 6 mm/30 mm, where 6 mm is the per-sample 

accuracy of a scan. 

Managing ScanWorld Copies 

Each ScanWorld is given a unique identifier (not visible to the user) when it is first created. When 

a ScanWorld is copied, the new ScanWorld shares the same identifier. Copying a ScanWorld 

behaves differently depending on whether the ScanWorld is pasted into the same, source 

database or into a different database. 

ScanWorld Copy Behavior within a Single Database 

When a ScanWorld is pasted into the same database, it is created as a link to the source 

ScanWorld, not as a new, distinct entity, and any change to one affects the other. 

Example: 

1.  Select a ScanWorld. 

2.  From the Edit menu, select Copy. 

3.  Select a location within the same database, and then select Paste from the Edit menu. A copy 

(link) of the ScanWorld appears. 

4.  Change the name of either ScanWorld. 

5.  Notice that the name of the other ScanWorld is also updated. 
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ScanWorld Copy Behavior Between Databases 

When a ScanWorld copy is pasted from one database to another, it is created as a new entity. 

Because the ScanWorlds are in different databases, each ScanWorld can be changed without 

affecting the other. However, when a ScanWorld is pasted into a database that already contains a 

ScanWorld with the same identifier, differences in annotations, ModelSpaces, and ControlSpaces 

must be resolved before the merge (copy) is completed. 

Example: 

1.  Select a ScanWorld. 

2.  From the Edit menu, select Copy. 

3.  Select a location in another database, and then select Paste from the Edit menu. A copy of 

the ScanWorld appears. 

4.  Change the name of either ScanWorld. 

� Notice that the name of the other ScanWorld is not updated. 

5.  Add, edit, or delete an annotation and a ModelSpace in the copied ScanWorld. 

6.  Select either ScanWorld. For merging purposes, this is the “source” ScanWorld. 

7.  From the Edit menu, select Copy. 

8.  Select any location in the database containing the other ScanWorld. For merging purposes, 

this is the “target” ScanWorld, which has the same identifier as the source ScanWorld. 

9.  Select Paste from the Edit menu. The Merging ScanWorlds: Resolve Differences dialog 

appears and displays discrepancies in the annotations. 

10.  Select the annotations you wish to have in the target ScanWorld, and then click OK. The 

Merging ScanWorlds: Select ModelSpaces dialog appears. 

11.  Select the default ControlSpace and ModelSpaces you wish to have in the target ScanWorld, 

and then click OK. The source and target ScanWorlds are merged into the target 

ScanWorld’s database. 
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Modeling 

Overview 

Cyclone’s tools analyze and extract information from point cloud data and convert point clouds to 

CAD object-based line and surface models. There are many advantages to using Cyclone for this 

purpose: 

� Most current CAD programs do not support massive clouds of points gracefully. 

� Modeled objects can provide dimensions and measurements that the clouds cannot provide 

directly (e.g., the outside diameter of a pipe, or the radius of a pipe bend). 

� A form of data compression can be realized, since a pipe has only a few parameters, as 

compared with hundreds or thousands of points sampled on the surface of the pipe. 

� Best-fit objects are often more accurate than the individual point samples, since the fitting 

tends to average out the individual sampling noise. 

Working with Objects 

Region Growing 

The Region Grow submenu commands are used to fit a patch, cylinder, or sphere to an 

appropriate group of points within a point cloud without first having to segment the points. This is 

done by picking one or more points within the region that contains a supported shape (patch, 

cylinder, or sphere), and then choosing the Region Grow submenu command appropriate for 

that shape. For example, if there is a wall behind an assortment of conduit and control boxes in 

the ModelSpace, you can pick a few points on the wall and direct the program to fit a patch via 

region growing. The algorithm determines the plane of the wall and ignores the points on the 

conduit and control boxes, since they do not fit to the plane. 

The Region Grow submenu also contains the Smooth Surface command. Rather than fitting an 

object to a group of points, this command is used to identify points on a connected smooth 

surface.  For example, the lawn of a golf course is smooth but not flat enough for Region Grow 

Patch. 

In the Region Grow: Smooth Surface dialog, the Hardtop Surface check box enables improved 

performance when segmenting points on a road from points on passing vehicles.  When using 

this option, you should use a fence to select only road points and associated noise points.  All 

other points (curbs, center dividers, sign posts, etc) should be excluded from the selection.  A 

single pick point on the road surface is required.  For Hardtop Surface, the Gap to Span defines 

the scale on which the road looks approximately flat.  When the segmentation is complete, the 

noise can be removed from the ModelSpace. 
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� Default region growing parameters can be preset to initial values in the Modeling tab of the 

Edit Preferences dialog. 

� Region growing can also be used to fit objects from parts tables. See the Region Grow entry 

in the Commands chapter for instructions. 

� Sometimes, the scanner’s line of sight to a surface is partially blocked by an obstruction 

(another object). Region growing stops when it encounters this type of occlusion, unless there 

are multiple pick points on each part of the object separated by the shadow or other occlusion. 

� When region growing, multiple clouds may be selected as long as there is at least one pick 

point. 

� When enabled, the Limit Box can improve performance by reducing the amount of points 

processed; only those visible points are used. 

Fitting Objects 

A point cloud can be quickly best-fit by using Cyclone’s Fit Fenced to Cloud and Fit to Cloud 

submenu commands. The fitters typically take only a few seconds to generate a best-fit object. 

The user indicates the type of surface to be fit for the selected point cloud, and the fitting 

algorithms perform a multi-dimensional minimization over the parameter space for the surface 

type. For example, a sphere in 3D has four parameters: X, Y, Z coordinates, and a radius, so the 

algorithm finds the combination of X, Y, Z coordinates and radius values for a sphere that best fits 

the point cloud (i.e., the average offset of the points to the sphere’s surface is zero). 

� Object fitting can be adjusted by applying constraints and catalog/parts tables via the Object 

Preferences dialog. 

� The user is notified of potentially bad fits based on the fit tolerances specified in the Object 

Preferences dialog. 

� After an object has been fit, the point cloud(s) that were used to create the object can be 

displayed using the Show Object’s Cloud command. This provides access to the points for 

visual comparison or verification. 

� The point cloud used in the fit may be retrieved for additional use through the Insert Copy of 

Object's Points command. Point clouds that have been automatically merged through the 

fitting process may be split into the component clouds via the Explode command. 
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Common Fitting Objects: 

PATCH                                   

flat surfaces: walls, floors; boxes and slabs when extruded 

CYLINDER                               

vessels, pipes, flanges, columns 

SPHERE                                 

vessels, targets 

CONE                                    

lights, funnels 

LINE SEGMENT                      

conduit, railing, cabling 

ELBOW                                   

bend, elbow 

CORNER                                  

three intersecting planes 

BOX                                      

rectangular slabs, crates, shipping containers 

STEEL SECTION                       

angle, channel, tee, rectangular tube, and wide-flange 

Using Fit Tolerances 

Object types that support fitting can be tested against user-specified tolerances in order to verify 

that the quality of a fit does not exceed the allowable quantities. Fit quality tolerances can be set 

in the Object Preferences dialog for each object type that can be fit. When fitting using 

tolerances, a warning message appears if the statistical errors of a fit are beyond one or more of 

the set tolerances. For example, if the Std Deviation value is set to 4 mm for cylinders, each time 

a cylinder is fit to a cloud of points, the standard deviation of the fit vs. the points in the cloud is 

compared with the "Std Deviation" fit tolerance for spheres; if it is greater than 4 mm, Cyclone 

warns that the fit may not be acceptable to the user. 

� To enable fitting to tolerances, first enable and set the tolerances within the Object 

Preferences dialog, and then toggle the Check Fit Tolerances command ON from the Fit to 

Cloud Options submenu. 
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Using Fit Constraints 

Some object types that can be fit to a point cloud also support the constraining of the fitting 

parameters to specific values. Fitting constraints can be set for each object type in the Object 

Preferences dialog. Each constraint may be Unspecified, Initial, or Fixed. The value of an 

Unspecified constraint is found by the fitting algorithm. An Initial value can help the fitter as a 

hint of what the value might be. The fitter uses a Fixed constraint as the final value of that 

parameter. For example: if you know that a cylinder to be fit must have a certain diameter, you 

could set the Fit Diameter to Fixed at that diameter. On the other hand, if you believe that the 

cylinder might be around a certain diameter, but aren't sure, you could set the Initial value to that 

diameter, but the final cylinder may have a different diameter. Finally, if you don't know what the 

diameter is, you can set the Fit Diameter to Unspecified. 

� To fit with constraints, first enable Fit Constraints with Initial or Fixed values within the 

Object Preferences dialog, and then toggle the Use Fit Constraints command ON from the 

Fit to Cloud Options submenu. Otherwise, the fitter determines the final values entirely on its 

own. 

� The Fit Constraints area of the Object Preferences dialog is disabled for objects that do not 

support fit constraints. 

Point Cloud Segmentation 

It is often necessary to divide (or segment) a point cloud into one or more subsets in order to 

focus further operations on a subset, remove unwanted data, etc. Segmentation provides a 

process for grouping different regions of point clouds based on shared characteristics. For 

example, points may be segmented because they are on the same pipe or on the same wall. The 

points may also be segmented because they are unnecessary for subsequent modeling or 

visualization (they may be stray or unnecessary points). 

Simple Segmentation 

Simple segmentation involves using the fence tool to manually separate the points of interest. 

The fence can be manipulated for the precise outline required to segment one set of points from 

another or to clear unwanted points. Once the fence contains the desired points, the Cut by 

Fence command creates at most two point clouds – one inside, and one outside the fence. 

Simple segmentation is limited in that it uses a single fence from a single viewpoint to create 

segments, and if further refinements are needed, additional segments are created. When more 

precise segmentation is needed, use the sub-selection function (see Advanced Segmentation in 

the Modeling chapter and Point Cloud Sub-Selection in the Commands chapter) before creating 

segments. 

Advanced Segmentation 

Advanced segmentation involves using multiple sub-selections to refine a selection (add or 

remove points) before segmentation, fitting, or other processes are performed. After the initial 

selection, the viewpoint can be changed and a new fence can be drawn in order to make a more 

precise selection. When the sub-selection contains only the desired points, the selected points 

are segmented via the Cut Sub-Selection command. 
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To make a precise segment from a point cloud: 

1. Draw a rough fence around the points that you want to segment. 

2. Using the Selection | Point Cloud Sub-Selection submenu commands, create a temporary 

selection. 

3. Continue to refine the temporary selection (add or subtract points) by manipulating the 

viewpoint, drawing a new fence, and using subsequent Selection | Point Cloud Sub-

Selection submenu commands. 

4. From the Create Object menu, point to Segment Cloud, and then select Cut Sub-Selection. 

The points within the temporary subset are now a separate point cloud and can be selected 

independently. 

Segmenting by Intensity 

The Cut Cloud by Intensity dialog can be used to manually segment a point cloud above and 

below a user-specified intensity. When a point cloud is viewed with an color map, the Cut by 

Intensity command provides a slider that interactively updates the point cloud and allows you to 

specify an intensity range for segmentation. This can be useful to separate points sampled on 

surfaces with different (light, dark, etc.) materials. 

Segmenting by Interfering Points 

The Highlight Interfering Points dialog is used to highlight points that are within a user-specified 

distance of a selected object and segment those points from the point cloud. For example, if you 

place a beam into a ModelSpace View using the Insert Object command, and you want to 

identify any points in the point cloud that may interfere with the beam, this command is used to 

identify and segment the interfering points. For directions on identifying and segmenting 

interfering points, see the Interfering Points entry in the Commands chapter.  

Trim Edges 

Occasionally, when scanning, the laser strikes partially on and partially off the edge of an object’s 

surface, which can negatively impact the accuracy of the captured point. The Trim Edges 

command creates a new subset that consists of all the points near the cloud’s boundary. The 

points left in the interior have fewer “partial” samples. 

Inserting Objects 

Not all objects can be produced by fitting to a point cloud. Sometimes the number of points 

sampled on the surface is insufficient for a good statistical fit, the distribution of points is 

unbalanced, or perhaps an object was never directly sampled. Cyclone provides manual insertion 

of objects as an alternative to automatic fitting via the Insert submenu command in the Create 

Object menu. Manually inserted objects behave identically to all other objects, except they are 

not based on sampled points. 

� Object insertion parameters can be adjusted via the Creation/Initial Values area of the 

Object Preferences dialog. (If there is a pick point or object selected in the ModelSpace, 

some of these settings may be overridden. The picked point or object serves as a reference 
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for the inserted object’s parameters.) 

� Object insertion parameters can also be set via standard parts tables. To insert objects from a 

parts table: First, enable Catalog/Parts Table and make Table and Item selections within the 

Object Preferences dialog (different tables and parts can be selected at the time of insertion). 

Then toggle the Use Parts Table command ON from the Create Object menu. 

Object Insertion Rules 

� The first object inserted into an empty scene is inserted at (0, 0, 0). 

� If there is no selected object and no pick point when an object is inserted, the size and 

alignment of the new object are defined in the Creation/Initial Values area of the Object 

Preferences dialog. The object is located in front of the current view at the focal point. 

� When an existing object is picked, the picked object provides a plane, direction, and/or 

vertex for the inserted object to base its initial position, orientation, and dimensions. For 

example, a patch readily defines a plane, a direction (plane normal), and a point (origin). The 

rules can be sophisticated (e.g., when inserting an object on a cylinder, picking near the end 

point inserts the object aligned with the cylinder's axis, but picking away from the end point 

inserts the object perpendicular to the cylinder's surface at the picked point). Exception: 

cameras are always inserted at the current viewpoint regardless of picks. 

� When inserting a series of objects, the previous object provides a plane, direction, and/or 

vertex for the inserted object to base its initial position, orientation, and dimensions. Using this 

method, it is possible to build a chain of objects, such as a piping run, from scratch. However, 

when using auto-pick (see the Auto-Pick Points entry in the Commands chapter), the specified 

auto-pick point overrides any selection point. 

� The inserted object is initially selected with a pick point based on the previous selection. 

If there was no previous selection, a default pick point is provided.  

Using Parts Tables 

Manufacturers of standard equipment fabricate the parts based on published specifications. 

These specifications can be formatted as tables, including geometric data (e.g., dimensions), 

derived properties (e.g., surface area, mass), and nominal information for each standard "part". 

Cyclone supports standard Parts Tables for pipes (cylinder), standard piping components, and 

steel sections (angle, channel, rectangular tube, tee, wide flange). The tables are ASCII text files 

organized under the Tables subdirectory under the “Library folder” of the Cyclone User 

Configuration Manager. Cyclone ships with standard tables for pipes, tubes, and steel sections. 

Do not edit these standard tables. Tables for other shapes are also supported, although standard 

tables are not provided. See the templates in the Lib\Tables subdirectory. 

Disclaimer:  

Although Leica Geosystems HDS provides standard tables, the contents of the tables are 

provided to the user as-is. The correctness of the tables should be checked to the user's 

satisfaction. 
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Fitting and Inserting Objects from Parts Tables  

Many object types support the use of tables for insertion; some support the use of tables in fitting 

to clouds. For those object types that support the use of tables, the Catalog/Parts Table area of 

the Object Preferences dialog is activated when that object is selected in the Object Type field. 

� To enable object fitting from a parts table: First, open the Object Preferences dialog, and 

then enable Catalog/Parts Table and make Table and Item selections. Next, toggle the 

Show Table Matches command ON from the Fit to Cloud Options submenu. See the Fit to 

Cloud entry in the Commands chapter for specific procedures. 

� To enable object insertion from a parts table: First, open the Object Preferences dialog, and 

then enable Catalog/Parts Table and make Table and Item selections (these selections can 

be changed at the time of insertion). Next, toggle the Use Parts Table command ON from the 

Create Object menu. See the Insert entry in the Commands chapter for specific procedures. 

Selection 

Selection Basics 

Generally speaking, an object is selected when you have indicated (in some way) that it will 

participate in the next command operation. Selected surface objects are indicated with a 

checkerboard texture overlay, while point clouds and lines temporarily become thicker while 

selected. 

� The Show Pick Polyline command toggles the display of a polyline along the current series 

of pick points. This is useful for keeping track of the order of picks for operations like creating 

a cubic spline or a polyline from pick points. It does not create a polyline - it only displays the 

order of the pick points. 

� The Show Pick Points command toggles the display of pick points as white points. 

� The Invert Selection command can be particularly helpful for selecting all but a few objects in 

a ModelSpace. This is accomplished by first selecting only the objects that you eventually do 

not want selected, and then using the Invert Selection command. 

� The ability to select any object of a specified type can be toggled ON/OFF from the 

Selectable/Visible tab of the View Properties dialog. (See the Set Selectable entry in the 

Commands chapter.) 

� The Auto-Pick function (see the Auto-Pick Points entry in the Commands chapter), allows 

you to specify a significant point (i.e., the end of a cylinder) that is automatically picked when 

that object type is selected. When using auto-pick, the specified point is always the only 

picked point regardless of whether the object was selected by fence or picked at any other 

point on the object. 
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Object Selection Methods 

A. In Pick mode, click the object with the Pick mode cursor . This is the only way to select 

objects that also allows you to indicate (or “pick”) a specific point on the selected object. 

Picking is useful for indicating where an action might take place next and is required for some 

operations. For example, if you pick an object, then insert an object via Insert submenu 

commands, the new object’s position and orientation may be based upon where you picked 

the first object. 

� Multiple objects can be selected in Pick mode by holding SHIFT and clicking the objects you 

want to select or by entering Multi-Pick mode and clicking objects with the Multi-Pick mode 

cursor . 

� Holding SHIFT and clicking an object that is already selected produces additional pick points. 

� Holding CTRL and clicking an object toggles the selection state of the object without affecting 

the selection state of other objects. 

B. Use the Select Fenced/Deselect Fenced commands to select/deselect every object within or 

overlapping the drawn rectangular data fence. See the Using a Fence section in this chapter 

for more information. Previous selections are not affected by the fence selection. 

C. All objects of a specified type can be selected/deselected from the Selectable/Visible tab of 

the View Properties dialog. (See the Set Selectable entry in the Commands chapter.) 

D. All objects assigned to a layer can be selected/deselected simultaneously from the Layers 

dialog. 

Point Cloud Selection 

Selecting Whole Point Clouds 

A. In Pick mode, click the point cloud with the Pick mode cursor. This is the only way to select 

point clouds that also allows you to indicate (or “pick”) a specific point. Picking is useful for 

indicating where an action might take place next and is required for some operations.  

� Multiple point clouds can be selected in Pick mode by holding SHIFT and clicking the point 

clouds you want to select or by entering Multi-Pick mode and clicking objects with the Multi-

Pick mode cursor . 

� Holding SHIFT and clicking an object that is already selected produces additional pick points. 

� Holding CTRL and clicking an object toggles the selection state of the object without affecting 

the selection state of other objects. 

B. Draw a fence and then use the Select Fenced/Deselect Fenced commands to 

select/deselect every point cloud within or overlapping the drawn rectangular data fence. 

C. All point clouds can be selected/deselected from the Selectable/Visible tab of the View 

Properties dialog. (See the Set Selectable entry in the Commands chapter.) 
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Point Cloud Sub-Selection 

Point Cloud Sub-Selection involves using multiple sub-selections to refine an initial selection (add 

or remove points) before segmentation, fitting, or other processes are performed. After the initial 

selection, the viewpoint can be changed and a new fence can be drawn to add or subtract points 

with subsequent point cloud sub-selection commands (See the Point Cloud Sub-Selection 

command entry). When the sub-selection contains only the desired points, the selected points 

can be manipulated independently of other points in the ModelSpace. 

To make a point cloud sub-selection: 

1. Draw a rough fence containing all the points that you may want to use. 

2. Using the Selection | Point Cloud Sub-Selection submenu commands, create a temporary 

selection. 

3. Continue to refine the temporary selection (add or subtract points) by manipulating the 

viewpoint, drawing a new fence, and using subsequent Selection | Point Cloud Sub-

Selection submenu commands. The points within the temporary subset can now be 

segmented, fit, or used for other processes. 

Using Object Handles 

Most objects in Cyclone provide handles that can be used to adjust the object's position, 

orientation, and/or dimensions. 

Displaying Handles 

Handles are color-coded as follows to indicate the type of handle behavior. 

Red            rotate 

Orange      resize, translate, snap 

Blue           translate, snap  

When an object is selected, the settings in the Handles submenu determine which handles are 

displayed. 

� The Show Handles command toggles the display of handles. This command overrides the 

Show Rotation Handles command. 

� The Show Rotation Handles command toggles the display of rotation handles. 

� The Handles Always Visible command toggles the constant visibility of handles even when 

hidden from view by an object. When this command is checked, it allows convenient access to 

handles that are behind or inside of objects, which would otherwise be hidden from view. 
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Using Handles to Translate, Resize, or Rotate Objects 

All object types in Cyclone can be translated, resized, and rotated using their handles. 

� To translate an object via its handles, drag one of the object’s blue handles, or press and hold 

CTRL and then drag one of the object’s orange handles. 

� To resize an object using its handles, drag one of the object’s orange handles. 

� To rotate an object using its handles, drag one of the object’s red handles. 

� When an object in a group is selected, both that object's handles and the handles on the 

group’s bounding box are displayed and available for manipulating the group as a whole. 

When the group is selected in any other way (e.g., by fence), only the handles on the group’s 

bounding box are shown. Orange resizing handles are not available for objects in a group. 

Resizing Steel Shapes 

� To resize a steel shape’s profile while maintaining the position of the face opposite the handle, 

drag one of the object’s handles. 

� To resize a steel shape’s profile around its midline, press and hold ALT while dragging one of 

the object’s edge handles. 

Constraining Handle Movement 

Object handle motion can be constrained to a specified axis or plane in two ways. The first 

method is to set the constraint before manipulation via the Edit Object | Handles | Constrain 

Motion to submenu commands. The second method cycles constraints during handle 

manipulation via keyboard modifiers. Additionally, object rotation via red handles can be restricted 

to user-specified angular intervals. 

Constraining Before Manipulation 

� To select the plane or axis along which the handle movement is restricted, use the Edit 

Object | Handles | Constrain Motion to submenu commands. The Screen Plane setting 

constrains motion to be perpendicular to the viewpoint, while the other settings use coordinate 

system axes. 

� Handles can also be constrained to move by user-specified increments by using the Snap to 

Grid command. 

� To constrain rotation handle movement, the Snap to Grid command must be ON. To set the 

rotation interval, use the Set Rotational Spacing command. 
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Constraining During Manipulation 

� To constrain handle movement to an axis, pick a handle and press the X, Y, or Z key. The first 

time the key is pressed, handle movement is constrained to be along the corresponding axis 

(i.e., pick a handle and press X and handle movement is constrained along the X axis). 

� To constrain handle movement to a plane, pick a handle and press the X, Y, or Z key a 

second time. The handle is constrained to the plane that does not include the axis of the key 

pressed. Pressing the X key a third time removes the constraint and reverts to the default 

behavior. 

� To toggle the Screen Plane constraint ON/OFF, press S. 

� To remove any active handle restraints, pick a handle and press Spacebar. 

Note:  Select either User Coordinate System or the Object Coordinate System axes for 

handle constraints in the Edit Object | Handles | Constrain Motion to submenu. 

Using Handles to Snap Objects 

Using Handles to Snap Objects 

Most objects in Cyclone provide one or more points, lines, and/or planes that can be used in 

addition to its handles as snapping points when moving or resizing other objects via handles. 

(Note that some objects provide bounding box handles only.) Objects that are being manipulated 

snap to other objects whose handles or other snapping points, lines, and/or planes come within 

the user-specified snapping threshold. The snapping threshold can be adjusted using the Snap 

to Object Threshold dialog. 

To snap selected objects: 

1. Multi-select the objects you want to snap. 

2. Press and hold SHIFT and drag the second object’s handle towards the reference object to 

resize the object. Press and hold SHIFT + CTRL while dragging the second object’s handle 

towards the reference object to translate the object. When the dragged handle passes over 

one of the reference object’s handles, it snaps to that handle. When any of the reference 

object’s snapping points are within the snapping threshold (specified in the Edit Snap to 

Object Threshold dialog), the object being manipulated jumps to the snapping point defined 

by the reference object.  

� When the snapping point is “handle-to-handle”, the handles appear larger when they snap. 

The dragged handle can be moved away from the snap when the cursor passes beyond the 

snapping threshold. 

� To make the object you are moving or resizing snap to the reference object’s snapping point 

at a perpendicular or parallel angle, press and hold SHIFT + ALT and drag the object handle 

towards the reference object. If the angle of intersection is at least 45 degrees, the second 

object is snapped at a perpendicular angle. If the angle is less than 45 degrees, the second 

object snaps parallel with the reference object. 
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Adding and Deleting Boundary Vertices to or from a Patch, Extrusion Face, 

Polygon, or Polyline 

Vertices can be added to or deleted from a selected patch, extruded face (top and bottom faces), 

polygon, or polyline while in Pick mode.  

� To add a vertex to the selected patch, extrusion face, polygon, or polyline, press and hold 

ALT and click along the edge of the selected object without moving the mouse. A vertex (and 

a handle) is added to the object. 

� To remove a vertex from the object, press and hold ALT and click the vertex you want to 

remove without moving the mouse. The vertex (and the handle) is removed. 

Editing Objects 

The Color and Material Editor dialog is used to change the display properties of the selected 

object(s). Color and material settings can be adjusted individually. For a vertex, line, or point 

cloud, only the diffuse material property affects how it is displayed. 

The Align submenu commands and dialogs are used to align objects in a variety of ways, 

including: aligning objects to a reference surface or axis; using a reference object to make objects 

coincident, colinear, coplanar, parallel, perpendicular, or codirectional; and placing selected 

objects at a specified distance or angle from each other. Many common modeling tasks can be 

accomplished with Align submenu commands and dialogs (e.g., making walls perpendicular to 

floors or making a ceiling parallel to a floor.) 

The Extend submenu commands extend a single object to the intersection with a reference 

object or extend the boundary of all selected objects to the planar or linear intersection with the 

other selected objects. A common use would be extending a column to a floor. 

Extrude 

The Extrude submenu commands are used to create an extrusion object from a patch or a face 

of an extrusion object. The extrusion is created with a specified thickness either along a user-

specified axis, along the patch’s normal towards the viewpoint, or towards a pick point. An 

extrusion can be used to create a box from a patch to represent an electrical box, for example. 

Merge 

The Merge command combines two or more selected objects of the same type. In the process of 

creating a single new object, the merging function fills in space between the selected objects. Use 

this command to create objects such as wide floors and ceilings and long pipes. This feature is 

particularly useful when filling areas that have not been scanned directly. If the objects were 

created from point clouds, the merged object is refit to the original point clouds. The current 

settings and Object Preferences for use of Parts Table, Fit Tolerances, and Fit Constraints are 

used in this fit. 
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Copy 

The Copy dialog is used to create a series of translated copies of the selected object(s). The 

Copy at Offset tab is used to specify the number of copies and the axis along which they are 

translated. This option is commonly used to model ceiling beams, pipe racks, or stairs. 

The Copy at Angle tab is used to make a series of copies of the selected object(s) rotated 

around a specified axis. The number of copies, the angle between each copy, the center point, 

and the axis of rotation can be specified in this tab. This option can be used to model the bolts on 

a flange face, for example. 

Move/Rotate 

The Move/Rotate dialog is used to rotate or move one or more selected objects. When moving 

an object, the distance and axis of the motion are user-specified. When rotating an object, the 

center point, angle of rotation, and axis around which the object is rotated are user-specified. 

Using a Fence 

A fence is a two-dimensional, rectangle or polygon that is used as a boundary to select and 

deselect objects and point clouds, segment point clouds and other objects, and create 2D line 

drawings. Fences can be created in Rectangular or Polygonal Fence Mode, or linear objects 

(such as polygons, ellipses, arcs, etc...) can be used to define the boundaries of a fence. 

Creating a Fence 

To create a fence from a linear object: 

� This function provides a convenient method for repeatedly creating the same fence. 

1. Select the linear object you wish to use to define a data fence. 

� Linear objects can be created by a variety of methods including via the 2D drawing tools. If an 

arc or other open curvilinear object is selected, the end points are connected for purposes of 

defining the data fence. 

2. From the Edit menu, point to Fence, and then select Set from Selection. The fence is 

created. 

To draw a rectangular fence: 

1. From the Edit menu, point to Modes, and then select Rectangle Fence Mode. The 

Rectangle Fence cursor appears. 

2. Drag the cursor around the area that you want to fence. 

� The newly drawn fence can adjusted by dragging its sides or vertices with the Rectangle 

Fence cursor. 

� To clear the newly drawn fence, select Clear from the Fence submenu. 
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To draw a polygonal fence: 

1. From the Edit menu, point to Modes, and then select Polygonal Fence Mode. The 

Polygonal Fence cursor appears. 

2. Click to place the first vertex. 

� Drag to adjust the vertex position. 

3. Continue adding vertices as needed. 

� A vertex can also be added by clicking anywhere along the line segment between existing 

vertices. 

� An existing vertex can be deleted by clicking the vertex without moving the mouse. 

� The newly drawn fence can adjusted by dragging its vertices with the Polygonal Fence 

cursor. 

� To clear the newly drawn fence, select Clear from the Fence submenu. 

Fence Operations 

Deleting with a Fence 

When a fence has been drawn, cloud points, mesh triangles, and line segments (in contour lines 

and polylines) can be deleted relative to the fence and according to their selection status using 

the Fence submenu commands in the Edit menu. Point clouds, meshes, contour lines, or 

polylines that are overlapping a fence are first segmented, and then the appropriate segment is 

deleted. Other objects are not affected by these fence operations. 

� The Delete Inside command removes all cloud points, mesh triangles, or line segments within 

or partially within the data fence. 

� The Delete Outside command removes all cloud points, mesh triangles, or line segments 

entirely outside of the data fence. If a triangle or line segment is partially within the fence, it is 

not deleted. 

� The Delete Selected Inside command removes every selected cloud point, mesh triangle, or 

line segment within or partially within the data fence. 

� The Delete Selected Outside command removes every selected cloud point, mesh triangle, 

or line segment entirely outside of the data fence. If a triangle or line segment is partially 

within the fence, it is not deleted. 

� When enabled, only those portions within the Limit Box are affected by these operations. 
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Selecting Objects with a Fence 

A fence can be used as a boundary for selecting objects (including mesh triangles and line 

segments) and point clouds using commands in the Selection menu. These commands do not 

segment selected objects. 

� The Select Fenced command selects every object or point cloud (the entire point cloud is 

selected) entirely within or partially overlapping a fence. In the case of a mesh object, the 

entire mesh object is selected, as are all triangles within or partially within the fence. 

Subsequent commands performed on the selected mesh/triangles may pertain to the entire 

mesh if the commands are not mesh-specific (e.g., Edit | Delete), and to the triangles if the 

commands are mesh-specific (e.g., Mesh | Delete Selection). In the case of contour lines 

and polylines, line segments within or partially within the fence are selected. 

� The Deselect Fenced command deselects every object or point cloud (the entire point cloud 

is deselected) entirely within or partially overlapping the fence. 

Segmenting with a Fence 

A fence can be used as a boundary to segment the selected cloud, mesh object, contour line, or 

polyline into two subsets using the Cut by Fence command. More than one point cloud, mesh 

object, contour line, or polyline can be segmented simultaneously. For more information, see the 

Point Cloud Segmentation section in the Modeling chapter. 

Copy Fenced Objects to a New ModelSpace 

The Copy Fenced to New ModelSpace command is very useful for editing objects in a separate 

ModelSpace containing only the objects with which you are currently working. This command 

creates a new ModelSpace, copies the fenced object(s) into the new ModelSpace, and opens a 

ModelSpace View for the new ModelSpace. Partially fenced objects are included in the new 

ModelSpace. Partially fenced clouds are not segmented, but only the points within the fence are 

copied. See the Copy Fenced to New ModelSpace entry in the Commands chapter for 

instructions. 

Extracting 2D Lines from the Contents of a Fence 

A 2D line drawing can be created from the contents of a rectangle fence using the From Fence 

Contents command. The 2D drawing is created and displayed in a new window. See the From 

Fence Contents entry in the Commands chapter for more information. 

Taking Measurements 

Cyclone provides a variety of object and linear measurement tools in the Measure submenu. 

Measurements can be viewed, saved, deleted, and copied to the Windows clipboard using the 

Measurements dialog. It is often unnecessary to save each measurement, so measurements are 

considered “temporary” unless the Save Measurements option is ON. Temporary measurements 
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are replaced by each newly executed measurement command, and can be cleared using the 

Clear Temporary Measurements command. Some objects must be picked to display a 

measurement graphic. 

Object Measurements 

ELEVATION 

This command calculates the distance between a picked point and the origin along the current 

vertical direction. If multiple points are being measured, the results are displayed in the order 

in which the points are picked. 

CENTERLINE LENGTH 

This command calculates the length along the centerline of the selected object(s). When more 

than one object is selected, this command sums the centerline length of each object. You can 

use this command to measure the distance along a pipe run . 

PIPING TAKEOFF  

This command calculates the takeoff for the selected piping run. The piping takeoff is similar 

to the centerline length, except that the length of an elbow or bend is not the arc length, but 

rather the sum of the distances from each of its endpoints to where its endpoint tangents 

cross. 

SURFACE AREA 

This command computes the surface area of the selected object(s). If more than one object is 

selected, individual and collective measurement results are displayed. 

VOLUME 

This command computes the volume of the selected object(s). If more than one object is 

selected, individual and collective measurement results are displayed. Mesh objects and point 

clouds viewed as a mesh do not contribute to this volume. 

Surface Deviation 

Measure surface-to-surface differences in elevation between a TIN and the active reference 

plane or another TIN. 

TIN Volume 

Measure cut/fill volume between a TIN and the active reference plane or another TIN. 

MESH VOLUME: ABOVE/BELOW REF PLANE 

This command computes the volume of a mesh to the active Reference Plane. For example, if 

you have a scan of a mound of dirt and need to know its volume, you can set the active 

Reference Plane to the ground level, create a mesh object from the point cloud (or view the 

point cloud as a mesh), and compute the mesh volume. 
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INTERFERING POINTS 

This command is used to highlight and segment points that are within a user-specified 

distance of a selected object. If the selected object defines a volume, the points contained 

inside the object are also highlighted and segmented. 

MESH TO POINTS DEVIATIONS 

This command compares the faces in a selected mesh object with the points in the selected 

point cloud, and uses the data to calculate deviations in accordance with user-defined 

parameters. This command is applicable to mesh objects only (as opposed to a point cloud 

viewed as a mesh). 

CONTOURS TO MESH DEVIATIONS 

This command compares the lines in a selected contour set with the faces in the selected 

mesh object, and uses the data to calculate deviations in accordance with user-defined 

parameters. This command is applicable to contours and mesh objects only (as opposed to a 

point cloud viewed as a mesh). 

FIND HIGH/LOW POINTS 

This command is used to locate the highest or lowest point in a point cloud within a specified 

area around a picked point. Vertices can be created when high/low points are found. 

Linear Distance Measurements 

POINT TO POINT 

This command calculates the shortest distance between picked points (a straight line) as well 

as the component offsets along the major axes. 

POINT TO CENTER LINE/POINT 

This command calculates the distance between the first picked point and the center point or 

the nearest intersection with the centerline of the object selected last.  

�� If the second object is a sphere, it does not matter where it was picked or if it was selected 

by other means, since the center point of a sphere is its exact center. 

�� If the measurement is to the centerline of the second object, it does not matter where the 

object was picked or if it was selected by other means. 

�� For measurements, centerlines are extended beyond the endpoint or boundary of the 

actual object to the nearest point of intersection. For example, a measurement to the 

centerline of a cylinder is made to the nearest point on the underlying axis of the cylinder, 

which is not necessarily a point within the length of the cylinder. 

POINT TO UNBOUNDED SURFACE   

This command calculates the distance between the first picked point and the nearest 

intersection with the surface of the object selected last. Since the measurement is to the 

unbounded surface of the second object, it does not matter where it was picked or if it was 

selected by other means. 

�� For measurements, surfaces are extended beyond the endpoint or boundary of the actual 

object to the nearest point of intersection. For example, a measurement to the surface of a 
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patch is made to the nearest point on the underlying plane of the patch, which is not 

necessarily a point within the boundary of the patch. 

CENTER TO CENTER 

This command calculates the distance between the centers of the first selected object and the 

nearest intersection with the center of the second selected object. The object type determines 

whether the measurement is to a centerline or to a center point (e.g., a sphere is measured to 

its center point and a cylinder is measured to its centerline.). It does not matter where the 

objects were picked or if they were selected by other means. 

POINT TO SCANNER            

This command calculates the distance between a picked point and the selected scanner. If a 

point cloud is picked and a scanner object is not selected, Cyclone determines the distance 

from the picked point to the scanner that was used to capture the point cloud. This can be 

used to get a sense of the “depth” of a scanned scene, and whether or not the point is within 

the calibrated range of the scanner. 

Datum Measurements 

A "datum" is a user-defined vertical line used to take measurements of other objects and 

features. You create a datum by picking a point in the ModelSpace and selecting the Set Datum 

to Pick Point command, or by selecting the Enter Datum command, then entering the (X, Y, Z) 

coordinates of the desired point; the datum is created as a vertical line passing through that point. 

Until a datum is defined by the user, the default datum passes through the point (0, 0, 0). You can 

measure the distance from the datum to any picked point(s) in the ModelSpace using the Point 

Distance command; the shortest distance from the point to the datum line is computed. 

Working with Meshes 

A mesh is a series of triangles created using the points in a point cloud, vertices, polylines, or any 

combinations of the three as vertices. For each adjacent trio of points in a cloud, a triangle is 

created. This has the effect of generating a coherent visual surface from a point cloud. 

Cyclone enables you to create dynamic mesh objects that can be manipulated extensively to 

achieve the visual results you need. Triangles can be added, edited, or removed. Mesh objects 

can be decimated using a dynamic real-time interface that allows you to adjust and fine-tune your 

mesh. New vertices can be incorporated into the mesh from user-drawn polylines, and breaklines 

can be placed into the mesh to preserve geometric features during a decimation. 

Sample Grid 

Resamples TIN meshes on a regular grid. 

Creating a Mesh Object 

Mesh objects are created using the Create Mesh... command. 

 Note:  If you merely wish to view the point cloud as a mesh, it is recommended that you use 

the View Object As... functionality to view the point cloud as a mesh. See the View 

Object As entry in the Commands chapter for more information. 
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� If you are creating a TIN, set the “up” direction as desired before creating a mesh object. 

To create a mesh object: 

1. Select the point cloud (vertices, or polylines) to be used for creating the mesh object. 

2. From the Create Object menu, select Create Mesh.... The Meshing Style dialog opens. 

3. Select the type of mesh object you wish to create.  

 Note: When creating a TIN, any selected polylines are incorporated as breaklines in the 

new TIN. 

� Select Basic Meshing to create a basic mesh consisting of triangles using trios of adjacent 

points as triangle vertices. Select Complex Meshing to create a mesh consisting of triangles 

using trios of adjacent points that are likely to lie on the same surface. Select TIN Meshing to 

create a mesh such that there are no overlapping triangles with respect to the vertical 

direction; the current coordinate system determines the “up” direction for a TIN. 

 Note:  Basic Meshing and Complex Meshing cannot be done with more than one point 

cloud. 

4. Click OK. The mesh object is created. 

� Click Cancel to abort the command. 

� Use the ScanWorld Explorer to make the point cloud visible again. See the ScanWorld 

Explorer entry in the Commands chapter for more information. 

 Tip: If your mesh object seems to have deep shadows or what seem to be large gaps, go to 

the ModelSpace tab in the Edit Preferences dialog, change the lighting preferences to Point 

Source, and click Apply. 

Mesh Viewing Options 

Cyclone provides you with a variety of options for adjusting and fine tuning the view of your mesh 

object. Viewing a mesh in wireframe can be helpful, especially when you are editing individual 

triangles and need to see triangle vertices and edges (See Illustration 1). 

Similarly, the "Per Face Normals" view option displays individual triangles such that they may be 

easier to distinguish. Each triangle is rendered as an individual surface with its own surface 

normal. As with wireframe, this is a useful view option when editing a mesh (See Illustration 2). 

Mesh Object Illustration 1 
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Mesh Object Illustration 2 

 

Editing a Mesh Object 

Once created, a mesh object can be edited and fine-tuned to produce a specific deliverable. 

Note: Only mesh objects can be edited. Point clouds viewed as meshes (via the View 

Objects As dialog) cannot be changed or edited using mesh tools.  

Editing Triangles 

Each triangle in the mesh object can be edited as an individual object using commands in the 

Mesh submenu. Use the Move Vertex command to change the shape of a triangle. You can also 

use the Flip Selected Edge command to make subtle changes in the mesh; this command flips 

the selected edge, redrawing the two triangles sharing the selected edge. 

Use the Delete Selection command in the Mesh submenu to remove unwanted triangles. Be 

careful not to use the DELETE key on your keyboard. It will result in deleting the entire mesh 

object. Similarly, avoid using the “Cut” and “Copy” functions in the Edit menu unless you intend to 

use them on the mesh object as a whole. 

Filling in Holes 

Holes in the meshing can be filled by using the Fill Selected Hole command. However, if a hole 

is not enclosed by the mesh (e.g., it coincides with the outer edge of the mesh), this command 

may not work as expected. A good technique for filling these types of open-ended gaps is to 

close off the gap at the edge of the mesh, either by moving a vertex across the gap to close it in, 

or by adding a face based on picks to either side of the open end of the gap. Once the open end 

has been closed off, the remaining hole can be filled using the Fill Selected Hole command.  

Polylines and Meshes 

Polylines can be used to enhance a mesh object. A common use for a polyline is to create a 

breakline in the mesh. A breakline is a polyline that has been incorporated into a mesh object. 
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The vertices of a breakline are “locked” during decimation; this can be a useful feature when you 

want to preserve a particular geometric feature of the mesh (e.g., a curb edge). In addition, 

breaklines are exported with a mesh object when exporting a TIN using the Export... command. 

Note:  A polyline that is projected onto a mesh as a polyline, is merely a relocation of that 

individual polyline. It is not incorporated into the mesh as a breakline, and it is not used 

during decimation. 

To incorporate a breakline into a mesh object (e.g., to preserve a curb edge): 

1. Identify the geometric feature to be preserved, and multi-select several points within the mesh 

along the edge of the feature. 

� It is not necessary to pick vertices within the mesh. 

2. From the Create Object menu, point to From Pick Points and select Polyline. A polyline is 

drawn using the pick points as vertices, and the newly created polyline remains selected. 

� You can also use polylines created from imported files (i.e., from survey data).  

3. Multi-select the mesh object. 

4. From the Tools menu, point to Mesh, then to Breaklines, and select either Project Polyline 

to Mesh or Extend Mesh to Polyline as appropriate. The polyline is incorporated into the 

mesh, the polyline vertices are added into the mesh, and triangles are redrawn as appropriate 

to accommodate the breakline. 

� See the Project Polyline to Mesh and Extend Mesh to Polyline entries in the Commands 

chapter for more information on incorporating polylines into a mesh object. 

� The Clear Breaklines command can be used to remove all breaklines from a mesh object. 

� When decimating a mesh containing breaklines, be sure to select either Maintain or Keep 

Exact in the Breaklines field of the Decimate Mesh dialog if you want to preserve breakline 

integrity.  

Decimating Meshes 

Mesh decimation is the process by which the number of triangles in a mesh is reduced according 

to user-defined parameters. The Decimate Mesh dialog supports interactive decimation; as you 

move the Percentage slider, the mesh in the ModelSpace view is continually redrawn to reflect 

the changing percentage value when the Auto Preview checkbox is selected.  

You control the decimation by determining the level of decimation that is to occur, and whether or 

not to maintain vertices, breaklines, and boundary edges. For example, when Maintain Vertices 

is enabled, the positioning of mesh vertices is preserved as closely as possible to their original 

locations, given the amount of decimation being performed; the higher the percentage, the more 

likely it is that vertices will remain at or near their original positions. You can choose to “maintain” 

breaklines and/or boundary edges: The boundary edges/breaklines are preserved geometrically 

relative to the level of decimation. However, you can also choose to ignore breaklines and/or 

boundary edges, in which case no attempt is made to preserve original positioning, or you can 

choose Keep Exact, in which case the vertices in breaklines and/or boundary edges are frozen in 

place and are not modified, no matter how heavily decimated the mesh is. 
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� For detailed instruction on decimating a mesh object, see the Mesh entry in the Commands 

chapter. 

Selecting Parts of a Mesh 

When editing a mesh object, it is necessary to select triangles, edges, holes, or vertices, 

depending on the function to be initiated. For example, an edge must be selected to use the Flip 

Selected Edge command. When a selection is made within a mesh object, the triangle (to which 

the selection pertains) is shown in a different color. Selection coloring can be re-defined as 

desired in the Object Properties dialog (see the Edit Properties entry in the Commands chapter). 

� To select a triangle, click on the desired triangle. Picking triangles while holding the SHIFT key 

allows you to select multiple triangles. If the selected triangle is adjacent to a hole in the mesh, 

the hole is selected as well. 

� For operations that require selection of a vertex or a triangle edge in a mesh object, the 

vertex/edge closest to your pick on the mesh will be selected and used. 

Using a Mesh to Create Other Objects 

Once a mesh is created, it can be used for creating other objects. Contours are drawn using a 

mesh as a basis; the mesh can be either a mesh object or a point cloud viewed as a mesh.  

� For detailed instructions on creating contours, see the Create entry in the Commands chapter. 

In addition to contour lines, you can use the Extract Cloud from Selection command to create a 

new point cloud containing the vertices in a mesh object. The resulting point cloud is a new cloud; 

it is not a retrieval of the original cloud(s) used in the creation of the mesh.  

Note:  To retrieve the original point cloud from which a mesh object was created, you can use 

the ScanWorld Explorer to make the points visible, or you can use the Insert Copy of 

Object’s Points command. 

Using Cutplanes 

The Cutplane is a 3D plane with the primary function of "cutting" through objects in a ModelSpace 

to produce a 2D cross-section. There may be more than one Cutplane cutting through the 

ModelSpace, although only one is the “active” Cutplane at any given time. The active Cutplane is 

the only Cutplane affected by user commands. The Cutplane can be used to create polylines 

from its intersections with objects and meshes, and the active Cutplane can be used to hide all 

geometry above itself, or to hide all geometry beyond a user-specified distance from its plane. 

� The Cutplanes dialog is used to create, delete, and edit Cutplanes. 

Positioning the Cutplane 

Raising and Lowering 

The Cutplane can be raised/lowered by user-defined increments using the Raise Active 

Cutplane and Lower Active Cutplane commands. The increment by which the active Cutplane 
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is raised and lowered using these commands is set in the Cutplane Offset dialog. This offset is 

used each time you raise or lower the Cutplane. 

Tip:    When manipulating a Cutplane repeatedly, it can be more efficient to assign hotkeys 

(see the Customize Hotkeys entry in the Commands chapter) to the Raise Active 

Cutplane and Lower Active Cutplane commands. 

Aligning 

The active Cutplane can be aligned to the active Reference Plane using the Set from Ref Plane 

command. The Cutplane can also be aligned to a reference object using the Set on Object 

command. This command aligns the active Cutplane through a pick point and along the axis of 

the selected object (for point clouds, the surface normal of the picked point is used as the axis). 

Cutplane Operations 

View Half-Space 

Once the Cutplane has been positioned, you can visually hide all geometry above the active 

Cutplane using the View Half-Space command. This produces a helpful visualization of the 

cross-section and everything below. It can be useful to see "inside" the surfaces that are left 

visible. 

� To toggle the visibility of the geometry, use the Flip Cutplane Normal icon in the Cutplanes 

dialog.  

Slice 

It can be useful to create a “slice” around the active Cutplane, beyond which all geometry is 

hidden. The results of the View Slice command resemble a cross-section that can be used for 

quick 2D plots directly from point clouds and surfaces. 

� To set the thickness of the slice, use the Set Slice Thickness... command. 

Create Lines 

The Cutplane can also be used to create polylines at the intersection of the active Cutplane with 

objects and meshes. The polylines that result from using the Create Lines from Cuts command 

are separate from the objects used to create them and can be manipulated independently. 

Likewise, changes to the source objects do not change the polylines once they have been 

created. 
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Fit Edge 

Cyclone’s Fit Edge tool can be used to generate polylines describing a swept edge best-fit to a 

point cloud. 

The Fit Edge Process 

The following is an outline of a typical work-flow: 

� All edge fitting is done via the Fit Edge dialog, which is in the Create Object submenu of the 

ModelSpace window. 

1. Select one or more point clouds to which you want to fit an edge. 

2. From the ModelSpace window, open the Fit Edge dialog, and then manipulate the viewpoint 

so that the cross-section of points is apparent. 

3. Draw a 2D template using the selected point cloud as a reference. 

4. Add nodal points to the 2D template. 

� The nodal points indicate the position at which polylines are created and swept across the 

point cloud based on the fit. 

� Hold the Alt key and click on a nodal point to delete it. 

5. Fit the results to the selected point cloud to create the swept polylines. 

Fit Edges Using Simple Templates 

The following example of finding the edges of a street curb illustrates how complex structures 

may be effectively modeled in simple pieces. 

Figure 1 shows a scan of a street corner within a limit box. (See Figure 1). In order to model the 

upper and lower edges of the curb, one approach is to use the Create Object - Fit Edge 

command to draw a polyline describing the cross-section of the curb (See Figure 2). However, 

because the curb changes height at the wheel chair access ramp and at the drain, this template 

only describes the points for a short distance. To avoid this problem, split the curb template split 

into two parts: the upper edge and the lower edge (See Figure 3 and Figure 4). By using these 

two templates separately, we are able to model the top edge over the drain and into the 

wheelchair access ramp. 
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Fit Edges Illustration 1 

 

 

Fit Edges Illustration 2 
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Fit Edges Illustration 3 

 

Fit Edges Illustration 4 
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Color Mapping 

In Cyclone, the default color mapping scheme works as follows: each cloud is assigned a range 

of intensities based on the highest and lowest intensity values of the sampled points. These high 

and low values are mapped to the highest and lowest possible colors in the given scheme (hue-

based, grayscale, etc.) producing the largest range of colors, which aids visualization. This is 

done for each individual point cloud. A consequence is that two points of identical intensity value 

that appear in different clouds are often mapped and colored differently. 

� To view a cloud/mesh’s color map, select the point cloud/mesh and point to Edit Object | 

Appearance | Apply Color Map and select the type of color map. 

 -or- 

 Select the point cloud/mesh and select the desired color map from View As tab of the View 

Properties dialog. See the View Object As..entry in the Commands chapter. 

� For definitions of the available types of color maps, see the Edit Color Map entry in the 

Commands chapter. 

� To edit the color map for the selected cloud/mesh, select Edit Color Map... from the 

Appearance submenu of the Edit Object menu. 

Global Color Map settings allow users to designate the color mapping for all clouds 

simultaneously, based not on the original or current range of its source scan but on the actual 

intensity value of each of its sampled points, so that all points with the same intensity are drawn 

with the same color. When Global Color Mapping is ON, it overrides any individual color map 

parameters or point coloring for individual point clouds and meshes. 

� To toggle Global Color Mapping ON/OFF, select Global Color Map from the Appearance 

submenu of the Edit Object menu. 

� To edit the Global Color Map, select Edit Global Color Map... from the Appearance 

submenu of the Edit Object menu. 

Object Preferences 

The Object Preferences dialog provides a central location where object modeling defaults may 

be configured. The dialog is available from the Navigator window (to set user default and 

session-level preferences) and ModelSpace Viewers (to set user default, session-level, and 

ModelSpace View-specific preferences). 

Object Information 

Cyclone displays information for any selected object within a ModelSpace when the Object Info 

command is selected from the Info submenu. The type of information displayed depends on the 

type of object selected. 

� When more than one object is selected, information is displayed for each object in its own 

Object Info dialog. These dialogs can be moved and closed individually. 

� When the Automatically Update box is checked in the Object Info dialog, the object 

information changes when the object changes. If the box is unchecked, the contents of the 
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Object Info dialog for that object do not change. Disabling the automatic update can be useful 

when performing a “before and after” comparison of values. 
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Working with the ModelSpace 

ModelSpace Navigation 

Changing the Viewpoint 

Changing the Viewpoint 

A viewpoint is a viewing position or camera angle used to simplify ModelSpace navigation. 

Cyclone provides controls in View mode that allow you to manually zoom in/out, and rotate or 

pan around a focal point using a mouse. The viewpoint can also be zoomed in/out, moved, and 

rotated around the focal point by preset increments using the commands in the Zoom, Move 

Viewpoint, and Turn Viewpoint submenus (located in the Viewpoint menu). The focal point is a 

certain distance in front of the center of the viewpoint; It can be reset in Seek mode and moved 

by panning the viewpoint.  

     Cyclone uses Level of Detail (LOD) reduction, which allows for faster loading of points clouds 

and smoother interaction and movement within a view when you are panning, rotating, or 

zooming.  

� If your display has automatic LOD reduction enabled for point clouds, you can temporarily 

disable the LOD reduction by holding down the left SHIFT key while panning, rotating, or 

zooming. 

Manual Viewpoint Controls 

� The ability to pan, zoom, or rotate can be disabled temporarily via the View Lock submenu 

commands. This can be useful when you need to refrain from rotating the viewpoint, for 

example. 

ROTATE  

To rotate the viewpoint around the focal point, drag (press and hold the left mouse button 

while moving the mouse) while in View mode. 

PAN  

Right-drag (press and hold the right mouse button while moving the mouse) while in View 

mode. 

ZOOM 

Press and hold both mouse buttons and move the mouse down/up to zoom in/out. 

Advanced Manual Viewpoint Controls 

ROTATE FOCAL POINT  

To rotate the focal point around the viewpoint, hold CTRL and drag while in View mode. 
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ROLL  

To roll the viewpoint around the current forward direction (similar to an airplane barrel roll), 

hold CTRL and right-drag while in View mode. Viewpoint | Keep Viewpoint Upright must be 

disabled to use this control. 

ZOOM FOCAL POINT AND VIEWPOINT  

To move both the focal point and the viewpoint forward/backward, hold CTRL and both mouse 

buttons while dragging up/down while in View mode. 

To reset the focal point: 

1. From the Edit menu, point to Modes, and then select Seek Mode. The cursor changes to the 

Seek Mode cross-hair. 

2. Pick the point that you want as your new focal point. The viewpoint is adjusted and the focal 

point is set. 

Standard Viewpoints 

Your viewpoint can be switched at any time to one of several standard viewpoints using the 

Standard Viewpoints submenu commands. Standard viewpoints include: top, bottom, left, 

right, front, back, isometric, and right isometric. See the corresponding commands in the 

Commands chapter. 

Aligning the Viewpoint to Objects 

The viewpoint can be aligned to a reference object in the ModelSpace with the Align to 

Selection command. This command moves the viewpoint the shortest possible distance in order 

to be parallel with the axis of a selected object.  

� For a selected point cloud, the viewpoint is aligned with the position of the scanner that 

scanned the point cloud (if available). 

Zoom Control 

In addition to manual zoom controls (described above), Cyclone provides commands to zoom the 

viewpoint in or out by preset increments (from 1.5 to 2 times larger or smaller), or to zoom to fill 

the view with a fence or selection. 

Saving and Restoring Viewpoints 

The ability to save and restore several viewpoints can be helpful in the navigation of larger 

ModelSpaces. User-defined viewpoints can be saved, deleted, and restored using the User 

Viewpoints dialog. You can save viewpoints that are useful for modeling or provide a specific 

viewpoint for later restoration. 
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Maintaining Up Direction 

Cyclone lets you pan, rotate, and zoom the viewpoint in 3D. However, you may prefer not to 

rotate the view with all three degrees of freedom (roll, yaw, and pitch) turned ON. For example, it 

is not always obvious which way is "up". The Keep Viewpoint Upright command removes the 

“roll” component of the viewer in order to keep the “up” axis oriented upward in the viewer while 

rotating the viewpoint. That is, you can rotate left and right, and up and down, but you can’t view 

a scene upside-down. 

� A ModelSpace’s "up" and "down" are initially defined by the current coordinate system. By 

default, "up" follows the same direction as the positive Y axis. 

� A ModelSpace’s “up” can be set via the Set Up Direction or the Set from Points... 

command. 

ModelSpace Views 

A ModelSpace View is a collection of settings applied to a ModelSpace, including the initial 

viewing position and settings for graphical viewing parameters that override the object’s default 

parameters. Multiple ModelSpace Views can be saved and restored for a given ModelSpace to 

provide ready access to particular aspects of a ModelSpace, or to provide a custom modeling 

environment for a modeler in a large, multi-person project.  

All changes made to objects within the ModelSpace are immediately reflected in all of the 

ModelSpace’s Views. Multiple users may share a single view; one user's changes to the shared 

View are visible to the other users of that View.  

� To save ModelSpace Views, use the Save View As dialog. 

 Note:  The View must be saved at least once before changes to the View are made persistent 

and before the View is available to other users. 

� To restore saved ModelSpace Views, use the Switch to Views dialog or open them from the 

Navigator window. 

Orthographic/Perspective Views 

A ModelSpace can be toggled between othrographic and perspective projection by clicking the 

Orthographic  or Perspective  icons, or by selecting the Orthographic/Perspective command in 

the Viewpoint menu. 

� In orthographic projection, parallel lines remain parallel, though perceived angles may change. 

It may be difficult to determine relative depth, but this view is often preferred by architects and 

engineers in top-down or side views. The real world, however, is viewed in perspective. 

� In perspective projection, parallel lines may converge and relative depth may be easier to 

visualize. 
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Coordinate System 

When a ModelSpace is contained by a ScanWorld, the default coordinate system is set to that of 

the ScanWorld. After changing the active coordinate system in the ModelSpace View, the default 

coordinate system can be restored by selecting the Default coordinate system in the User 

Coordinate Systems dialog (see the Save/Edit Coordinate Systems entry in the Commands 

chapter). When working with larger and more complex ModelSpaces, it can be helpful to define 

and save multiple coordinate systems for navigating and analyzing the ModelSpace. Coordinate 

systems are stored with the ModelSpace View. 

� The current coordinate system for a ModelSpace View can be copied into its parent 

ScanWorld. This is done via the Set ScanWorld Coordinate System command. After a 

ScanWorld’s coordinate system is reset, any subordinate ModelSpace Views are created 

using the new coordinate system. 

Editing the Coordinate System 

Individual coordinate system axes can be set to the axis of a reference object using the Set 

Using One Axis submenu commands, while the remaining two axes are arbitrarily assigned, 

perpendicular to the one axis. Using the Set Using Two Axes submenu commands, all three 

coordinate system axes can be set at once to the axes of two reference objects. With the Using 

Two Axes submenu commands, the first reference axis is used exactly, and the second is used 

to find an axis perpendicular to the first axis as close to the second reference axis as possible. 

The third axis is set perpendicular to the first two and ensures that a right-handed coordinate 

system is created. 

Additionally, the coordinate system’s origin can be set to a picked point via the Set Origin 

command in the Coordinate System submenu. The Set Origin procedure does not affect the 

orientation of the axes. 

� The coordinate system can also be edited via the Set from Points command, using pick 

points. This command allows you to set any or all of the following: reference point (coordinate 

system origin), azimuth (horizontal orientation), and “up” direction (vertical orientation). 

Layers 

As ModelSpaces become larger and more complex, using layers can improve modeling 

efficiency. Layers are used to organize objects into logical groups that can be hidden, made 

selectable/unselectable, and colored uniformly. Unlike “grouping” (see the Group entry in the 

Commands chapter), which causes several objects to act as a single object, objects in layers 

maintain their individual properties. One advantage to using layers is that the visibility of individual 

layers can be toggled ON/OFF, so certain layers can be hidden while others remain visible. For 

example, it is possible to have all of the “pipes” in a ModelSpace on one layer. Turning OFF all 

other layers would then make it easier to focus on modeling or viewing only the pipes. An added 

benefit to working on one layer at a time is that it may improve system performance, because 

Cyclone does not need to render objects or point clouds on hidden layers. It can also be useful to 

keep a layer visible but unselectable in order to use that layer’s objects as a visual reference 

without being able to alter them while modeling. 
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Note:  Layer properties (e.g., visibility and color settings) are set at the ModelSpace View 

level, and are not shared by other users working in the same ModelSpace. This enables 

multiple users to use Layer settings to personalize their Views. 

 

Basic Layer Functions 

Layer functions are controlled from the Layers tab of the View Properties dialog. From this 

dialog, layers can be created, merged, renamed, deleted, and designated as the current layer 

(the layer to which new objects belong by default). Additionally, the visibility and selectability of 

layers can be toggled ON/OFF. Finally, selected objects in the ModelSpace can be assigned to a 

layer, and all of an existing layer’s visible objects can be selected/deselected. 

To assign selected objects in the ModelSpace to a specific layer:  

1. Select the desired objects, and then select the layer you want in the Layers tab of the View 

Properties dialog. 

2. Click the Assign button. The objects are assigned to the selected layer. 

To select or deselect all objects in a layer: 

1. From the Layers tab of the View Properties dialog, select the relevant layer. 

2. Click the Select/Deselect button. All of the layer’s visible objects are selected/deselected in 

the ModelSpace. If the layer or object type is unselectable or invisible, then selecting the layer 

has no effect. 

Assigning Colors to Layers 

Each layer is assigned a default color that can be edited. A layer’s objects can be displayed using 

either the layer’s color or the objects’ individual colors. 

� To display a layer’s objects using the layer’s color, select the box next to the layer’s color box. 

When this box is not selected, objects maintain their individual color and material properties. 

To edit a layer’s color: 

1. Click the color box next to the layer for which you want to change the color. The Color Picker 

appears. 

2. Make the desired adjustments to the layer’s color. 

3. Click OK to close the View Properties dialog. The layer’s color is updated. 

Assigning an Object Type to a Single Layer 

In some cases, modeling efficiency can be improved by assigning all objects of a particular type 

to a single layer. 
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Lighting 

Surfaces in Cyclone are filled in and shaded with color and material, which are, in turn, affected 

by light sources in the scene. 

The default light sources in a scene are the head light, which is tied to the viewpoint, and the 

ambient lighting. Additional light sources (point lights and spot lights) may also be inserted in 3D. 

� Non-surface shapes such as point clouds and thin lines do not respond to lighting. The only 

material property that affects their appearance is the diffuse material property. 

Default Light Sources 

Ambient Light 

This is the amount of “natural” light in the scene; it has no position or direction, and affects all 

surfaces. The ambient light interacts with the ambient material property of an object. The ambient 

light is a dim white light by default. 

� To adjust ambient light color and intensity, use the Light Settings dialog. (See the Edit 

Environmental Lights entry in the Commands chapter.) 

Head Light 

This is a light source with a position and direction matching those of the viewpoint. Wherever the 

view is pointing, so is the head light. The head light interacts with the diffuse material property of 

objects for natural shading effects and with the specular material property of objects for 

highlights. The head light is a bright white light by default. 

� To adjust head light color, intensity, and ON/OFF state, use the Light Settings dialog. (See 

the Edit Environmental Lights entry in the Commands chapter.)  

� To select the head light type (directional or point source), go to the ModelSpace tab in the 

Edit Preferences dialog. 

3D Light Sources 

Point Light 

A point light source emits light in all directions from a 3D point. By default, the light is bright white 

and does not dim with distance. A point light’s color, attenuation, position, size, and ON/OFF 

state can be edited within the Light Properties dialog. (See the Edit Point/Spot Light entry in the 

Commands chapter.) 

� To insert a point light: From the Tools menu, point to Lighting, and then select Insert Point 

Light. The point light is inserted at the current pick point. If there is no pick point, the point 

light is inserted at the current viewpoint. 

Spot Light 

A spot light emits light within a cone from a 3D point. The centerline of the cone determines the 

direction of the spot light source, and the tip determines the origin. The angle of the cone 
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determines the spread of the spot light. By default, the light is bright white and does not dim with 

distance; the cut-off of the light at the edge of the cone is immediate. 

� To insert a spot light: From the Tools menu, point to Lighting, and then select Insert Spot 

Light. If there is a pick point on an object, the object provides the location and (in most cases) 

orientation for your spot light. If there is no pick point, the spot light is inserted at the current 

viewpoint. 

Fog 

The fog setting adds a sense of depth to a ModelSpace by making more distant objects appear 

darker. 

� To toggle fog ON/OFF, select Fog from the Lighting submenu of the Tools menu. 

� Having Fog ON while segmenting clouds may make distant points difficult to see and can lead 

to modeling and measurement errors. 

Limit Box Manager 

Limit boxes allow you to restrict the scope of objects and points loaded, improving performance 

and facilitating comprehension of point clouds.  The Cyclone Limit Box Manager (accessed from 

the Add/Edit Limit Boxes command) allows you to define and edit multiple limit boxes for each 

ModelSpace, select from among your defined limit boxes, and import and export limit boxes for 

use in other projects. 

� Limit Box commands are found in the View menu in the ModelSpace window. 

Drawing 

In addition to creating best-fit objects and inserting objects, Cyclone provides interactive tools for 

drawing 2D objects in a 3D space. This allows you to create shapes that are otherwise 

unavailable in Cyclone, and to create shapes where fitting or object insertion are impractical. 

� There may be many Reference Planes in a given ModelSpace View; however, all drawing is 

done on the active Reference Plane. The active Reference Plane does not need to be visible 

to perform 2D drawing. 

Supported Shapes 

Line, Polyline, Square, Rectangle, Polygon, Isometric Polygon, Text, Arc, Circle, Ellipse, Cubic 

Spline, Cubic Spline Loop 
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Drawing 2D Objects 

In general, 2D objects are drawn by selecting the type of object you want to draw from the Tools | 

Drawing submenu, which puts Cyclone in Drawing mode, and then plotting a sequence of 

vertices in the active Reference Plane in the ModelSpace. A drawing is completed by pointing to 

Drawing within the Tools menu and selecting Create Drawing. Slight variations in the way that 

different shapes are drawn are documented in the individual command entries for each supported 

shape in the Commands chapter of this manual. 

Plotting Vertices 

To place a vertex in the plane, you can either click or drag the cursor while in Drawing mode. If 

you click, one vertex is created. If you drag the cursor before releasing, the new vertex tracks the 

cursor. When you release the mouse button, the vertex is inserted at the current position. 

� For polylines and cubic splines, hold the ALT key and drag the mouse to insert a stream of 

vertices along the path of the cursor. 

� To align a vertex along a grid axis of the Reference Plane from the previous vertex, first 

enable Align Vertices to Axes, then drag the cursor in the direction you want. The second 

vertex snaps along the closest Reference Plane axis from the first vertex. 

Editing Vertices 

At any time before a drawing object is complete, vertices can be moved and deleted. When 

deleting vertices, the resulting shape depends on the order in which they were plotted. For 

example, an arc requires three vertices - the first two define its endpoints, and the third defines 

the point through which the curve of the arc passes. If you have plotted all three, and then delete 

the first vertex plotted, the remaining two become the first and second endpoints. Likewise, if you 

have plotted all three and then delete the second, the first and third then become the first and 

second endpoints respectively. If the shape you are drawing already has enough vertices (e.g., a 

line segment with two vertices), plotting a new vertex replaces the last vertex placed. 

� To translate the current drawing on the reference plane, hold the CTRL key and drag the 

mouse. 

� To delete a vertex, hold the ALT key and click on the vertex without moving the mouse. 

� To move a vertex, drag it to the desired location. Depending on the shape being drawn, the 

other vertices may be moved accordingly. For example, moving one vertex of a square which 

already has four sides drawn, moves the other vertices as necessary in order to maintain the 

integrity of the square. 

� To cancel a drawing in progress, select another drawing command or select Cancel Drawing 

from the Drawing submenu. 

� To remove a shape that you have just created, select Undo from the Edit menu, or select the 

object, and then select Delete from the Edit menu. 

� When Snap to Grid is ON, vertices jump to the next increment on the Reference Plane’s grid 

as you plot them (press and hold ALT to snap at angular intervals). When OFF, vertices are 
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plotted/moved independently of grid settings. 

Inserting Vertices 

For polygons and polylines being drawn, a new vertex can be inserted by holding the ALT key 

and clicking on an existing line segment within the active drawing. 

Converting Drawings 

A drawing may be converted into another shape (if appropriate). For example, a line may be 

converted into a polyline, into an arc (with the first two vertices defined), etc. An arc may be 

converted into a circle or ellipse, but not into a line unless only one or two of its vertices have 

been plotted. To convert a drawing into another type, select the new type of drawing. If 

conversion from the previous type of drawing into the new type of drawing is supported, the 

Convert button is available. 

Multiple Drawings 

More than one drawing can be in progress. To begin drawing another shape, select another 

drawing command (of the same or different type). If you have plotted at least one vertex, the 

Keep button is available. 

Only one drawing can be active. To resume drawing another drawing in progress, move the 

cursor over the existing drawing (the cursor changes shape) and click. This activates the other 

drawing. All drawings in progress may be created or cancelled at the same time. 

Pipe Modeling... 

Pipe Modeling is used to insert piping components in a model, without best-fitting to a point cloud. 

Placement of the components is typically performed using the point cloud as a reference. 

Components can be inserted in sequence to create a run of connected piping components. The 

components can be assigned information, such as piping specification, line ID, insulation 

thickness and Symbol Keys. This information can be exported and mapped to various plant 

design software applications. 

� Pipe Modeling is accessed through the Pipe Modeling command. See the Pipe Modeling 

entry in the Commands chapter. 

A typical workflow is as follows: 

1. Select an existing object (e.g., from region growing, fitting, or insertion) to which a piping 

component is to be added, or start with nothing selected to start a new sequence. 

2. Using the Pipe Modeling dialog, insert the connected piping components with supplemental 

piping-specific information in Cyclone. 

3. Export the ModelSpace to PCF. 

4. Using the I-Convert (from Alias Ltd) converter, process the PCF file into a format compatible 

with the target piping design package. 
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� I-Convert currently supports PDS, PDMS, and AutoPlant. 

Piping Mode... 

Piping Mode is used to add piping component information to a model in the form of annotations. 

The component information includes piping specification, line ID, insulation thickness and Symbol 

Keys. This information can be exported and mapped to various plant design software 

applications. 

� Piping Mode is accessed through the Piping Mode command. See the Piping Mode entry in 

the Commands chapter. 

A typical workflow is as follows: 

1. Model objects in Cyclone. 

2. Using the Piping Mode dialog, add piping-specific information. Piping-specific information 

may also be added during the modeling process. 

3. Export ModelSpace to PCF. 

4. Using the I-Convert (from Alias Ltd) converter, process the PCF file into a format compatible 

with the target piping design package. 

� I-Convert currently supports PDS, PDMS, and AutoPlant. 

 

Animation 

Cyclone’s animation tool can be used to generate a series of frames along an editable path 

through a ModelSpace for a fly-through animation. The ModelSpace should remain static 

(individual objects cannot be edited in any way) throughout the animation. However, multiple 

animations can be created and combined to produce this effect. 

The Animation Process 

Creating an animation can be accomplished in a variety of ways. The following series of steps 

represents an outline of a typical project. 

� All animation commands and dialogs are found in the ModelSpace window within the Tools | 

Animation submenu. 

1. In the ModelSpace window, define an animation path by inserting Camera objects along the 

path in which you wish to create an animation (Create Object | Insert | Camera). The 

Camera objects serve as keyframes. 

2. Create a path by selecting the Camera objects and then selecting the Create Path or Create 

Path (Loop) command. A spline or spline loop connecting the Camera objects is created. 

3. Set the path via the Set Path command, which associates the keyframe cameras with the 

spline and allows the animation tools to use the spline as the animation path. Once the path is 
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set you may begin the editing process. 

4. Open the Animation Editor dialog, and edit the animation by setting keyframes and 

specifying the number of frames between keyframes. In the ModelSpace Viewer, edit the 

animation by adjusting the spline shape and camera angles. 

5. Preview the current animation via the Animate button in the Animation Settings dialog 

(Tools | Animation | Animate...). For previewing, the Output setting should be In Window 

Only. 

6. When finished editing, create animation frames by changing the Output setting to To File 

(prefix) in the Animation Settings dialog and then clicking the Animate button. The specified 

sequence of frames is saved as numbered files in the specified folder and can be used in your 

animation software to create the final animation. 

Creating a Path 

The first step in the animation process is creating a path along which the animation moves. 

To create an animation path: 

1. Define the path. 

� Insert a series of Camera objects at intervals along the path you want the camera to follow in 

the final animation. The Camera objects serve as key frames. 

2. Create the path. 

� Multi-select the Camera objects in the same sequence that you want the camera to move, and 

then select Create Path or Create Path (Loop) from the Animation menu. A spline curve or 

closed spline loop connecting the Camera objects is created. 

� Alternatively, a path can be created via Cyclone’s drawing tools by drawing a cubic spline or 

cubic spline loop (instead of inserting Camera objects). However, for predictable results, this 

method requires the camera to be oriented towards a single focal point throughout the 

animation. (The Keep Current Focal Point box should be selected in the Animation 

Settings dialog.) Using the camera objects method, the focal point and viewpoint orientation 

are defined by each inserted Camera object. 

3. Set the path. 

� With the spline and cameras selected, select Set Path from the Animation menu. A green 

spline with tangent manipulation handles appears connecting the Camera objects. Once the 

path is set, you may begin editing the animation. 

Note:  The path is not saved with the database, so each time a ModelSpace viewer is opened the path 

must be reset via the Set Path command in order to continue editing or generating frames. 

4. Edit the path. 

� Use the handles connected to each point in the spline or spline loop to edit the shape of the 

curves in each section of the spline. 

� Use the camera translation and rotation handles to edit the viewpoint at each keyframe. 

� To clear the current path, select Clear Path. 

Editing the Animation 

The second step in creating an animation is defining the animation characteristics via the 
Animation Editor dialog. 

 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Animation 

94 

To edit the animation: 

1. From the Animation submenu, select Animation Editor. The Animation Editor dialog 

appears. 

� Set keyframes, specify the number of frames between keyframes, adjust other settings and 

then click OK. For details on Animation Editor dialog settings, see the Animation Editor 

command. 

2. Preview the animation with the current settings. 

� To preview the animation without the Camera objects or animation path, use the Set Visibility 

command to turn visibility OFF for those object types. 

� From the Animation menu, select Animate. The Animation Settings dialog appears. Select 

In Window Only, and then click Animate. The animation is displayed in the current 

ModelSpace window. 

-or-  

� From the Animation menu, select Animation Editor. The Animation Editor dialog appears. 

Press the arrow icon by Frame or Parametric Time, and then press and hold the ENTER key. 

The animation is displayed in the current ModelSpace window. 

Generating the Frames 

The final step is generating the actual frames for the animation via the Animation... command. 

1. From the Animation submenu, select Animation.... The Animation Settings dialog appears. 

2. Set output options and then click OK. Individual frames are saved to a series of files with a 

user-defined prefix, available for use with your animation software. 
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Databases 

Databases 

Cyclone databases can reside on your local hard drive or on a remote server, which can be a 

network server or another networked workstation. The advantages to having a database stored 

on a networked server are many: 

� Multiple users can easily access the database and work concurrently.  

� Database integrity can be protected by limiting access to the host server. 

� Storing a database on a remote server puts the bulk of memory load on the server, rather than 

on an individual’s workstation 

Cyclone provides tools for remote Cyclone database administration, and options for maximizing 

database storage and performance.  

Unshared Database Server 

Databases added to the “(unshared)” server can only be opened by the local client, but the 

performance of disk-based operations (e.g., loading points) can be significantly improved. 

Remote Administration 

Databases can be stored on a networked server and administered remotely from a user 

workstation using the Configure Database dialog. This is a secure feature that requires the 

database administrator to log in by entering a password. Once the login has been authenticated, 

the administrator can not only add and remove databases from the remote server, but can also 

destroy and compact databases on the remote server. 

� Access to databases by other users can be restricted by toggling the visibility of selected 

databases in the Configure Database dialog. 

To set up a server (or networked workstation) for remote administration: 

Note:  This feature is applicable within Cyclone only, and does not permit you to perform 

functions beyond those defined in this section. 

1. From the server console where the database resides, run the password utility. 

2. From the Windows Start menu, point to Programs | Leica HDS Cyclone 5.8, and then click 

Set Server Password. The Set Cyclone Server Password dialog appears. 

3. Set the password. 

� To set the password, type the desired password and click OK. At the confirmation prompt, 

type the password again and click OK. 

� To remove any existing password, leave the field blank and click OK.  
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To log on to a remote server:  

1. From the Navigator window, open the Configure Databases dialog. 

2. Select the Admin Login... button. A Login dialog appears. 

3. Enter the password as configured on the remote server. The Configure Databases dialog is 

redisplayed with all buttons active. 

� See the Database entry in the Commands chapter for more detailed information on the use of 

the buttons in the Configure Databases dialog.  

Configure Databases Dialog Options 

ADD 

The Add button is used to add a database to the selected server in the Navigator window.  

Note:  A valid database file is one that is a Cyclone IMP file. 

� This function is available to all users when administering their local machine; it is available 

only to authorized users administering a remote server. 

REMOVE 

The Remove button is used to remove a database from the Navigator window.  

Note:  Activating this button does not remove or delete files; it only removes the database 

object from the Navigator window. Use the Add button to reinstate a database that has 

been removed.  

� This function is available to all users when administering their local machine; it is available 

only to authorized users administering a remote server. 

DESTROY 

The Destroy button is used to remove a database from the Navigator window and delete the 

database file from the computer or server where the database resides. 

Note: Destroying a database is irreversible. Use this function with caution. 

� This function is available to all users when administering their local machine; it is available 

only to authorized users administering a remote server. 

COMPACT 

The Compact button rewrites the selected database from the ground up to a second file, 

minimizing slack space in the new database file without increasing database size. 

Note: It is recommended that you create a backup copy of the database when prompted to do 

so. 

Note: Compacting a database can be a time-consuming process depending on the size of the 

database. 

Note:  Make sure you have enough free disk space to perform this operation (at least twice 

the size of the database being compacted). 

OPTIMIZE 

The Optimize button optimizes the selected databases (see the Optimize entry in the 

Commands chapter). 
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Optimizing a Database  

With the degree of changes in this version of Cyclone, older databases must be optimized before 

they may be used. Optimizing a database makes sure that the data in the database is consistent; 

new objects (e.g., ControlSpaces) may be created as needed. 

Note:  Optimizing a database can be a time-consuming process depending on number of 

objects to be processed. 
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Virtual Surveyor 

Cyclone’s Virtual Surveyor tool can be used to generate traditional survey output from a 

scanned model in Cyclone. Virtual Surveyor allows you to pick points in a ModelSpace, assign 

feature codes, and export data in custom text formats that can be imported into other software 

programs. 

The Virtual Surveyor Process 

Creating survey data can be accomplished in a variety of ways. The following series of steps 

represents a typical project. Your specific projects may differ from the following general 

guidelines: 

� All Virtual Surveyor commands and dialogs are accessed in the ModelSpace window from the 

Tools | Virtual Surveyor command. 

1. Open the Select Virtual Surveyor Input/Output dialog, and create a new file (or open an 

existing file) for data input/output. The Virtual Surveyor dialog appears. 

2. From the Virtual Surveyor dialog, set feature data. 

� Feature data include prefix, starting number, feature code, and any notes that you wish to 

attach to the feature. The prefix and number are combined into a unique Point Number for 

each feature. 

� Use the polyline creation feature to define linework (as a polyline or polygon) as you pick each 

feature. 

3. Pick a point for a candidate feature. The current feature data are attached to the candidate 

feature and displayed in parentheses. 

� You may edit and/or lock coordinates for candidate features using the X, Y, and Z fields. 

4. Multi-pick (continue picking while holding the SHIFT key) to add additional features with the 

current feature settings. 

� Features are sequentially numbered in the order in which they were picked. 

5. Confirm candidate features. 

� Confirmed features are displayed with an asterisk following the feature data. 

6. Continue picking and adding sequential sets of features with the appropriate feature attributes. 

7. Export all features and data to the text file. 

� Export formats can be customized to match the input format rules of your preferred survey 

data processing software. 

• Click Create Vertices to create one vertex for each feature. (Candidate features are 

ignored.) 

• Click Export LandXML to export features directly into the LandXML format. 

(Candidate features are ignored.) 

• Click Export Leica System 1200 to export features as Leica System 1200 files. 

(Candidate features are ignored.) See Export Leica System 1200 in the Command 

Reference. 
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Select a File for Data Input/Output 

The first step in the Virtual Surveyor process is selecting a file for data input and output. You can 

create a new file, you can append or overwrite an existing file, or you can skip selection of a file 

and continue with Virtual Surveyor (you will be prompted for the file to save later). 

To create a new file: 

1. From the Tools menu in the ModelSpace window, select Virtual Surveyor. The Select 

Virtual Surveyor Input/Output dialog appears. 

2. Navigate to the desired folder, enter a name in the File name: field, and click Save. The 

Virtual Surveyor dialog appears. 

To overwrite an existing file: 

� Overwriting a file discards all existing data in the file. 

1. From the Tools submenu in the ModelSpace window, select Virtual Surveyor. The Select 

Virtual Surveyor Input/Output dialog appears. 

2. Navigate to the desired file and click Save. A confirmation prompt appears. 

3. Click Overwrite. A second confirmation prompt appears. 

4. Click Overwrite. All data in the current file is deleted. 

5. The Virtual Surveyor dialog appears. 

To append an existing file: 

� Appending a file opens a file with current data intact. 

1. From the Tools submenu in the ModelSpace window, select Virtual Surveyor. The Select 

Virtual Surveyor Input/Output dialog appears. 

2. Navigate to the desired file and click Save. A confirmation prompt appears. 

3. Click Yes. A second prompt appears. 

4. Click Append. The Import: ASCII File Format dialog appears. 

5. Choose the appropriate import settings, and then click Import. The file is imported and the 

Virtual Surveyor dialog appears. 

� See the Import entry in the Commands chapter of the Cyclone User’s Manual for details on 

import settings. 

� Existing features and attached data may be displayed in the ModelSpace. 

Set Feature Data 

The next step in the Virtual Surveyor process is setting feature data for the next feature you add. 

Feature data include prefix, starting number, feature code, and any custom notes that you wish to 

attach to the feature. 

To set feature data: 

1. After selecting a file for data input/output, the Virtual Surveyor dialog appears. 

2. Enter the desired feature data. 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Sections Manager 

101 

� The current feature data displayed in the dialog is applied to the next feature that you add as 

well as all subsequent features until the feature data is changed. 

� To customize attributes, push the Customize Columns button, or right-click the Attribute 

field and select Customize Text Fields. The Customize Virtual Surveyor Attributes dialog 

appears. This dialog can be used to create, delete and reorder attribute fields. When finished, 

click OK. The Virtual Surveyor dialog reappears. 

3. You are ready to begin adding features. 

Pick and Add Features 

Once feature data have been set, the next steps are to pick and edit (candidate) features and 

then add or confirm the ones you want to keep. 

To add features: 

1. In Pick mode, pick a point you want to designate as a feature. The feature is considered a 

“candidate” until confirmed. 

� The current feature data are attached to the candidate feature. The point number for a 

candidate feature is displayed in parentheses. 

� Until confirmed, candidate features are removed with the next pick, unless the next pick is 

made while holding the SHIFT key. 

� The Auto-Pick function (see the Auto-Pick Points entry in the Commands chapter) can be 

useful when adding features. It allows you to specify a significant point (i.e., the highest or 

lowest point on a cylinder) that is automatically picked when that object type is selected. When 

using auto-pick, the specified point is always the only picked point regardless how the object 

was selected (i.e., selected by fence, or picked at any other point on the object). For example, 

when fitting a cylinder, the cylinder is automatically selected and its top-most point may be 

auto-picked. 

2. Multi-pick (continue picking while holding the SHIFT key or while in Multi-Pick mode) to pick 

additional features with the current feature settings. 

� Features are sequentially numbered in the order in which they were picked. 

� To use a different prefix or starting number for the next candidate feature, change the 

appropriate field and pick a new feature. Previously picked candidate features are not 

affected. 

3. Edit candidate features. 

� To edit the coordinate data for the current candidate features, click the arrow icon  next to the 

X, Y, or Z field and enter the desired data. All current candidate features are adjusted 

accordingly. 

� To lock the coordinate data for successive picks, click the lock icon  next to the desired 

coordinate. A locked coordinate does not change in response to a new pick. 

� To change the feature code or note for all current candidate features, enter a new code or 

note in the appropriate field. The data for all candidate features are updated. 
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� To delete one of a series of current candidate features, press and hold SHIFT and re-pick the 

candidate feature you want to delete. The candidate feature is deleted. Note that other 

candidate features in the series are not renumbered, which may result in gaps in the series. 

However, you may fill in the gap, by entering the number (of the feature that you deleted) in 

the Number field and picking a new feature. 

4. Click the Add Features from Picks button to add (or confirm) candidate features. 

� Confirmed features are displayed with an asterisk following the point number. 

� To revert added features to candidate features, click the Undo button. 

� Candidate features can be added as they are picked by clicking the Auto-Add Features icon. 

5. Continue picking and adding sequential sets of features with the necessary feature settings 

until all features are added. 

To edit added features: 

� The only features that may be deleted via Virtual Surveyor are the current candidate features. 

1. In the Virtual Surveyor dialog, select the prefix and number of the feature to be edited (in the 

Prefix and Number fields). 

2. Edit the feature. 

� Edited features are displayed with an asterisk following the point number. 

� To edit the coordinate data for the current feature, click the arrow icon  next to the X, Y, or 

Z field and enter the desired data. 

� To change the feature code or notes for the current feature, enter the new code or notes in the 

appropriate field. 

� To back out of an edit without applying it, press ESC. 

Create Polyline 

You can simultaneously define a polyline or polygon as you pick features. 

To create a polyline or polygon: 

1. In the Create Lines area of the Virtual Surveyor dialog, click Polyline or Polygon to select the 

type of linework to be created. 

2. Push the Start button in the Create Lines area. 

� The button text changes to Cancel. Push this button again to discard the linework before the 

features are committed. 

� To use a different prefix or starting number for the next candidate feature, change the 

appropriate field and pick a new feature. Previously picked candidate features are not 

affected. 

3. Edit the code tags, which will be prepended to the feature code of each of the corresponding 

features. 

� The Begin tag is prepended to the first feature in the linework. The End tag is prepended to 

the last feature in the linework. The Continue tag is prepended to the remaining features 
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within the linework. 

4. Pick on points to define the features that comprise the linework. Note the graphical preview of 

the linework. 

5. Click the Add Features from Picks button to add the features as well as the linework. The 

linework is added as a polyline or polygon to the ModelSpace. 

Export Data 

The final step in the Virtual Surveyor process is exporting your data. 

To export data: 

1. When finished adding features, click Format Output  in the Virtual Surveyor dialog. The 

Export: ASCII File Format dialog appears. 

2. Choose the appropriate export settings, and then click Save. The file is exported to the 

selected file, and the Virtual Surveyor dialog reappears. 

� See Custom ASCII Export section of the Export entry in the Commands chapter for details 

on import settings. 

Virtual Surveyor Dialog 

 
A. Click to add a candidate feature with each pick. 
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B. Show features in the ModelSpace viewer. 

C. Show candidate features in the ModelSpace viewer. 

D. Show unsaved features in the ModelSpace viewer. 

E. Highlight the current feature in the ModelSpace viewer. 

F. Show features options, which affect how features are displayed. 

G. Select to add a feature with each pick. 

H. Change the viewpoint to view the current feature. 

I. Adds one vertex to the ModelSpace for each feature. 

J. Exports the features directly to LandXML. 

K. Exports the features directly to the Leica System 1200 format. 

L. Invokes the Layers command. 

M. The prefix of the current feature. 

N. The point number that will be assigned to the candidate feature created from the next pick. 

O. Displays coordinate data for the current feature. Click the arrow icon to edit the coordinate 

data. Click the lock icon to keep that value constant. 

P. Select a feature code library. 

Q. List of values for the available attributes. 

R. The Create Lines area. Select the creation of a polyline or polygon, supply the Code Tags 

that will be prepended to each corresponding feature, then click the Start button. 

S. Click to customize the attributes displayed. 

T. Invokes the Customize Lookup Lists command. See the Customize Lookup Lists entry in 

the Commands chapter for information on managing the libraries. 

U. Visibility of each attribute in the graphical window. 

V. Click to select or enter a value for the desired attribute. 

W. Undo last add features. 

X. Commit the candidate features. 

Y. Click to export current added features. 

Z. Click to close the Virtual Surveyor. 

 

Sections Manager 

The Sections Manager tool can be used to generate and manage sections of point clouds from a 

selected alignment. 

The Sections Process 

Creating and editing sections can be accomplished in a variety of ways. The following series of 

steps represents a typical project. Your specific projects may differ from the following general 

guidelines: 

� All Sections commands and dialogs are accessed in the ModelSpace window from the Tools 

| Alignment and Section submenu. 

1. Create and select an alignment. 

2. Open the Sections Manager dialog and create sections on the selected alignment using the 

Create Sections dialog. 
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3. Use the Sections Manager tools to navigate through the sections, modify section parameters, 

delete sections, collect the points that make up a section, and create section lines. 

 

Create an Alignment 

The first step in the process of creating sections is creating the alignment object you want to 

serve as the reference for your sections. 

To create an alignment: 

1. Select the line, polyline, or arc you want to use as an alignment. 

� The object used to create an alignment can be imported from your CAD software via the COE 

exchange format (see the Cyclone Object Exchange chapter). The object may also be created 

in a variety of ways including using Cyclone’s Drawing tools and creating the object via the 

From Pick Points submenu commands (see the From Pick Points entry in the Commands 

chapter). 

� When a single object is selected, the object must be picked near the end-point at which the 

starting station is assigned. 

� When multiple objects are selected, the objects must be geometrically connected in a single 

unbroken sequence. The object picked last provides the end-point at which the starting station 

is assigned. 

� Alignments may be horizontal, skewed, or a mixture of both, but may not be vertical. 

2. From the Tools menu, point to Alignment and Section, and then select Create Alignment. 

The Create Alignment dialog appears.  

3. Enter a Starting Station Number and click OK. The alignment object is created. 

� Station numbers increase with the linear distance "travelled" along the alignment, from the 

starting station. 

Create Sections 

The next step is to create sections from your alignment object. 

To create sections: 

1. Select the desired alignment object. 

2. From the Tools menu, point to Alignment and Section, and then select Create Sections. 

The Create Sections dialog appears.  

� The Create Sections command can also be accessed from the Sections menu in the 

Sections Manager dialog. 

3. Choose the desired alignment settings, and then click OK. The sections are created and the 

Sections Manager dialog appears. 

Managing and Editing Sections 

The final step is managing and editing sections from the Sections Manager dialog. 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Sections Manager 

106 

1. For existing sections, select the alignment, and then point to Tools | Alignment and Section 

and select Sections Manager. The Sections Manager dialog appears. 

2. Use the Sections Manager dialog to create, delete, and edit sections. When finished click 

Close. 

� To edit multiple sections simultaneously (see below), activate a single section, and then multi-

select the desired sections from the sections list and make your edits. Changes are applied to 

all selected sections. 

Create Sections Dialog Options 

INITIAL STATION 

Specify the distance along the alignment at which you want to place the first section. 

END STATION 

Specify the distance along the alignment at which you want to place the last section. 

SPACING 

Specify the interval between sections. 

INCLUDE TRANSITION POINTS 

Select this option to also create a section at each transition point (the point at which two of the 

original curves or arcs connect) that falls within the creation interval. 

SECTION EXTENTS 

All Section Extents settings are relative to the direction (from the start station towards the 

end station) of the alignment. 

CREATE LINES 

Select this option to create lines based on a temporary TIN mesh, which is created from the 

points within each section. More controllable results may be obtained by first creating the 

sections, and then adjusting sections and creating lines afterward via the Create Lines at 

Section in the Sections Manager dialog. 

COLLECT POINTS 

Select this option to introduce merged clouds from the points that fall within the boundaries of 

each section. This function can also be performed after sections have been created via the 

Collect Points in Section in the Sections Manager dialog. 

Sections Manager Dialog Commands 

� The Section menu contains commands to create, edit, and navigate through sections. 

CREATE SECTIONS 

This command opens the Create Sections dialog. See the Create Sections section for details. 

 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Sections Manager 

107 

CREATE LINES AT SECTION 

This command creates lines for the selected section(s) based on a TIN mesh temporarily 

created from the points within the section’s extents. 

COLLECT POINTS IN SECTION 

This command segments the points that fall within the extents of the selected section(s). 

DELETE SECTION 

This command deletes the selected selection. 

ACTIVATE SECTION 

This command activates the selected section and displays the section within a limit box (using 

the section's six dimensions). The viewpoint, a temporary Reference Plane, and a temporary 

limit box are aligned to the current section. Additionally, the datum and coordinate system 

origin and axes are temporarily aligned to the section. The section extents can be interactively 

edited by using the handles on the limit box. 

DEACTIVATE SECTION 

This command deactivates the active section and returns to the ModelSpace View. 

ACTIVATE NEXT/PREVIOUS SECTION 

These commands are used to activate the section following or preceding the currently 

activated section. 

ZOOM/VIEW ALL 

The Zoom/View All command is an ON/OFF toggle to determine whether to adjust the 

viewpoint so that the entire Section is visible in the current window. 

FRONT VIEWPOINT 

This command is an ON/OFF toggle to determine whether to adjust the viewpoint to Front 

view relative to the current UCS. 

KEEP VIEWPOINT 

This command is an ON/OFF toggle to determine whether to keep the current viewpoint when 

scrolling through the Sections in the Sections Manager. 

� The Alignment menu contains commands to edit and navigate through alignments. 

DELETE ALIGNMENT 

This command deletes the selected alignment and all associated sections from the Sections 

Manager. The original alignment is not removed from the ModelSpace. 

RESTORE ALIGNMENT INTO MODELSPACE 

This command is used to restore an alignment that may have been deleted from the 

ModelSpace. 

EXPAND ALIGNMENT 

This command displays the list of all sections associated with the selected alignment. 
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COLLAPSE ALIGNMENT 

This command collapses the list of sections associated with the selected alignment. 

To incorporate a polyline as a breakline into the temporary TIN mesh 

1. Before using the Create Lines command, select the polyline objects(s). 

2. The TIN mesh is extended to the polyline. The polyline is incorporated into the mesh; the 

polyline vertices are added into the mesh, and mesh triangles are redrawn as appropriate to 

accommodate the breakline. 

 

Texture Mapping 

Texture mapping is drawing objects using colors from an image. The colors are assigned based 

on the mapping defined for the image (the texture in this context). Cyclone supports defining and 

applying texture maps to point clouds and meshes. 

The Texture Mapping Process 

The basic process involves: 

1. Adding the image from the database. 

2. Matching points in 3D with pixels in the image. 

3. Computing the optimal mapping. 

4. Displaying the texture map. 

5. Managing texture maps. 

Most of these procedures are accessed via the Texture Map Browser command. Invoke the 

Texture Map Browser command to open the dialog. 

Adding the Image 

1. Select one point cloud or mesh. Most of the commands in Texture Map Browser support 

only one selected object at a time. 

2. In the Texture Map Browser, click the Add toolbar button. 

3. Browse to and select an Image using the Select Image dialog. 

• For convenience, images can be imported into the database from this dialog. Push the 

Import button, then select one or more image files. 

4. In the Texture Map Type dialog, indicate the image’s type. Most images will be 

“Perspective”. “Orthographic“ images include posters, wallpaper, or other flat images. 

5. A texture map is added to the object with that Image. The Texture Editor dialogs appear. 

Adding a Cube-Map 

A cube-map is a special set of images that correspond to the six faces of a cube, with the camera 

placed at the center of the cube. The six images are: Up, Down, Front, Back, Left, Right. A cube-

map in Cyclone consists of one to six of these cube images. Because of the nature and 

arrangement of the images, cube-maps provide a complete and convenient mapping of the full 

field-of-view. The images are arranged in this manner: 
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1. Select one point cloud or mesh. 

2. In the Texture Map Browser, click the Add (Cube-Map) toolbar button. 

3. Browse to and select a Project that contains cube-map images using the Select Project with 

Cube-Map Images dialog. 

• The cube-map images must follow a naming convention: There must be at most one image 

from each side of the cube in the Project, and each image must have a name ending in “_u”, 

“_d”, “_f”, “_b”, “_l”, or “_r”, for Up, Down, Front, Back, Left, and Right, respectively. 

• For convenience, images can be imported into the database from this dialog. Push the 

Import button, then select one or more image files. 

4. A cube-map texture map is added to the object with that Image. The Texture Editor dialogs 

appear. 

Editing and Computing a Texture Map 

Texture maps are defined by correspondences (or constraints) between points in 3D with pixels 

on the image.Orthographic images need at least three constraints. Perspective images need at 

least six constraints, plus one for confidence, for a minimum of seven constraints. The Texture 

Editor dialogs provide access to constraint creation and management. 

1. Select one point cloud or mesh. 

2. In the Texture Map Browser, select a texture map and click the Edit toolbar button, or 

double-click on the texture map. The two Texture Editor dialogs appear. 

• The two Texture Editor dialogs are linked. Click the Close button in the Texture Editor to 

dismiss both. 

3. Identify and pick points in the 3D scene that correspond to pixels in the image, then click the 

Add toolbar button in the Texture Editor. Pick features that are easy to identify (e.g., the 

corner of a room or sign) rather than more vague features. Constraints with higher 

correspondences result in better texture mapping. 

• When adding multiple picks, be sure to pick the 3D point and the corresponding pixel in the 

same order. 

4. To replace one or both of the picks in an existing constraint, re-pick one or both 3D point 

and/or image pixel, then click the Replace toolbar button. 

 

Front 

 

Right 

 

Back 

 

Down 

 

Left 

 

Up 

F L R 

U 

D 

B 
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5. With enough enabled constraints, the Compute toolbar button becomes enabled. Push the 

Compute toolbar button to compute the texture mapping parameters. 

• If the Suggest Improvements option in the Texture Map Editor Options dialog is set to 

“Yes”, after the computation is finished (success or failure), Cyclone searches for a subset of 

constraints that results in a lower overall error, if available. The process may be cancelled at 

any time. If any improvements were found, Cyclone displays the list of up to ten 

improvements. 

• To visually verify the texture mapping results, select the texture map in the Texture Map 

Browser and click the Align toolbar button. The 3D viewpoint should change to closely 

match the image. 

Displaying a Texture Map 

Once a texture mapping has been computed, the texture map is considered “valid” and can be 

used to color the point cloud or mesh. 

1. Enable texture mapping in the ModelSpace View by toggling ON the View | Global Texture 

Map command. 

2. Select one point cloud or mesh. 

3. In the Texture Map Browser, select the texture map and toggle its Use checkbox ON. 

4. Use Edit Color Map or Edit Global Color Map to select the Image Texture Map mode. 

Alternately, select the Edit Object | Appearance | Apply Color Map | Image Texture Map 

command. 

5. When a single cloud or mesh has multiplem enabled texture maps, the texture maps may 

overlap. Where two texture maps overlap, the texture map that appears lower in the Texture 

Map Browser’s list will be covered by the other texture map. To change the order of the 

texture maps, click the Raise and Lower toolbar buttons in the Texture Map Browser. 

Managing Texture Maps 

Copy/Paste 

Texture maps can be copy/pasted between objects. Creating a texture map for one object and 

then copying it to other objects can be an efficient way of propagating a texture map among 

different scans taken from the same position. 

1. Select one or more point cloud or mesh with at least one texture map. 

2. In the Texture Map Browser, select one or more texture map and click the Copy toolbar 

button. The texture maps to be copied do not need to be enabled or valid. 

3. Select one or more point cloud or mesh. 

• Texture maps may be copy/pasted to the same object. This can be useful for keeping 

different texture mappings. 

• If multiple objects are selected, the Texture Map Browser’s list will show only the texture 

maps shared in common by the selected objects. 

4. Click the Paste toolbar button. The texture maps are copied to the selected objects. 

Replacing the Image 

The image of a texture map can be replaced by another image. The replacement image may 

have different dimensions from the current image, but they must have the same proportions. 
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Uses of image replacement include: to have different images taken from the same position (so 

they can use the same texture mapping) but at different times (e.g., a day-time image versus a 

night-time image); to create the texture mapping using a lower-resolution “preview” image and 

then replacing the image with a higher-resolution version of the image. 

1. Select one point cloud or mesh with at least one texture map. 

2. In the Texture Map Browser, select a texture map and click the Replace toolbar button. 

Follow the same process for adding a new image. The image is replaced in the texture map. 

• When replacing the images for a cube-map, images are replaced by the corresponding 

Images in the selected Project, and any new cube-images are added to the cube-map. Any 

images without a corresponding Image in the selected Project are unaffected. 

Saving the Texture Map 

Loading texture maps for point clouds incurs some additional cost in the computer’s resources. 

Once the texture mapping is satisfactory/, the colors displayed by the Colors from Scanner color 

map mode can be replaced by the colors from texture mapping, and then texture mapping can be 

disabled. 

1. Select one point cloud with a valid texture map. 

2. In the Texture Map Browser, select a valid texture map and click the Save toolbar button. 

• Saving does not work for point clouds copied by reference from another database. 

3. Confirm the saving, then restart Cyclone when prompted. 

• The saved texture map appears in the Texture Map Browser (saved texture maps always 

appear at the bottom of the list), but it can no longer be edited or enabled as a texture map. 

However, the saved texture map can be copy/pasted as a new texture map that can then be 

edited and activated (e.g., for updating the texture mapping and then re-saving it). 

Texture Mapping Hints and Tips 

• Source images: For best results, use images that are taken from positions and orientations 

close to the scanner position and orientation. This minimizes the effects of parallax, where 

the image contains elements that were not visible from the scanner. 

• When to create texture maps: Create and save the texture mapping before any other 

modeling. 

• Computation #1: Pick points that are well-distributed in space for better results. Avoid 

picking only constraints that are clustered together or points on a single plane. 

• Computation #2: When creating constraints in a cube-map, try to pick at least one point in 

each image. 

• Computation #3: Disabling or deleting the constraint with the highest error may not lead to a 

lower overall error. 

• Computation #4: A lower overall error is not necessarily a better texture mapping. Always be 

sure to check the graphical results visually. 

• Computation #5: When starting out, increase the Texture Map: Tolerance preferences. The 

actual values can depend on the resolution of the image as well as the quality desired. 

• Graphics Performance #1: Disable any texture maps that are not used in the point cloud or 

mesh. For example, if a point cloud is segmented such that only one of two textures is 

relevant in the segmented cloud, turn off or delete the unused texture map. For cube-maps, 
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disable individual images via the Enable/Disable Cube-Map Components toolbar button in 

the Texture Map Browser dialog. 

• Graphics performance #2: Meshes perform actual texture mapping, where the interior of 

each triangle can have multiple colors. Some graphics cards may not robustly support large 

texture maps. Try selecting a software-only OpenGL Mode for Cyclone. 

Texture Map Browser Dialog 

 

A. Click to select and add an Image in the database. 

B. Click to select and add a Project in the database containing cube-map Image(s). 

C. Click to edit the selected texture map in the Texture Editor. 

D. Click to delete the selected texture map(s). 

E. Click to copy the selected texture map(s) to the clipboard. 

F. Click to paste the texture map(s) on the clipboard to the selected object. If multiple point 

clouds and meshes are selected, the list area will be blank, but you will still be able to paste 

the copied texture maps to the selected objects. This is a convenient way of propagating 

texture maps. 

G. Click to align the viewpoint to the selected texture map. 

H. Click to enable/disable individual images within the selected cube-map. 

I. Click to create a Multi-Image from the selected cube-map texture maps. The Multi-Image can 

be used as a background when publishing a TruView data set. 

J. Click to replace the image for the selected texture map with another image in the database. 

The replacement image can have different dimensions, but it must have the same proportions 

as the current image. 

K. Click to display information about the selected texture map. 
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L. Click to save the selected texture map(s) to the selected point cloud. This replaces the colors 

displayed by Colors from Scanner for each point in the point cloud. Points not in the current 

cloud are not (re)colored. 

M. Click to move the selected texture map higher or lower in the list. Texture maps higher in the 

last can be covered by texture maps lower in the list wherever they overlap. 

N. The name of the texture map. Click to rename it. 

O. The visibility of the texture map. If the texture map is visible and is valid, the object’s color 

map is Image Texture Map, and Global Texture Map is enabled, then the object is drawn 

with colors from the enabled texture map. 

P. The name of the image used for the texture map. 

Q. The size of the image used for the texture map. 

Texture Editor Dialog 

 
A. Click to add one constraint for each pick in the ModelSpace viewer and in the Texture Editor 

(Image) dialog, in sequence. 

B. Click to replace the selected constraint’s 3D pick and/or image pick, depending on the 

existing pick(s). 

C. Click to delete the selected constraint(s). 

D. Click to focus the viewpoint on the selected constraint. For a cube-map, the corresponding 

image is loaded into the Texture Editor (Image) dialog. 

E. Click to compute the texture mapping parameters based on the current constraints. 

F. Click to toggle the graphical display of the constraints. 

G. Click to toggle the automatic refreshing of the texture map graphics in the ModelSpace 

viewer whenever the texture mapping changes. Toggle this OFF if you are making several 

computations, to avoid the overhead of refreshing the graphics each time. 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Sections Manager 

114 

H. Click to access the Texture Map Editor Options dialog. 

I. Click to access the Modeling tab of the Edit Preferences dialog. The Texture Map: 

Tolerance preferences are available in the Modeling tab. 

J. The name of the constraint. Click to rename it. 

K. The difference (in pixels) between the location of the constraint’s pixel vs where its 3D pick 

lands on the image for the texture mapping parameters. 

L. Click to toggle the use of the selected constraint(s) during the texture mapping computation. 

Constraints that are disabled do not constribute to the computation. 

Texture Editor (Image) Dialog 

The Texture Editor (Image) dialog accompanies the Texture Editor dialog. 

1. Click in the image to zoom and pan to the pixel of interest, then release to select a pixel. 

2. Right-click on the image for a context menu. 

• Single-Pick: Select this mode to have at most one pick at a time in the image. 

• Multi-Pick: Select this mode to have multiple picks at a time in the image. It can be more 

efficient to make multiple picks and then add them in a single click. 

• Remove Last Pick: This command discards the last pick made on the image. 

• Clear Pick/Clear All Picks: This command discards the picks made on the image. 

• Set Zoom…: This command invokes the Zoom Factor dialog to let the user enter the image 

magnification. 

• Back, Down, Front, Left, Right, Up: For a cube-map, select the image to activate in the 

image dialog. 

• Cancel: This command dismisses the context menu. 

Texture Map Editor Options Dialog 

The Texture Map Editor Options dialog provides access to several settings used by the Texture 

Editor dialogs. The settings are saved. 

• Constraint Color (Enabled): Select the color used to display the enabled constraints. 

• Constraint Color (Disabled): Select the color used to display the disabled constraints. 

• Callout Length: Enter the length (in pixels) of the line between the graphical constraint text 

and the picked point. 

• Callout Angle: Enter the angle of the line from the picked point to the graphical constraint 

text. 

• Font: Enter the name of the font to use for the graphical constraint text. 

• Font Size: Enter the size (in pixels) of the font to use for the graphical constraint text. 

• Suggest Improvements: This setting determines if Cyclone attempts to find a set of 

constraints (from the enabled constraints) that results in a lower overall error. Disabled 

constraints are not used. 

• Image Render Mode: Select “Software-only” if your graphics card has trouble drawing the 

image in the Texture Editor (Image) dialog. 
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Cyclone Object Exchange (COE) 

COE for AutoCAD 

Introduction 

COEIN, an AutoCAD 2000 and higher ObjectARX application, was developed to enable the 

translation of objects from Cyclone to AutoCAD and vice versa. When used to import objects into 

AutoCAD, COEIN generates 3D representations of objects imported from a Cyclone COE file. 

Users can then interact with these objects using the full range of AutoCAD’s modeling functions. 

COEIN also provides the means for exporting to a COE file from AutoCAD, with Cyclone as the 

destination application. Using COE to export AutoCAD modeled/edited objects allows you take 

advantage of AutoCAD’s advanced modeling functionality, yet maintain a link to the original COE 

file created in Cyclone. Drawings from AutoCAD may also be imported into Cyclone for various 

uses, including interference checking, and visualization. 

This document describes the main features of the COE application, along with any limitations. A 

troubleshooting section is included to help resolve common problems. 

Requirements 

� To use the COE import/export feature, you must be running AutoCAD 2000 or higher. For 

information on system requirements, consult the AutoCAD documentation. 

Installation 

Installation is done via the Cyclone installer. It is a one-time process that consists of loading the 

COEIN.ARX application, making the following commands available: 

COEIN 

This command is used to import COE files into AutoCAD. 

COEOUT 

This command is used to export drawing contents to a COE file. 

COEXPLODE 

This command is used to explode blocks, and is similar to the AutoCAD Explode command. 

� The Cyclone installer adds a COE menu and toolbars to the default AutoCAD user profile. If 

you are using a different user profile, you can add the COE menu by loading the menu file 

CYCLONECOE.MNC using AutoCAD menu customization.  

Usage 

The COEIN feature allows you to use both Cyclone and AutoCAD to maximize your modeling 

capabilities. Not only can you translate objects from Cyclone to AutoCAD, but you can make 

changes to those objects and even model new objects, which can then be translated back to 

Cyclone and incorporated into the source database. 
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Translating Objects from Cyclone to AutoCAD 

Objects modeled in a Cyclone environment can be exported to a COE file using the COE export 

feature. The COE import feature can then be used to import COE files into any active AutoCAD 

drawing. COE translates objects from the Cyclone environment by generating equivalent, or near 

equivalent, objects in the destination environment. The following sections describe the process 

for exporting objects via COE from Cyclone, and importing those objects via COE into AutoCAD. 

Note:  This ARX application is designed primarily to translate modeled 3D objects between 

applications. While it is possible to translate points via COE, we recommend using 

CloudWorx for AutoCAD when you need to bring Cyclone point clouds into AutoCAD. 

Creating a COE File in Cyclone 

To export modeled objects to a COE file from Cyclone: 

1. Open the desired ModelSpace, and use Cyclone’s 3D modeling tools to create equipment, 

piping, vessels, or other objects. 

� If you want to isolate selected objects for export to the COE file, multi-select the desired 

objects, then select File | Launch | Copy Selection to New ModelSpace. 

2. When you are ready to export, click File | Export.... The Export to File dialog appears. 

3. Identify a location for the file, name the file to be created, then select “COE format (*.coe)” 

from the Save as type field.  

4. Click OK to create the COE file. All objects within the Cyclone ModelSpace are translated to 

COE format. This step may take some time, depending on the complexity of the ModelSpace 

being translated and your computer’s capabilities. 

BRINGING A COE FILE INTO AUTOCAD 

Once a drawing has been exported to COE format from Cyclone, it can be imported into 

AutoCAD using COEIN. 

To import a COE file into AutoCAD: 

1. From the menu bar, select Cyclone | COE | Import COE Objects, or type COEIN at the 

command line. The Import Options dialog appears. 

2. Find and select the COE file to be imported into AutoCAD by clicking the Browse button 

below the File Name field. 

3. Select whether to import objects as ACIS solids or as Blocks.  

IMPORT OBJECTS AS ACIS SOLIDS 

Select this option to bring in modeled objects as 3D ACIS solids.  

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Cyclone Object Exchange (COE) 

117 

IMPORT OBJECTS AS BLOCKS  

Select this option to bring in modeled objects as 3D blocks. Use of this option results in the 

best compression rate as the objects are brought into the AutoCAD drawing. In addition, the 

blocks can be exploded once in AutoCAD.  

Note:  All Xdata added to the blocks by COEIN will remain intact once a block has been 

exploded. 

4. Check Import Pointsets if point clouds are contained in the COE file. 

� This option is not recommended for large point clouds. Instead, we recommend using Leica 

Geosystems HDS's CloudWorx application for bringing Leica Geosystems HDS point clouds 

into AutoCAD.  

5.  Check Create Log file to generate a <drawing name>.LOG file (recommended). This log file 

can help you identify problems and potential solutions if the COEIN process is aborted. 

� If Use Default File Path is checked, the log file is saved to the default folder (the same folder 

as the current drawing). You can specify a destination for the log file by deselecting this 

option, and typing in or browsing to select the desired folder location for the log file.  

6. Select the units used in the current drawing from the pull-down list in the Import Drawing 

Units field, or select “User defined” and enter a user-defined multiplier in the Scale Factor 

field to multiply all measurements, including coordinates, by this number.  

� By default, all COE objects are brought into AutoCAD from Cyclone using meters and radians 

to define size and position. You need to define the units to which COEIN will convert for your 

drawing by selecting the current drawing units from the pull-down list. 

7. Click the OK button. The COE file is loaded into the current drawing. The complexity of the 

COE file, as well as your computer’s capability, determines the speed with which the objects 

are brought in and displayed. You may click Cancel at any time during the process to abort 

the process. 

� If an error message is displayed at any time during the import, refer to the Troubleshooting 

section in this appendix. 

Working with Imported Objects in AutoCAD 

Once objects have been loaded into an AutoCAD drawing from a COE file, standard AutoCAD 

commands and functionality are fully available to view, edit, and manipulate the objects as 

needed. You can also model new objects for later export back to Cyclone. 

In addition to AutoCAD’s powerful capabilities, COEIN provides you with additional options which 

are discussed in the following sections. 
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EXPLODING OBJECTS 

You can use the COEExplode (coeXplode) command or AutoCAD’s Explode command to 

explode objects imported as blocks.  

Note:  All Xdata associated with the blocks by COEIN remains intact even when a block has 

been exploded by either command.  

The major difference between the coeXplode command and the AutoCAD Explode command is 

that coeXplode actually deletes the exploded block and redraws it as an Acis Solid. Otherwise, 

the two commands behave similarly. 

Note:  The coeXplode command requires the presence of the original COE file that created 

the object.  

FULL LAYER TRANSLATION AND FUNCTIONALITY 

When you import a COE file, you can elect to import layer settings as defined in Cyclone into 

AutoCAD, along with any objects contained in the file. Cyclone-defined layers are easily and 

cleanly translated; COE not only uses the same naming protocol defined in Cyclone, but it also 

translates layer settings and object assignment.  

Once in place, imported layers function as any other AutoCAD layer, and can be used to make 

your modeling session more productive. 

It is important to note that AutoCAD does not accept certain characters in a layer name (< > / 

\  \  : ? * | , = ' ) If the import finds a layer name in a COE file with one of these characters in it, it 

removes the invalid character and replaces it with an underscore “_”. The changed layer name is 

recorded in the *.log file and you are informed via a popup message at the end of the import that 

some layer names had invalid characters. 

Limitations 

NO POINT CLOUDS 

We do not recommend using COEIN to bring large point clouds into AutoCAD. If a Leica 

Geosystems HDS point cloud contains large quantities of points, a lot of memory is used, and an 

attempt to import a COE file containing a point cloud may lock up your system. Instead, we 

recommend that you use Leica Geosystems HDS’s CloudWorx application to bring Cyclone point 

clouds into AutoCAD. 

Translating Objects from AutoCAD to Cyclone 

Objects modeled within the AutoCAD environment can be exported to a COE file using the 

COEOUT command for subsequent import into Cyclone. There are two primary reasons for 

translating objects from AutoCAD to Cyclone: 
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Simple export: Objects modeled in AutoCAD can be exported to a new COE file. When this file is 

imported into Cyclone, a new ModelSpace is created and populated with the AutoCAD-modeled 

objects contained in the COE file. 

Data integration: Objects modeled in Cyclone and imported into AutoCAD via a COE file can be 

modified in AutoCAD and then exported back into Cyclone, all the while maintaining much of the 

original data (e.g., annotations) from the original COE file from Cyclone. To do this, CoeOut uses 

the original COE file as a reference when creating the COE file to be translated to Cyclone. 

Creating a COE file in AutoCAD 

1. Do your modeling as desired in AutoCAD.   

2. From the menu bar, select Cyclone | COE | Export COE Objects, or type coeout at the 

command line. The Export Options dialog appears. 

3. Enter a new file name and path in the Export File Name field, or use the Browse button to 

find and select a path. 

4. Select an export process option from one of the two options listed: 

EXPORT OBJECTS WITHOUT ORIGINAL COE REFERENCE FILE  

Select this option if you are creating a new COE file and do not want any reference or 

connection made to the original COE file you brought into AutoCAD.  

EXPORT OBJECTS USING ORIGINAL COE FILE AS REFERENCE 

Select this option if you want to integrate data with the original COE file brought into AutoCAD. 

When this new COE file is created, references are made to the original COE file imported into 

AutoCAD, enabling COE to maintain as much original object information/data as possible 

when the object is brought back into Cyclone.  

5. Define which objects to export by selecting one of the following options: 

ALL OBJECTS 

Select this option to export all objects on all layers that are contained within the current 

drawing. 

VISIBLE OBJECTS  

Select this option to export only those objects that belong to layers that are turned on 

(viewable) in the current view. Be sure the correct view is displayed before selecting this 

option. 

SELECTED OBJECTS 

This option is active only if there are objects currently selected in the drawing. If selected, only 

those objects currently selected in the drawing will be exported.  
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6. Click OK to begin exporting the selected objects to the COE FILE. The complexity of the 

objects, as well as your computer’s capability, determine the speed with which the objects are 

exported. 

Note:  If an error message appears during the exportation process, refer to the 

Troubleshooting section in this appendix for information. 

Bringing a COE File into Cyclone 

COE files are brought into Cyclone via Cyclone’s Navigator window, where a new ModelSpace is 

created for the imported file. Most objects, as well as layer functionality, can be brought into 

Cyclone from AutoCAD. Complex objects (e.g., cubes with rounded corners, objects with 

notches, etc.) may not be translated as objects, but may instead be translated as a collection of 

lines and arcs. 

To bring a COE file into Cyclone:  

1. Open the Cyclone Navigator window and select the database or project into which you want 

to import the COE file.  

2. Right click the Database/ModelSpace name and select Import, or select File | Import from the 

Navigator window. The Import from File dialog appears. 

3. Locate the COE file to be imported and initiate the process. A new ModelSpace is created in 

the selected project.  

Limitations 

SHAPES 

If there is an unsupported shape, it will be brought into Cyclone as a wireframe object, but ONLY 

if you check the “Unsupported objects” options in the COEOUT Options dialog in MicroStation; 

otherwise, the unsupported objects are not translated. Instead, a message is displayed informing 

you of that the objects have not been translated, and asking if you want to select the objects not 

translated. 

MODELSPACES 

You cannot bring COE objects directly into an existing ModelSpace; however, you CAN multi-

select and copy objects from the ModelSpace created from the COE import, and paste them to 

the desired ModelSpace. Alternatively, you can use the Merge from ModelSpace command to 

merge ModelSpace Views. See the Merge from ModelSpace entry in the Commands chapter for 

more information.  
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ANNOTATIONS 

With the exception of tags, annotations and measurements made in AutoCAD are not translated 

to Cyclone.  

Troubleshooting 

SOME OBJECTS ARE NOT TRANSLATED OR ARE PARTIALLY TRANSLATED 

It may be that the non-translated object is a type of complex 3D solid object that is not presently 

supported by the COE import/export tool. Try exploding the object before exporting to the COE 

file. 

COEIN/COEOUT PROCESS ABORTS PREMATURELY 

If you check the Create Log File option, open the Log file to find the reason for the premature 

abort. Knowing the reason may help you determine the appropriate resolution.  

If you selected “Use Default File Path”, you will find the Log file in the folder containing the active 

AutoCAD drawing. It has the same name as the drawing, but with a *.LOG extension. Otherwise, 

the Log file will be in the folder you specified during the import/export. 

COE FILE WILL NOT LOAD IN AUTOCAD; SYSTEM LOCKS UP 

Does the COE file you are trying to import contain points? If so, try this: 

1. Return to Cyclone and multi-select only the objects (this is easy if you use the View 

Properties dialog to turn off the “selectable” option for points). 

2. Select all objects and copy them into a new ModelSpace by selecting File | Launch | Copy 

Selection to New ModelSpace. 

3. Create a new COE file from this ModelSpace, and then import this new file into AutoCAD. 

COEIN.ARX IS NOT LOADED WHEN AUTOCAD IS REBOOTED 

Add the folder containing the file COEIN.ARX to the Support File Search Path in the AutoCAD 

Options dialog.  

Note:  For instructions on adding a folder to the Support File Search Path, refer to your 

AutoCAD documentation. 

YOU ARE UNABLE TO LOAD COEIN.ARX FILE 

Are the COEIN.ARX and CyraCoeOut.DLL files located in the same folder? Search for both files, 

and if they aren’t both in the same folder, copy the CyraCoeOut.DLL file to the folder containing 

the COEIN.ARX folder, and try loading COEIN.ARX again.  
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You Are Unable to Import a COE file into Cyclone 

COE files can only be imported into Cyclone via the Navigator window. If you were trying to 

import via a ModelSpace View, the COE option is not available. Retry your import from the 

Cyclone Navigator. 

If you are in the Cyclone Navigator and you are not seeing the *.COE option in the Files of Type 

field, you cannot import a COE file into the selected Navigator level. COE files can be imported 

only at a Database or Project level. 

Commands 

Import Objects (coein) 

Window:  AutoCAD 

Menu: Cyclone | COE 

Action: Opens dialog  

Usage: The Import Objects (coein) command loads the Import Options dialog, which is used 

to set parameters for importing COE files from Cyclone into AutoCAD.  

Note: This command can be activated by selecting it from the Cyclone COE menu, by typing 

coein at the command line, or by clicking the Import Objects icon in the toolbar. 

Explode Blocks (coeXplode) 

Window:  AutoCAD 

Menu: Cyclone | COE 

Action: Executes command  

Usage: The Explode Blocks (coeXplode) command is used to explode objects imported as 

blocks from Cyclone.  

� The coeXplode command is similar to the AutoCAD Explode command; however, the 

coeXplode command actually deletes the exploded block and redraws it as an Acis Solid. 

   

Note:  The coeXplode command requires the presence of the original COE file from which 

the object was imported.  

Export Objects (coeout) 

Window: AutoCAD 

Menu: Cyclone | COE 

Action: Opens dialog 

Usage: The Export Objects (coeout) command opens the Export Options dialog, which is 

used to set parameters for exporting COE files from AutoCAD to Cyclone.  
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Note:  This command can be activated by selecting it from the Cyclone | COE menu, by 

typing coeout at the command line, or by clicking the Export Objects icon in the 

toolbar. 

COE for MicroStation 

Introduction 

The Cyclone Object Exchange (COE) file format is a neutral file format  created for the specific 

purpose of interchanging objects between Cyclone and major CAD systems, including 

MicroStation. 

COE files are accessible via two MicroStation command plug-ins: COEIN and COEOUT. This 

chapter addresses how to use these plug-ins in MicroStation, as well as how to create new COE 

files and read imported COE files in Cyclone. A troubleshooting section is also included to help 

you address some of the more common problems that may occur when working with COE files.  

Requirements 

To use the COE import/export feature, you must be running MicroStation SE or later. 

Note:  Although COEOUT functions in MicroStation SE, the translation of complex 

surface/solid type objects into Cyclone objects (e.g., extrusions or revolutions of 

complex shapes or complex strings) is more likely to succeed when using 

MicroStation/J or later. 

The following files are required to run COEIN and COEOUT: 

COEIN.MA 

This MDL application is used to import a COE file into a DGN file. 

COEOUT.MA 

This MDL application is used to export a DGN file (or selected parts) to a COE file. 

CYRACOE.DLL 

This DLL file resides in the system directory. 

COE.INI 

This INI file is used to configure preference and mapping between Cyclone layers and 

MicroStation levels. 

Usage 

The COE feature allows you to use both Cyclone and MicroStation together to maximize your 

modeling capabilities. Not only can you translate objects from Cyclone to MicroStation, but you 

can also make changes to those objects and even model new objects, which can then be 

exported back to Cyclone and incorporated into the source database. 
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Translating Objects from Cyclone to MicroStation 

Objects modeled in a Cyclone environment can be exported to MicroStation using the COEIN 

MDL application. COEIN can be used to import COE files into any active MicroStation DGN file 

that has been initialized using a 3D seed file. COEIN translates objects from the Cyclone 

environment by calculating equivalent, or near equivalent objects, in the destination environment. 

Some objects, however, may not be translated directly because a direct equivalent doesn’t exist 

in MicroStation. In such cases, a group of shapes representing the unknown object may be used. 

For more information on how COE objects from Cyclone are translated into MicroStation entities, 

see the section entitled  How Objects Are Translated in this appendix. 

The following sections describe the processes both for exporting objects from Cyclone, as well as 

importing COE objects into MicroStation. Limitations to the COE functionality are also discussed, 

along with a troubleshooting section. 

Note:  This MDL application is designed primarily to translate modeled 3D objects between 

supported applications. While it is possible to translate point clouds via COE, we 

recommend using the Leica Geosystems HDS’s CloudWorx application when you need 

to bring Cyclone point clouds into MicroStation. 

Creating a COE File in Cyclone 

To export modeled objects to a COE file from Cyclone: 

1. Open the desired ModelSpace, and use Cyclone’s 3D modeling tools to create equipment, 

piping, vessels, or other objects. 

� If you want to isolate selected objects for export to the COE file, multi-select the desired 

objects, then select File |Launch | Copy Selection to New ModelSpace.  

2. When you are ready to export, click File | Export.... The Export to File dialog appears. 

3. Identify a location for the file, name the file to be created, then select “COE format (*.coe)” 

from the Save as type field. 

4. Click OK to create the COE file. All objects within the Cyclone ModelSpace are translated to 

COE format. This step may take some time, depending on the complexity of the ModelSpace 

being translated.  

Note:  When you import the COE file into MicroStation, you have the option of importing point 

clouds. However, be aware that bringing point clouds into MicroStation using COE can 

be a memory-intensive process, both when importing, and when attempting to work with 

the imported points. In addition, because points consume so much memory, COE will 

only bring in the first 500,000 points. For these reasons, we recommend using the 

CloudWorx application to view Cyclone point clouds in MicroStation. 

Bringing a COE File into MicroStation 

Once a ModelSpace has been exported to COE format from Cyclone, it can be imported into 

MicroStation using the COEIN MDL application. 
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To import a COE file into MicroStation: 

1. Open a new or existing MicroStation drawing created from a 3D seed file. 

2. If you do not currently have a command line interface available, select Key-in from the Utility 

menu to display the Key-in dialog.  

3. Enter the command MDL LOAD COEIN at the command line. 

4. From the file dialog, select the COE file to be imported. The COEIN Options dialog appears. 

5. Select your desired options, which are described as follows. 

6. Choose your desired options and click OK to continue (or Cancel to abort). The Select World 

Coordinate System dialog appears.  

� Notice that any user coordinate systems (UCS) you mapped while in Cyclone are listed here; 

if you wish to use one of these Cyclone-defined coordinate systems as your world coordinate 

system (WCS) in this DGN file, select the desired coordinate system from the list, then click 

=>WCS to map the selected user coordinate system to the world coordinate system, making 

them one and the same. All objects are aligned accordingly. 

� If you do not wish to use a UCS in this DGN file, click the Default button to map the COE data 

to the current WCS in MicroStation. 

Note: Whether selected or not, all user coordinate systems contained within the COE file are 

imported into the DGN file as “auxiliary coordinate systems (ACS).”  

� Once the coordinate system has been set, the COE file will be loaded into the current DGN 

file. The complexity of the COE file, as well as your computer’s capability, determine the 

speed with which the objects are brought in and displayed. 

� If an error message or a standard output window is displayed indicating a system fault, refer to 

the Troubleshooting section in this document. 

Mapping COE Layers to MicroStation Levels 

In Cyclone, you have access to an unlimited number of layers for use in organizing your 

drawings. When you export objects to a COE file, these layers are saved to the COE file as well, 

and when the COE file is brought into MicroStation, these layers are mapped to MicroStation 

“levels.” However, MicroStation only supports 63 levels, which are named by default numerically 

(1 to 63), with level 62 reserved by COEIN for auxiliary objects and piping/extrusion centerlines, 

and level 63 reserved as the “default.” 

If you used numbering to identify your Cyclone layers, COEIN can intelligently map the defined 

layers to corresponding MicroStation levels (e.g., COE layer 22 is mapped to MicroStation level 

22).Layers with names that do not conform to the numbering scheme are mapped incrementally 

to available MicroStation levels (e.g., “Walls” layer is mapped to the next available MicroStation 

level; for example, level 12).  

If the number of COE layers exceeds the number of available MicroStation levels, COEIN assigns 

excess COE layers to MicroStation level 63 (default), unless you have configured the mapping 

table to do otherwise. 
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Note: When mapping layers to levels, COEIN gives first priority to instructions given in the 

mapping table. 

To customize the mapping table: 

Note: You should edit the mapping table before running COEIN. 

1. Use a file browser to locate the COE.IN file; open this file by double-clicking. Scroll down to 

find the mapping table, which is defined in the [CXFIN LEVEL MAP] section. 

Warning!  DO NOT modify the contents of the [GENERAL] section! 

2. Enter your customized mapping directives by typing the name of the COE layer, followed by a 

“=”, followed by the MicroStation level number. See the example below. 

            [CXFIN LEVEL MAP] 

            Default=63 

            Piping=2 

            Walls=4 

� You may enter as many lines as necessary to map all the levels. You can map multiple layers 

to the same MicroStation level if desired 

� If you don't want to use the mapping table, you can comment the section name out, or delete 

the entire [CXFIN LEVEL MAP] section from the coe.ini file. 

3. Once you have set the layer-level mapping as desired, save the COE.INI file. Run COEIN as 

described in this document. 

Limitations 

SUPPORTED EQUIPMENT 

Not all objects modeled in Cyclone are available in MicroStation. Where there is not an exact 

object match, the objects are represented by geometrical shapes (or groups of shapes) 

approximating the translated object. For more information on how COE objects from Cyclone are 

translated into MicroStation entities, see the section entitled How Objects Are Translated in this 

document. 

POINT CLOUDS 

MicroStation uses a zero-length line to represent a point, and COEIN is capable of translating 

points from Cyclone (via COE) into such points. However, point clouds brought into MicroStation 

in this manner are limited to the first 500,000 points, as performance and DGN file size are 

impacted significantly. Unless you have a compelling reason, we recommend that you not use 

COEIN to import points into MicroStation.  

Note:  An alternative method for bringing Cyclone point clouds into MicroStation is to use 

Leica Geosystems HDS’s CloudWorx application.  
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Translating Objects from MicroStation to Cyclone 

Objects modeled within the MicroStation environment can be exported using the COEOUT 

command to a COE file for subsequent import into Cyclone. There are two primary reasons for 

translating objects from MicroStation to Cyclone: 

Simple export: Objects modeled in MicroStation can be exported to a new COE file. When this 

file is imported into Cyclone, a new ModelSpace is created and populated with the MicroStation-

modeled objects contained in the COE file. 

Data integration: Objects modeled in Cyclone and imported into MicroStation via a COE file can 

be modified in MicroStation, and then exported back into Cyclone, all the while maintaining much 

of the original data (e.g., annotations) from the original COE file from Cyclone. To do this, 

COEOUT uses the original COE file as a reference when creating the COE file to be translated to 

Cyclone. 

Note:  Although COEOUT functions in both MicroStation/J and Micro-Station SE, the 

translation of complex surface/solid type objects into Cyclone objects (e.g., extrusions 

or revolutions of complex shapes or complex strings) is more likely to succeed when 

using MicroStation/J. 

MicroStation-modeled objects are translated by mapping to equivalent or near equivalent objects 

within Cyclone. However, some objects may not have equivalent or near equivalent objects in the 

destination environment; in these cases, the objects are represented by geometrical shapes (or 

groups of shapes) approximating the translated object. For more information on how COE objects 

from Cyclone are translated into MicroStation entities, see the section entitled How Objects Are 

Translated in this appendix. 

The following sections describe the process for exporting objects from MicroStation, as well as 

importing COE objects into Cyclone. Limitations to the functionality are included as well, along 

with a troubleshooting section. 

Note:  This MDL application is designed primarily to translate modeled 3D objects between 

Cyclone and MicroStation. While points can be translated from Cyclone to MicroStation, 

both your DGN file size and your system performance will be greatly impacted. As an 

alternative, we recommend using Leica Geosystems HDS’s CloudWorx application to 

view point clouds in MicroStation.  

Creating a COE file from MicroStation 

Note:  You must be in a 3D environment (i.e., an active DGN file initialized using a 3D seed 

file) to run this command. 

To perform an export to a COE file: 

1. Do your modeling as desired in MicroStation, using a 3D seed DGN file.   

� If you plan to export the entire DGN file contents, make sure all objects are deselected before 

proceeding. If you plan to export only objects that are visible (e.g., objects in levels that are 

turned on and viewable), make sure you are in the correct view before proceeding. If you plan 
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to export only selected objects, make sure those selections are made now, taking care to 

select only what you intend to export. 

� If you do not currently have a command line interface available, select Key-in from the Utility 

menu to display the Key-in dialog.  

2. Enter the command MDL LOAD COEOUT at the command line. 

3. In the file dialog, enter a unique file name in the Files field, select the destination folder, and 

click OK. The COEOUT Options dialog appears. 

4. Choose your desired options and click OK to continue (or Cancel to abort). The selected 

objects are exported to the COE FILE.  

� The complexity of the DGN file, as well as your computer’s capability, will determine the speed 

with which the objects are exported. 

� If an error message is displayed indicating a system fault, refer to the Troubleshooting section 

in this appendix. 

Mapping MicroStation Levels to COE Layers 

MicroStation supports as many as 63 levels, with level 63 reserved as the “default” layer. When 

you export a DGN FILE to a COE FILE, these levels are exported as well, and COEOUT 

intelligently maps each level containing objects to a Cyclone layer, naming the Cyclone layer 

based on the level number (or level name if you used a level name file *.LVL).  

However, as with COEIN, you also have the option of customizing the level/layer mapping 

process by editing the mapping table in the COE.INI file.  

To customize the mapping table: 

Note: You should edit the mapping table before running COEOUT. 

1. Use a file browser to locate the COE.INI file; open this file by double-clicking. Scroll down to 

find the mapping table, which is defined in the [CXFOUT LEVEL MAP] section.  

Warning! DO NOT modify the contents of the [GENERAL] section! 

2. Enter your customized mapping directives by typing the number (or name) of the MicroStation 

level, followed by a “=”, followed by the Cyclone layer name. See the example below. 

            [cxfout level map] 

            63=Default 

            2=Piping 

            4=Walls 

� You may enter as many lines as necessary to map all the levels. You can map multiple levels 

to the same Cyclone layer.  

� If you don't want to use the mapping table, you can comment the section name out, or delete 

the entire [CXFOUT LEVEL MAP] section from the COE.INI file. 
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3. Once you have set the layer-level mapping as desired, save the COE.INI file. Run COEOUT 

as described in this document. 

Importing a COE File into Cyclone 

To import a COE file into Cyclone: 

1. Open the Cyclone Navigator and select the database or project into which you want to import 

the COE file.  

2. Right click the database or project name and select Import, or select File | Import from the 

Navigator window. The Import from File dialog appears. 

3. Locate the COE file to be imported and initiate the process. A new ModelSpace is created in 

the selected database or project.  

Limitations 

SHAPES 

If there is an unsupported shape, it will be brought into Cyclone as a wireframe object, but ONLY 

if you check the “Unsupported objects” options in the COEOUT Options dialog in MicroStation; 

otherwise, the unsupported objects are not translated. Instead, a message is displayed informing 

you of that the objects have not been translated, and asking if you want to select the objects not 

translated. 

MODELSPACES 

You cannot bring COE objects directly into an existing ModelSpace; however, you CAN multi-

select and copy objects from the ModelSpace created from the COE import, and paste them to 

the desired ModelSpace. Alternatively, you can use the Merge from ModelSpace command to 

merge ModelSpace Views. See the Merge from ModelSpace entry in the Commands chapter for 

more information.  

ANNOTATIONS 

With the exception of tags, annotations and measurements made in MicroStation are not 

translated to Cyclone.  

Troubleshooting 

COEIN/COEOUT Does Not Finish And an Error Is Displayed 

If you checked the Create LOG option in the COEIN/COEOUT Options dialog (recommended), 

open the LOG file to check the reason. You will find the LOG file in the same folder as the active 

DGN file; it has the same file name as the DGN file, but with a *.LOG extension. 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Cyclone Object Exchange (COE) 

130 

SOME OBJECTS ARE NOT TRANSLATED TO THE DESTINATION ENVIRONMENT 

If you are translating objects from Cyclone to MicroStation, it may be that the objects are not 

supported by COE, and they may have not have been translated. If you checked the Create LOG 

option in the COEIN/COEOUT Options dialog (recommended), you can check the LOG file to 

confirm that this is the cause.  

If you are translating objects from MicroStation to Cyclone, double the check the 

following: 

� Did you select the correct Export Objects option (All, Visible, Selected) in the COEOUT 

Options dialog? 

� If you intended to export the entire DGN file contents, did you deselect all objects before 

proceeding? 

� If you intended to export only visible objects, did you have the correct levels turned on? 

� If you intended to export only selected objects, were all the desired objects selected? 

� Did you check the Unsupported Objects (Smartsolid use wire, Unknown surface use wire) 

options in the COEOUT Options dialog? 

THE APPEARANCE OF OBJECTS (COLOR) IS NOT AS DEFINED IN THE SOURCE 

ENVIRONMENT 

Objects translated via COE files are managed in layers. Each layer has its own appearance 

override (assigned color), which is imported as “level symbology” in MicroStation.  

OBJECT PRECISION IS INADEQUATE 

Check the resolution parameters in the Design File Settings dialog (Settings | Design File...). If 

the resolution parameters are set too low, you will have decreased drawing precision, though you 

will have more design space. Adjust these parameters to achieve the desired results. 

COE CONTENTS DO NOT FIT INTO THE DGN DESIGN SPACE 

Check the resolution parameters in the Design File Settings dialog (Settings | Design File..., then 

select the Working Units category). If the resolution parameters are set too high or the DGN units 

are set improperly (e.g., DGN units are set to mm for a model that has a large area more 

appropriately measured in meters), you will have a decreased design space, though you will have 

more object precision. Adjust these parameters to achieve the desired results. 

How Objects Are Translated 

In most translations between Cyclone and MicroStation, there are elements in one system that 

have no exact equivalent in the other. The following tables show how COEIN and COEOUT 

translate objects. 
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From Cyclone to MicroStation 

Cyclone                                                                 MicroStation Object Type 

Vertex 03:Line 

 17:Text (when object contains annotation "Text"  

 or “Note”) 

  

Line Segment 03:Line 

  

Circular Arc 15:Ellipse (when curve is closed) 

 16:Arc 

  

Elliptical Arc 15:Ellipse (when curve is closed) 

 16:Arc 

  

Polyline 04:Line String 

  

Steel Shapes 04:Line String 

 User Data Linkage: "StdShape" 

  

Spline Curve 27:B-spline curve 

  

Patch 06:Shape 

  

Extruded Patch 18:Surface (when it is not fully capped) 

 19:Solid (when both side flat capped) 

 User Data Linkage:”PlanarPolylineExtrusion" 

  

Box See PlanarPolylineExtrusion 

 User Data Linkage: "RectangularBox" 

  

Steel Section See PlanarPolylineExtrusion 

 User Data Linkage: "Steel" 

 User Data Linkage:{ section type,d,bf,tf,tw}  

  

Cylinder 02:Cell Header (Cone+Caps when using cells) 

 23:Cone (for cone) 
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 18:Surface(for semi-elliptic, hemispheric caps) 

 15:Ellipse (for flat caps) 

  

Cone See Cylinder 

  

Flange See Cylinder 

 User Data Linkage: "Flange" 

  

Reducer See Cylinder 

 User Data Linkage: "Reducer" 

  

Sphere 18:Surface 

 User Data Linkage: "Sphere" 

  

Torus 02:Cell Header (Solid+Caps when using cells) 

 19:Solid (for torus) 

 18:Surface (for semi-elliptic, hemispheric caps) 

 15:Ellipse (for flat caps) 

 User Data Linkage: "Torus" 

  

Elbow, Reducing Elbow 02:Cell Header (Solid+Caps when using cells) 

 19:Solid or 18:Surface (for torus) 

 18:Surface (for semi-elliptic, hemispheric caps) 

 15:Ellipse (for flat caps) 

 User Data Linkage: "Torus" 

  

Valve 02:Cell Header (Cone+Line+Ellipse when 

 using cells) 

 23:Cone (for valve admission and exhaustion) 

 03:Line (for stem) 

 15:Ellipse (for handle wheel) 

 User Data Linkage to 1st Cone: Valve 
parameters 

  

Group 02:Cell Header 
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Contours 02: Cell Header (with LineString and Text) 

 User Data Linkage: "ContourObj"  

  

Mesh 02: Cell Header (w/Shapes, limit to 800 
triangles) 

 User Data Linkage: "TriMesh" (V3.1 feature) 

  

ExclusionVolume 02:Cell Header 

 User Data Linkage: "ExclusionVolume", 

 User Data Linkage: { size.x, size.y, size.z}  

  

Layer Level  

  

Point Cloud 03:Line (individual zero-length lines) 

  

Annotation (attached to object) 37:Tag 

  

User Coordinate Systems 05: level 3 object Aux_coordinate 

From MicroStation to Cyclone 

Using COEOUT to translate objects to Cyclone is not as straightforward as the translation from 

Cyclone to MicroStation, largely because MicroStation’s advanced CAD capabilities allow users 

to create any number of unique objects which do not exist in Cyclone, and thus, cannot be 

translated by COEOUT.  

However, COEOUT can translate most standard objects to Cyclone. In addition, objects that were 

originally translated from Cyclone using COEIN  are fully reversible whether the original COE file 

is referenced or not. If the original COE file is referenced, all non-geometric parameters and 

Cyclone reserved parameters are kept intact.  

The following table shows the translation protocol that COE uses when using COEOUT to 

translate objects back to Cyclone from MicroStation. The “Mapped” column indicates whether the 

listed item can be mapped, and to what extent by using the following codes: 

     Y = fully mapped  

     P = mapping is possible but some complex objects are not supported  

     F = implementation may change in a future release 
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MicroStation Entity                                              Mapped   Cyclone Object 

02: Cell Header P COE tries to fit these into the following Leica HDS 
objects: 

  - Valve (only with Leica HDS label) 

  Cylinder with caps (only with Leica HDS label) 

  Flange with caps (only with Leica HDS label) 

  Cone with caps (only with Leica HDS label) 

  Reducer with caps (only with Leica HDS label) 

  Elbow , Reducing Elbow with caps (only with Leica 
HDS label) 

  Group (other non-name Cell Headers) 

  Mesh (only with Leica HDS label) 

  Contours (only with Leica HDS label) 

  Not supported: Smart Geometry SMSLD, SMSURF 

  Not supported (other named cell headers) 

   

03: Line Y - Vertex (when line length is zero) 

  - Line Segment 

   

04: Line String Y - Polyline for non-planar Polyline 

  - Planar Polyline (only with Leica HDS label 
"StdShape") 

   

05: Group Data  - User Coordinate Systems: Lvl 3 obj. 
Aux_Coordinate 

   

06: Shape Y - Patch 

   

07: Text Node F - Group of Vertices (with Annotation Text) 

   

12: Complex Line String F - Group of Polylines and Circular Arcs 

   

14: Complex Shape F - Group of Polylines and Circular Arcs 

   

15: Ellipse Y - Circular Arc for circle 

  - Elliptical Arc for general ellipse 
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16: Arc Y - Circular Arc for circular arc 

  - Elliptical Arc for general elliptic arc 

17: Text Y - Vertex (with Annotation "Text") 

   

18: Surface (Complex) P COE tries to convert these to these Leica HDS 
objects: 

  - Extruded Patch (always capped) 

  - Steel Section (only with Leica HDS label) 

  - Sphere 

  - Torus 

  - Elbow, Mitered Elbow, Reducing Elbow 

  - Cone, Cylinder, Reducer 

  - Revolved complex shapes as group of connected  

      shapes 

  - Cones/Cylinders, Extruded complex shape as an  

      Extruded Patch 

   

19: Solid (Complex) P COE tries to fit these into the following Leica HDS 
objects: 

  - Extruded Patch (always capped) 

  - Steel Section (only with Leica HDS label) 

  - Sphere 

  - Torus 

  - Capped Elbow or Mitered Elbow or Reducing 
Elbow 

  - Capped Cone, Cylinder, Reducer 

  - Revolved complex shapes as a group of 
connected  

       shapes 

  - Cones/Cylinders, Extruded complex shapes use  

      Extruded Patch 

   

23: Cone Y - Cylinder (capped or uncapped) 

  - Cone (capped or uncapped) 

  - Flange (only with Leica HDS label) (capped or 
uncapped) 

  - Reducer (capped or uncapped) 
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27: B-spline Curve P Spline Curve 

   

37: Tag P - Find associated element and add as an annotation  

   

Levels Y - Layers 

  - Reads mapping tables from COE..INI  

  - Current level mapped to Default Layer 

  - Other levels (with objects) to named  external layers 
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OpenGL Modes 

OpenGL Modes Introduction 

The OpenGL Modes applet (installed with Cyclone) displays the available graphics modes 

supported by the graphics system of your computer. It is intended for use with Cyclone, to help 

the user choose an alternate graphics mode. Each graphics mode has its own particular 

characteristics. The relevant characteristics are described below. 

Sometimes, the graphics system does not fully support a particular mode, or Cyclone may have 

odd interactions with a given mode. In the case that Cyclone chooses one of those problematic 

modes, the user has the option of reconfiguring Cyclone to use another graphics mode. 

Note:  A particular graphics card/drive combination may have additional settings that affect 

Cyclone's performance. 

To set a new graphics mode: 

1. Launch the OpenGL Modes applet. 

� To launch the OpenGL Modes applet: From the Windows Start menu, point to Programs | 

Leica HDS Cyclone 5.8 | Utilities and then select OpenGL Modes. The Supported 

OpenGL Modes dialog appears. 

2. Select a new graphics mode. 

� The default graphics mode chosen by Cyclone has an asterisk next to it, and the user-

selected graphics mode is enclosed in brackets. To reset the mode to the user default, click 

the User Default button. This gives Cyclone the option of choosing the mode to use. 

� To select a new graphics mode, click a number in the Mode column, and then click the Set 

Mode button. The new mode is written to your registry. 

� The Check Screen Saver checkbox controls Cyclone's redrawing while a screen saver is 

active. When enabled, Cyclone does not redraw when the screen saver is active - this can 

reduce load on the CPU over time (e.g., when scanning). If Cyclone does not render properly, 

turn this option OFF and then restart Cyclone. 

3. Click Exit, and then restart Cyclone to switch to the new mode. 

� If you change your graphics card or graphics driver, please be sure to test whether or not you 

still need that graphics mode, or if in fact that mode still exists with the desired characteristics. 

Graphics mode characteristics 

Please note that some graphics modes may seem identical as presented by this program, when 

in fact, there are differences not listed. 

MODE 

The number of the graphics mode. 
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RGB 

This settings determines the number of color bits used in the graphics mode when rendering 
objects in color. At least 15 bits is recommended for good color differentiation. 

       2 bits = black and white (not recommended) 

       4 bits = 16 colors (not recommended) 

       8 bits = 256 colors 

       15 bits = 32,768 colors 

       16 bits = 65,536 colors 

       24 bits = 16,777,216 colors 

       32 bits = 4,294,967,296 colors 

The difference between 24 bits and 32 bits for a modern display monitor is insignificant, but 
can have a positive or negative effect on memory layout and memory usage. 

ZBUF 

This setting determines the number of bits used for the depth buffer, or "Z-buffer", which is a 
commonly used way of rendering in 3D so that objects closer to the viewer appear "on top" of 
objects further away. At least 16 bits is recommended for avoiding some rendering artifacts. 
24 bits is better, etc.. On some cards, the Z-buffer depth is limited by the number of RGB bits, 
so you may need to change the display settings to access a deeper Z-buffer. 

DBLBUF 

This setting determines whether or not the graphics mode supports double-buffering, which 
lets the system draw sequential frames without flickering. 

       Y = sequential frames will not flicker (recommended) 

       (blank) = sequential frames may obviously flicker 

SW 

This setting determines whether or not the graphics mode supports software rendering, where 
the main CPU in the computer does all of the rendering, which can be more correct than 
hardware rendering (depending on the graphics driver), but at the expense of rendering 
performance. If none of the other graphics modes work correctly, then try one of these. 

       Y = rendering is done entirely in software 

       (blank) = some rendering tasks may be done by the graphics hardware 

HW 

This setting determines whether or not the graphics mode supports hardware acceleration, 
where the graphics card does some or all rendering tasks, which can be faster than software 
rendering. 

       Y = supports rendering entirely in the graphics hardware 

       (blank) = some rendering tasks may be done by the graphics hardware 

OPENGL 

This settings determines whether or not the graphics mode supports the OpenGL API. This 
must be set to Y. 
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Command Reference 

2D Drawing Mode 

Window: ModelSpace 

Menu: Edit | Modes 

Action: Executes command 

Usage: The 2D Drawing Mode command enters Drawing mode and sets the drawing tool 

to draw the shape selected in the Drawing submenu in the Tools menu. 

For 2D drawing procedures, see the Drawing entry in the Modeling chapter. 

2D Extraction 

Window: ModelSpace 

Menu: Tools  

Action: Displays submenu 

Usage: Pointing to 2D Extraction displays submenu commands used to create 2D 

drawings from the contents of a rectangular data fence. 

The following commands are available from the 2D Extraction submenu: 

From Fence Contents..., From Selection in Fence... 

� For 2D Extraction submenu command and dialog details, see the individual command 

entries. 

About Cyclone 

Window: All Windows 

Menu: Help 

Action: Opens dialog 

Usage: The About Cyclone dialog displays a splash screen containing the version number 

of the Cyclone software. 

� To exit the About Cyclone dialog, click OK. 

 

 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Index 

140 

Above Ref Plane (Mesh) 

Window: ModelSpace 

Menu: Tools | Measure | Mesh Volume 

Action: Opens dialog 

Usage: The Above Ref Plane command is used to measure the “cut” volumes of a 

selected mesh relative to the active Reference Plane. 

�     To measure the "fill" volume of a mesh, see the Below Ref Plane (Mesh) command for more 

information. 

To measure the “cut” volume of a mesh down to the active Reference 
Plane: 

1. Select the mesh whose “cut” volume you want to measure. 

����    The cloud must be viewed as a mesh. (See the View Object As entry in this chapter.) 

2. From the Tools menu, point to Measure | Mesh Volume, and then select Above Ref 

Plane.... The Sampling Step dialog appears. 

3. Enter a value for the interval by which the Reference Plane is divided into a grid for 

measurement. 

����    A smaller interval may yield more accurate results, but may take longer to compute. 

4. Click OK. The measurement results are displayed in cubic units. The measurement result is 

also displayed in the Output Box, if it is enabled. 

Acquire Targets 

Window: Scan Control 

Menu: Scanner Control 

Action: Opens dialog 

Usage:  The Acquire Targets command displays a dialog that is used to acquire HDS 

Targets, 6" diameter spherical targets or black/white targets near user-controlled 

picks in the current point cloud, as well as to acquire HDS Targets or 6" diameter 

spherical targets from selected point clouds. 

� Once acquired, HDS targets and sphere targets are automatically added to the ControlSpace. 
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Acquire Targets Dialog 

 

Acquire Selects one of the following target acquisition options: HDS Targets from Pick 

Points, Spheres from Pick Points, Black/White Targets from Pick Points, HDS 

Target from Fence, Black/White Target from Fence, Sphere from Fence, HDS 

Targets from Selected Cloud, Spheres from Selected Cloud, or Recheck Targets. 

 Click the Keep on Top icon to display this dialog on top of other open windows. 

 Click the Acquire HDS Targets from Picks icon to find potential HDS target 

candidates near user-picked points. 

 Click the Acquire Black/White Targets from Picks icon to find potential black/white 

target candidates near user-picked points. 

 Click the Acquire Spheres from Picks icon to find potential sphere target candidates 

near user-picked points. 

 Click the Acquire HDS Target from Fence icon to find a HDS target within the user-

defined fence. The fence should be as small as possible (no larger than the actual 

target), centered on the target. 

 Click the Acquire Black/White Target from Fence icon to find a black/white target 

within the user-defined fence. The fence should be as small as possible (no larger than 

the actual target), centered on the target. 

 Click the Acquire Sphere from Fence icon to find a sphere target within the user-

defined fence. The fence should be as small as possible (no larger than the actual 

target), centered on the target. 
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 Click the Search HDS Targets from Selected Cloud icon to find potential HDS Target 

candidates in a selected point cloud. You are only required to select a point cloud 

before activating this command; you are not required to pick near potential targets. 

Cyclone locates and lists up to a maximum number of potential HDS Target targets in 

the point cloud (with the maximum number defined in the Max # field in this dialog). 

 Click the Search Spheres from Selected Cloud icon to find potential sphere target 

candidates in a selected point cloud. You are only required to select a point cloud 

before activating this command; you are not required to pick near potential targets. 

Cyclone locates and lists up to a maximum number of potential sphere targets in the 

point cloud (with the maximum number defined in the Max # field in this dialog). 

Note: The number of target candidates listed when you invoke either Search HDS 

Targets from Selected Cloud or Search Spheres from Selected Cloud, is 

independent of the number of potential targets already listed in this dialog. 

 Click the Recheck Targets icon to automatically re-acquire the checked targets and 

display a report of the deviations from the previous results. In the dialog that appears, 

specify the Recheck Tolerance (the maximum distance that the target position is 

allowed to have changed) and Target Prefix (prepended to the names of the re-

acquired targets). This can be used to detect if the scanner or targets have 

unknowingly changed location over some period of time. The rechecked targets are 

placed on the special Target QA/QC layer for reference. 

# The Target Number (#) column displays target candidates that have been identified 

either by the user or by Cyclone (using one of the icon commands). 

Target ID Type a unique registration label for each potential target. 

Target Ht Type the height for each potential target. 

Comment Type notes or commentary about the potential target. When this field contains data for 

a target that is subsequently acquired, the data becomes a text annotation. 

Acquire Select this check box to mark the target for attempted acquisition. If cleared, Cyclone 

ignores the potential target during target acquisition. 

Status Displays the ongoing status of target acquisition for each target, ending with the final 

result of the attempted acquisition. 

Max # Type the maximum number of target candidates to be found by Cyclone when either 

the Search HDS Targets from Selected Cloud or Search Spheres from Selected 

Cloud commands are selected. 

Acquire Begins the acquisition process of selected targets. 

Stop Stops the acquisition process of selected targets. 
 

To acquire targets from picks: 

� The process of acquiring targets is usually done after an initial scan of the scene, which 

provides a general reference as to the location of targets in the scene. 

1. From the Project menu in the Scan Control window, select Open ModelSpace Viewer (or 

click the Open Viewer button on the right side of the Scan Control window). A new 

ModelSpace viewer for the incoming scan data opens. 

 In order to make targets stand out from the scene, make sure color mapping is turned ON. 

(See the View Object As entry in this chapter). 

2. In the ModelSpace window, multi-select the target  locations. Each pick should be within two 
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inches of the actual location. If you have both HDS Targets and spheres in your scan, select 

all the potential HDS Targets first and proceed through step 4, then select all the sphere 

targets and repeat steps 2 - 4. 

3. From the Scanner Control menu in the Scan Control window, select Acquire Targets. The 

Acquire Targets dialog appears. 

4. From the Acquire Targets menu in the dialog, select HDS Targets from Pick Points to mark 

potential HDS Targets in the ModelSpace viewer, and list them in the Acquire Targets dialog; 

select Black/White Targets from Pick Points to mark potential black/white targets in the 

ModelSpace viewer, and list them in the Acquire Targets dialog; select Spheres from Pick 

Points to mark potential sphere targets in the ModelSpace viewer, and list them in the 

Acquire Targets dialog. 

5. View each potential target to determine which ones you want Cyclone to attempt to acquire. 

� To center the ModelSpace viewpoint on a potential target, select the potential target from the 

list in the Acquire Targets dialog. 

� To rotate the ModelSpace viewpoint around a potential target, select the potential target from 

the list in the Acquire Targets dialog, and then press the LEFT/RIGHT ARROW keys. 

� To move up/down the list of potential targets, press the UP/DOWN ARROW keys. 

6. Add an identifier or comment to potential targets to be acquired. 

� To add an identifier or comment: select the target, click the ID or Comment field, type an 

identifier or comment, and press ENTER. 

� Identifiers function as registration labels and can be used for automatic registration. 

� Comments function as text annotations in the ModelSpace once a target is acquired. 

7. Once you have viewed potential targets, select the targets to be acquired by checking the box 

in the fourth column for each target to be acquired. 

� To toggle the check box for a selected target, press the SPACEBAR key. 

8. Click Acquire. The target acquisition process begins; progress and results are displayed in 

the Status column. 

� During the target acquisition process, Cyclone performs a coarse and then a fine scan on 

each potential target, and then fits a vertex to the target. If the coarse scan fails to find 

sufficient data to begin a fine scan, the Status column in the Acquire Targets dialog displays 

Failed at Coarse. If the fine scan fails to find sufficient data to place a target, the Status 

column in the Acquire Targets dialog displays Failed at Fine. 

� Coarse and fine scans appear in the ModelSpace viewer. Coarse scans are deleted upon 

successful acquisition. 

� Fine scans can be viewed by double-clicking the scan item in the Navigator window. Fine 

scans are saved in the HDS Target Scans folder of the parent ScanWorld. 

� To adjust the resolution of the fine scan, see the use the Scan Control tab of the Edit 

Preferences dialog. 

To acquire a target from a fence: 

� The process of acquiring targets is usually done after an initial scan or image acquisition of 

the scene, which provides a general reference as to the location of targets in the scene. 

1. In the Scan Control window, visually identify a potential target in the point cloud or image. 

2. For each potential target, draw the smallest fence that completely contains the target. The 

larger the fence is, the more likely it is that the target will be missed in the coarse scan. 

3. From the Scanner Control menu in the Scan Control window, select Acquire Targets. The 
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Acquire Targets dialog appears. 

4. From the Acquire Targets menu in the dialog, select HDS Target from Fence to list the 

potential HDS Target in the Acquire Targets dialog; select Black/White Target from Fence 

to list the potential black/white target in the Acquire Targets dialog; select Sphere from Pick 

Fence to list the potential sphere target in the Acquire Targets dialog. 

5. View each potential target to determine which ones you want Cyclone to attempt to acquire. 

� To center the ModelSpace viewpoint on a potential target, select the potential target from the 

list in the Acquire Targets dialog. 

� To rotate the ModelSpace viewpoint around a potential target, select the potential target from 

the list in the Acquire Targets dialog, and then press the LEFT/RIGHT ARROW keys. 

� To move up/down the list of potential targets and spheres, press the UP/DOWN ARROW 

keys. 

6. Add an identifier or comment to potential targets to be acquired. 

� To add an identifier or comment: select the target, click the ID or Comment field, type an 

identifier or comment, and press ENTER. 

� Identifiers function as registration labels and can be used for automatic registration. 

� Comments function as text annotations in the ModelSpace once a target is acquired. 

7. Once you have viewed potential targets, select the targets to be acquired by checking the box 

in the fourth column for each target to be acquired. 

� To toggle the check box for a selected target, press the SPACEBAR key. 

8. Click Acquire. The target acquisition process begins; progress and results are displayed in 

the Status column. 

� During the target acquisition process, Cyclone performs a coarse and then a fine scan on 

each potential target, and then fits a vertex to the target. If the coarse scan fails to find 

sufficient data to begin a fine scan, the Status column in the Acquire Targets dialog displays 

Failed at Coarse. If the fine scan fails to find sufficient data to place a target, the Status 

column in the Acquire Targets dialog displays Failed at Fine. 

� Coarse and fine scans appear in the ModelSpace viewer. Coarse scans are deleted upon 

successful acquisition. 

� Fine scans can be viewed by double-clicking the scan item in the Navigator window. Fine 

scans are saved in the HDS Target Scans folder of the parent ScanWorld. 

� To adjust the resolution of the fine scan, see the use the Scan Control tab of the Edit 

Preferences dialog. 

To acquire targets from selected clouds: 

� The process of acquiring targets is usually done after an initial scan of the scene, which 

provides a general reference as to the location of targets in the scene. 

1. From the Project menu in the Scan Control window, select Open ModelSpace Viewer (or 

click the Open Viewer button on the right side of the Scan Control window). A new 

ModelSpace viewer for the incoming scan data opens. 

2. In the ModelSpace viewer, select the point cloud from which you want to acquire potential 

targets. 

3. From the Scanner Control menu in the Scan Control window, select Acquire Targets. The 

Acquire Targets dialog is displayed. 

4. From the Acquire menu in the dialog, select HDS Targets from Selected Cloud to find 

potential HDS Targets in the selected point cloud and list them in the Acquire Targets dialog; 
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select Spheres from Selected Cloud to find potential sphere targets in the selected point 

cloud, and list them in the Acquire Targets dialog. Cyclone searches the point cloud for 

characteristics indicative of HDS tie-points or 6" sphere targets (depending on which 

command is selected), marks up to the maximum number of potential targets (user-defined), 

and lists them in the dialog. 

5. View each potential target to determine which ones you want Cyclone to attempt to acquire. 

� To center the ModelSpace viewpoint on a potential target, select the potential target from the 

list in the Acquire Targets dialog. 

� To rotate the ModelSpace viewpoint around a potential target, select the potential target from 

the list in the Acquire Targets dialog, and then press the LEFT/RIGHT ARROW keys. 

� To move up/down the list of potential targets, press the UP/DOWN ARROW keys. 

6. Add an identifier or comment to potential targets to be acquired. 

� To add an identifier or comment: select the target, click the ID or Comment field, type an 

identifier or comment, and press ENTER. 

� Identifiers function as registration labels and can be used for automatic registration. 

� Comments function as text annotations in the ModelSpace once a target is acquired. 

7. Once you have viewed potential targets, select the targets to be acquired by checking the box 

in the fourth column for each target to be acquired. 

� To toggle the check box for a selected target, press the SPACEBAR key. 

8. Click Acquire. The target acquisition process begins; progress and results are displayed in 

the Status column. 

� During the target acquisition process, Cyclone performs a coarse and then a fine scan on 

each potential target, and then fits a vertex to the target. If the coarse scan fails to find 

sufficient data to begin a fine scan, the Status column in the Acquire Targets dialog displays 

Failed at Coarse. If the fine scan fails to find sufficient data to place a target, the Status 

column in the Acquire Targets dialog displays Failed at Fine. 

� Coarse and fine scans appear in the ModelSpace viewer. Coarse scans are deleted upon 

successful acquisition. 

� Fine scans can be viewed by double-clicking the scan item in the Navigator window. Fine 

scans are saved in the HDS Target Scans folder of the parent ScanWorld. 

� To adjust the resolution of the fine scan, see the use the Scan Control tab of the Edit 

Preferences dialog. 

Activate (Limit Box Manager) 

Window:  Limit Box Manager 

Menu: Limit Box 

Action:  Executes command 

Usage: The Activate command activates the selected limit box. 
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Activate Next (Limit Box Manager) 

Window:  Limit Box Manager 

Menu: Limit Box 

Action:  Executes command 

Usage: The Activate Next command activates the limit box in the list position below the 

currently active limit box. 

Activate Previous (Limit Box Manager) 

Window:  Limit Box Manager 

Menu: Limit Box 

Action:  Executes command 

Usage: The Activate Previous command activates the limit box in the list position above 

the currently active limit box. 

Add Both Flat Caps 

Window: ModelSpace 

Menu: Edit Object | End Caps  

Action: Executes command 

Usage: The Add Both Flat Caps command creates flat end caps on both ends of the 

selected object. 

To add caps to both ends of the selected object: 

1. Select the object that you want to cap. 

2. From the Edit Object menu, point to End Caps, and then select Add Both Flat Caps. The 

caps appear. 

� To add a cap to only one end, see the Add Flat Cap Closest to Pick entry in this chapter. 

Add Both Semi-Elliptical Heads 

Window: ModelSpace 

Menu: Edit Object | End Caps  

Action: Executes command 

Usage: The Add Both Semi-Elliptical Heads command creates semi-elliptical heads on 

both ends of the selected object. 

To add semi-elliptical heads to both ends of the selected object: 

1. Select the object that you want to cap. 

� From the Edit Object menu, point to End Caps, and then select Add Both Semi-Elliptical 
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Heads. The caps appear. 

� To add a semi-elliptical head to only one end, see the Add Semi-Elliptical Head Closest to 

Pick entry in this chapter. 

� To remove caps, see the Remove Cap Closest to Picks entry or the Remove Both Caps entry 

in this chapter. 

Add Cloud Constraint 

Window: Registration 

Menu: Cloud Constraint 

Action: Executes command 

Usage: The Add Cloud Constraint command creates a constraint between two ScanWorlds 

from two selected point clouds or meshes. 

� For more information on the cloud registration process, see the Cloud Registration entry in the 

Registration chapter. 

� You can create Cloud Constraints using Add Cloud Constraint without picking initial pick 

hints for the two following cases: 

1. If you have registered your ScanWorlds with targets, you are able to add cloud constraints to 

tighten the registration in areas where that have overlapping scan clouds but targets are not 

available. 

2. If you have set the ScanWorld Default Coordinate system to a shared or global coordinate 

system for both ScanWorlds. 

To add a cloud constraint: 

1. From the ModelSpaces tab of the Registration window, load both of the ModelSpaces that 

contain the objects you want to constrain. 

� To load a ModelSpace: In the upper pane, select the ModelSpace you want to view, and then 

go to the ScanWorld menu and select View ModelSpace. The first ModelSpace that you 

open appears in the Constraint viewer on the bottom left side of the Registration window. 

The next appears on the right, and then each subsequently loaded ModelSpace alternates 

between loading in the left and right Constraint viewers. 

2. Pick two or more corresponding points on meshes or point clouds in each viewer. Picks on 

objects other than meshes/clouds are ignored. 

� When picking only two points, the picks must be in the same order for both ScanWorlds. We 

recommend three or more picks since two picks are often inadequate for the Optimize Cloud 

Alignment command to work reliably. 

� The picking order does not matter for three or more picks, except where the point layout has 

some symmetry and the order of the picks is used to reduce this geometric ambiguity. 

3. From the Cloud Constraint menu, select Add Cloud Constraint. A new Cloud Constraint is 

added to the Constraint List, labeled as a cloud/mesh constraint, and automatically named. 

Picked clouds/meshes are copied to the appropriate ControlSpace as needed. 

� To view the objects involved in a selected constraint, see the Show Constraint entry in this 

chapter. Bad pick points (those that are further than the Max Search Distance preference in 

the Edit Preferences dialog) are displayed in blue. 
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� If the algorithm fails to match at least two points or if the corresponding points are more than 

the Max Search Distance preference after alignment, then a warning dialog appears. 

To add a cloud constraint without initial pick hints: 

� You can create Cloud Constraints using Add Cloud Constraint without picking initial pick hints 

for the two following cases: 

1. From the ScanWorlds' Constraints tab of the Registration window, select both of the 

ScanWorlds that contain the clouds you want to constrain. 

2. From the Cloud Constraint menu, select Add Cloud Constraint. The Add Cloud 

Constraint dialog appears. 

3. Select the appropriate initial alignment method, and then click OK. A new Cloud Constraint is 

added to the Constraint List, labeled as a cloud/mesh constraint, and automatically named. 

Add Constraint 

Window: Registration 

Menu: Constraint 

Action: Executes command 

Usage: The Add Constraint command creates a constraint between two ScanWorlds from 

two selected objects. 

�    For more information on the registration process, see the Registration entry in the Getting 

Started chapter. 

�       Adding a constraint defines two objects as having similar size and shape and being located 

in the overlapping area of the ScanWorlds that you are registering. 

To manually add a constraint: 

1. From the ModelSpaces tab of the Registration window, load both of the ModelSpaces that 

contain the objects you want to constrain. 

� To view a ModelSpace: In the upper pane, select the ModelSpace you want to view, and then 

go to the ScanWorld menu and select View ModelSpace. The ControlSpace appears in one 

of the two Constraint viewer windows. The first ModelSpace that you open appears in the 

subwindow on the bottom left side of the Registration window. The next appears on the right, 

and then each subsequently loaded ModelSpace alternates between loading in the left and 

right windows. 

2. In each Constraint viewer, select the object you want to constrain. 

� In order to manually add a constraint, both objects must first be copied to their respective 

ControlSpace. 

3. From the Constraint menu, select Add Constraint. The constraint is added and labeled as a 

manual constraint and given the lowest available number (e.g., the first manually added 

constraint is named “Manual 1”). 

� To view the objects involved in a selected constraint, see the Show Constraint entry in this 

chapter 
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Note:    A manual constraint is not added if a constraint between the two objects already 

exists in the Registration. 

Add/Edit Annotations... 

Window: ModelSpace, Navigator, Image Viewer 

Menu: ModelSpace: Tools | Annotations 

 Navigator: Edit 

 Image Viewer: Annotation 

Action: Opens dialog 

Usage: The Annotations dialog is used to add, edit, and delete annotations for selected 

objects. 

�       Annotations can be attached to any selectable object, and can consist of text, numerals, or 

file attachments. In addition, multiple annotations can be created for an object. Annotation 

visibility can be adjusted globally or specifically as described below: 

•       To enable the visibility of all annotations marked as “visible” in the Image Viewer or 

ModelSpace windows, select Show Annotations from the Annotations submenu (Annotation 

menu in the Image Viewer window). 

•       To toggle the visibility of an individual annotation, select the object with which the annotation 

is associated, then open the Annotations dialog. Select/deselect the box in the Visibility column 

for the desired annotation. The Show Annotations option in the viewer must be enabled before 

any annotation is drawn. 

•       The Annotations dialog contains two tabs:the Annotations tab, and the Custom tab. The 

Annotation tab lists all annotations for the current selection, including annotations created in the 

Custom tab, feature code annotations, and registration labels.  

•       See the Add/Edit Custom Annotations command for information on creating and editing 

custom annotations. Refer to the following text for directions on adding, editing, and deleting 

annotations using the Annotations tab of the Annotations dialog. 

Note:    The procedures below refer to the menus and sub-menus in the ModelSpace window 

for accessing the Annotations dialog. If you are in the Navigator or Image Viewer 

windows, substitute the appropriate menus. 

To create a new annotation: 

 Note:    In addition to the procedure described below, you can create new annotations 

from the Custom tab when you are in a ModelSpace View. For information on 

creating custom annotations, see the Add/Edit Custom Annotations entry in this 

chapter. 
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1. Select the object to which you want to attach an annotation. 

� When creating an annotation in the Image Viewer window, select an existing vertex, or pick a 

spot on the image. 

� When you want to annotate an area within the ModelSpace View rather than a specific object, 

insert an info marker, and then attach the annotation to the info marker. 

2. From the Tools menu, point to Annotations, then Add/Edit Annotations.... The Annotations 

dialog appears. 

3. Click the New Annotation icon. The New Annotation dialog appears. 

4. Enter the key, enter the value, and select the desired type of annotation according to the field 

information provided below: 

� The Key field is used to identify the annotation (e.g., pipe size) and cannot be used twice for 

the same object. However, the same annotation key can be used by multiple objects. For 

information on showing/hiding annotation keys, see the Show Annotation Keys entry in this 

chapter. 

� The Value field is the main information of the annotation. (For example, if the annotation key 

is “pipe size,” you can enter the actual pipe size in this field.) You may also attach a file of any 

type (including executable files) as an annotation value, either by typing in the file name and 

location, or by clicking the Browse button and selecting the desired file from the browser. If 

you choose to attach a file, you must select External Document for the Type field to enable 

additional functionality. 

Note:    File and program names/paths that include spaces and/or non-standard characters 

(e.g., commas, semi-colons) must be enclosed by quotation marks. 

� The Type field identifies the type of data entered in the Value field. The types available for 

annotation values are Text, Integer, Decimal, and External Document. 

5. Click OK to assign the annotation and return to the Annotations dialog. 

To edit annotations: 

1. Select the object for which you want to change the annotations. 

2. From the Tools menu, point to Annotations, and then select Add/Edit Annotations.... The 

Annotations dialog appears. 

3. Make the desired changes to the Value, Type, or Visibility field; the changes are applied 

immediately.  

 Note:    The Key field cannot be modified. 
 

To attach a file as an annotation: 

1. Select the object to which you want to attach a file. 

2. From the Tools menu, point to Annotations, then select Add/Edit Annotations.... The 

Annotations dialog appears. 

3. Create an annotation and set the Type field to External Document. 

4. Click the Browse File icon. The Open dialog appears. 

5. Find and select the desired file and click Open to return to the Annotations dialog. The file that 

you selected is displayed in the Value field. 

� You can attach a text document, or specify a command line executable. 
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To open an external document: 

1. Select the object containing the annotated file attachment to be opened. 

2. From the Tools menu, select Annotations, then select Add/Edit Annotations.... The 

Annotations dialog appears. 

3. Highlight the key containing the file you want to open. 

4. Click the Open a File Annotation icon. 

� If the annotation file is an executable file, use the Launch an Executable File icon , rather 

than the Open a File icon. 

To launch an executable file attachment: 

1. Select the object or point containing the executable file attachment to be launched. 

2. From the Tools menu, point to Annotations, then select Add/Edit Annotations.... The 

Annotations dialog appears. 

3. Highlight the key containing the executable you want to launch. 

4. Click the Launch an Executable File icon to launch the program. 

To edit an annotation’s properties: 

1. Select the object(s) for which the annotation properties are to be edited. 

Hint:     Multi-selecting like objects (e.g., pipes) and setting their annotations properties to 

identical values is a good visual tool for quickly distinguishing groups of annotations. 

2. The Tools menu, point to Annotations, then select Add/Edit Annotations.... The 

Annotations dialog appears. 

3. Highlight the annotation key name of the desired annotation. 

4. Click the Annotation Properties icon. The Annotation Properties dialog appears, 

containing the following settings: 

TEXT COLOR 

Use the color picker to select the color used to display the annotation text and callout line. 

FONT SIZE 

Enter a point value for the font size used to display the annotation text. 

LEADER LINE LENGTH 

Enter the length (in pixels) of the line connecting the annotation text to the source object. 

LEADER LINE ANGLE 

Enter the angle of the callout line. 

5. Edit the desired settings and then click OK. Your changes are made. 

To delete an annotation: 

1. Select the object(s) (in the Image Viewer window, select a vertex) containing the 

annotation(s) to be deleted. 

2. From the Tools menu, point to Annotations, then select Add/Edit Annotations.... The 
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Annotations dialog appears. 

3. Highlight the annotation key name of the annotation to be deleted, and then click the Delete 

icon. The annotation is deleted. 

Add/Edit Camera Images... 

Window: ModelSpace 

Menu: Tools | Annotations 

Action: Opens dialog 

Usage: The Camera Images dialog is used to add, delete, and view images associated with 

a camera object. 

Camera Images Dialog 

 

A.  Add image. 

B.  Add image file. 

C.  Open image. 

D.  Delete image. 

E.  Move the selected image one position higher in the list. 

F.  Move the selected image one position lower in the list. 
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To open an existing image: 

1. From the Camera Images dialog, select the image you want to view from the Image List. 

2. Click the Open Image icon.. The image is opened in an Image Viewer window. 

To delete an existing image: 

1. From the Camera Images dialog, select the image you want to delete from the Image List. 

2. Click the Delete Image icon. The image is deleted from the Image List. 

To add a camera image from within Cyclone: 

1. From the Tools menu, point to Annotations and then select Add/Edit Camera Images. The 

Camera Images dialog appears. 

2. Click the Add Image icon. The Select Images dialog appears displaying a database browser 

in the left pane. 

3. Select the image you want, and then click the Add icon between the panes. The image 

appears in the right pane. 

� To add more images, repeat this step. 

� To remove images, select the image in the right pane and click the left arrow icon between the 

panes. 

4. Click OK. The added image appears in the Image List. 

Note:    If the image being added is from a different database, the image is prefixed by 

“(Copy)” to indicate that it has been copied into the local directory. 

5. Click Close. 
 

To add a camera image from a file: 

1. From the Tools menu, point to Annotations and then select Add/Edit Camera Images. The 

Camera Images dialog appears. 

2. Click the Add Image File icon. The Import File dialog appears. 

3. Navigate to the image file you want to import. 

4. Select Open. The Camera Images dialog reappears, and the imported file appears in the 

Image List. 

5. Click Close. 

Add/Edit Colors... 

Window: ModelSpace 

Menu: Edit Object | Appearance 

Action: Opens dialog 

Usage: The Color Palette dialog is used to save and restore color samples. 

�       The Color Palette can operate independently of the Color and Material Editor. If the Color 

and Material Editor is closed, Color Palette operations interact directly with the ModelSpace. 
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To apply a saved color from the Color Palette directly to selected object(s) 
in the ModelSpace: 

1. In the current ModelSpace, select the object(s) whose color you want to change. 

2. Close the Color and Material Editor dialog if it is open. 

3. From the Color Palette, select the color that you want to apply. 

4. From the Color Palette shortcut menu, select Apply Color (or double-click the color you want 

from the Color Palette). The color (the diffuse and ambient properties) of the selected object 

is changed. 

To apply a saved color from the Color Palette to the current color swatch in 
the Material Editor: 

1. From the Color Palette, select the color you want to apply. 

2. From the Color Palette shortcut menu, select Apply Color (or double-click the color you want 

from the Color Palette). The current color swatch changes to match the selected color in the 

Color Palette. 

To save a color to the Color Palette from a selected object in the 
ModelSpace: 

1. Open the Color Palette. 

2. Close the Color and Material Editor dialog if it is open. 

3. Select the object whose color you want to save. 

4. From the Color Palette shortcut menu, select Add Color. The current color is inserted into 

the Color Palette. 

To save a color to the Color Palette from the Color and Material Editor 
dialog: 

1. Create/place the color you want in the Current Color swatch. 

2. From the Color Palette shortcut menu, select Add Color. The current color is inserted into 

the Color Palette. 

To replace a current saved color in the Color Palette: 

1. In the Color Palette, select the color you want to replace. 

2. Create/place the color you want in the Current Color swatch, or, if the Color and Material 

Editor is closed, select the object whose color you want in the current ModelSpace. 

3. From the Color Palette shortcut menu, select Replace Color. 

To delete a color from the Color Palette: 

1. Select the color that you want to delete. 

2. From the Color Palette shortcut menu, select Delete Color. 
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Add/Edit Custom Annotations... 

Window: ModelSpace 

Menu: Tools | Annotations 

Action: Opens dialog 

Usage: The Custom tab in the Annotations dialog is used to add, edit, and delete 

annotations for selected objects using a customizable framework.  

�       The Annotations dialog contains two tabs:the Custom tab, and the Annotations tab. See 

the Add/Edit Annotations command for information on creating and editing annotations using the 

Annotations tab.  

�       Though the Annotations and Custom tabs contain much of the same data, the annotations 

are displayed and accessed differently. In the Annotations tab, each annotation is listed as a 

row; each row contains a unique annotation key, a value, a type, and a visibility toggle. If there 

are ten annotations for one object, they are all listed. In contrast, the Custom tab contains only 

one entry (row) for each object selected, no matter how many annotations exist for that object. 

Any number of columns may be defined by the user, in addition to the default Name and Position 

columns, which can't be deleted (though they can be hidden). Each column is equivalent to an 

annotation in the Annotations tab, and each is headed by an annotation key. In the cells below 

the annotation key column headers, you can either enter new values, or select from the pull-down 

list for each key, which lists the most recently entered values for re-use. Each new value entered 

is added to the pull-down list.  

Note:    The lookup lists used to populate these cells can be edited via the Customize 

Lookup Lists... command in the Navigator Edit menu. 

To add a custom annotation key (column) to the Custom tab: 

1. Select the object(s) to which you want to attach a custom annotation. 

2. From the Tools menu, point to Annotations, then select Add/Edit Custom Annotations.... 

The Annotations dialog appears with the Custom tab displayed. 

3. Click the Add Custom Annotation Keys icon. The Customized Annotation Keys dialog 

appears. 

4. Click the Create a new key icon. 

5. Enter a unique name in the Keys column. The same key name cannot be used more than 

once. 

6. Click in the Type column and select a value type from the pull-down list: External Document, 

Decimal, Integer, or Text. This cell is identical in functionality to the Type field in the 

Annotation tab. 

7. Click in the Lookup List column. Leave this cell blank if you plan to define a new list, or select 

a pre-defined list from the pull-down. 

Note:    For information on editing lookup lists, see the Customize Lookup Lists entry in this 

chapter. 
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8. Use the Arrow icons to move keys up or down the list as desired. The order from top to 

bottom in which keys are listed in this window dictates the order in which columns are 

displayed from left to right in the Custom tab of the Annotations dialog. 

� Use the Visibility toggle option to show/hide this or any other key in the Custom tab. 

9. Click on Close to return to the Custom tab of the Annotations dialog. The new column is 

displayed. 

� Column displays can be resized as desired by clicking and dragging the divider lines 

separating the column headers. Additionally, columns can be moved by picking up column 

headers and dragging them to a different location in the table. 

� Columns can be hidden by dragging the key off the header. Hiding a column does not affect 

existing annotations. 

Note:    To edit existing annotations, see the Add/Edit Annotations entry in this chapter for 

more information. 

To add a custom annotation to an object: 

1. Select the object(s) being annotated. 

2. From the Tools menu, select Annotations, then Add/Edit Custom Annotations.... The 

Annotations dialog appears with the Custom tab displayed. 

3. Create a new annotation key. 

4. Enter a value for each selected object under the newly created annotation key (or pick a value 

from the list if a lookup list has been defined). The custom annotation is created. 

� If you move the Annotations tab, you will see the newly created annotation. 

 Note:    To edit or delete existing annotations, see the Add/Edit Annotations entry in this 

chapter for more information. 

To populate and save a new lookup list: 

 Note:    These instructions are suitable for creating brief lookup lists. You may prefer to use 

the Customize Lookup Lists... command in the Navigator Edit menu to create more 

extensive lists. 

1. Select the object(s) being annotated. 

2. From the Tools menu, select Annotations, then Add/Edit Custom Annotations.... The 

Annotations dialog appears with the Custom tab displayed. 

3. Click in the cell in the object’s row and in the column with the key name for which a list is to be 

created, and type a list entry followed by ENTER. Repeat this step for each list entry. 

� Notice that, each time you click in the cell, a list of previously entered selections appears, with 

the most recent entry at the top of the list. Also notice that, as you type a new value, the entry 

is auto-completed for you; continue typing, press BACKSPACE to ignore the auto-match, or 

press ENTER to accept the auto-match 

4. When you have entered all the desired lookup list options, click the Add Custom Annotation 

Keys icon to display the Customized Annotation Keys dialog. 

5. Highlight the key containing the list you just entered, and click the Save this key’s lookup list 

icon. The Save Lookup List dialog is displayed. 

6. Enter a new name for the lookup list, or leave the default name in place, as desired. Click OK 
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to save the list and return to the Customized Annotation Keys dialog. The newly saved list 

will now appear as a pull-down option in the Lookup List column. 

� See the Customize Lookup Lists command entry for information on editing and deleting 

lookup lists. 

To delete a custom annotation key: 

1. Select the object(s) containing the annotation key to be deleted. 

2. From the Tools menu, point to Annotations, then select Add/Edit Custom Annotations.... 

The Annotations dialog appears with the Custom tab displayed. 

3. Click the Add Custom Annotation Keys icon to display the Customized Annotation Keys 

dialog. 

4. Highlight the key to be removed, and click the Delete icon. The annotation key is removed 

from this dialog, and the corresponding column in the Custom tab in the Annotations dialog 

is removed as well. 

Note:    Deleting a custom annotation key as described above does not remove annotations 

from objects. If you wish to remove actual annotations, use the Delete icon in the 

Annotations tab. 

To copy Custom Annotation values to the Windows clipboard: 

1. Select the object(s) containing the desired custom annotation. 

2. From the Tools menu, point to Annotations, then select Add/Edit Custom Annotations.... 

The Annotations dialog appears with the Custom tab displayed. 

3. Multi-select the entries to copy, or select nothing to copy all entries. 

4. Click the Copy Custom Annotations to Clipboard icon. The selected contents of the custom 

tab are copied as tab-delimited text to the Windows clipboard, from which it may be pasted 

into another application (e.g., Notepad). 

Add/Edit Cutplanes... 

Window: ModelSpace 

Menu: Tools | Cutplane  

Action: Opens dialog 

Usage: The Cutplanes dialog is used to edit cutplanes and cutplane attributes. 
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Cutplanes Dialog 

 

A.  Create a copy of the selected Cutplane. 

B.  Delete the selected Cutplane. 

C.  Set the selected Cutplane as the active Cutplane, which is used in all Cutplane operations. 

D.  Add a Reference Plane on the selected Cutplane. The new Reference Plane appears in the 

Reference Planes dialog. 

E.  Flip the selected Cutplane normal in order to toggle the visibility of geometry above/below the 

default Cutplane. 

F.  Move the selected Cutplane one position higher in the list. 

G.  Move the selected Cutplane one position lower in the list. 

H.  View origin and normal coordinates for the selected Cutplane. 
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I.   Toggle the visibility of the Cutplane. 

J.  Lock the Cutplane in place. 

K.  Click to use the color picker to set material properties for the Cutplane. 

L.  Select the axis to which you want to align the selected Cutplane. 

M. To align the selected Cutplane, select an axis from the Align drop-down menu, and then click 

Align. 

N.  Execute the Cutplane offset with the current settings. 

O.  Choose Reference or Self from the Offset drop-down list, depending on whether you want to 

use the Reference Plane or the Cutplane itself as the offset reference point.  

P.  This setting determines the increment used for the Raise Active Cutplane and Lower Active 

Cutplane commands in the Cutplanes submenu. 

To offset the selected cutplane: 

1. From the Tools menu, point to Cutplane, and then select Add/Edit Cutplanes.... The 

Cutplanes dialog appears. 

2. Choose Reference or Self from the Offset drop-down list, depending on whether you want to 

use the Reference Plane or the Cutplane itself as the reference point. 

3. Enter a value in the by box, and then click Offset. The selected Cutplane is moved, and the 

increment for raising and lowering Cutplanes is set. 

Add/Edit Feature Code... 

Window: ModelSpace 

Menu: Tools | Annotations 

Action: Opens dialog 

Usage: The Add/Edit Feature Code dialog is used to add and edit Feature Code 

annotations for a selected object.  

�       Specific to surveying, feature codes are used to identify specific reference objects. For 

example, "toc" is a feature code used to represent "top of curb." Measurements taken with the top 

of curb as a reference would be annotated with the feature code "toc."  

�       Cyclone Feature Codes maintains their "feature code" identity when exported. 

To add a feature code annotation: 

1. Select the object to which you want to attach a feature code annotation. 

� It is not possible to add a feature code annotation to an Info Marker, Camera, or similar 
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“reference-only” object. 

2. From the Tools menu, point to Annotations, then select Add/Edit Feature Code.... The 

Add/Edit Feature Code dialog appears. 

3. Select a pre-defined Features List, and then assign a Feature Code to the selected object 

from the Feature list. Alternatively, you can enter a new Feature Code, which is added to the 

selected Feature List. 

4. Click OK to attach the feature code annotation to the selected object(s). 

Note:    Feature code annotations are listed in the Annotations dialog in addition to any 

other annotations which may have been added. If you wish to edit feature code 

annotations, do so from the Annotations dialog. 
 

To edit a feature code annotation: 

1. Select the object for which the feature code annotation is to be edited. 

2. From the Tools menu, point to Annotations, then select Add/Edit Feature Code.... The 

Add/Edit Feature Code dialog appears. 

3. You may change the Feature List, and/or the Feature Code selected from the Feature List as 

desired. Alternatively, you may enter a new Feature Code, which is then added to the selected 

Feature List. 

Note:    The annotation key Feature Code may not be edited. 

4. Click OK to attach the updated feature code annotation to the selected object(s). 

To delete a feature code annotation: 

1. Select the object(s) with the feature code annotation to be deleted. 

2. From the Tools menu, point to Annotations, then select Add/Edit Annotations.... The 

Annotations dialog appears. 

3. Select the feature code annotation from the list in the Annotations tab, and click the Delete 

icon in the toolbar. The feature code annotation is removed. 

Add/Edit Limit Boxes 

Window: ModelSpace 

Menu: View | Add/Edit Limit Boxes 

Action: Opens dialog 

Usage: The Limit Box Manager dialog is used to add, delete and edit the properties of limit 

boxes in the current ModelSpace View. 

�       Limit boxes are unique to the ModelSpace View in which they are defined and are not 

shared with other ModelSpace Views. 

�       For information on specific Limit Box Manager commands, see the individual command 

entries. 
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Limit Box Manager Dialog 

Limit boxes are unique to the ModelSpace in which they are defined and are not shared with 

other views. 

Name: Displays the name of the Limit Box. 

X, Y, Z: Type topic text here. 

W, H, D: Displays limit box dimensions. 

Align: Indicates whether or not the limit box is aligned with the current user coordinate system 

axes. 

New: Creates a new limit box that is a copy of the currently selected limit box. The new limit 

box is automatically identified as a copy of the original limit box. 

Delete: Deletes the selected limit box. 

Set 

Current: 

Sets the selected Limit Box as the active Limit Box. 

Info: Displays the parameters of the selected limit box. 

Enable 

Limitbox: 

Select this check box to enable the current limit box. 

Show 

Limit 

Box: 

Select this check box to display limit boxes or clear this check box to hide limit boxes. 

Show All: Select this check box to display all limit boxes or clear this check box to display only 

activated limit boxes. When selected (and all limit boxes are displayed), the active limit 

box is highlighted with thick lines and the selected limit box is displayed with dashed 

lines. 

Add/Edit Materials... 

Window: ModelSpace 

Menu: Edit Object | Appearance 

Action: Opens dialog 

Usage: The Material Palette is used to save and restore material samples. 

The Material Palette functions identically to the Color Palette (See the Add/Edit Colors 

command.) except that it handles materials (combinations of color properties) rather than colors. 

Add/Edit Reference Planes... 

Window: ModelSpace 

Menu: Tools | Reference Plane  

Action: Opens dialog 

Usage: The Reference Planes dialog is used to add, edit, and delete Reference Planes. 
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Reference Planes Dialog 

 

A.  List of Reference Planes in current ModelSpace. 

B.  Create a copy of the selected Reference Plane. 

C.  Set the selected Reference Plane as the active Reference Plane, which is used in all 

Reference Plane operations. 

D.  Delete the selected Reference Plane. 

E.  Move the selected Reference Plane one position lower in the list. 

F.  Move the selected Reference Plane one position higher in the list. 

G.  Toggle the visibility of the Reference Plane. 

H.  Click to use the color picker to adjust the color of the Reference Plane. 

•       To rename a Reference Plane: click the name of the Reference Plane to be changed, click it 

again after a short pause to select the current name, type a new name, and then press ENTER. 
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Add/Edit Registration Label 

Window: Registration 

Menu: Constraint 

Action: Opens dialog 

Usage: The Registration Label dialog is used to add or edit a label to the objects involved in 

the selected constraint, or to the object selected in the Constraint Viewer. 

����    To edit the label of the object selected in the Constraint Viewer, right-click in the Constraint 

Viewer and invoke this command from the context menu. The command in the main menu 

applies to the selection in the Constraint List. 

����    For more information on the registration process, see the Registration entry in the Getting 

Started chapter. 

To add or edit the registration label of the objects involved in a constraint: 

1. Select the constraint in the Constraint List. 

2. From the Constraint menu, select Add/Edit Registration Label. The Registration Label 

dialog appears. 

3. Enter the registration label, and click OK to assign the registration label to the objects involved 

in the selected constraint. 

4. Click OK. The objects involved in the constraint may be present in other ControlSpaces and 

ModelSpaces. The corresponding objects are renamed wherever they are found under the 

constraint’s ScanWorlds. 
 

To add or edit the registration label of the object selected in a Constraint 
Viewer: 

1. Select the object in the Constraint Viewer. 

2. Right-click in the Constraint Viewer to invoke the context menu. From the context menu, 

select Add/Edit Registration Label. The Registration Label dialog appears. 

3. Enter the registration label, and click OK to assign the registration label to the selected object. 

4. Click OK. The selected object may be present in other ControlSpaces and ModelSpaces. The 

corresponding objects are renamed wherever they are found under the constraint’s 

ScanWorlds. 

Add/Edit ScanWorld Annotations... 

Window: Scan Control 

Menu: Edit 

Action: Opens dialog 

Usage: The Add/Edit ScanWorld Annotations... command opens the Annotations dialog, 

which is used to attach annotations to the current destination ScanWorld. 

�       The Annotations dialog opened from the Scan Control window functions identically to the 

Annotations dialog opened from other windows (See the Add/Edit Annotations command), 
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except that there is no visibility option, there is no “Custom” tab, and the ScanWorld itself is used 

as the “object” to which all annotations are attached. 

To edit ScanWorld annotations: 

1. From the Edit menu, select Add/Edit ScanWorld Annotations.... The Annotations dialog 

appears. 

2. Make the desired changes to the Value and Type fields, and then click OK. 

Add/Edit Target Height 

Window: Registration 

Menu: Constraint 

Action: Opens dialog 

Usage: The Set Target Height dialog is used to add (or edit) a target height to the objects 

involved in the selected constraint, or to the object selected in the Constraint Viewer. 

����    To edit the target height of the object selected in the Constraint Viewer, right-click in the 

Constraint Viewer and invoke this command from the context menu. The command in the 

main menu applies to the selection in the Constraint List. 

����    For more information on the registration process, see the Registration entry in the Getting 

Started chapter. 

To add or edit the target height of the objects involved in a constraint: 

1. Select the constraint in the Constraint List. 

2. From the Constraint menu, select Add/Edit Target Height. The Set Target Height dialog 

appears. 

3. Select the ScanWorld containing the object to be edited, enter the target height, and click OK 

to assign the target height to that object. 

4. Click OK. The objects involved in the constraint may be present in other ControlSpaces and 

ModelSpaces. The target height of the corresponding objects are set wherever they are found 

under the constraint’s ScanWorlds. 
 

To add or edit the target height of the object selected in a Constraint 
Viewer: 

1. Select the object in the Constraint Viewer. 

2. Right-click in the Constraint Viewer to invoke the context menu. From the context menu, 

select Add/Edit Target Height. The Set Target Height dialog appears. 

3. Enter the target height, and click OK to assign the target height to the selected object. 

4. Click OK. The selected object may be present in other ControlSpaces and ModelSpaces. The 

target height of the corresponding objects are set wherever they are found under the 

constraint’s ScanWorlds. 
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Add Face 

Window: ModelSpace 

Menu: Tools | Mesh 

Action: Executes command 

Usage: The Add Face command adds a new triangle to a mesh object by connecting 

existing vertices and/or creating new vertices on the mesh. 

�       Mesh editing can be performed only on a mesh object, as opposed to a point cloud that is 

viewed as a mesh. To create a mesh object from a point cloud, see the Create Mesh command. 

To add a face to a mesh: 

1. Multi-select three points in the ModelSpace View (the points do not have to be on the mesh 

object). 

� If none of the first three points selected is on a mesh object, a fourth selection must be made 

on a mesh object. 

2. From the Tools menu, point to Mesh, and then select Add Face. A new triangle is added. 

Add Flat Cap Closest to Pick 

Window: ModelSpace 

Menu: Edit Object | End Caps  

Action: Executes command 

Usage: The Add Flat Cap Closest to Pick command creates a flat end cap on the selected 

object’s end nearest to the picked point. 

To add a flat cap to the selected object: 

1. Pick a point on the object near the end that you want to cap. 

2. From the End Caps submenu, select Add Flat Cap Closest to Pick. The cap appears. 

� To add flat caps to both ends of the selected object, see the Add Both Flat Caps entry in this 

chapter. 

� To remove end caps, see the Remove Cap Closest to Picks entry or the Remove Both Caps 

entry in this chapter. 

Add Inside Fence 

Window: ModelSpace 

Menu: Selection | Point Cloud Sub-Selection 

Action: Executes command 

Usage: The Add Inside Fence command adds any points within the fence to the sub-

selection set. 
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�    For more information, see the Advanced Segmentation entry in the Modeling chapter. 

Add Outside Fence 

Window: ModelSpace 

Menu: Selection | Point Cloud Sub-Selection 

Action: Executes command 

Usage: The Add Outside Fence command adds any points outside a fence to the sub-

selection set. 

�    For more information, see the Advanced Segmentation entry in the Modeling chapter. 

Add/Replace Coordinate… 

Window: Scan Control (ScanStation, ScanStation 2, HDS6000) 

Menu: Project 

Action: Opens dialog 

Usage: The Add/Replace Coordinate dialog is used to add or edit known or assumed 

coordinates that will be used in the Field Setup or Traverse procedures. 

����    The known or assumed coordinates are saved in the Known Coordinates ScanWorld under 

the current Project. 

����    For more information on Field Setup and Traverse, see the Field Setup (ScanStation, 

ScanStation 2) and Traverse (ScanStation, ScanStation 2) entries in the Scanning with the 

ScanStation, ScanStation 2, and HDS3000 chapter, or the Field Setup (HDS6000) and 

Traverse (HDS6000) section in the Scanning with the HDS6000 and HDS4500 chapter. 

To add known or assumed coordinates: 

1. From the Project menu, select Add/Replace Coordinate. The Add/Replace Coordinate 

dialog appears. 

2. Enter the coordinate ID and position, and click Add to add a vertex with that ID and position to 

the Known Coordinates ScanWorld. 

To edit or replace known or assumed coordinates: 

1. From the Project menu, select Add/Replace Coordinate. The Add/Replace Coordinate 

dialog appears. 

2. Select the existing coordinate ID, enter the new coordinate, and click Replace to replace the 

existing vertex’s coordinates in the Known Coordinates ScanWorld. 
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Add ScanWorld... 

Window: Registration 

Menu: ScanWorld 

Action: Opens dialog 

Usage: The Select ScanWorlds for Registration dialog is used to add ScanWorlds to the 

current Registration. 

To add a ScanWorld to the current registration: 

1. From the ScanWorld menu, select Add ScanWorld.... The Select ScanWorlds for 

Registration dialog appears. The left side of the dialog contains a Navigator pane. 

2. In the Navigator pane, select the ScanWorld(s) that you want to add to the Registration, and 

then click the Add icon. The selected ScanWorld appears in the right-hand pane. 

3. Continue adding ScanWorlds until all of the ScanWorlds that you want to add to the 

Registration appear in the right-hand window, and then click OK. The ScanWorlds are added 

to the Registration. 

Add Semi-Elliptical Head Closest to Pick 

Window: ModelSpace 

Menu: Edit Object | End Caps  

Action: Executes command 

Usage: The Add Semi-Elliptical Head Closest to Pick command creates a semi-elliptical 

head on the selected object’s end nearest to the picked point.  

To add a semi-elliptical head to the selected object: 

1. Pick a point on the object near the end that you want to cap. 

2. From the End Caps submenu, select Add Semi-Elliptical Head Closest to Pick. The cap 

appears. 

� To add semi-elliptical heads to both ends of the selected object, see the Add Both Semi-

Elliptical Heads entry in this chapter. 

� To remove flat caps, see the Remove Cap Closest to Picks entry or the Remove Both Caps 

entry in this chapter. 

Adjust Exposure... 

Window: Scan Control 

Menu: Scanner Control 

Action: Opens dialog 

Usage: The Adjust Exposure dialog is used to adjust the exposure time used when 

capturing images from the HDS2500 scanner. 
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�       When acquiring an image in the Scan Control window (using the Get Image command), the 

prevailing lighting conditions can greatly affect the quality and usability of the image. To 

compensate for the level of light in the scene, adjust the image exposure. 

To adjust image exposure: 

1. From the Scanner Control menu in the Scan Control window, select Adjust Exposure. The 

Camera Exposure dialog appears. 

2. From the Setting list, make the appropriate selection for the current lighting conditions. 

Exposure times can range from 0.1 to 2000 milliseconds. 

3. Adjust settings for the option selected in the Setting field. 

� To specify exposure time in milliseconds, enter a value in the Exposure box. 

� To view a preview image using the current settings, click Preview. 

4. Click OK. The current settings are applied to the entry in the Setting field. These settings are 

persistent for the scanner object in the database. 

5. Acquire another image (using the Get Image command) to view the results of your 

adjustments. 

Adjust Image... 

Window: Image Viewer, Scan Control 

Menu: Edit 

Action: Opens dialog 

Usage: The Adjust Image... command launches the Brightness/Contrast dialog, which is 

used to adjust the brightness and contrast of the current image. 

To adjust image viewer images: 

1. From the Edit menu, select Adjust Image.... The Brightness/Contrast dialog appears. 

2. Use the sliders or enter a specific value to set the brightness/contrast levels, and then click 

OK. The image is adjusted. 

� To exit the Brightness/Contrast dialog without saving changes, click Cancel. 

Align 

Window: ModelSpace 

Menu: Edit Object 

Action: Displays submenu 

Usage: Pointing to Align displays submenu commands, submenus, and dialogs to align 

objects in a variety of ways. 

The following commands, submenus, and dialogs are available from the Align submenu: 

Align Surfaces, Align to Axis, Coincident, Colinear, Coplanar, Parallel, Perpendicular, 

Codirectional, Put at Angle..., Put at Distance.... 
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� For Align submenu command, submenu, and dialog details, see the individual 

command entries. 

Align Surfaces 

Window: ModelSpace 

Menu: Edit Object | Align  

Action: Executes command 

Usage: The Align Surfaces command aligns the surface of one or more selected objects to 

the surface of a reference object. 

To align the surfaces of objects: 

1. Multi-select the objects you want to align. 

� The last object selected is the reference object (the one to which the others align). 

2. From the Align submenu, select Align Surfaces. The surface of the object(s) is aligned to the 

surface of the reference object. 

Align to Axis 

Window: ModelSpace 

Menu: Edit Object | Align  

Action: Displays submenu 

Usage: Pointing to Align to displays submenu commands to align one or more selected 

objects to the current X, Y, Z, or XYZ axis. 

The following commands are available from the Align to Axis submenu: 

X Axis, Y Axis, Z Axis, XYZ Axes 

To align the selected object to the current X, Y, Z, or XYZ axes: 

1. Select the object(s) you want to align. 

2. From the Align to Axis submenu, select the axis to which you want the selected object 

aligned. The object is rotated about its center until its principal direction matches the selected 

axis. 

� To align to the XYZ axes, the object will take the path of the least rotation(s) to make the axes 

coincide. 
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Align to Selection 

Window: ModelSpace 

Menu: Viewpoint 

Action: Executes command 

Usage: The Align to Selection command orients the ModelSpace viewpoint to be parallel 

to the axis of the selected object. 

To align the viewpoint to the selected object: 

1. Select the object to whose axis you want to align the viewpoint. 

2. From the Viewpoint menu, select Align to Selection. The viewpoint is moved the shortest 

possible distance in order to be parallel with the axis of the selected object. 

� 
If a point cloud is selected, the viewpoint is oriented to match the orientation of the point 
cloud’s scanner. If a scanner object is selected, the viewpoint is oriented to the view of the 
scanner when it took the scan. For HDS3000, ScanStation, and ScanStation 2 ScanWorlds, 
this is a useful way to get to a photographic view of the scan data. 

Align Vertices to Axes 

Window: ModelSpace 

Menu: Tools | Drawing  

Action: Toggles menu item ON/OFF 

Usage: The Align Vertices to Axes command toggles the restriction of each vertex to be 

along the same X or Y axes as the previously plotted vertex. 

�       After plotting the first vertex in a drawing, the next vertex snaps to the same X or Y axis 

(whichever is closer) on the drawing plane as the previous vertex when Align Vertices to Axes 

is ON. 

Align View to Active Plane 

Window: ModelSpace 

Menu: Tools | Reference Plane  

Action: Executes command 

Usage: The Align View to Active Plane command orients the ModelSpace viewer to a top-

down view of the active Reference Plane and centers the Reference Plane axes 

relative to the window borders. 
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Alignment and Section 

Window: ModelSpace 

Menu: Tools 

Action: Displays submenu 

Usage: Pointing to Alignment and Section displays submenu commands used to generate 

and manage alignments and sections. 

The following commands and dialogs are available from the Alignment and Section submenu: 

Create Alignment, Append to Alignment, Switch Alignment Start/End, Create Sections..., 

Create Sections from Picks…, Sections Manager..., Set Active Alignment, Reset Active 

Alignment 

�       For more information about alignments and sections, see the Sections Manager chapter. 

All in Selection 

Window: ModelSpace 

Menu: Create Object | Slice 

Action: Executes command 

Usage: The All in Selection command cuts each selected object(s) by any intersecting 

object that is selected. 

To slice all selected objects at their intersections: 

1. Multi-select the objects that you want to cut. 

2. From the Create Object menu, point to Slice, and then select All in Selection. All selected 

objects are cut at their intersections. 

Angle 

Window: ModelSpace 

Menu: Tools | Measure  

Action: Executes command 

Usage: The Angle command calculates the angle between the centerlines and/or planes of 

the selected objects. 

To measure the angle between objects: 

1. Pick the objects you want to measure. 

2. From the Tools menu, point to Measure, and then select Angle. The measurement is 

represented graphically. The measurement results are also displayed in the Output box if it is 

enabled. 

� If multiple points are being measured, measurements are taken from the first picked object to 
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all other picked objects, and the results are displayed in the order in which they were picked. 

Note:    When measuring the angles to the faces of extruded patches, the measurement is 

made from/to the plane of the picked face rather than the centerline of the extrusion. 

Animate... 

Window: ModelSpace 

Menu: Tools | Animation 

Action: Opens dialog 

Usage:  The Animation Settings dialog is used to specify animation output options and 

generate animation frames. 

�       For an overview of the animation process, see the Animation entry in the Modeling chapter. 

Animation Settings Dialog 

 

A.  Output frames to the designated file folder, using the indicated file name prefix. 

B.  Preview the animation without generating frames. 
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C.  Override viewpoints designated by individual Camera objects and maintain the current focal 

point throughout the animation. 

D.  Enter the frame rate. 

E.  Generate or preview all frames. 

F.  Generate or preview a specified range of frames. 

G.  Enter a range of frames to generate or preview. 

H.  Enter the width and height of the output images. 

I.   Lock the aspect ratio for the size of the output images. 

J.  Begin the preview or frame generation. 

K.  Use the browser to select a folder for animation frames. 

L.  Select None, Medium, or High antialiasing for the output images. 

To generate animation frames: 

1. From the Animation submenu, select Animate. The Animation Settings dialog appears. 

2. Select To File (prefix), and then click the Browse icon. The Windows browser appears. 

3. Navigate to the desired file folder, select a file type, and enter a file name. 

� The file name is used as a prefix and each frame is given a sequentially numbered suffix 

when frames are generated. 

4. Click Save. 

5. Select All or designate a range of frames you wish to generate. 

6. Adjust the output image size and select the desired amount of antialiasing. 

7. Click Animate. A progress meter appears as the frames are generated and saved in the 

specified file folder. 

� To generate frames without the Camera objects or animation path, use the Set Visibility 

command to turn visibility OFF for those object types. 

� The level of detail for objects is kept at the highest setting by default. Edit the level of detail via 

the View Object As command. 

To preview the animation in the current window: 

1. From the Animation submenu, select Animate. The Animation Settings dialog appears. 

2. Select In Window Only. 

3. Select All or designate a range of frames you wish to generate. 

4. Click Animate. The animation preview runs in the current ModelSpace window. 
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Animation Editor... 

Window: ModelSpace 

Menu: Tools | Animation 

Action: Opens dialog 

Usage:  The Animation Editor dialog is used to set and add keyframes, specify the number 

of frames between keyframes, and navigate through the animation by frame or 

parametric time. 

�       For an overview of the animation process, see the Animation entry in the Modeling chapter. 

Animation Editor Dialog 

 

A.  Selected keyframes. 

B.  Jump to the designated frame. 

C.  Current frame. 

D.  Enter a value for the increment to move forward/backward by frames. 

E.  Jump forward/backward by the specified delta in frames. 
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F.  Select to move the viewpoint each time the time or frame number change. When unselected, 

a current frame/time indicator moves along the animation path, but the viewpoint does not move. 

G. Use the current focal point for each frame regardless of the view points of the keyframe 

Camera objects. 

H.  Cycle through keyframes. 

I.   Jump to the selected keyframe. 

J.  Current number of frames between the From and To keyframes 

K.  Enter a value for the number of frames inserted between the From and To keyframes. 

L.  Jump to the designated time. 

M. Enter a value for the increment to move forward/backward in time. 

N.  Jump forward/backward by the specified time delta. 

O. Add a keyframe at the designated time. 

To edit animations: 

1. From the Animation submenu, select Animation Editor. The Animation Editor dialog 

appears. 

2. View keyframes and adjust viewpoints. 

� To jump to a specific keyframe, enter the number of the keyframe in the To or From field, and 

then click Go. 

� To adjust the viewpoint of a keyframe, select the Camera object and use its handles to edit its 

orientation. 

� To maintain the current focal point throughout the animation, select Keep Current Focal 

Point. 

3. Add frames between keyframes. 

� To add frames between keyframes, enter the numbers of the two keyframes in the To and 

From fields, and then enter a value in the Number of Frames Between Keyframes field and 

click Set. Any existing frames or keyframes between the two selected keyframes are 

removed. 

4. Navigate through/preview the animation. 

� To navigate through the animation, select Auto-Preview Frame/Time, and then click the 

left/right arrow icons under either Frame Number or Parametric Time. The viewpoint is 

moved forward/back through the animation by the increment of time or frames specified in the 

appropriate Delta field. 

� When Auto-Preview Frame/Time is not selected, a current frame/time indicator moves along 

the animation path, but the viewpoint does not move when the time or frame arrows are 

pressed. 
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5. Add additional keyframes if needed. 

� To add a keyframe, navigate to the desired location on the animation path, and then click Add 

Keyframe @ Time. A new keyframe is inserted. 

6. When finished, click OK. The changes are saved to the database, and the Animation Editor 

dialog closes. The animation output process may now be started via the Animate... 

command. 

Annotations 

Window: ModelSpace 

Menu: Tools 

Action: Displays submenu 

Usage: Pointing to Annotations displays submenu commands used add, edit, and delete 

annotations, custom annotations, feature codes, and camera images. 

The following commands and dialogs are available from the Annotations submenu: 

Add/Edit Annotations..., Add/Edit Custom Annotations..., Show Annotations, Show 

Annotation Keys, Add/Edit Camera Images..., Add/Edit Feature Code... 

�       For Annotation submenu command details, see their individual entries. 

Appearance 

Window: ModelSpace 

Menu: Edit Object 

Action: Displays submenu 

Usage: Pointing to Appearance displays submenu commands used to adjust the object’s 

display properties. 

The following commands, dialogs, and submenus are available from the Appearance submenu: 

Edit Color/Material..., Add/Edit Colors, Add/Edit Materials..., Randomize Color of Visible 

Objects (changes to selected objects if any objects are selected), Create Objects with Random 

Colors, Apply Color Map, Edit Color Map, Global Color Map, and Edit Global Color Map. 

Append to Alignment 

Window: ModelSpace 

Menu: Tools | Alignment and Section 

Action: Executes command 

Usage: The Append to Alignment command adds a line, polyline, or arc to the end of an 

existing alignment. 
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�       For more information about alignments and the sections process, see the Sections Manager 

chapter. 

To append to an alignment: 

1. Select the existing alignment to which you want to append. 

2. Multi-select the line, polyline, or arc you want to append to the selected alignment. 

3. From the Tools menu, point to Alignment and Section, and then select Append to 

Alignment. The new segment is added to the alignment and the station numbers from the 

original alignment are continued. 

Apply Color Map 

Window: ModelSpace 

Menu: Edit Object | Appearance 

Action: Displays submenu 

Usage: Pointing to Apply Color Map displays submenu commands used to adjust color 

map styles to the selected point cloud or mesh. 

� For an overview of color mapping in Cyclone, see the Color Mapping entry in the Modeling 

chapter. 
Apply Color Map Submenu Commands 

IMAGE TEXTURE MAP 

Draws the points/vertices using the per-point color, if available. If not, it applies the hue-based 

color map or a single color if there are no intensities. In addition, any active texture maps are 

then drawn over the other colors. 

COLORS FROM SCANNER 

Draws the points/vertices using the per-point color, if available. If not, it applies the hue-based 

color map or a single color if there are no intensities. 

INTENSITY MAP MULTI-HUE 

Applies a multi-hue (red to blue) color map. 

INTENSITY MAP GRAYSCALE 

Applies a grayscale color map. 

ELEVATION MAP 

Applies a color map based on elevation in the current UCS. 

SINGLE COLOR 

Applies a single color to all points. 
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Apply MultiImage 

Window: Navigator 

Menu: Context Menu 

Action: Executes command 

Usage: The Apply MultiImage command colors the Scans under the ScanWorld 

containing the selected MultiImage using the colors from the selected MultiImage. 

To apply the colors from a MultiImage to the ScanWorld's Scans: 

1. In the Navigator window, select the MultiImage that will provide the colors. 

2. From the right-click context menu, select Apply MultiImage. The Scans under the ScanWorld 

containing the selected MultiImage are re-colored using the colors from the MultiImage. 

Arc (3 Points on Arc) 

Window: ModelSpace 

Menu: Create Object | From Pick Points 

Action: Executes command 

Usage: The Arc (3 Points on Arc) command creates a circular arc through three picked 

points. 

To create an arc: 

1. Multi-select three non-colinear points to define an arc. 

� The resulting circular arc passes through all three points in the order in which they are picked. 

The first and last pick point serving as the endpoints. 

2. From the Create Object menu, point to From Pick Points, and then select Arc (3 Points on 

Arc). The arc is created. 

Arc (Start, Center, End) 

Window: ModelSpace 

Menu: Create Object | From Pick Points 

Action: Executes command 

Usage: The Arc (Start, Center, End) command creates a circular arc through three picked 

points. 

To create an arc: 

1. Multi-select three points to define an arc. 

� The first and third pick points serve as the endpoints and must be equidistant from the 

second. 

2. From the Create Object menu, point to From Pick Points, and then select Arc (Start, 

Center, End). The arc is created. 
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Atmosphere 

Window: Scan Control 

Menu: Window 

Action: Expands Tab 

Usage: The Atmosphere command expands the Atmosphere tab in the Scanner Control 

Panel. 

�       Environmental conditions (ambient temperature and atmospheric pressure) can affect the 

range computations by a small amount. Although differences are minuscule over the ranges and 

environmental tolerances supported by the HDS3000, ScanStation, and ScanStation 2, controls 

are provided to compensate for such atmospheric conditions. 

�       The default values should be acceptable under most conditions. 

Atmosphere Tab Options 

AMBIENT TEMPERATURE 

Enter the ambient temperature. 

ATMOSPHERIC PRESSURE 

Enter the atmospheric pressure. 

PPM TOTAL 

ppm Total is calculated automatically. To enter a value manually, select the radio button to the 

left of the field and enter the value in the field. 

Auto-Add Cloud Constraints 

Window: Registration 

Menu: Cloud Constraint 

Action: Executes command 

Usage: The Auto-Add Cloud Constraints command automatically creates cloud constraints 

for all pairs of ScanWorlds that have overlapping point clouds, based on the current 

registration. 

� The existing registration should be good enough to arrange the clouds to be constrained so 

their corresponding surfaces are close to each other. 

To automatically add cloud constraints based on the current registration: 

1. Set up the registration so that the clouds are roughly registered. 

� For example, make use of target- or geometry-based registration, Station Data, etc. 

2. From the Cloud Constraint menu, select Auto-Add Cloud Constraints. The Registration 

creates a cloud constraint for each pair of ScanWorlds that have overlapping point clouds and 

do not yet have a cloud constraint. The Registration automatically optimizes the cloud 
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constraints. 

 

This can be a time-consuming process since each pair of ScanWorlds must be checked for 

overlapping point clouds. To save time, the user may select one or more ScanWorlds and 

select Auto-Add Cloud Constraints. The command will only check ScanWorlds that overlap 

with the selected ScanWorlds. For example, if a ScanWorld is added to a registration and the 

user wants to automatically add cloud constraints involving only that ScanWorld, the user 

would select that ScanWorld and select Auto-Add Cloud Constraints, and the search would 

ignore other possible ScanWorld pairings that do not involve that ScanWorld. 

 

Another option for the user is to use the Add Cloud Constraint command, which can be used 

to create a cloud constraint between a selected pair of ScanWorlds. This command does not 

require initial alignment pick hints for the cloud constraint if the ScanWorlds are already 

aligned using other constraints. 

Auto-Add Constraints 

Window: Registration 

Menu: Constraint 

Action: Executes command 

Usage: The Auto-Add Constraints command adds constraints between user-specified 

ScanWorlds by matching registration labels and geometric shapes. 

�       Cloud Constraints are not created by this command (see the Add Cloud Constraint 

command for more information). 

�       Geometric objects that are potential constraints must be manually added to the 

ControlSpace of each ScanWorld before they will be considered by the Auto-Add Constraints 

command. See the Copy to ControlSpace command for more information. 

�       The Auto-Add Constraints process uses any currently existing constraints, if any, then 

searches the ControlSpaces for objects with matching registration labels. It then attempts to infer 

additional constraints from matching pairs of geometry in the involved ControlSpaces that are 

mutually consistent (that would be accurate given the pre-existing constraints and registration 

label constraint pairs). In the case that several possible sets of pairs exist, it chooses the set 

which aligns the largest number of objects. 

�       For more information on the registration process and ControlSpaces, see the Registration 

entry in the Getting Started chapter. 

�       For instructions on adding a registration label, see the Add/Edit Registration Label 

command. 
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Auto-Pick Points 

Window: ModelSpace 

Menu: Selection 

Action: Toggles menu item ON/OFF 

Usage: The Auto-Pick Points command toggles the auto-picking function for the current 

ModelSpace viewer. 

�       The auto-picking function allows the user to specify a significant point (i.e., the end of a 

cylinder) that is automatically picked when an object of that object type is selected. When using 

auto-pick, the specified point is always the only picked point regardless of how the object was 

selected (i.e., selected by fence, or automatically selected after creation). 

To use the Auto-Pick function: 

1. From Selection menu, toggle Auto-Pick Points ON. 

� By default, when an object is picked directly or a default pick is supplied by a command, the 

Auto-Pick setting is ignored in favor of the specified pick point. To override the direct or 

default pick point, select Use Auto Pick (instead of Ignore Auto-Pick) from ModelSpace tab 

of the Edit Preferences dialog. 

2. From the Edit menu, select Object Preferences. The Object Preferences dialog appears. 

3. From the Object Type list, select the type of object with which you want to use auto-picking. 

4. Select the Automatically pick point on selection check box. 

5. Make a selection from the drop-down list, which displays points that can be automatically 

picked for the selected object type. 

6. Click OK. Auto-picking is enabled for the selected object type. 

Auto-Update 

Window: Registration 

Menu: Registration 

Action: Toggles menu item ON/OFF 

Usage: The Auto-Update command toggles whether or not the Registration is recomputed 

after each change of a constraint or component ScanWorld. 

AutoCAD... 

Window: ModelSpace 

Menu: File | Launch 

Action: Executes command 

Usage: The AutoCAD command launches the current ModelSpace View in AutoCADΕ2 

using Cyclone Object Exchange (COE). 
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�       When this command is initiated, objects in the current ModelSpace View are first transferred 

to a COE file, which is then loaded into AutoCAD. See COE for AutoCAD for information on 

working with COE files. 

�       Before executing this command, it is important to verify that AutoCAD and COE Data 

Transfer for AutoCAD are properly installed on your workstation. 

To launch AutoCAD from a ModelSpace View: 

1. From the File menu, point to Launch, and then select AutoCAD. 

� You may be prompted to locate the AutoCAD executable (ACAD.EXE). If this occurs, 

navigate to the folder containing the file and select it. 

2. If you want to open an existing file, navigate to the appropriate folder and select the desired 

file; if you are opening a new drawing, enter a new file name. 

3. Click Open. AutoCAD is launched. 

� You can open a temporary file by clicking CANCEL; a file will be created in your system’s 

TEMP directory. To save any work done in a temporary file, be sure to save your drawing from 

AutoCAD. 

Back 

Window: ControlSpace, ModelSpace, Registration, Scan Control (ScanStation, 

ScanStation 2, HDS3000, HDS4500, HDS6000) 

Menu: Point Cloud Rendering  

Action: Toggles menu item ON 

Usage: The Back command determines the active side of the estimated surfaces in point 

clouds. 
• The command affects the Shaded and One-Sided Point Cloud Rendering modes. 

Back Angle 

Window: ModelSpace 

Menu: Tools | Measure  

Action: Executes command 

Usage: The Back-Angle command calculates the back angle between the centerlines 

and/or planes of the selected objects. The “back angle” added to the shorter angle 

measured by the Angle command forms a full circle. 

To measure the back angle between objects: 

1. Pick the objects you want to measure. 

2. From the Tools menu, point to Measure, and then select Back Angle. The measurement is 

represented graphically. The measurement results are also displayed in the Output box if it is 

enabled. 

� If multiple points are being measured, measurements are taken from the first picked object to 
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all other picked objects, and the results are displayed in the order in which they were picked. 

Note:    When measuring the back angles to the faces of extruded patches, the 

measurement is made from/to the plane of the picked face rather than the centerline 

of the extrusion. 

Batch Registration 

Window: Navigator 

Menu: Tools 

Action: Executes command 

Usage: The Batch Registration command executes the Register command for each 

selected Registration object and saves a log file to a specified folder. 

�       Batch registration is used for performing multiple registrations without user intervention. 

To perform batch registration: 

1. From the Navigator window, select the Registration objects to be registered. 

� The Registration objects should be in a state where you could perform the final Register 

command. The ScanWorlds should be added and the constraints should be created and 

edited as needed. 

2. From the Tools menu, select Batch Registration. A browser prompt appears. 

3. Use the browser to select a location for the log file. 

� To execute the batch registration without producing a log file, clear the Save log file to check 

box. 

4. When the registrations are complete, the Batch Registration Logs dialog appears. 

Registration logs can be viewed, printed, and saved. 

Below Ref Plane (Mesh) 

Window: ModelSpace 

Menu: Tools | Measure | Mesh Volume 

Action: Opens dialog 

Usage: The Below Ref Plane command is used to measure “fill” volume of a selected mesh 

relative to the active Reference Plane. 

� The Below Ref Plane command functions identically to the Above Ref Plane..., except 

that it is used to measure “fill” volume from the active Reference Plane down to the 

selected mesh. 
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Breaklines 

Window: ModelSpace 

Menu: Tools | Mesh 

Action: Displays submenu 

Usage: Pointing to Breaklines displays submenu commands used to manipulate breaklines 

with regards to mesh objects or vice versa. 

The following commands are available from the Breaklines submenu: 

Project Polyline to TIN, Extend TIN to Polyline, Clear Breaklines. 

Black/White Target 

Window: ModelSpace 

Menu: Create Object | Fit to Cloud 

Action: Opens dialog 

Usage: The Black/White Target command fits a vertex at the center of a tie-point. When a 

tie-point is created, it is added automatically to the ControlSpace as well. 

To fit an HDS tie-point: 

1. Segment the point cloud to which you want to fit a tie-point from the surrounding cloud points 

(if any). 

2. Pick near the intersection of the black and whihte quadrants of the point cloud subset to which 

you want to fit a tie-point. 

3. From the Create Object menu, point to Fit to Cloud, and then select Black/White Target. 

The Tie-Point ID dialog appears. 

4. Enter an identifier and a comment in the appropriate fields, and then click OK. A vertex is fit to 

the tie-point. 

Bubble Level… 

Window: Scan Control (ScanStation, ScanStation 2, HDS6000) 

Menu: Scanner 

Action: Opens dialog 

Usage: The Bubble Level… command is used to display a visualization of the current tilt of 

the scanner. 

To display the bubble level: 

1. From the Scanner menu, select Bubble Level…. The Bubble Level dialog appears. 

To re-calibrate the bubble level (HDS6000): 
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1. From the Bubble Level dialog, click the Find Zero button. The scanner takes several 

readings and computes its actual offset from level. 

To configure the appearance of the bubble level: 

1. From the Bubble Level dialog, click the Configure… button. The Configure Bubble Level 

dialog appears. 

Configure Bubble Level Dialog 

 

A.  Outer Circle: Specify the line Thickness, Line color, and Fill color of the circle that 

represents the outer fixed ring of the display. 

B.  Inner Circle: Specify the line Thickness, Line color, and Fill color of the circle that 

represents the inner fixed ring of the display. 

C.  Bubble Circle: Specify the line Thickness, Line color, and Fill color of the circle that 

represents the current position of the virtual bubble. 

D.  OK: Click to accept the settings and close the Configure Bubble Level dialog. 

E.  Cancel: Click to close the Configure Bubble Level dialog without keeping any changes 
made to the settings. 

by Last Selection 

Window: ModelSpace 

Menu: Create Object | Slice 

Action: Executes command 

Usage: The by Last Selection command cuts selected object(s) by the patch selected last. 

To slice objects using a selected patch: 
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1.  Multi-select the objects that you want to cut, and then multi-select the patch with which you 

want to cut them. 

�       The last object selected must be a patch, which is then used to cut all of the other selected 

objects. 

2.  From the Create Object menu, point to Slice, and then select by Last Selection. The objects 

are cut by the plane of the last patch selected. 

by Ref Plane 

Window: ModelSpace 

Menu: Create Object | Slice 

Action: Executes command 

Usage: The by Ref Plane command cuts selected object(s) by the active Reference Plane. 

To slice objects using the Reference Plane: 

1.  Multi-select the objects that you want to cut. 

2.  From the Create Object menu, point to Slice, and then select by Ref Plane. The objects are 

cut by the Reference Plane. 

Calibrate Camera... 

Window: Scan Control 

Menu: Scanner Control | Camera Calibration 

Action: Opens dialog 

Usage: The Calibrate Camera dialog is used to execute camera calibration for the 

HDS2500. 

�       For more information on camera calibration, see the Camera Calibration entry in the 

Scanning with the HDS2500 chapter. 

To calibrate the camera: 

1. Place the scanner at a distance of roughly 3 to 5 meters from the wall as described in the 

Camera Calibration entry in the Scanning with the HDS2500 chapter, aimed at the center of 

the wall. Be sure that you have room to move the scanner back at least 3 to 5 more meters for 

the second position. 

� The view from the scanner to the wall should be unobstructed, and the wall should be a light, 

diffuse color (for example, white or beige); the process may not work with red, black, or shiny 

surfaces). 

� Using a wall large enough to cover the entire scanner field of view at 10 meters (about 7 
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meters on each side) is recommended. 

2. Open the Scan Control viewer and connect to the scanner. See the Connect entry in this 

chapter. 

3. From the Scanner Control menu, point to Camera Calibration and select Calibrate 

Camera.... The Camera Calibration dialog appears. 

4. Click Calibrate (do not move the scanner). When the first step is complete, the dialog 

reappears. 

5. Move the scanner (without disconnecting it) back at least 5 more meters from the wall. 

� If you have room to move it back to 15 meters from the wall, do so, although 10 meters from 

the wall will also work (although if you use 10 meters in this step, you should place it 5 meters 

from the wall in step 1). 

6. Click Continue. 

7. A dialog notifies you when a successful calibration is complete; the scanner stores the 

calibration parameters, used for future scans and images. 

8. Test the calibration with a few scans. Alternately, use the Verify Calibration command, which 

automatically tests the accuracy of the calibration, using the scene in front of the scanner. 

Note:    It is possible for the external camera in the 2500 to drift out of calibration over time. 

If issues with the calibration are noted, the camera should be recalibrated. 

Cancel Drawing 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Executes command 

Usage: The Cancel Drawing command discards the current 2D line drawing. 

�       For more information on drawing, see the Drawing entry in the Modeling chapter. 

Cancel Scan 

Window: Scan Control 

Menu: Scanner Control 

Action: Executes command 

Usage: The Cancel Scan command ends the current scan operation. 

� Any points collected before the scan’s cancellation are inserted into the ScanWorld and 

destination ModelSpace and made available for modeling. 

Center on Fence 

Window: Scan Control 

Menu: Scanner Control 
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Action: Executes command 

Usage: The Center on Fence command centers the viewpoint on the current fence. 

Centerline Length 

Window: ModelSpace 

Menu: Tools | Measure  

Action: Executes command 

Usage: The Centerline Length command calculates and displays the length of the 

centerline of the selected object(s). 

To measure centerlines: 

1. Select the object(s) you want to measure. 

2. From the Tools menu, point to Measure, and then select Centerline Length. The 

measurement is displayed in the Output Box. 

Check Calibration 

Window: Scan Control 

Menu: Scanner 

Action: Executes command 

Usage: The Check Calibration command is used to scan selected targets to judge if the 

scanner requires calibration. 

� To check the calibration of a connected scanner: 

1. Pick one or more black/white targets in the Scan Control viewer or in the attached 

ModelSpace viewer. 

2. From the Scanner menu, select Check Calibration. 

3. Each target is acquired from each side of the scanner and the distance between each is 

measured. 

4. The Calibration Check Results dialog displays the measurement results. The distances 

should be within acceptable values. 

Check Fit Tolerances 

Window: ModelSpace 

Menu: Create Object | Fit to Cloud Options 

Action: Toggles menu item ON/OFF 

Usage: The Check Fit Tolerances command enables/disables a warning message that 

appears if a cloud fit is beyond one or more of the tolerance limits. 
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�       In order to use fit constraints, the Fit Tolerances box must also be selected and tolerance 

values must be specified within the Object Preferences dialog for the type of object being fit. 

See the Object Preferences command. 

�       For an overview of fitting objects in Cyclone, see the Modeling entry in the Getting Started 

chapter. 

Check/Re-Level HDS6000... 

Window: Scan Control (HDS6000) 

Menu: Scanner 

Action: Opens dialog 

Usage: The Check/Re-Level HDS6000... command opens the Check/Re-Level HDS6000 

dialog, which displays the angular “tilt” of the scanner. 

To check or re-level the scanner: 

1. From the Scanner menu, select Check/Re-Level HDS6000.... The Check/Re-Level 

HDS6000 dialog appears. 

2. The TiltL and TiltR values indicate the degree of inclination from horizontal. When both are 0, 

the ScanStation/ScanStation 2 is perfectly level. As long as the TiltL and TiltR are IN 

RANGE, the HDS6000 can sense if the scanner inclination changes. When the Tilt Sensor 

Status is OUT OF RANGE, only the Cancel button is enabled. 

� If the tilt sensor state changes significantly (e.g., a large amount of drift, manual adjustment of 

the tribrach, or out-of-range), for data integrity, the current ScanWorld is automatically 

advanced to the next ScanWorld. You may re-select the previous ScanWorld for additional 

work, but be sure that the data are consistent. 

Check/Re-Level ScanStation... 

Window: Scan Control (ScanStation, ScanStation 2) 

Menu: Scanner 

Action: Opens dialog 

Usage: The Check/Re-Level ScanStation... command opens the Check/Re-Level 

ScanStation dialog, which displays the angular “tilt” of the scanner. 

To check or re-level the scanner: 

1. From the Scanner menu, select Check/Re-Level ScanStation.... The Check/Re-Level 

ScanStation dialog appears. 

2. The TiltL and TiltR values indicate the degree of inclination from horizontal. When both are 0, 

the ScanStation/ScanStation 2 is perfectly level. As long as the TiltL and TiltR are IN 

RANGE, the ScanStation/ScanStation 2 will compensate for the scanner’s tilt. When the Dual-

Axis Compensator Status is OUT OF RANGE, only the Cancel button is enabled. 

� If the dual-axis compensator state changes significantly (e.g., a large amount of drift, manual 
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adjustment of the tribrach, or out-of-range), for data integrity, the current ScanWorld is 

automatically advanced to the next ScanWorld. You may re-select the previous ScanWorld for 

additional work, but be sure that the data are consistent. 

Circular Fence Mode 

Window: ModelSpace 

Menu: Edit | Modes 

Action: Executes command 

Usage: The Circular Fence Mode command enters Circular Fence mode and selects the 

Circular Fence mode cursor. 

�       For more information on working with fences, see the Using a Fence entry in the Modeling 

chapter. 

To draw a circular fence: 

1. From the Edit menu, point to Modes, and then select Circular Fence Mode. The Circular 

Fence cursor appears. 

2. Drag the cursor around the area that you want to fence. 

� The newly drawn fence can adjusted by dragging its sides or vertices with the Circular Fence 

cursor. 

� To clear the newly drawn fence, select Clear from the Fence submenu. 

Clear 

Window: ModelSpace 

Menu: Edit | Fence 

Action: Executes command 

Usage: The Clear command removes a fence from the screen but does not affect its 

contents. 

�       For more information, see the Using a Fence entry in the Modeling chapter. 

Clear Breaklines 

Window: ModelSpace 

Menu: Tools | Mesh | Breaklines 

Action: Executes command 

Usage: The Clear Breaklines command removes breaklines from the selected mesh 

object. 

�       If an individual breakline is picked, only that breakline is removed. 
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� See the Project Polyline to TIN command for more information on creating a breakline. 

Clearances 

Window: ModelSpace 

Menu: Tools | Measure 

Action: Opens dialog 

Usage: The Clearances command is used to measure the vertical and horizontal 

clearances to overhead and adjacent structures in a roadway/overpass/tunnel 

setting. 

� This topic describes a typical workflow. Your process may differ. 

� The Clearances command requires: 

 � that the points from transient surfaces (e.g., passing automobiles) first be removed. 

 � that the road surface. 

� This command requires selection of at least 2 points on the road surface to establish the travel 

lane(s) and 2 or 4 points on the lowest edge(s) of the overhead structure (bridge, sign 

structure). The points must be selected in a specific order. 

  The pick points on the road surface must be along the travel lanes (edge of pavement to 

edge of pavement) to compute the minimum vertical clearance for traveling vehicles. 

 � The Lane Measurement Tolerance (< 1.0 m) defines the width of a strip of points 

centered along each travel lane border. The Overhang Measurement Tolerance (<1.0 

m) is 2x the largest horizontal distance that the points picked on the overhead surface can 

be from the lowest edge. The intersection of the Lane and Overhead tolerances 

determines the points on the road surface and the points on the overhead surface used to 

compute the vertical distance at each crossing. 

 � Additionally, with 2 points picked on each of the approach and departure sides of the 

overhead structure, the lines defined by each successive pair of picks enclose the area in 

which the minimum vertical clearance is measured. 
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Area used for vertical distance at each crossing 

 
 

Area used for minimum vertical distance 

 

To measure vertical clearances: 

1. Shift+Pick two points on your lower surface (e.g., a road surface). Pick the points such that 

the second pick point indicates the forward direction of travel from the first pick point. 

����    Shift+Pick additional pairs of points wherever a vertical clearance is to be measured (e.g., on 

the edge of pavement or along a lane stripe). 

����    Each pair should be roughly parallel to the line described by the first two pick points. 

����    Each additional pair should be to the right of the previous pairs; the first pair of pick points 

should be on the left-most side. 

����    For purposes of this topic, the line described by each pair of pick points on the lower surface 

is a lane line. 

2. Shift+Pick two points on your upper surface (e.g., an overpass or tunnel). Pick the points such 

that the two pick points are close to the edge of the upper surface. 
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����    (Optional) Shift+Pick an additional pair of points on the opposite end of the upper surface. 

����    The edges indicated on the upper surface are referred to as Approach and Departure. The 

Approach is the first edge encountered, based on the direction of travel. For purposes of this 

topic, these edges are on an overhang. 

3. From the Tools menu, point to Measure, and then select Clearances…. The Measure 

Clearances dialog appears. 

4. Adjust the labeling that will be applied to the measurements and sections. Each measurement 

and section generated by this command has a distinct name. 

����    Enter the Base Label for the measurement names. For example, if the Base Label is “A”, the 

first lane line is “A”, the second is “B”, the third is “C”, etc. 

����    By default, each vertical measurement is named by appending the Base Label onto “A” (for 

approach) or “D” (for departure), incrementing the Base Label for each additional lane line. 

����    Click … next to the Base Label to invoke the Detailed Labeling dialog for custom labeling. 

����    Click Update to apply changes to the labeling to the existing measurements and sections. 

5. Adjust the Measurement Tolerances for the Vertical Clearance measurements. 

����    The points within the Lane tolerance of the lane lines are used in the lane-to-overhang 

measurements. 

����    The points within the Overhang tolerance of the overhang edges are used in the lane-to-

overhang measurements. 

6. Click Measure Vertical to measure the vertical clearances from the lower surface to the upper 

surface. Two sets of vertical measurements are generated: 

����    The vertical distance between each lane line and overhang edge, where they cross in plan 

view. 

����    The minimum vertical clearance, where the points on the upper surface come closest to the 

lower surface. Only the points within the boundary defined by the picked points are used. 

7. (Optional) Measure the horizontal clearances. 

8. Click Create Lines to create a line segment for each clearance measurement. These lines are 

available for manipulation, export, etc. 

9. Click Report to display the Clearance Measurement Report dialog. 

10. Close the dialog. Click OK to keep the measurements and sections, or Cancel to discard the 

measurements and sections. 

To measure horizontal clearances: 

1. Before measuring horizontal clearances, the vertical clearances must first be measured. 

Measure the vertical clearances. (See earlier.) 

2. Specify the elevation at which the horizontal clearances will be measured in at Elevation. 

3. Specify the Region Tolerance. All points within this vertical distance of at Elevation will be 

used to measure the horizontal clearances. 

4. Select the measurement options. 

����    Select Left Clearance to measure the minimum distance to a point to the left of the left-most 

lane. 

����    Select Right Clearance to measure the minimum distance to a point to the right of the right-

most lane. 

����    Select Perpendicular to measure distances perpendicular to each lane. When not selected, 

the distances are measured parallel to the edge on the upper surface. 

5. Click the Measure Horizontal button to measure the horizontal clearances between the 
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lanes, and optionally the left and right lateral clearances. Up to three sets of horizontal 
measurements are generated: 

����    The horizontal distance between each lane line. 

����    (Optional) The minimum horizontal clearance to the left of the left-most lane line, at the 

specified elevation. 

����    (Optional) The minimum horizontal clearance to the right of the left-most lane line, at the 

specified elevation. 

Clear Calibration Info 

Window: Scan Control, Image Viewer 

Menu: Scan Control: Scanner Control | Camera Calibration 

 Image Viewer: Image | Calibration 

Action: Executes command 

Usage: The Clear Calibration Info command is used to remove camera calibration data 

from the current image if the calibration seems to be incorrect. 

�       For a general overview of camera calibration, see the Camera Calibration entry in the 

Scanning with the HDS2500 chapter. 

Note:    Clearing the calibration disables the ability to texture map the current image onto point 

clouds or meshes, and also removes the distortion correction of the image when viewed 

in the Scan Control or Image Viewer windows.  

Clear Image 

Window: Scan Control 

Menu: Edit 

Action: Executes command 

Usage: The Clear Image command removes the image from the viewing window in the 

Scan Control window. 

Clear Locks 

Window: ModelSpace 

Menu: Viewpoint | View Lock 

Action: Executes command 

Usage: The Clear Locks command turns OFF all View Locks. 
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Clear Path 

Window: ModelSpace 

Menu: Tools | Animation 

Action: Executes command 

Usage:  The Clear Path command clears the currently set animation path. 

�       For an overview of the animation process, see the Animation chapter. 

Clear Target 

Window: Scan Control 

Menu: Scanner Control 

Action: Executes command 

Usage: The Clear Target command removes the current target box in the Scan Control 

window. 

Clear Temporary Measurements 

Window: ModelSpace 

Menu: Tools | Measure  

Action: Executes command 

Usage: The Clear Temporary Measurements command deletes the last unsaved 

measurement taken. 

�       Subsequent measurements are not considered temporary when the Save Measurements 

command is toggled ON. Once saved, a measurement is no longer temporary and cannot be 

cleared using this command. 

Clear Undo/Redo 

Window: ModelSpace, Navigator, Registration, Scan Control, Image Viewer 

Menu: Edit 

Action: Executes command 

Usage: The Clear Undo/Redo command clears all previous actions that are subject to 

Undo and Redo from memory. 

�       After the Clear Undo/Redo command has been used, the ability to Undo and Redo 

previous actions is lost for this viewer. Subsequent operations may still generate Undo and Redo 

events. 
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�       Clear Undo/Redo can be used to free memory otherwise consumed by undo and redo 

events. 

Close 

Window: ModelSpace, Image Viewer, Registration, Scan Control 

Menu: File 

Action: Executes command 

Usage: The Close command closes the current window. 

�       To exit Cyclone, select Exit from the File menu in the Navigator window. 

�       When closing a ModelSpace View window that was created via the Copy to New 

ModelSpace command in the Launch menu, you will be prompted whether to merge the 

ModelSpace View back into the original, and whether to keep or remove the launched 

ModelSpace. 

Cloud Constraints Wizard… 

Window: Registration 

Menu: Cloud Constraint 

Action: Opens dialog 

Usage: The Cloud Constraints Wizard launches a series of wizard dialogs that guide the 

user through the process of creating cloud constraints. 

�       For more information on the cloud registration process, see the Cloud Registration entry in 

the Registration chapter. 

This is the recommended method for creating cloud constraints. The Cloud Constraints Wizard 

guides you through the entire process of creating cloud constraints and can save considerable 

time compared to the other methods. First, specify which ScanWorld pairs are overlapping, and 

then the Wizard steps through the process of creating a cloud constraint for each specified pair of 

ScanWorlds. See the Cloud Constraints Wizard entry in the Commands chapter for detailed 

instructions. The Cloud Constraints Wizard offers the following advantages: 

�   It automatically copies all scan clouds (except HDS Target clouds) into the ControlSpace for 

the selected ScanWorlds. 

�   It automatically opens the ControlSpaces side-by-side in the Constraint viewers, and advances 

to the next ScanWorld pair after the user has picked corresponding points and pushed the 

Cloud Constraints Wizard's Create Constraint button. 

�   It provides a quick way to check for overlap between two ScanWorlds. Pressing the eyeglass 

button in the Cloud Constraint Wizard's grid control displays the corresponding ScanWorlds' 

ControlSpaces in the Constraint viewers. 
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To create cloud constraints via the Cloud Constraints Wizard: 

1. Open a new or existing Registration window, and add the ScanWorlds that are to be 
registered. 

� The registration may already have target or object constraints. 
2. From the Cloud Constraint menu, select Cloud Constraints Wizard. The first wizard page 

appears, displaying a matrix of all ScanWorlds that have been added to the registration. 
� An initial check mark indicates that the corresponding pair of ScanWorlds already has an 

existing Cloud Constraint. 
3. Select the check boxes in the matrix to indicate that a Cloud Constraint should be created 

between the two ScanWorlds (if one does not already exist), and clear check boxes to remove 
any existing Cloud Constraints that are no longer needed from the Registration. 

� Click the View icon at the intersection of two ScanWorlds to see their ControlSpaces. If a 
ControlSpace has no point clouds or meshes, all non-target scans in the ScanWorld are 
automatically added to the ControlSpace. 

� To select all check boxes, click Select All 
� To clear all check boxes, click Deselect All. 
� Click Select Cycle to select the check boxes between each ScanWorld and the next 

ScanWorld in the sequence (including the check box between the last and first ScanWorlds to 
complete the cycle). 

� Click Cancel to exit the Cloud Constraints Wizard without saving changes. 
4. Click Update. The Cloud Constraints Wizard initiates the cloud constraint construction 

sequence for the selected ScanWorld pairs (pairs with existing cloud constraints are skipped). 
The ControlSpaces for the first selected ScanWorld pair are displayed in the Constraint 
viewers. 

� If the two ScanWorlds already have a cloud constraint, the pick points (if any) of the cloud 
constraint are shown. 

5. Multi-pick two or more matching points in each ControlSpace of the ScanWorld pair. 
� If the ScanWorlds are already registered, or the default ScanWorld coordinates are already 

specified in global coordinates, then no pick points are needed. 
� See the Cloud Registration section in the Registration chapter for information on picking good 

points. 
� To preview the point cloud alignment based on the current picks, click Preview. A temporary 

ModelSpace opens and displays the alignment of the ScanWorld pair’s point cloud/meshes. 
Close the temporary ModelSpace view to return to the Cloud Constraint Wizard. 

� To move on to the next ScanWorld pair in the sequence without creating a cloud constraint, 
click Next. 

� To return to the previous ScanWorld pair in the sequence, click Back. 
� To return to the first Cloud Constraints Wizard page, click Return. 
6. Click Constrain. The constraint is created and the Cloud Constraints Wizard opens the next 

ScanWorld pair in the Constraint viewers. 
7. Repeat steps 5 and 6 for each selected ScanWorld pair as needed. 

Note:    To be used in global registration, cloud constraints must be optimized via the 
Optimize Cloud Alignment command. 

Codirectional 

Window: ModelSpace 

Menu: Edit Object | Align  

Action: Executes command 

Usage: The Codirectional command aligns one or more selected objects so that they are 

parallel and facing in the same direction as a reference object. 
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To make objects codirectional: 

1. Multi-select the objects you want to make codirectional. 

� The last object selected is the reference object (the one to which the others align). 

2. From the Edit Object menu, point to Align, and then select Codirectional. The objects are 

rotated about their origins to align with their axes in the same direction as the reference 

object. 

Coincident 

Window: ModelSpace 

Menu: Edit Object | Align  

Action: Executes command 

Usage: The Coincident command moves and aligns one or more objects to the 

corresponding axis and origin of a reference object. 

To make objects coincident: 

1. Multi-select the objects you want to make coincident. 

� The last object selected is the reference object (the one to which the others align). 

2. From the Edit Object menu, point to Align, and then select Coincident. The selected objects 

are moved to align their origins and axes to the reference object. 

Colinear 

Window: ModelSpace 

Menu: Edit Object | Align  

Action: Executes command 

Usage: The Colinear command moves and aligns one or more objects to the axis of a 

reference object. 

To make objects colinear: 

1. Multi-select the objects you want to make colinear. 

� The last object selected is the reference object (the one to which the others align). 

2. From the Edit Object menu, point to Align, and then select Colinear. The axes of the 

selected objects are moved and aligned to the axis of the reference object. 

Collapse 

Window: ModelSpace 

Menu: Tools | Exclusion Volume  

Action: Executes command 

Usage: The Collapse command resizes the selected exclusion volume to the minimum 
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required to contain its contents without changing its orientation. 

To minimize the size of an exclusion volume: 

1. Select the exclusion volume. 

2. From the Tools menu, point to Exclusion Volume, and then select Collapse. The sides are 

moved in to contain the minimum volume without changing its orientation. 

Collapse (Limit Box Manager) 

Window: Limit Box Manager 

Menu: View 

Action: Executes command 

Usage: The Collapse command resizes the selected limit box to the minimum volume 

required to contain the currently selected objects (if any) or to contain all objects (if 

there is no selection) without changing the orientation of the limit box.. 

Collapse Limit Box 

Window:  ModelSpace 

Menu: View | Collapse Limit Box 

Action: Executes command 

Usage: The Collapse Limit Box command resizes the limit box to the minimum volume 

required to contain the currently selected objects (if any) or to contain all objects (if 

there is no selection) without changing the orientation of the limit box. 

•  To obtain the minimum possible limit box size regardless of limit box orientation, use the 

Minimize Limit Box command 

Connect 

Window: Scan Control 

Menu: Scanner 

Action: Executes command 

Usage: The Connect command is used to connect to the selected scanner. 

•       To connect to a scanner: From the Scanner menu, select Connect. When a successful 

connection is made, the Scanner Status box at the bottom of the Scan Control window reads 

“Connected and Ready”. 

 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Index 

200 

Connect Piping 

Window: ModelSpace 

Menu: Tools | Piping  

Action: Executes command 

Usage: The Connect Piping command finds and establishes any valid connections among 

selected objects. 

To connect piping: 

1. Select objects among which you want to establish a piping connection. 

� Cyclone supports two types of connectivity: linear (end-to-end) and branching. An end-to-end 

connection may exist between two opposing piping components that share a common 

endpoint. The diameters of the components need not match. A branching connection may 

exist where one piping component's endpoint sits on the centerline of a pipe. The branch's 

endpoint must lie within the extents of the run. The angle between the two centerlines does 

not need to be perpendicular. 

� To set preferences that determine whether or not a connection is made, see the Piping: Max. 

Offset and Piping: Max. Angle settings in the Modeling tab of the Preferences entry in this 

chapter. 

2. From the Tools menu, point to Piping and then select Connect Piping. Any valid 

connections are established, and selected objects that are not connected with any other 

selected object are deselected. 

� Once connected, two piping components can only be disconnected by executing the 

Disconnect Piping (Shared) or Disconnect Piping (All) commands or by changing the 

geometry of object such that the connection is automatically broken (because the connection 

now exceeds the current Piping: Max. Offset and Piping: Max. Angle settings). 

Note:    The Connect Piping command may take longer to finish depending on the number 

of objects selected. Selecting more objects may greatly increase the time required to 

find the shared connections. 

Constrain Motion to 

Window: ModelSpace 

Menu: Edit Object | Handles  

Action: Displays submenu 

Usage: Pointing to Constrain Motion to displays submenu commands to select the plane 

or axis along which objects can be moved using their handles. 

The following commands are available from the Constrain Motion to submenu: 

User Coordinate System, Object Coordinate System, X Axis, Y Axis, Z Axis, Screen Plane 

(perpendicular to the current viewpoint), X-Y Plane, X-Z Plane, Y-Z Plane 
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�       This command limits handle motion to be along a specified axis or plane. Constraining the 

object handles to move only along a certain plane or axis prevents you from moving the object in 

an unwanted direction. 

�       Some handles may not be able to move according to the constraints (e.g., rotation and other 

custom handles). 

�       For more information on using handles, see the Handles entry in the Modeling chapter. 

Contours 

Window: ModelSpace 

Menu: Tools 

Action: Displays submenu 

Usage: Pointing to Contours displays submenu commands used to create and manipulate 

contour lines. 

The following commands are available from the Contours submenu: 

Create..., Decimate Contours, Delete Line. 

�       For Contours submenu command functionality, see the individual command entries. 

Contours to Mesh Deviations... 

Window: ModelSpace 

Menu: Tools | Measure 

Action: Opens dialog 

Usage: The Contours to Mesh Deviations... command compares the line segments in the 

selected contour set with the faces in a selected mesh (or originating mesh if no 

mesh is selected), and uses the data to calculate deviations in accordance with user 

defined parameters. 

�       This command is active only for mesh objects that have been created from a point cloud as 

opposed to point clouds that are merely viewed as a mesh. See the Create Mesh command for 

more information on creating a mesh object. 

To calculate contours to mesh deviations: 

1. Select a contour line for which to measure deviation from the original mesh object. 

� Selecting one line effectively selects the entire contour line set to which the selected line 

belongs, enabling you to measure deviations for the entire contour line set. 

� It is recommended that you hide the mesh so that only contour lines are visible. This makes it 
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easier to see deviating line segments. To hide the mesh, see the Set Object Visibility entry in 

this chapter. 

2. Select the mesh object for which to take the deviation measurements. If no mesh object is 

selected, the mesh object used to create the contours is used. 

3. From the Tools menu, point to Measure, then select Contours to Mesh Deviations.... 

Initialization commences, which culminates with the display of the Deviation Analysis dialog. 

4. Use the slider bar to set the threshold on which to measure deviations. As the slider is moved, 

the graphical display is adjusted continually to highlight only those line segments with 

deviations from the mesh object that fall above the threshold. 

Note:    The Minimum and Maximum fields are display only, and indicate the range for 

which deviations can be measured. 

5. Select whether to highlight line segments based on Maximum or Average deviation, and 

whether to use Absolute values (no positive or negative values) or Signed values. 

Note:    Deviation analysis results are displayed in the Details field. 

6. Click OK when you are done. The Deviation Analysis dialog is closed. 

Convert Elbow to Miter... 

Window: ModelSpace 

Menu: Tools | Piping 

Action: Executes command 

Usage: The Convert Elbow to Miter... replaces the selected elbow connector with a 

mitered connector. 

�       The command may also be used to change the value of an existing miter. 

To convert an elbow to a mitered connector: 

1. Select the elbow you want to convert. 

2. From the Tools menu, point to Piping, and then select Convert Elbow to Miter.... The 

Number of Miter Segments dialog appears. 

3. Enter the number of segments you want to represent the miter and click OK. The elbow is 

converted. 

Coordinate System 

Window: ModelSpace 

Menu: View 

Action: Displays submenu 

Usage: Pointing to Coordinate System displays submenu commands used to set and 

show the current coordinate axes, set the origin, and save and edit user-defined 

coordinate systems. 
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�       Setting your own coordinate system as you begin modeling is helpful in maintaining your 

orientation. 

The following commands, submenus and dialogs are available from the Coordinate System 

submenu: 

Save/Edit Coordinate Systems, Show Axes, Set Origin, Set From Points, Set Using One 

Axis, Set Using Two Axes, Set ScanWorld Coordinate System, Reset ScanWorld 

Coordinate System 

Coplanar 

Window: ModelSpace 

Menu: Edit Object | Align  

Action: Executes command 

Usage: The Coplanar command aligns one or more selected objects so that they lie in the 

same plane as a reference object. 

To make objects coplanar: 

1.  Multi-select the objects you want to make coplanar. 

�       The last object selected is the reference object (the one to which the others align). 

2.  From the Edit Object menu, point to Align, and then select Coplanar. The selected objects 
are aligned to the plane of the reference object. 

Copy 

Window: ModelSpace 

Menu: Create Object 

Action: Opens dialog 

Usage: The Copy dialog is used to make a copy (or an array of copies) of the selected 

object at a specific location relative to the original object. 

To place a copy of an object at a specific location: 

1. Select the object you want to copy. 

2. From the Create Object menu, select Copy. The Copy dialog appears, and a graphical 

indicator appears in the ModelSpace viewer illustrating the direction and distance of the move 

at the current settings. 

� If multiple objects are selected, each object is labeled with a unique identifier (such as 
cylinder 1, cylinder 2, etc.) in the ModelSpace to aid in differentiating objects and points on 
those objects. 

� Significant points (i.e., the end points of a cylinder) as well as current and subsequent pick 
points are numbered and displayed on the selected objects. These numbers can be used as 
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references to move objects. 

� If multiple objects are selected, you may specify a subset of the selected objects to be 

affected by the move from the Apply to list. 

3. Click the arrow icon to the right of the Direction of Move row. The Direction of Move 

subdialog appears. 

4. Specify the direction for the move using axes, points or picks, and then click OK. The 

Direction of Move subdialog closes. 

5. Click the arrow icon to the right of the Distance of Move row. The Distance subdialog 

appears. 

6. Specify the distance for the move using points, picks, or custom distance, and then click OK. 

The Distance subdialog closes. 

7. In the Number of Copies field, enter the number of copies you want to create. 

• If you are creating more than one copy, the copies are moved so that each copy after the first 

is translated from the previous copy according to the current settings. 

8. Select Copy Annotations to duplicate any annotations that are attached to the original object 

for each new copy. 

9. Click Copy. The copy appears. 

• To create another copy using the current settings, click Copy again. 

10. When you are finished creating copies of the object, click Close to exit the dialog. 

To place a copy of an object at a specific angle: 

1. Select the object you want to copy. 

2. From the Create Object menu, select Copy. The Copy dialog appears. 

�  If multiple objects are selected, each object is labeled with a unique identifier (such as 

cylinder 1, cylinder 2, etc.) in the ModelSpace to aid in differentiating objects and points on 

those objects. 

� Significant points (i.e., the end points of a cylinder) as well as current and subsequent pick 

points are numbered and displayed on the selected objects. These numbers can be used as 

references to move objects. 

3. Select the Copy at Angle tab. A graphical indicator appears in the ModelSpace viewer 

illustrating the rotation angle and axis of the current settings. 

4. Click the arrow icon to the right of the Axis of Rotation row. The Axis of Rotation subdialog 

appears. 

5. Specify the axes around which you want to rotate using standard or custom axes, points or 

picks, and then click OK. The Axis of Rotation subdialog closes. 

6. Click the arrow icon to the right of the Center of Rotation row. The Center of Rotation 

subdialog appears. 

7. Specify the centerpoint around which you want to rotate using picks or reference points, or 

custom coordinates, and then click OK. The Center of Rotation subdialog closes. 

8. Click the arrow icon to the right of the Angle of Rotation row. The Angle of Rotation 

subdialog appears. 

9. Specify the angle by which you want to rotate using reference axes, points, or custom values, 

and then click OK. The Angle of Rotation subdialog closes. 

10. If multiple objects are selected, you may specify a subset of the selected objects to be 

affected by the move from the Apply to list. 

11. In the Number of Copies field, enter the number of copies you want to create. 
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• If you are creating more than one copy, the copies are swept so that each copy after the first 

is rotated from the previous copy according to the current settings. 

12. Select Copy Annotations to duplicate any annotations that are attached to the original object 

for each new copy. 

13. Click Copy. The copy appears. 

• To create another copy using the current settings, click Copy again. 

14. When you are finished creating copies of the object, click Close to exit the dialog. 

Copy (Limit Box Manager) 

Window:  Limit Box Manager 

Menu: Limit Box 

Action:  Executes command 

Usage: The Copy command creates a new limit box that is a copy of the currently selected 

limit box. The new limit box is automatically identified as a copy of the original limit 

box. 

Copy Fenced to New ModelSpace 

Window: ModelSpace 

Menu: File | Launch 

Action: Executes command  

Usage: The Copy Fenced to New ModelSpace command creates a new ModelSpace, 

copies the fenced object(s) into the new ModelSpace, and opens a ModelSpace 

View for the new ModelSpace. 

�       This command is very useful for editing objects in a separate ModelSpace containing only 

the objects with which you are currently working. 

To copy fenced objects into a new ModelSpace for editing: 

1. Draw a fence around the object(s) or group you want to copy. 

� The fence is projected forward in the view plane. Partially fenced objects are included. 

Partially fenced clouds are not segmented, but only the points within the fence are copied. 

2. From the File menu, point to Launch and then select Copy Fenced to New ModelSpace. A 

new ModelSpace is created, and a ModelSpace View containing the fenced objects is 

opened. 

3. Edit the objects as desired. 

� To copy the edited objects back to the original ModelSpace, see the Update Original 

ModelSpace entry in this chapter, or close the launched ModelSpace viewer. 

4. When finished editing, close the ModelSpace. The Closing ModelSpace Viewer dialog 

appears. 

5. Select closing options for the copied ModelSpace and objects. 

� Select Merge into original ModelSpace to copy all objects that were either edited or created 
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in the descendant ModelSpace back into the original ModelSpace. Objects from the source 

ModelSpace that have not changed are not duplicated in the resulting merged ModelSpace. 

� Select Remove link from original ModelSpace to save the copied ModelSpace. 

� Select Delete after close to mark the current ModelSpace for deletion. 

6. Click Close. The copied ModelSpace is closed. 

Copy Pick Point(s) 

Window: ModelSpace 

Menu: Edit 

Action: Executes command 

Usage: The Copy Pick Point(s) command copies picked points to the Windows clipboard 

in text format. 

Copy Selection to New ModelSpace 

Window: ModelSpace 

Menu: File | Launch 

Action: Executes command  

Usage: The Copy Selection to New ModelSpace command creates a new ModelSpace, 

copies the selected object(s) into the new ModelSpace, and opens a ModelSpace 

View for the new ModelSpace. 

�       This command is very useful for creating a smaller ModelSpace that contains only the 

objects with which you are currently working. 

To edit selected objects in a new ModelSpace: 

1. Select the object(s) or group you want to edit. 

2. From the File menu, point to Launch and then select Copy Selection to New ModelSpace. 

A new ModelSpace is created, and a ModelSpace View containing the fenced objects is 

opened. 

3. Edit the objects as desired. 

� To copy the edited objects back to the original ModelSpace, see the Update Original 

ModelSpace entry in this chapter, or close the launched ModelSpace viewer. 

4. When finished editing, close the ModelSpace. The Closing ModelSpace Viewer dialog 

appears. 

5. Select closing options for the copied ModelSpace and objects. 

� Select Merge into original ModelSpace to copy all objects that were either edited or created 

in the descendant ModelSpace back into the original ModelSpace. Objects from the source 

ModelSpace that have not changed are not duplicated in the resulting merged ModelSpace. 

� Select Remove link from original ModelSpace to save the copied ModelSpace. 

� Select Delete after close to mark the current ModelSpace for deletion. 

6. Click Close. The copied ModelSpace is closed. 
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Copy to ControlSpace 

Window: ModelSpace 

Menu: Tools | Registration 

Action: Executes command 

Usage: The Copy to ControlSpace command adds the select object(s) to the designated 

ControlSpace(s). 

����       If there is are Registration-specific ControlSpaces a dialog appears and allows you to 

choose the ControlSpace(s) to which the object is copied. 

Note:    Many objects are added to the ControlSpace automatically, such as objects with 

registration labels, HDS Targets, and sphere targets. The Copy to ControlSpace 

command provides you with a method for adding objects manually to a ControlSpace 

that should be considered by the Auto-Add Constraints command. 

�       For more information on the ControlSpace and its use in the registration process, see the 

Registration section in the Getting Started chapter. 

Create... (Contours) 

Window: ModelSpace 

Menu: Tools | Contours 

Action: Opens dialog 

Usage: The Contours Parameters dialog is used to generate and customize contours 

parallel to either the active Reference Plane or the current coordinate system as 

defined by the user. 
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Contours Parameters Dialog 

 

A.  Enter a value representing the distance between major contour lines and select the units of 

distance desired. 

B.  Enter a value representing the number of minor contours to be displayed between each major 
contour. 

C.  Set boundaries within which to generate contours by checking Minimum and/or Maximum for 
the desired plane(s). A value representing the extent of each selected limit can be entered as 
desired. Contours extent values are represented by the same units as those selected for the 
distance between major contours. 

D.  Check this box to display labels for each contour line. 

E.  Select whether to use the Reference Plane or the current coordinate system as the base for 
contour measurements. 

To create contours: 

1. Select the point cloud(s) or the mesh that you want to contour. 

� Make sure that the clouds are displayed as a mesh. See the View Object As entry in this 

chapter for more information. 

2. From the Tools menu, point to Contours, then select Create.... The Contours Parameters 
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dialog appears. 

3. Set the distance between major contours, the units by which that distance is measured, and 

the number of minor contours to be drawn between major contours. 

4. If you want to set boundaries within which to draw contours, check Minimum and/or 

Maximum in the Contours Extents box for the desired plane(s), then enter a value 

representing the extent of each selected limit (optional). 

� Values entered in the Contours Extents fields are measured in units as defined in the 

Interval between Major Contours field 

5. Check the Label Contours box to display contour line labels. 

� Contour label properties can be edited by selecting the contour line, then selecting Edit 

Properties from the Edit Objects menu. You can change text color and size, you can elect 

the type of notation for elevation values and whether or not to display elevation unit suffixes 

(e.g., ft), and you can change the alignment of the contour label text relative to the contour 

lines. 

6. Select either Reference Plane or Current Coordinate System as the base from which to 

draw the contours (Z=0). 

7. Click OK to create the contours. Contours are drawn parallel either to the active Reference 

Plane or to the current coordinate system as defined in the previous step. 

� By default, major contours are drawn with a heavier line weight than minor contours. Use the 

Edit Properties dialog (Edit Object | Edit Properties...) to modify contour line properties. 

Create (Exclusion Volume) 

Window: ModelSpace 

Menu: Tools | Exclusion Volume 

Action: Executes command 

Usage: The Create command replaces an object or group of objects with a box containing 

the objects. 

�       An exclusion volume is an object that encloses other objects. It is typically used to contain 

clouds of points for which you need only a rough approximation of the volume occupied. 

To create an Exclusion Volume: 

1. Select the object(s) or group you want to enclose. 

2. From the Tools menu, point to Exclusion Volume, and then select Create. The object(s) or 

group is replaced by a rectangular volume containing the objects. 

� To restore the contents of an exclusion volume, select the exclusion volume, and then select 

Disassemble from the Tools | Exclusion Volume submenu. 
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Create (Limit Box Manager) 

Window:  Limit Box Manager 

Menu: Limit Box 

Action:  Displays dialog 

Usage: The Create command displays the Create Limit Boxes dialog, which is used to add 

new limit boxes with specified locations and size. 

�       If more than one pick point is present, the limit box is initialized to the minimum bounding 

box of the pick points. This is useful for quickly isolating cloud data with a few picks. 

Create Alignment 

Window: ModelSpace 

Menu: Tools | Alignment and Section 

Action: Opens dialog 

Usage: The Create Alignment dialog is used to generate an alignment object for a selected 

line, polyline, or arc. 

�       For more information about alignments and the sections process, see the Sections Manager 

chapter. 

To create an alignment: 

1. Select the line, polyline, or arc you want to use as an alignment. 

� The object used to create an alignment can be imported from your CAD software via the COE 

exchange format (see the Cyclone Object Exchange chapter). The object may also be created 

in a variety of ways including using Cyclone’s Drawing tools and creating the object via the 

From Pick Points submenu commands (see the From Pick Points entry in the Commands 

chapter). 

� When a single object is selected, the object must be picked near the end-point at which the 

starting station is assigned. 

� If the start station is assigned to the wrong end, use the Switch Alignment Start/End 

command in the Tools | Alignment and Section menu. 

� When multiple objects are selected, the objects must be geometrically connected in a single 

unbroken sequence. The object picked last provides the end-point at which the starting station 

is assigned. 

� Alignments may be horizontal, skewed, or a mixture of both, but may not be vertical. 

2. From the Tools menu, point to Alignment and Section, and then select Create Alignment. 

The Create Alignment dialog appears. 

3. Enter a Start Station and click OK. The alignment object is created. 

� Station numbers increase with the linear distance "traveled" along the alignment, from the 

starting station. 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Index 

211 

Create and Open ModelSpace 

Window: Registration 

Menu: Registration 

Action: Executes command 

Usage: The Create and Open ModelSpace command creates and opens a ModelSpace 

from the registered ScanWorld created from a successful registration. 

�       The Create and Open ModelSpace command behaves identically to the Create 

ModelSpace command. 

�       The data contained in the resulting ModelSpace depends on which component 

ModelSpaces are selected in the ModelSpaces tab when the Create ModelSpace command is 

executed. 

�       For more information on the registration process, see the Registration entry in the Getting 

Started chapter. 

Create and Open ModelSpace View 

Window: Navigator 

Menu: File 

Action: Executes command 

Usage: The Create and Open ModelSpace View command creates and opens a 

ModelSpace View for the selected ModelSpace. 

�       Views created using this command are stored in the ModelSpace folder from which they 

were created. 

�       Multiple views can be created from the same ModelSpace using this command. 

�       ModelSpace View names can be changed; select the ModelSpace View in Navigator, select 

Rename from the Edit menu, then type in the new name. 

Create Branch 

Window: ModelSpace 

Menu: Tools | Piping 

Action: Executes command 

Usage: The Create Branch command creates an intersection of two or more selected 

pipes. 
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�       The supported piping connectors are: T, Y, and Cross. The geometric arrangement of the 

selected pipes determine which (if any) branch is created. 

�       To set preferences that determine whether or not a branch can be made, see the Piping: 

Max. Offset and Piping: Max. Angle settings in the Modeling tab of the Edit Preferences 

dialog. 

To create a piping connector: 

1. Select the pipes you want to connect. 

� A "T" consists of one pipe (the "run") intersected (but not crossed) by another pipe (the 

"branch"). 

� A “Y” consists of three non-overlapping pipes intersecting at a shared point. 

� A Cross consists of two crossing pipes, or one pipe (the "run") intersected (but not crossed) by 

two other pipes (the "branches"). 

2. Open the Piping Mode dialog and select the SKEY appropriate for the type of branch to be 

created. See the Piping Mode entry in this chapter. 

3. From the Tools menu, point to Piping, and then select Create Branch. If the geometric 

arrangement supports a connection, a branch is created. 

� The branch is represented by a placeholder object to which the selected pipes are connected. 

� The placeholder for the branch is assigned the current SKEY appropriate to the type of branch 

represented. The pipes are automatically extended or sliced as necessary, and a piping 

connection is established (see the Connect Piping entry in this chapter). 

Create Drawing 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Executes command 

Usage: The Create Drawing command is the final step to finish the current drawing 

procedure. 

�       For more information on drawing, see the Drawing entry in the Modeling chapter. 

Create Drawing from Object 

Window: ModelSpace 

Menu: Tools | Drawing  

Action: Executes command 

Usage: The Create Drawing from Object command converts an existing line object back 

into a drawing object, projecting the existing object onto the drawing plane as a 

polyline.  
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�       The Create Drawing from Object command works with previously created line drawings 

(including polylines, arcs, rectangles, etc.) and imported line objects. 

�       The Create Drawing from Object command can be used to convert a line object into a 

drawing to be used with the Export Template command. 

Create Lines from Cuts 

Window: ModelSpace 

Menu: Tools | Cutplane  

Action: Executes command 

Usage: The Create Lines from Cuts command creates polylines where the active Cutplane 

intersects objects and meshes. 
 

To create polylines where the active Cutplane intersects objects and 
meshes: 

1. Position the Cutplane to intersect the objects or meshes from which you want polylines. 

2. From the Tools menu, point to Cutplane and then select Create Lines from Cuts. Polylines 

are created where the active Cutplane intersects objects or meshes. 

  

Create Mesh... 

Window: ModelSpace 

Menu: Tools | Mesh 

Action: Executes command 

Usage: The Create Mesh... command creates a mesh object from the selected point 

clouds, polylines, vertices, or meshes. 

�       Mesh objects created using this command can be modified using commands in the Tools | 

Mesh submenu. For information on mesh editing, see the Meshes section in the Modeling 

chapter, or any of the Mesh submenu option commands. 

�       The number of points used when creating a mesh from a point cloud is set via the 

Computation: Create TIN: Max Points setting in the Point Cloud tab of the Edit Preferences 

dialog. 

To create a mesh object: 

1. Select the point clouds, polylines, vertices, or meshes to be used for creating the new mesh 

object. 

2. From the Tools menu, point to Mesh, and then select Create Mesh.... The Meshing Style 

dialog appears. 
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3. Select the type of mesh object you wish to create. 

� Select Basic Meshing to create a basic mesh consisting of triangles drawn by using trios of 

adjacent points as triangle vertices. Select Complex Meshing to create a mesh consisting of 

triangles drawn by using trios of adjacent points that are likely to lie in the same plane. Select 

TIN Meshing to create a mesh wherein no two vertices share the same horizontal 

coordinates; the current coordinate system determines the “up” direction for a TIN mesh. 

Note:    Basic Meshing and Complex Meshing cannot be done with more than one point 

cloud. 

� When there are multiple selections in Step 1, only the TIN Meshing option is available. 

� Basic Meshing and Complex Meshing can only be used with a single point cloud selection. 

4. Click OK. The mesh object is created. 

� Click Cancel to abort the command. 

� To make the point cloud visible again, use the ScanWorld Explorer. See the ScanWorld 

Explorer entry in this chapter for more information. 

Create ModelSpace 

Window: Registration 

Menu: Registration 

Action: Executes command 

Usage: The Create ModelSpace command creates a ModelSpace from the Registered 

ScanWorld created from a registered ScanWorld. 

�       For more information on the registration process, see the Registration entry in the Getting 

Started chapter. 

�       The data contained in the resulting ModelSpace depends on which component 

ModelSpaces are selected in the ModelSpaces tab when the Create ModelSpace command is 

executed. 

To create a ModelSpace from a successful registration: 

1. From the ModelSpaces tab, select the ModelSpaces whose data you want included in the 

new ModelSpace. 

� If no ModelSpace is selected, the resulting ModelSpace contains only the raw scan data from 

all of the component ScanWorlds. 

2. From Registration menu, select Create ModelSpace. The ModelSpace is created with the 

data from the selected component ModelSpaces. 

� The ModelSpace is located beneath the registered ScanWorld in the Navigator window. 

� To create and open a ModelSpace with a single command, use the Create and Open 

ModelSpace. 
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Create Objects with Random Colors 

Window: ModelSpace 

Menu: Edit Object | Appearance  

Action: Toggles menu item ON/OFF  

Usage: The Create with Random Colors command toggles the assignment of a random 

color to all created or fit objects. 

�       When this command is checked, an object is assigned a random color when it is created in 

order to make it stand out. When unchecked, objects are created with the default color. 

Create Path 

Window: ModelSpace 

Menu: Tools | Animation 

Action: Executes command 

Usage:  The Create Path command creates a spline curve through the selected Camera 

objects, following the order in which they were selected. 

�       For an overview of the animation process, see the Animation chapter. 

Create Path (Loop) 

Window: ModelSpace 

Menu: Tools | Animation 

Action: Executes command 

Usage:  The Create Path (Loop) command creates a closed spline loop through the 

selected Camera objects, following the order in which they were selected. 

�       For an overview of the animation process, see the Animation entry in the Modeling section of 

the Getting Started chapter. 

Create Redlines 

Window: ModelSpace 

Menu: Tools | Redlining  

Action: Toggles menu item ON/OFF  

Usage: The Create Redlines command toggles Redline mode, which is used to create 2D 

lines and add comments to a ModelSpace View’s current viewpoint. 
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�       Redlining behaves identically to 2D drawing except that 2D drawing is done on the active 
Reference Plane, and Redlining is done on an imaginary plane that is perpendicular to and 
centered in the current ModelSpace View. 

�       Redlines are tied to a specific viewpoint. Loading a redline restores the viewpoint from which 
it was created. When the viewpoint changes, the redline is no longer visible (you can restore 
visibility by reloading the redline). 

�       To load and manage saved redlines, see the Edit Redlines command. 

To create a Redline: 

1. From the Tools menu, point to Redlining and then select Create Redlines. You are now in 

Redlining mode. 

� Alternatively, you can load a Redline from the Edit Redline dialog to enter the redline mode 

(see the Add/Edit Redlines entry in this chapter). This allows you to add drawings to an 

existing set of redlines. 

2. Follow the procedures for 2D drawing (see the Drawing entry in the Modeling chapter) to 

create your redlines. 

� All lines and text created during one redlining session are saved and restored as a single 

redline in the redline list (see the Add/Edit Redlines entry in this chapter). 

3. From the Tools menu, point to Redlining and then select Create Redlines to toggle it OFF 

and exit Redlining mode. 

Create ScanWorld/Freeze Registration 

Window: Registration 

Menu: Registration 

Action: Executes command 

Usage: The Create ScanWorld/Freeze Registration command uses the current 

registration to create a single ScanWorld that includes the registered (component) 

ScanWorlds in a unified coordinate system. It also locks all constraints in place. At 

this point constraints can no longer be modified unless the registration is unfrozen 

via the Unfreeze Registration command. 

�       When this command is executed, a ScanWorld appears in the Navigator in place of the 

Registration object, which is made a child of the newly created ScanWorld. 

�       For more information on the registration process, see the Registration entry in the Getting 

Started chapter. 
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Create Sections 

Window: ModelSpace 

Menu: Tools | Alignment and Section 

Action: Opens dialog 

Usage: The Create Sections dialog is used to generate sections along the selected 

alignment object. 

�       For more information about alignments and the sections process, see the Sections Manager 

chapter. 

Create Sections Dialog Options 

INITIAL STATION 

Specify the distance along the alignment at which you want to place the first section. 

END STATION 

Specify the distance along the alignment at which you want to place the last section. 

SPACING 

Specify the interval between sections. 

INCLUDE TRANSITION POINTS 

Select this option to also create a section at each transition point (the point at which two of the 

original lines or arcs connect) that falls within the creation interval. 

SECTION EXTENTS 

All Section Extents settings are relative to the current "up" direction and the direction of the 

alignment (from the start station towards the end station). 

CREATE LINES 

Select this option to create lines based on a temporary TIN mesh that is created from the 

points within each section. More controllable results may be obtained by first creating and 

adjusting the sections, and then creating lines afterward via the Create Lines at Section 

command in the Sections Manager dialog. 

COLLECT POINTS 

Select this option to introduce merged clouds from the points that fall within the boundaries of 

each section. This function can also be performed after sections have been created via the 

Collect Points in Section command in the Sections Manager dialog. 

To create sections: 

1. Select the desired alignment object. 

2. From the Tools menu, point to Alignment and Section, and then select Create Sections. 

The Create Sections dialog appears. 

� The Create Sections command can also be accessed from the Sections menu in the 
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Sections Manager dialog. 

3. Choose the desired alignment settings, and then click OK. The sections are created and the 

Sections Manager dialog appears. 

Create Sections from Picks 

Window: ModelSpace 

Menu: Tools | Alignment and Section 

Action: Opens dialog 

Usage: The Create Sections dialog is used to create sections between sequential pairs of 

pick points. 

� The sections created are managed in the Sections Manager. 

To create sections from pick points: 

1. Pick the point at the left-most end of the section to be created. Shift+Pick the point at the right-

most end. The section will pass between these two points. 

� 
When the section is activated in the Sections Manager, its “Left” and “Right” are determined 
by the order in which the points were picked. 

2. Shift+Pick any additional pairs of points. 

3. From the Tools menu, point to Alignment and Section, then Create Sections from Picks. 

The Create Sections dialog appears. 

4. Select how the Top and Bottom parameters of each section are set. 

� 
Select Automatic Top and Bottom to set the Top and Bottom parameters of each section 
based on the highest and lowest points within that section. 

� 
Select Specify Section Elevation to set the Top and Bottom parameters of each section 
based on user-specified absolute elevations, relative to the current UCS. 

5. Enter the Depth of the section. This is the distance between the Front and Back parameters 

of the section. 

6. Select the Create Lines checkbox to create cross-section lines within each section. 

7. Select the Collect Points checkbox to introduce merged clouds from the points that fall within 

each section. 

8. Click OK. The sections are created and added to the Sections Manager. The cross-section 

lines and points are optionally processed. 

Create Simulated Scanner... 

Window: ModelSpace 

Menu: Tools | Scanner  

Action: Executes command 

Usage: The Create Simulated Scanner... command launches a Scan Control window for 

a simulated scanner. 
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�       The Scan Control window created by this command operates identically to a Scan Control 

window connected to a real scanner. For information on Scan Control commands, see their 

individual entries.  

�       For general information on the Scan Control window, see the Scanning entry in the 

Scanning with the HDS2500 chapter. 

Cubic Spline 

Window: ModelSpace 

Menu: Create Object | From Pick Points 

Action: Executes command 

Usage: The Cubic Spline command creates a cubic spline curve that passes through a 

series of picked points. 
 

To create a cubic spline: 

1. Multi-select a series of points. 

2. From the Create Object menu, point to From Pick Points, and then select Cubic Spline. 

The cubic spline is created. 

� The cubic spline curve is drawn from point to point in the same order in which the points were 

picked. 

� To edit a cubic spline, select it and then use the vertex handles to change its shape. 

Curve 

Window: ModelSpace 

Menu: Create Object | From Intersections 

Action: Executes command 

Usage: The Curve command creates a line at the intersection of two planar objects. 

To create a line at the intersection of objects: 

1. Select the planar objects at whose intersection you want to use to create a line. 

2. From the Create Object menu, point to From Intersections, and then select Curve. The line 

is created. 

� Even if the selected planes are not physically touching, the line is created at the planar 

intersection. 
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Customize Hotkeys... 

Window: ModelSpace, Navigator, Image Viewer, Scan Control, Registration 

Menu: Edit 

Action: Opens dialog 

Usage: The Customize Hotkeys dialog is used to manage your hotkeys, which allow you to 

activate commands by a simple key combination, bypassing the toolbar and menu. 

Customize Hotkeys Dialog 

 

A.  List of all commands in the selected category/menu. 

B.  List of windows. 

C.  List of categories/menus in the selected window. 

D.  Description of the selected command. 

E.  View any currently assigned hotkey(s) for the selected command.  

F.  Click to view a list of all commands and assigned hotkeys by window. 
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G.  Assign the entered hotkey to the selected command. 

H.  Remove the selected current hotkey from the selected command. 

I.   Use these fields to assign hotkey combinations to selected commands. 

J.  Cancel hotkey changes.         

K.  Click to save hotkey changes and continue working in this dialog.          

L.  Click to save hotkey changes and close the dialog. 

To assign a keyboard hotkey: 

1. From the Edit menu, select Customize Hotkeys.... The Customize Hotkeys dialog appears. 

2. From the Window list, select the type of window that contains the command for which you 

want a hotkey. 

3. From the Category/Menus list, select the menu that contains the command for which you 

want a hotkey. 

4. From the Commands/Menu Items list, select the command for which you want a hotkey. 

5. Click in the Press new shortcut/hotkey field and press the key or combination of keys that 

you want as a hotkey for the selected command. 

� Certain key combinations must be entered using the check boxes and the drop-down list in 

the Or use section. 

6. Click Assign. The new hotkey appears in the Current Keys list. 

7. Click Apply or OK to save changes. 

To remove a keyboard hotkey: 

1. From the Edit menu, select Customize Hotkeys.... The Customize Hotkeys dialog appears. 

2. From the Current Keys list, select the hotkey you want to delete. 

3. Click Remove. The selected hotkey is removed from the Current Hotkeys list. 

4. Click Apply or OK to save changes. 

Customize Lookup Lists... 

Window: Navigator 

Menu: Edit 

Action: Opens dialog 

Usage: This command opens the Annotation Lookup Lists dialog, which is used to import 

and export text files used as lookup list contents, as well as to delete lookup lists.  

Note:    Actual editing of lookup lists is not performed in this dialog. Instead, the editing is 

done using the text editor of your choice. 

�       Once a lookup list is created, it is available for custom annotations creation for all databases 

residing on the local server. For example, a custom lookup list created for one project is also 

visible in all other projects. 
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To create a quick lookup list: 

1. From the Navigator window, open the Edit menu and select Customize Lookup Lists.... The 

Annotation Lookup Lists dialog is displayed. 

2. To create a text file you can use as a template for proper formatting of a list file, click the 

Export a sample quick lookup list file icon in the toolbar. The Select a file name for 

example lists dialog appears. 

3. Type a file name in the File Name field; be certain to type in the .txt extension as well. Select 

a folder destination for the file, and click SAVE. 

4. Use the text editor of your choice (e.g., Notepad) and open the newly created text file. 

Instructions for creating lookup lists are included in the text file. Follow the directions precisely, 

or you will not be able to import the file back into the Annotation Lookup Lists dialog. 

Note:    Below the instructions, you may see previously defined lists (if they exist). Because 

these lists are in the proper format, you may opt to use one as a template for your list. 

5. Enter your new list name using the following format: 

List Name=enter list name  

List Type=enter list type (text, integer, or decimal) 

Note:    “List Name=...” and “List Type=...” should be typed exactly as shown; put spaces 

where indicated, and none where they are not. Use uppercase and lowercase exactly 

as indicated. 

6. Below the list name and type, enter your list contents, with each entry appearing on a new 

line. You can copy/paste data into the document, as long as the list conforms to the formatting 

instructions. 

7. Save the .txt document, close the text editor, and return to Cyclone Navigator. 

8. If it is not already open, open the Annotation Lookup Lists dialog, and click the Import a 

lookup list file icon. 

9. Find and select the .txt file you just saved, and click OPEN. The newly created list is added, 

and its contents are displayed in the Lookup List Contents window. 

To edit lookup list contents: 

1. From the Navigator window, open the Edit menu and select Customize Lookup Lists.... The 

Annotation Lookup Lists dialog is displayed. 

2. Click the Export lookup lists to a text file icon in the toolbar. The Select a file for export 

dialog is displayed. 

3. Select a previously existing text file, or type in a new file name in the File Name field. Be sure 

to type in the .txt extension as well. 

Note:    All currently defined lists are exported when the Export lookup lists to a text file 

icon is selected; it is not possible to export only a selected list. However, as long as 

you edit only your targeted list, the other lists will remain unchanged when this file is 

imported back into Cyclone. 

4. Select a destination folder for the file, and click Save. 
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5. Open the newly created text file in the text editor of your choice (e.g. Notepad). Instructions for 

creating quick lookup lists are included in the text file. Follow the directions precisely, or you 

will be unable to import the file back into the Annotation Lookup Lists dialog. 

6. Scroll down the text in the file and search for the list you wish to edit, then make changes as 

necessary; keep in mind that you must comply with the formatting instructions, or Cyclone will 

not be able to import the list. 

7. Save the .txt document, close the text editor, and return to the Navigator window. 

8. If it is not already open, open the Annotation Lookup Lists dialog, and click the Import a 

lookup list icon. 

9. Find and select the .txt file you just edited and saved, and click Open. You will receive a 

notice that a list already exists with the same name. Select Overwrite to replace existing lists 

(where the list name has not changed) with new contents, or Merge to keep the existing lists’ 

entries, but also add entries from the new file that are not in the existing list. New lists are 

added without prompting. All lists in the window reflect the latest changes. 
 

To delete an annotation lookup list: 

1. From the Navigator window, open the Edit menu and select Customize Quick Lookup 

List.... The Annotation Lookup Lists dialog is displayed. 

2. Highlight the list to be deleted, and click the Delete icon in the toolbar. The lookup list is 

deleted. 

� Deleting an annotation lookup list does not affect lists in use in other windows. 

Customize Toolbars... 

Window: ModelSpace, Navigator, Image Viewer, Scan Control, Registration 

Menu: Edit 

Action: Opens dialog 

Usage: The Customize Toolbars dialog is used to customize all aspects of the toolbars 

that are available in Cyclone. 

 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Index 

224 

Customize Toolbars Dialog 

 

A.  The Toolbars tab allows you to create new toolbars, as well as elect whether to display new 

or existing toolbars. The Commands tab allows you to add available buttons to visible toolbars.  

B.  List of all available toolbars for the window from which the dialog was opened. Select a toolbar 

name to display that toolbar in the current window. 

C.  Check Large Buttons to display enlarged toolbar buttons. 

D.  Click the New button to create a new toolbar. You will be prompted to name the new toolbar. 

Once you OK the name, the toolbar is added to the list; it is checked automatically and displayed 

in the current window without contents. Use the Commands tab to add buttons. 

E.  Use the Rename button to give new names to existing toolbars. 

F.  The Reset button is available for standard Cyclone toolbars; the Delete button is available for 

toolbars that you have added. Use the Reset button to reset the configurations of the selected 

Cyclone toolbar to the default configurations. Use the Delete button to permanently remove a 

user-defined toolbar both from the toolbar list and from the current window. 
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To display/hide existing Cyclone toolbars: 

1. From the Edit menu of the window for which you want to display/hide toolbars, select 

Customize Toolbars.... The Customize Toolbars dialog appears. 

2. In the Toolbars window of the Toolbars tab, click on a checkbox to display/hide the toolbar 
named. If checked, the toolbar is displayed; if not, the toolbar is hidden. As you 
select/deselect toolbar options, the corresponding toolbars appear/disappear from the current 
window display. 

� To rename a toolbar, highlight the desired toolbar and click Rename. Type in the new name 

and click OK. The toolbar is renamed 

� To reset a toolbar so that the original Cyclone contents are reinstated,and all user edits are 
eliminated, highlight the desired toolbar and click Reset. The toolbar is returned to its default 
state. 

3. Check Large Buttons to display larger versions of toolbars and button faces. 

4. Click Close when done. 

To create a new toolbar: 

1. From the Edit menu of the window for which you want to display/hide toolbars, select 

Customize Toolbars.... The Customize Toolbars dialog appears. 

2. In the Toolbars tab, click on New. The New Toolbar dialog appears. 

3. Enter a toolbar name and click OK. The toolbar is added to the toolbars list; it is automatically 

checked and displayed in the current window. 

� Click Cancel to exit this dialog without adding a new toolbar. 

To add/remove buttons from toolbars: 

1. From the Edit menu of the window for which you want to display/hide toolbars, select 

Customize Toolbars.... The Customize Toolbars dialog appears. 

2. From the Command tab, select the category for which you want available buttons displayed. 

To the right, a series of buttons is displayed. 

� It is not necessary to be in the Command tab to remove buttons from toolbars. 

� The available categories correspond to the available menus for the current window. 

� Click any button to see a description of that button’s function. 

3. To add a button to a toolbar, click the desired button and drag it from the dialog to the desired 

location. You can add buttons to both existing and new toolbars. 

4. To remove a button from a toolbar, click the desired button in its present toolbar location and 

drag it out of the toolbar. When you let go, the button disappears. 

� You can use the click and drag method to move buttons from one toolbar to another. 

� Use the Reset button to restore the original contents of a Cyclone toolbar. 

Cut 

Window: ModelSpace, Navigator 

Menu: Edit 

Action: Executes command 

Usage: The Cut command deletes a selected object from its current location and copies it 

to the Cyclone clipboard. 
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Note:  Cutting an object from a ModelSpace places it on the clipboard and removes it from its 

current location and from the database. Though cutting a point cloud removes it from 

the ModelSpace, it does not remove the original scan from the database. Original scans 

are always recoverable via the ScanWorld Explorer dialog. 

Note:  The Navigator's clipboard behaves differently from the ModelSpace clipboard; when 

Copy is selected, the selected object is marked for copying; however, it is not actually 

copied until you initiate the Paste command. 

Cut by Distance from Point 

Window: ModelSpace 

Menu: Create Object | Segment Cloud 

Action: Opens dialog 

Usage: The Segment Cloud by Distance from Point dialog is used to segment the 

selected point cloud(s) based on each point's distance from a central point. 

� For an overview of the segmentation process, see the Segmentation entry in the Modeling 

chapter. 

To segment a point cloud by distance from a point: 

1. Select the point cloud you want to segment. 

2. From the Create Object menu, point to Segment Cloud, and then select Cut by Distance 

from Point…. The Segment Cloud by Distance from Point dialog appears. 

3. Click the button next to the Point field to specify the central point’s coordinate. 

� Select Last Pick Point to use the last pick point. 

� Select Last Pick Point Always to use the last pick point, even when the pick point changes. 

� Select Origin to use the UCS origin. 

� Select Custom to manually enter a coordinate. 

4. Select Interval to enter the interval at which the cloud will be regularly segmented, within the 

Min and Max distances. 

5. Use the slider to interactively adjust the distances at which you want to divide the point cloud. 

� Pick one point on the cloud before invoking this command to automatically establish the lower 

bound, based on the distance to that pick point from the central point. 

� Shift+Pick two points on the cloud before invoking this command to automatically establish the 

lower and upper bounds, based on the distance to those pick points from the central point. 

6. Click Reset to reinitialize this dialog, based on any changes to the selection or pick points. 

7. Click Segment. The points within the indicated distance of the indicated point are now a 

separate point cloud that can be selected independently. Optionally, these points are also 

segmented at regular intervals. 
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Cut by Fence 

Window: ModelSpace 

Menu: Create Object | Segment Cloud  

Action: Executes command 

Usage: The Cut by Fence command segments the selected point cloud(s) into two subsets. 

�       For an overview of the segmentation process, see the Segmentation entry in the Modeling 

chapter. 

To create a new segment of a point cloud: 

1. Draw a fence around the points that you want to segment. (See the Creating a Fence entry in 

the Modeling chapter). 

2. From the Create Object menu, point to Segment Cloud, and then select Cut with Fence. 

The points within the fence are now a separate point cloud and can be selected 

independently. 

Cut by Intensity 

Window: ModelSpace 

Menu: Create Object | Segment Cloud 

Action: Opens dialog 

Usage: The Segment Cloud by Intensity Range dialog is used to segment the selected 

point cloud(s) based on each point's intensity value. 

� For an overview of the segmentation process, see the Segmentation entry in the Modeling 

chapter. 

To segment a point cloud by intensity: 

1. Select the point cloud that you want to segment. 

2. From the Create Object menu, point to Segment Cloud, and then select Cut by Intensity.... 

The Segment Cloud by Intensity dialog appears. 

3. Use the slider to interactively adjust the intensities at which you want to divide the point cloud. 

� Shift+Pick two points on the cloud before invoking this command to automatically establish the 

lower and upper bounds, based on the intensities at those pick points. 

4. Click Reset to reinitialize this dialog based on any changes to the selection or pick points. 

5. Click OK. The points above and below the indicated intensities are now separate point clouds 

that can be selected independently. The points between those bounds are separated from the 

rest of the points in the cloud. 
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Cut by Offset from Plane 

Window: ModelSpace 

Menu: Create Object | Segment Cloud 

Action: Opens dialog 

Usage: The Segment Cloud by Offset from Plane dialog is used to segment the selected 

point cloud(s) based on each point's offset from the indicated plane. 

 

� For an overview of the segmentation process, see the Segmentation entry in the Modeling 

chapter. 

To segment a point cloud by distance from a plane: 

1. Select the point cloud you want to segment. 

2. From the Create Object menu, point to Segment Cloud, and then select Cut by Offset from 

Plane…. The Segment Cloud by Offset From Plane dialog appears. 

3. Click the button next to the Point field to specify the coordinate through which the plane 

passes. 

� Select Last Pick Point to use the last pick point. 

� Select Last Pick Point Always to use the last pick point, even when the pick point changes. 

� Select Origin to use the UCS origin. 

� Select Custom to manually enter a coordinate. 

4. Click the button next to the Normal field to specify the plane’s normal vector. 

� Select Up Direction to use the Up direction, even when it changes. 

� Select X-Axis (Easting) to use the UCS X-axis (Easting). 

� Select Y-Axis (Northing) to use the UCS Y-axis (Northing). 

� Select Z-Axis (Elevation) to use the UCS Z-axis (Elevation). 

� Select Reference Plane Normal to use the active reference plane’s normal vector. 

� Select Pick Point Normal to use the normal vector at the last picked point. 

� Select Custom to manually enter a normal vector. 

5. Select Interval to enter the interval at which the cloud will be regularly segmented, within the 

Min and Max offsets. 

6. Use the slider to interactively adjust the offsets at which you want to divide the point cloud. 

� Pick one point on the cloud before invoking this command to automatically establish the lower 

bound, based on the distance to that pick point from the plane. 

� Shift+Pick two points on the cloud before invoking this command to automatically establish the 

lower and upper bounds, based on the distance to those pick points from the plane. 

7. Click Reset to reinitialize this dialog, based on any changes to the selection or pick points. 

8. Click Segment. The points within the indicated offsets of the indicated plane are now a 

separate point cloud that can be selected independently. Optionally, these points are also 

segmented at regular intervals. 
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Cut Near Ref Plane... 

Window: ModelSpace 

Menu: Create Object | Segment Cloud  

Action: Opens dialog 

Usage: The Cut Near Ref Plane dialog is used to segment a point cloud into one cloud that 

contains points near the active Reference Plane and another cloud that contains all 

other points. 

�       For an overview of the segmentation process, see the Segmentation entry in the Modeling 

chapter. 

To segment point clouds near the Reference Plane: 

1. Position the active Reference Plane, and then select the point cloud(s) that you want to 

segment. 

2. From the Create Object menu, point to Segment Cloud, and then select Cut Near Ref 

Plane. The Cut Near Ref Plane dialog appears. 

3. Enter a value, or use the Region Thickness slider to interactively adjust the thickness of the 

slice (or partition) near the active Reference Plane. 

4. Click OK. The selected clouds are segmented. 

Cut Sub-Selection 

Window: ModelSpace 

Menu: Create Object | Segment Cloud  

Action: Executes command 

Usage: The Cut Sub-Selection command segments a point cloud(s) into two subsets 

based on a point cloud sub-selection. 

� For an overview of the segmentation process, see the Point Cloud Segmentation entry in the 

Modeling chapter. 

To cut a point cloud sub-selection: 

1. Draw a fence around the points that you want to segment. 

2. Use the Selection | Point Cloud Sub-Selection submenu commands to make an initial sub-

selection. 

� You may continue to refine the selection via subsequent Selection | Point Cloud Sub-

Selection submenu commands. See the Advanced Segmentation entry in the Modeling 

chapter for more information. 

2. From the Create Object menu, point to Segment Cloud, and then select Cut Sub-Selection. 

The points within the sub-selection are now a separate point cloud and can be selected 

independently. 
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Cutplane 

Window: ModelSpace 

Menu: Tools 

Action: Displays submenu 

Usage: Pointing to Cutplane displays submenu commands used to execute Cutplane 

operations and change settings. 

�       The Cutplane is a 3D plane with the primary function of "cutting" through objects in a 

ModelSpace and producing a 2D cross-section. 

�       For an overview of Cutplanes, see the Cutplanes entry in the Modeling chapter. 

The following commands and dialogs are available from the Cutplane submenu: 

Add/Edit Cutplanes..., Set on Object, Set from Active Ref Plane, Raise Active Cutplane, 

Lower Active Cutplane, Set Offset..., View Half-Space, View Slice, Set Slice Thickness..., 

Create Lines from Cuts, Set Half-Space at Pick, Set Slice from Picks 

Databases... 

Window: Navigator 

Menu: Configure 

Action: Opens dialog 

Usage: The Configure Databases dialog is used to add, remove, destroy, compact, and 

optimize databases. 

Note:    For detailed information on administering databases in Cyclone, see the Databases 

chapter. 

To add a database: 

1. Select the server to which you want to add a database. 

2. From the Configure menu, select Databases.... The Configure Databases dialog appears. 

3. Click Add. The Add Database dialog appears. 

4. In the Database Name field, type a logical name as an identifier for your logical database. 

� The logical name is the name displayed in the Navigator. 

5. In the Databases File name field, type a file name for your database. 

� The database file name is the name used for the database file, which is saved in the Cyclone\ 

Databases directory by default. 

� If you leave the Database File name field empty, Cyclone bases the file name on the logical 

name you entered in the Databases Name field. 

� You may select a new location for the database file by clicking the Browse icon to the right of 

the Database Name field. 

6. Click OK. The database is created. 
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To remove a database: 

� When a database is removed, the database is removed from the list of databases available on 

the server; however, the database file is not deleted and may be restored using the steps to 

add a database (above). 

1. From the Configure menu, select Databases.... The Configure Databases dialog appears. 

2. From the list of databases, select the database that you want to remove, and then click 

Remove. The database is removed. 

� To close the Configure Databases dialog and return to the Navigator window, click Close. 

To destroy a database: 

� When a database is destroyed, the database is removed and its file is permanently deleted 

and cannot be recovered from within Cyclone. 

1. From the Configure menu, select Databases.... The Configure Databases dialog appears. 

2. From the list of databases, select the database that you want to destroy, and then click 

Destroy. The database is deleted. 

� To close the Configure Databases dialog and return to the Navigator window, click Close. 
 

To toggle database visibility: 

1. From the Configure menu, select Databases.... The Configure Databases dialog appears. 

� To toggle visibility, select/deselect the box below the Visibility icon next to the desired 

database. 

� To close the Configure Databases dialog and return to the Navigator window, click Close. 

To compact a database: 

1. Select the server that contains the database you wish to compact. 

2. From the Configure menu, select Databases.... The Configure Databases dialog appears. 

3. Select the database you wish to compact, and click Compact. A confirmation dialog appears. 

4. Click Yes. A dialog appears prompting you to create a backup before beginning the 

compacting process. 

5. Click Yes to create a backup (strongly recommended). The compaction process begins. 

6. When finished, a notification dialog appears. Click OK to resume working in Cyclone. 

To optimize a database: 

1. Select the server that contains the database you wish to optimize. 

2. From the Configure menu, select Databases.... The Configure Databases dialog appears. 

3. Select the database you wish to optimize, and click Optimize. A confirmation dialog appears. 

4. Click Yes. A progress meter appears as the database is optimized. 

To remotely administer databases: 

1. Use the Set Server Password applet (installed with Cyclone) to set a password for local 

server. 

2. From the Configure menu, select Databases.... The Configure Databases dialog appears. 

3. Select the database you wish to remotely administer, and click Admin Login.... 
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4. Enter the password (set with the Set Server Password applet) from a remote client in order 

to administer (add, remove, etc.) databases on the remote database. 

Note:    To add a database on a remote server, the database file name must be entered 

using the server's drive letter and directories. For example, to add a database file 

name located at "D:\ Databases\ Example.imp" on the remote server “Remote”, enter 

"D:\ Databases\ Example.imp" as the file name (not \ \ REMOTE\ D$\ Example.imp"). 

Datum 

Window: ModelSpace 

Menu: Tools | Measure  

Action: Displays submenu 

Usage: Pointing to Datum displays submenu commands used to measure the distance from 

a picked point to a specified datum. 

The following commands are available from the Datum submenu: 

Point Distance, Set Datum to Pick Point, Enter Datum, Show Datum 

�       For Datum submenu command functionality, see the individual command entries. 

Decimate Contours 

Window: ModelSpace 

Menu: Tools | Contours 

Action: Opens dialog 

Usage: The Decimate Contours dialog is used to reduce the number of vertices in a 

selected contour line. 

�       When Cyclone reduces the number of vertices in a contour line, it does so with the mandate 

of minimizing the deviation from the originating mesh (Deviation is measured perpendicular to the 

contour's plane). 

To reduce the number of vertices in a contour line: 

1. Select the contour you want to reduce. 

� If the contour is selected with pick points, only lines on the picked elevations are decimated. If 

the contour is selected by any other method (e.g., by a fence) all lines are decimated. 

2. From the Tools menu, point to Contours then select Decimate Contours.... Deviations are 

initialized and then the Decimate Contours dialog appears. 

3. Set the maximum absolute deviation either by entering a value, or by moving the slider. 

� As this value is changed, the values for absolute deviation, maximum deviation, and minimum 

deviation, as well as the number of line segments, change accordingly and are displayed in 
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the lower half of the dialog. 

� To exit the dialog without decimating the contour line, click Cancel. 

4. Click OK. The number of vertices in the contour line is reduced, and the line is redrawn. 

Decimate Mesh 

Window: ModelSpace 

Menu: Tools | Mesh 

Action: Opens dialog 

Usage: The Decimate Mesh dialog is used to reduce the number of triangles in a mesh 

object. 

Decimate Mesh Dialog 

 

A.  Click to perform the decimation. When clicked this button is replaced by an Auto-Preview 
option and a slider bar (see B and F below).  

B.  When selected, the display in the ModelSpace viewer is adjusted continually as the 
Decimation Percentage slider to the right of this option is moved. 

C.  Displays the number of triangles resulting from movement of the slider or entry of a 
percentage in the % of Original field. You may also enter an exact number in this field. Note that 
entering the target number automatically adjusts the value in the % of Original field. Note also 
that the value in this field is automatically updated when the slider is used. 
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D.  Displays the original number of triangles in the selected mesh object. 

E.  When selected, original vertices are maintained as much as possible. When unselected, 
vertices may be moved to maintain the overall shape of the mesh more accurately. 

F.  Use this slider to adjust the percentage of decimation. If Auto-Preview is selected (see B), the 
viewer is automatically updated as you move the slider. 

G. Displays the percentage of the original number of triangles by which the mesh is to be 
decimated. You may also enter an exact number in this field. Note that entering a value in this 
field automatically adjusts the value in the Target Number field. Note also that the value in this 
field is automatically updated when the slider is used. 

H.  When Ignore is selected, the integrity of the mesh object’s boundary is not protected. When 
Maintain is selected, added weight is given to maintaining boundary edge shape during 
decimation. When Keep Exact is selected, the mesh object’s boundaries remain intact, no matter 
how much the mesh is decimated.  

I.   When Ignore is selected, breakline integrity is not protected. When Maintain is selected, 
added weight is given to maintaining breakline shape during decimation. When Keep Exact is 
selected, breaklines remain intact, no matter how much the mesh is decimated. 

Mesh editing can be performed only on a mesh object as opposed to a point cloud that is viewed 
as a mesh. To create a mesh object from a point cloud, see the Create Mesh entry in this 
chapter. 

To reduce the number of triangles in a mesh: 

1. Select the mesh object that you want to reduce. 

2. From the Tools menu, point to Mesh, and then select Decimate Mesh. The Decimate Mesh 

dialog appears. 

3. Enter a decimation target either by triangle count in the Target Number of Triangles field, or 

by percentage of original in the % of Original field. 

4. Select whether to maintain vertices and how Cyclone should deal with boundary edges and 

breaklines during decimation. 

5. Click the Decimate button to preview the settings, and display a slider tool which enables you 

to further adjust the mesh 

� If Auto-Preview is selected, as the slider is adjusted the mesh is adjusted in real-time, 

reflecting the value represented. 

6. Click OK when the mesh is displayed as desired. The mesh is replaced by a subsampled 

version of the original mesh. 

� To disregard changes and exit the dialog, click Cancel. 

Note:    If Maintain or Ignore check box is changed at any time while the dialog is open, the 

Decimate button reappears, as Cyclone needs to recompute the decimation. 
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Decimate Polyline/Patch 

Window: ModelSpace 

Menu: Edit Object 

Action: Opens dialog 

Usage: The Decimate Polyline/Patch dialog is used to intelligently reduce the number of 

vertices in a polyline or patch, preserving the original shape as much as possible. 

�       Polylines provide a potentially compact representation of cross-sections and other contours. 

However, some polylines may have vertices numbering in the hundreds (if not thousands), where 

tens of vertices may suffice. 

Decimate Polyline/Patch Dialog 

 

A.  Click to update the display in the ModelSpace viewer. When clicked, this button is replaced by 
the Auto-Preview option and a slider bar (see B and F below). 

B.  When selected, the display in the viewer is adjusted continually as the Decimation 
Percentage slider to the right of this option is moved. 

C.  Displays the number of vertices resulting from movement of the slider or entry of a percentage 
in the % of Original field. You may also enter an exact number in this field. Note that entering the 
target number automatically adjusts the value in the % of Original field. Note also that the value 
in this field is continually updated when the slider is used. 
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D.  Displays the original number of vertices in the selected polyline object. 

E.  Use this slider to set a maximum distance between each vertex along the decimated polyline. 

F.  Use this slider to set a minimum distance between each vertex along the decimated polyline. 

G. Use this slider to adjust the percentage of decimation. If Auto-Preview is selected (see B), the 
viewer is continually updated as you move the slider. 

H.  Displays what percentage of the original number of vertices in the polyline object by which the 
polyline object is to be decimated. You may also enter an exact number in this field. Note that 
entering a value in this field automatically adjusts the value in the Target Number field. Note also 
that the value in this field is continually updated when the slider is used. 

I.   Displays the largest distance measurement from any original vertex to the resulting 
(decimated) polyline. 

J.  Enter a value for the maximum distance between each vertex along the decimated polyline. 

K.  Enter a value for the minimum distance between each vertex along the decimated polyline. 

To reduce the number of vertices in a polyline or patch: 

1. Select the polyline or patch you want to reduce. 

2. From the Edit Object menu, select Decimate Polyline/Patch. The Decimate Polyline/Patch 

dialog appears. 

3. Set the decimation parameters. 

� To decimate by a percentage of original vertices, use the slider or enter a value in the % of 

Original field. 

� To decimate by constraining the range of distances between vertices, use the Min and Max 

sliders, and then click Decimate. This method produces spacing between vertices along the 

polyline such that adjacent vertices are no closer or further than desired. 

� To exit the dialog without decimating, click Cancel. 

4. Click OK. The number of vertices in the polyline or patch is reduced, and the polyline or patch 

is redrawn. 

Note:    In some cases it can be difficult to get a satisfactory reduction with a polyline. It may 

be helpful to break the polyline into several pieces (using the Create Object | Slice | 

by Last Selection command) and reduce each piece separately. 

Decrease Point Width 

Window: ControlSpace, ModelSpace, Registration, Scan Control (ScanStation, 

ScanStation 2, HDS3000, HDS4500, HDS6000) 

Menu: Point Cloud Rendering 

Action: Toggles menu item ON 

Usage: The Decrease Point Width command decrements by one pixel the thickness of 

each cloud point displayed in the ModelSpace View. 
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Defect Report... 

Window: All windows 

Menu: Help  

Action: Opens dialog 

Usage: The Defect Report dialog is provided for users to report bugs, limitations, or other 

perceived defects in the Cyclone software. 

To report a defect: 

1. From the Help menu, select Defect Report.... The Defect Report dialog appears. 

2. Enter personal data (name, company, email, phone, etc.) in the appropriate fields. It is 

important that you provide this data so we can contact you to follow up if necessary. 

� The Date and Time fields are populated automatically with the current date and time. 

3. Enter a summary of the problem being reported in the Summary field, followed by a 

description of the problem in the Detailed description field. Provide as much detail as 

possible, such as what your actions were prior to the problem occurrence, whether you are 

able to duplicate the problem, etc. 

� When possible, include the text from any error message that appears. To copy the text from 

an error message, click the program icon in the top left corner of the message box and select 

Copy. The text can then be pasted into the defect report. 

4. Check the Include log files option to attach any log files generated by Cyclone , along with 

information about your current computer configuration (recommended). 

5. Click Create Report to open the Save Report to File dialog; enter a file name for the .txt file 

(or accept the default, “defect.txt”), select the folder into which you want to save the file, and 

click Save. The report is created and saved to the designated file and location. 

6. E-mail the newly created .txt file to support@hds.leica-geosystems.com. 

Delete 

Window: ModelSpace, Navigator, Registration, Image Viewer  

Menu: Edit 

Action: Executes command 

Usage: The Delete command removes a selected object without placing it on the Cyclone 

clipboard. 

Delete (Limit Box Manager) 

Window:  Limit Box Manager 

Menu: Limit Box 

Action:  Executes command 

Usage: The Delete command deletes the selected limit box. 
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Delete Inside 

Window: ModelSpace 

Menu: Edit | Fence 

Action: Executes command 

Usage: The Delete Inside command removes all cloud points, polyline segments, and 

mesh faces within the data fence. 

�       For more information on working with fences, see the Using a Fence entry in the Modeling 

chapter. 

Delete Line 

Window: ModelSpace 

Menu: Tools | Contours 

Action: Executes command 

Usage: This command removes selected contour lines from the ModelSpace without 

affecting the remaining contour lines. 

Note:    Attempting to delete a contour line using the Delete command in the Edit menu 

results in deleting the entire set of contours, rather than just the selected contour line. 

To delete a contour line: 

1. Pick the contour line to be deleted. 

2. From the Tools menu, point to Contours and then select Delete Line. The selected contour 

line is deleted from the ModelSpace. 

Delete Outside  

Window: ModelSpace 

Menu: Edit | Fence 

Action: Executes command 

Usage: The Delete Outside command removes all cloud points outside of a data fence. 

Delete Selected Inside  

Window: ModelSpace 

Menu: Edit | Fence 

Action: Executes command 

Usage: The Delete Selected Inside command removes all points in selected point clouds 

within a fence. 
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�       For more information on working with fences, see the Using a Fence entry in the Modeling 

chapter. 

Delete Selected Outside  

Window: ModelSpace 

Menu: Edit | Fence 

Action: Executes command 

Usage: The Delete Selected Outside command removes all cloud points in selected point 

clouds outside of a data fence. 

�       For more information on working with fences, see the Using a Fence entry in the Modeling 

chapter. 

Delete Selection 

Window: ModelSpace 

Menu: Tools | Mesh 

Action: Executes command 

Usage: The Delete Selection command deletes selected triangles from a mesh. 

To delete triangles: 

1. Multi-select the triangles in the mesh object to be deleted. 

� Mesh editing can be performed only on a mesh object, as opposed to a point cloud that is 

viewed as a mesh. To create a mesh object from a point cloud, see the Create Mesh entry in 

this chapter. 

2. From the Tools menu, point to Mesh, and then select Delete Selection. The selected 

triangles are deleted. 

Deselect 

Window: ModelSpace, Image Viewer 

Menu: Selection 

Action: Executes command 

Usage: The Deselect command clears the current selection. 

� All objects can also be deselected by pressing ESC. 
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Deselect Fenced 

Window: ModelSpace 

Menu: Selection 

Action: Executes command 

Usage: The Deselect Fenced command deselects every object and point cloud within or 

overlapping the drawn data fence. 

�       For more information on working with fences, see the Using a Fence entry in the Modeling 

chapter. 

Disable 

Window: Registration 

Menu: Constraint 

Action: Executes command 

Usage: The Disable command marks the selected constraint as OFF, so that it is not used 

when computing the registration. 

�       For more information on the registration process, see the Registration entry in the Getting 

Started chapter. 

To disable a constraint: 

1. In either the ScanWorlds’ Constraints or the Constraint List tab, select the constraint you 

want to disable. 

2. From the Constraint menu, select Disable. The constraint is disabled and its status is 

marked as OFF. 

Disassemble 

Window: ModelSpace 

Menu: Tools | Exclusion Volume 

Action: Executes command 

Usage: The Disassemble command replaces an exclusion volume with its original 

component(s). 

To restore the contents of an exclusion volume: 

1. Select the exclusion volume. 

2. From the Tools menu, point to Exclusion Volume, and then select Disassemble. The 

original component(s) reappear. 
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Disconnect 

Window: Scan Control 

Menu: Scanner 

Action: Executes command 

Usage: The Disconnect command disconnects Cyclone from the currently connected 

scanner. 

Disconnect (All) 

Window: ModelSpace 

Menu: Tools | Piping  

Action: Executes command 

Usage: The Disconnect Piping (All) command breaks all connections to the selected 

object. 

�       To connect piping, see the Connect Piping and Piping Mode commands. 

Disconnect (Shared) 

Window: ModelSpace 

Menu: Tools | Piping  

Action: Executes command 

Usage: The Disconnect Piping command breaks the connections shared between two or 

more selected objects.  

�       This command breaks any shared connections between any two of the selected objects. All 

other connections are unaffected. 

•       To connect piping, see the Connect Piping and Piping Mode commands. 

Display License  

Window: Navigator, ModelSpace, Image Viewer, Registration, Scan Control 

Menu: Help  

Action: Opens dialog 

Usage: This command displays a dialog box containing Cyclone licensing information. 

Licenses may be uninstalled from this dialog.  

•       To uninstall the licenses, click Uninstall and follow the prompts. 
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Distance 

Window: ModelSpace 

Menu: Tools | Measure  

Action: Displays submenu 

Usage: Pointing to Distance displays submenu commands used to measure a variety of 

linear distances. 

The following commands are available from the Distance submenu: 

Point to Point, Point to Centerline/Point, Point to Unbounded Surface, Center to Center, 

Point to Scanner 

Distance of Point to Submenu Commands: 

POINT TO POINT 

Calculates the distance between picked points. 

POINT TO CENTERLINE/POINT 

•       Calculates the distance between a picked point and the centerline or center point of the 

other selected object(s). 

•       The type of object selected as the second object determines whether the measurement 

is to a centerline or a center point. (For example, a sphere is measured to its center point 

and a cylinder is measured to its centerline.) 

POINT TO UNBOUNDED SURFACE 

Calculates the distance between the first picked point and the nearest intersection with the 

surface plane of the selected object. 

•       For measurements, surfaces are extended beyond the endpoint or boundary of the 

actual object to the nearest point of intersection. For example, a measurement to the 

surface of a patch is made to the nearest point on the underlying plane of the patch, which 

is not necessarily a point within the boundary of the patch. 

CENTER TO CENTER 

Calculates the distance between the center of the first selected object and the center of the 

second selected object. 

•       The object type determines whether the measurement is to a centerline or a center point. 

(For example, a sphere is measured to its center point, and a cylinder is measured to its 

centerline.) 

POINT TO SCANNER 

Calculates the distance between the picked point(s) in a scanned point cloud and the selected 

scanner. 

•       If a scanner object is not selected, Cyclone determines the distance from the selected 

point to the scanner that was used to capture the point. 
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To take a measurement: 

1. Pick the point or object from which you want to measure a distance. 

2. If necessary, multi-select a point, surface, or object (with a center point or centerline if 

required by the command) for the second point of the measurement. 

3. From the Tools menu, point to Distance, and then select the appropriate command for the 

type of object to which you are measuring. The measurement is calculated and displayed. 

� If there are more than two points or objects selected, multiple measurements are taken from 

the first point or object to the subsequent selection items (i.e., first to second, first to third, 

etc.). 

� Center points, centerlines, and surfaces are measured differently depending on the type of 

object selected, and some measurements are not supported by all object types. 

Download HDS6000 Scans… 

Window: Navigator 

Menu: Tools 

Action: Executes command 

Usage: The Download HDS6000 Scans command is used to download ZFS files from the 

HDS6000 that were not automatically downloaded. Only HDS6000 scans that were 

not automatically downloaded (as per the HDS4500/HDS6000: Max # Points Auto-

Imported preference) are considered. 

To download HDS6000 scans: 

1. In the Navigator window, select the container under which HDS6000 Scans eligible for 
download are located. 

• The container can be a database, Project, ScanWorld, Registration, or Scan. 

• You can select multiple containers. 

2. Turn on the HDS6000 and physically connect it to the network. 

• This command does not need the Scan Control to be connected to the scanner. 

3. In the Navigator window on the Tools menu, select Download HDS6000 Scans…. 

4. If there are multiple HDS6000 scanners configured on the computer, select the specific 
HDS6000 from which to download, using the Download Scans from HDS6000 dialog that 
appears in this case. 

5. The ZFS files are downloaded from the HDS6000. 

6. Use the Re-Import Scans… command to import the downloaded scans. 

Draw Arc (3 Points on Arc) 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Executes command 

Usage: The Draw Arc (3 Points on Arc) command enters drawing mode and sets the 

drawing tool to draw an arc in the active Reference Plane. 
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�       For more information on drawing, see the Drawing entry in the Modeling chapter. 

To draw an arc: 

1. From the Tools menu, point to Drawing, and then select Draw Arc (3 Points on Arc). The 

Drawing cursor appears. 

2. In the ModelSpace, click once to place a vertex that serves as the first endpoint. 

3. Click again to place a second vertex that serves as a point on the arc. 

4. Click a point or drag the cursor to place a third vertex that serves as the second end point. 

� A vertex can be moved by dragging it to a new position, or deleted by clicking on it without 

moving the cursor. 

5. From the Tools menu, point to Drawing, and then select Create Drawing. The arc is drawn, 

and you are ready to draw another arc. 

� To delete the newly created arc, either select Undo from the Edit menu, or select the arc, and 

then select Delete from the Edit menu. 

Draw Arc (Start, Center, End) 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Executes command 

Usage: The Draw Arc (Start, Center, End) command enters drawing mode and sets the 

drawing tool to draw an arc in the active Reference Plane. 

�       For more information on drawing, see the Drawing entry in the Modeling chapter. 

To draw an arc: 

1. From the Tools menu, point to Drawing, and then select Draw Arc (Start, Center, End). The 

Drawing cursor appears. 

2. In the ModelSpace, click once to place a vertex that serves as the first end point. 

3. Click again to place a second vertex that serves as the center point. 

4. Click a point or drag the cursor to place a third vertex that serves as the second end point. 

� A vertex can be moved by dragging it to a new position, or deleted by clicking on it without 

moving the cursor. 

5. From the Tools menu, point to Drawing, and then select Create Drawing. The arc is drawn, 

and you are ready to draw another arc. 

� To delete the newly created arc, either select Undo from the Edit menu, or select the arc, and 

then select Delete from the Edit menu. 
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Draw Arc (Start, End, Center) 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Executes command 

Usage: The Draw Arc (Start, End, Center) command enters drawing mode and sets the 

drawing tool to draw an arc in the active Reference Plane. 

�       For more information on drawing, see the Drawing entry in the Modeling chapter. 

To draw an arc: 

1. From the Tools menu, point to Drawing, and then select Draw Arc (Start, End, Center). The 

Drawing cursor appears. 

2. In the ModelSpace, click once to place a vertex that serves as the first end point. 

3. Click again to place a second vertex that serves as the second end point. 

4. Click a point or drag the cursor to place a third vertex that serves as the center point. 

� A vertex can be moved by dragging it to a new position, or deleted by clicking on it without 

moving the cursor. 

5. From the Tools menu, point to Drawing, and then select Create Drawing. The arc is drawn, 

and you are ready to draw another arc. 

� To delete the newly created arc, either select Undo from the Edit menu, or select the arc, and 

then select Delete from the Edit menu. 

Draw Circle (3 Points on Circle) 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Executes command 

Usage: The Draw Circle (3 Points on Circle) command enters drawing mode and sets the 

drawing tool to draw a circle in the active Reference Plane. 

� For more information on drawing, see the Drawing entry in the Modeling chapter. 

�  

To draw a circle: 

1. From the Tools menu, point to Drawing, and then select Draw Circle (3 Points on Circle). 

The Drawing cursor appears. 

2. In the ModelSpace, click once to place a vertex at a point on the circle. 

3. Click again to place a second vertex on the circle. 

4. Click a point or drag the cursor to place a third vertex through which the circle must pass. 

� A vertex can be moved by dragging it to a new position, or deleted by clicking on it without 

moving the cursor. 

5. From the Tools menu, point to Drawing, and then select Create Drawing. The circle is 

drawn, and you are ready to draw another circle. 
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� To delete the newly created circle, either select Undo from the Edit menu, or select the circle, 

and then select Delete from the Edit menu. 

Draw Circle (Point, Center) 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Executes command 

Usage: The Draw Circle (Point, Center) command enters drawing mode and sets the 

drawing tool to draw a circle in the active Reference Plane. 

�       For more information on drawing, see the Drawing entry in the Modeling chapter. 

To draw a circle: 

1. From the Tools menu, point to Drawing, and then select Draw Circle (Point, Center). The 

Drawing cursor appears. 

2. In the ModelSpace, click once to place a vertex at a point on the circle. 

3. Click again or drag the cursor to place a vertex that serves as the center point. 

� A vertex can be moved by dragging it to a new position, or deleted by clicking on it without 

moving the cursor. 

4. From the Tools menu, point to Drawing, and then select Create Drawing. The circle is 

drawn, and you are ready to draw another circle. 

� To delete the newly created circle, either select Undo from the Edit menu, or select the circle, 

and then select Delete from the Edit menu. 

Draw Cubic Spline 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Executes command 

Usage: The Draw Cubic Spline command enters drawing mode and sets the drawing tool 

to draw a cubic spline in the active Reference Plane. 

�       For more information on drawing, see the Drawing entry in the Modeling chapter. 

�       The procedures for drawing a cubic spline are identical to those for drawing a polyline, 
except that the vertices are connected by the curves of a cubic spline curve rather than by 
straight lines. Also, vertices cannot be added between existing vertices while drawing a cubic 
spline. 
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Draw Cubic Spline Loop 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Executes command 

Usage: The Draw Cubic Spline Loop command enters drawing mode and sets the 

drawing tool to draw a cubic spline loop in the active Reference Plane. 

�       For more information on drawing, see the Drawing entry in the Modeling chapter. 

�       The procedures for drawing a cubic spline loop are identical to those for drawing a cubic 
spline, except that the first and last vertices are automatically connected. 

Draw Ellipse 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Executes command 

Usage: The Draw Ellipse command enters drawing mode and sets the drawing tool to draw 

an ellipse in the active Reference Plane. 

�       For more information on drawing, see the Drawing entry in the Modeling chapter. 

To draw an ellipse: 

� An ellipse is drawn by first placing two vertices, and then placing a third vertex to adjust the 

eccentricity of the ellipse. The midpoint between the first two vertices becomes the center of 

the ellipse that passes through both points. 

1. From the Tools menu, point to Drawing, and then select Draw Ellipse. The Drawing cursor 

appears. 

2. In the ModelSpace, click once to place a vertex. 

3. Click again to place a second vertex. The midpoint between the first two vertices becomes the 

center of a circle that passes through both vertices. 

4. Click a point or drag the cursor to place a third vertex, which adjusts the eccentricity of the 

ellipse. 

� The third vertex can be moved by dragging or clicking in a new location. 

� A vertex can be moved by dragging it to a new position, or deleted by clicking on it without 

moving the cursor. 

5. From the Tools menu, point to Drawing, and then select Create Drawing. The ellipse is 

drawn, and you are ready to draw another ellipse. 

� To delete the newly created ellipse, either select Undo from the Edit menu, or select the 

ellipse, and then select Delete from the Edit menu. 
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Draw Isometric Polygon 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Executes command 

Usage: The Draw Isometric Polygon command enters drawing mode and sets the drawing 

tool to draw a polygon with a user-specific number of symmetric sides in the active 

Reference Plane. 

�       For more information on drawing, see the Drawing entry in the Modeling chapter. 

To draw an isometric polygon: 

1. From the Tools menu, point to Drawing, and then select Draw Isometric Polygon. The 

Drawing cursor appears. 

2. In the ModelSpace, click once to place a vertex at the center of the isometric polygon. The 

Isometric Polygon dialog appears. 

3. Enter the number of sides to be drawn for the isometric polygon, and then click OK. 

4. Click again to place one vertex on the polyline. The other vertices are drawn automatically. 

5. From the Tools menu, point to Drawing, and then select Create Drawing. The isometric 

polygon is drawn, and you are ready to draw another. 

� To delete the newly created isometric polygon, either select Undo from the Edit menu, or 

select the isometric polygon, and then select Delete from the Edit menu. 

Draw Line 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Executes command 

Usage: The Draw Line command enters drawing mode and sets the drawing tool to draw a 

line segment in the active Reference Plane. 

�       For more information on drawing, see the Drawing entry in the Modeling chapter. 

To draw a line: 

1. From the Tools menu, point to Drawing, and then select Draw Line. The Drawing cursor 

appears. 

2. In the ModelSpace, click once to place a vertex that serves as first endpoint. 

3. Click again to place a vertex for the second endpoint. 

� The second vertex may be moved by dragging or clicking in a new location. 

� A vertex can be moved by dragging it to a new position, or deleted by clicking on it without 

moving the cursor. 

4. From the Tools menu, point to Drawing, and then select Create Drawing. The line is drawn, 

and you are ready to draw another line. 

� To delete the newly created line, either select Undo from the Edit menu, or select the line, and 

then select Delete from the Edit menu. 
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Draw Polygon 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Executes command 

Usage: The Draw Polygon command enters drawing mode and sets the drawing tool to 

draw a polygon in the active Reference Plane. 

�       For more information on drawing, see the Drawing entry in the Modeling chapter. 

�       The procedures for drawing a polygon are identical to those for drawing a polyline, except 

that the first and last vertices are automatically connected. 

Draw Polyline 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Executes command 

Usage: The Draw Polyline command enters drawing mode and sets the drawing tool to 

draw a polyline in the active Reference Plane. 

�       For more information on drawing, see the Drawing entry in the Modeling chapter. 

To draw a polyline: 

1. From the Tools menu, point to Drawing, and then select Draw Polyline. The Drawing cursor 

appears. 

2. In the ModelSpace, click once to place a vertex at the first endpoint. 

3. Click again to place a vertex and create a line segment from the previous point. 

� To continuously add vertices as you move the mouse, press and hold ALT, and drag the 

cursor. 

4. Continue adding vertices as needed. 

� A vertex can be moved by dragging it to a new position, or deleted by clicking on it without 

moving the cursor. 

� Vertices may also be added by clicking on an existing line segment. 

5. From the Tools menu, point to Drawing, and then select Create Drawing. The polyline is 

drawn, and you are ready to draw another polyline. 

� To delete the newly created polyline, either select Undo from the Edit menu, or select the 

polyline, and then select Delete from the Edit menu. 
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Draw Rectangle 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Executes command 

Usage: The Draw Rectangle command enters drawing mode and sets the drawing tool to 

draw a square in the active Reference Plane. 

�       For more information on drawing, see the Drawing entry in the Modeling chapter. 

To draw a rectangle: 

1. From the Tools menu, point to Drawing, and then select Draw Rectangle. The Drawing 

cursor appears. 

2. In the ModelSpace, click once to place a vertex on one corner of the rectangle. 

3. Click again to place a vertex at the second corner of the rectangle. 

4. Click at the desired distance from either side of the line segment to determine the length and 

direction of the sides parallel to the first segment. The angle and length of the fourth side 

matches the first line segment. 

� This segment can be adjusted by dragging or clicking in a new location. 

� A vertex can be moved by dragging it to a new position, or deleted by clicking on it without 

moving the cursor. 

5. From the Tools menu, point to Drawing, and then select Create Drawing. The rectangle is 

drawn, and you are ready to draw another rectangle. 

� To delete the newly created rectangle, select Undo from the Edit menu, or select the 

rectangle, and then select Delete from the Edit menu. 

Draw Square 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Executes command 

Usage: The Draw Square command enters drawing mode and sets the drawing tool to 

draw a square in the active Reference Plane. 

�       For more information on drawing, see the Drawing entry in the Modeling chapter. 

To draw a square: 

1. From the Tools menu, point to Drawing, and then select Draw Square. The Drawing cursor 

appears. 

2. In the ModelSpace, click once to place a vertex on one corner of the square. 

3. Click again to place a vertex at the second corner of the desired square. This line segment 

determines the length of the sides of the square. 

4. Click on either side of the line segment to place the remaining three sides. The angle and 

length of the remaining three sides are determined by the first line segment. 
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� The final three sides can be moved by dragging either vertex of the first line segment. 

� A vertex can be moved by dragging it to a new position, or deleted by clicking on it without 

moving the cursor. 

5. From the Tools menu, point to Drawing, and then select Create Drawing. The square is 

drawn, and you are ready to draw another square. 

� To delete the newly created square, either select Undo from the Edit menu, or select the 

square, and then select Delete from the Edit menu. 

Draw Text... 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Opens dialog 

Usage: The Draw Text dialog is used to enter drawing mode and add text in the active 

Reference Plane. 

�       For more information on drawing, see the Drawing entry in the Modeling chapter. 

To draw text: 

1. From the Tools menu, point to Drawing, and then select Draw Text.... The Drawing cursor 

appears. 

2. In the ModelSpace, click to select a point to anchor the text. The 2D Drawing : Text dialog 

appears. 

3. In the Text to be Drawn field, type the text you want, and click OK. 

� The text can be moved by dragging or clicking in a new location. 

4. From the Tools menu, point to Drawing, and then select Create Drawing. The text is placed, 

and you are ready to add more text. 

� To view the newly created text, the Show Annotations command must be ON. 

� To delete the newly created text, either select Undo from the Edit menu, or select the text, 

and then select Delete from the Edit menu. 

Drawing 

Window: ModelSpace 

Menu: Tools 

Action: Displays submenu 

Usage: Pointing to Drawing displays submenu commands used to access a variety of 

drawing tools and settings. 

The following commands and dialogs are available from the Drawing submenu: 

Create Drawing, Cancel Drawing, Draw Line, Draw Polyline, Draw Square, Draw Rectangle, 

Draw Isometric Polygon, Draw Polygon, Draw Text..., Draw Arc (3 Points on Arc), Draw Arc 
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(Start, End, Center), Draw Arc (Start, Center, End), Draw Circle (3 Points on Circle), Draw 

Circle (Point, Center), Draw Ellipse, Draw Cubic Spline, Draw Cubic Spline Loop, Align 

Vertices to Axes, Set Distance to Next Vertex..., Edit Drawing Parameters..., Create 

Drawing from Object, Export Template 

�       For complete more information, see the individual entries in this chapter or the Drawing 

entry in the Modeling chapter. 

Eccentric Reducer Connectors 

Window: ModelSpace 

Menu: Tools | Piping 

Action: Executes command 

Usage: The Eccentric Reducer Connectors command connects two parallel selected 

pipes via a reducer that has one perpendicular leg. 

To connect parallel pipes: 

1. Pick a point on the first pipe near the end you want connected. 

2. Multi-select the second pipe near the end that you want connected. 

3. From the Tools menu, point to Piping, and then select Reducer Connectors. The pipes are 

connected with a reducer. 

Edit Active Plane...  

Window: ModelSpace 

Menu: Tools | Reference Plane  

Action: Opens dialog 

Usage: The Edit Active Plane... command launches the Reference Plane Parameters 

dialog, which is used to set various display and orientation options for the active 

Reference Plane. 

Note:    The active Reference Plane may not be edited while a 2D drawing is in progress. 
Reference Plane Parameters Dialog Options: 

PLANE NORMAL 

Set direction vector used for the plane’s normal (the Reference Plane’s positive Z axis). 

PLANE ORIGIN 

Set coordinates for the plane’s center. 

PLANE CROSS AXIS 

Enter a direction vector for the cross axis (the Reference Plane’s positive X axis). 

GRID SPACING 
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Enter the desired distance between grid lines. 

GRID LINE WEIGHT 

Enter a value for the thickness of grid lines. 

GRID COLOR 

Use the color picker to select the color used for the grid. 

Edit Clipping Planes... 

Window: ModelSpace 

Menu: View 

Action: Opens dialog 

Usage: The Clipping Planes dialog is used to set the near and far boundaries of what is 

visible in the ModelSpace View. 

�       Clipping planes are the boundaries that determine the visible volume of a scene.  

�       The six default boundaries are the top, bottom, left, right, near and far clipping planes. The 

top, bottom, left, and right planes are at the corresponding edges of the ModelSpace window; the 

near and far clipping planes automatically update to contain the scene, but may be adjusted by 

the user. 

To set near and far clipping planes: 

1. From the View menu, select Edit Clipping Planes.... The Clipping Planes dialog appears. 

2. Choose values for the near and far clipping planes. 

� To set custom clipping planes, select the Use Custom Clipping Planes box, and then enter 

values in the Near Clipping Plane and Far Clipping Plane boxes. 

� To reset near and far clipping planes to their default values, select the Use Default box, and 

then click Apply. 

3. Click OK. The near and far clipping planes are set. 

Edit Color Map... 

Window: ModelSpace 

Menu: Edit Object | Appearance  

Action: Opens dialog 

Usage: The Color Map Parameters dialog is used to specify color and range settings for 

the selected color map. 

� For an overview of color mapping in Cyclone, see the Color Mapping entry in the Modeling 

chapter. 

� Settings made in this dialog are overridden if Global Color Map is toggled ON. 

� The Minimum and Maximum settings typically range from 0 to 1. These values correspond to 
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the range from dark to bright (red to blue for the Multi-Hue setting). For a greater difference in 

shades, set a narrower range. 
Color Map Parameters Dialog Options 

MODE 

From the drop-down list, select Image Texture Map, Colors from Scanner, Intensity Map, 

Elevation Map, or Single Color. 

SCHEME 

From the drop-down list, select Multi-Hue/Rainbow, Grayscale, a topography-based palette, 

or a scaled individual color with which to display the intensity or elevation map (for the 

corresponding Mode). If the Mode is Image Texture Map or Colors from Scanner, this 

scheme is used when the cloud/mesh lacks per-point color. 

NUMBER OF COLORS 

Enter a value for the total number of colors that will be used by the color scheme. 

REPEAT COLORS OUTSIDE RANGE 

Select this to use a cyclic color scheme. For example, if the Minimum is 0 and the Maximum 

is 1, a value of 1.3 would be same color as a value of 0.3. Otherwise, values lower than the 

Minimum (or Start) are given the color at the low end of the selected color scheme, and 

values higher than the Maximum are given the color at the high end of the selected color 

scheme. 

GAMMA CORRECTION 

Select this to enable gamma correction, which can accentuate subtle differences in intensities. 

A value of 1.0 is equivalent to disabling gamma correction. 

APPLY TO 

Select what the parameters affect. 

When Mode is Image Texture Map, Colors from Scanner or Intensity Map: 

MINIMUM 

Enter a value for the lowest intensity to be mapped to the low end of the selected color 

scheme. 

MAXIMUM 

Enter a value for the highest intensity to be mapped to the high end of the selected color 

scheme. 

ACTUAL 

Displays the object’s original minimum and maximum intensity values. 

When Mode is Elevation Map: 

START 

Enter a value for the elevation to be mapped to the low end of the selected color scheme. 
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DELTA 

Enter a value for the difference in elevation represented by each color in the selected color 

scheme (see Number of Colors earlier). 

Edit Color/Material... 

Window: ModelSpace 

Menu: Edit Object | Appearance 

Action: Opens dialog 

Usage: The Color and Material Editor dialog is used to change the appearance of the 

selected object. 

Color and Material Editor Dialog 

 

A.  The color wheel allows you to select hue and saturation simultaneously. 

B.  Click and drag the color picker to select any color on your screen (including those outside of 

Cyclone). The selected color appears in the current color swatch. 
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•       When the current color swatch is changed, any selected material swatches are also 

changed. 

•       The current color swatch can be edited by using the color picker, the color wheel, the HSV 

and RGB sliders, or any of the four material buttons (click the button to copy the color in the 

material's swatch to the current color swatch). 

C.  The current color swatch displays the color settings from the color wheel and the HSV and 

RGB sliders. When a change is made to any of the HSV or RGB sliders, the current color swatch, 

or the color wheel, the change is reflected in all three areas. 

D.  Open/Close the lower portion of the Color and Material Editor dialog, which contains material 

editing controls. 

•       When the lower portion is closed, color changes affect only diffuse and ambient properties 

(equally). 

E.  Use this slider to adjust the amount of shine or glare that an object reflects. 

•       This setting interacts with the Specular setting. Values range from 0 (dull) to 1 (glossy). 

F.  Use this slider to adjust the degree to which you can see through an object. Values range from 

0 (opaque) to 1 (invisible). 

G.  Click to access sliders that edit the mix of red, green, and blue that define the current color. 

Values range from 0 to 1. 

H.  Click to access sliders that edit the mix of hue, saturation, and value that define the current 

color. Values range from 0 to 1. 

I.   Displays the current material. 

J.  When checked, the associated material property is linked to the current color swatch so that 

any changes made to the current color are duplicated in the selected materials. 

K.  Click to copy the material property to the current color swatch, which in turn also changes all 

selected material swatches. 

•       Ambient is the color reflected by an object in response to the ambient lighting. See Edit 

Environmental Lights entry in this chapter. 

•       Diffuse is the base color of an object in response to a white light source. 

•       Specular is the color reflected in a surface’s highlights. 
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•       This setting interacts with the Shininess setting to determine the overall highlighting effect 

of the material. 

•       Emissive is the color generated by the object. It does not need an external light source, but 

does not necessarily emit light. 

L.  Material swatches display the color of their various properties. Right click to use the slider to 

adjust individual brightness. 

•       When the current color swatch is changed, any selected material swatches are also 

changed. 

Color and Material Editor Menus 

The Edit menu contains Copy and Paste commands: 

Copy:  Copies the current color to the Cyclone color clipboard. 

Paste:  Copies the color from the Cyclone color clipboard to the current color swatch and 
any selected material swatch(es). 

The Colors menu contains commands that assign standard colors and values to the current color 
swatch and any selected material swatches. 

The Palette menu contains commands used to open the Color Palette and the Material Palette 
(see the Add/Edit Colors and Add/Edit Materials entries in this chapter). 

To edit an object’s color and material: 

1. Select the object whose color and material you want to change. 

2. From the Edit Object menu, point to Appearance, and then select Edit Color/Material.... 
The Color and Material Editor appears. 

3. Make the desired changes, and then click OK. The selected object’s color and material are 
updated. 

Edit Drawing Parameters... 

Window: ModelSpace 

Menu: Tools | Drawing 

Action: Opens dialog 

Usage: The Drawing Parameters dialog is used to set the color and line weight parameters 

for 2D drawing. 

�       Changes in the Drawing Parameters dialog are reflected in current and subsequent 2D 
drawings only. 2D drawings created prior to any changes are not affected. 
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To set default drawing parameters: 

1. From the Tools menu, point to Drawing, and then click Edit Drawing Parameters.... The 

Drawing Parameters dialog appears. 

2. Edit the line weight and color parameters. 

Edit Elbow BendRatio... 

Window: ModelSpace 

Menu: Tools | Piping 

Action: Opens dialog 

Usage: The Edit Elbow Bend Ratio dialog is used to edit the ratio of elbow bend radius to 

pipe OD (outside diameter) for the selected pipes and elbows. 

To adjust the elbow bend ratio: 

1. Select the objects that you want to edit in the following order: pipe, (joining) elbow, pipe. 

2. From the Tools menu, point to Piping, and then select Edit Elbow Bend Ratio.... The Elbow 

Bend Ratio dialog appears. 

3. Enter a value for the ratio of elbow bend radius to pipe OD. 

4. Click OK to complete the operation. 

Edit Environmental Lights... 

Window: ModelSpace 

Menu: Tools | Lighting  

Action: Opens dialog 

Usage: The Edit Environmental Lights dialog is used to adjust Head Light and Ambient 

Light settings. 

�       For more information about lighting, see the Lighting entry in the Modeling chapter. 

Light Settings Dialog Options (Head Light tab): 

HEAD LIGHT COLOR 

Use the color picker to assign a color to the Head Light. 

HEAD LIGHT INTENSITY 

Set the Head Light intensity from 0 (dark) to 1 (bright). 

HEAD LIGHT STATE 

Turn the Head Light ON or OFF. 
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Light Settings Dialog Options (Ambient Light tab): 

AMBIENT LIGHT COLOR 

Use the color picker to assign a color to the Ambient Light. 

AMBIENT LIGHT INTENSITY 

Set the Ambient Light intensity from 0 (dark) to 1 (bright). 

To adjust Light Settings: 

1. From the Tools menu, point to Lighting, and then select Edit Environmental Lights.... The 

Light Settings dialog appears. 

2. Make the changes you want to the various settings. 

� To return all options to factory default settings, click Reset. 

3. Click OK to complete the operation. 

� To see the changes immediately, click Apply. 

� To exit without saving unapplied changes, click Close. Changes that have been applied are 

already saved. 

Edit Global Color Map... 

Window: ModelSpace 

Menu: Edit Object | Appearance  

Action: Opens dialog 

Usage: The Global Color Map dialog is used to specify color and range settings for the 

global color map. 

� For an overview of color mapping in Cyclone, see the Color Mapping entry in the Modeling 

chapter. 

� The Minimum and Maximum settings typically range from 0 to 1. These values correspond to 

the range from dark to bright (red to blue for the Multi-Hue setting). For a greater difference in 

shades, set a narrower range. 
Color Map Parameters Dialog Options: 

MODE 

From the drop-down list, select Image Texture Map, Colors from Scanner, Intensity Map, 

Elevation Map, or Single Color. 

SCHEME 

From the drop-down list, select Multi-Hue/Rainbow, Grayscale, a topography-based palette, 

or a scaled individual color with which to display the intensity or elevation map (for the 

corresponding Mode). If the Mode is Image Texture Map or Colors from Scanner, this 

scheme is used when the cloud/mesh lacks per-point color. 

ENABLE GLOBAL COLOR MAP 

Select this to apply the global color map to all clouds and meshes in the ModelSpace, 

overriding individual color map parameters. 
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NUMBER OF COLORS 

Enter a value for the total number of colors that will be used by the color scheme. 

REPEAT COLORS OUTSIDE RANGE 

Select this to use a cyclic color scheme. For example, if the Minimum is 0 and the Maximum 

is 1, a value of 1.3 would be same color as a value of 0.3. Otherwise, values lower than the 

Minimum (or Start) are given the color at the low end of the selected color scheme, and 

values higher than the Maximum are given the color at the high end of the selected color 

scheme. 

GAMMA CORRECTION 

Select this to enable gamma correction, which can accentuate subtle differences in intensities. 

A value of 1.0 is equivalent to disabling gamma correction.  

When Mode is Image Texture Map, Colors from Scanner or Intensity Map: 

MINIMUM 

Enter a value for the lowest intensity to be mapped to the low end of the selected color 

scheme. 

MAXIMUM 

Enter a value for the highest intensity to be mapped to the high end of the selected color 

scheme. 

ACTUAL 

Displays the object's original minimum and maximum intensity values. 

When Mode is Elevation Map: 

START 

Enter a value for the elevation to be mapped to the low end of the selected color scheme. 

DELTA 

Enter a value for the difference in elevation represented by each color in the selected color 

scheme. (See Number of Colors earlier.) 

Edit Measurements... 

Window: ModelSpace 

Menu: Tools | Measure  

Action: Opens dialog 

Usage: The Edit Measurements dialog is used to view, save, delete, and copy 

measurements to the Windows clipboard. 
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To customize the Edit Measurements dialog: 

1. Right-click anywhere in the column header and select Customize from the context menu. The 

Customize Columns dialog appears. 

2. Select the columns of information you wish to display in the Edit Measurements dialog, and 

then click Exit. The dialog’s columns are customized to your specifications. 

� Note that additional information columns such as the delta X, Y, Z, and Horizontal, Vertical, 

and projected measurements are not displayed by default. 

To copy Measurement values to the Windows clipboard: 

1. Select the measurement(s) you want to copy. 

2. Click the Copy to Clipboard icon. The measurement value(s) are copied as tab-delimited text 

to the Windows clipboard, from which it may be pasted into another application (e.g., 

Notepad). 

Measurements Dialog 

 

A.  Highlight the selected measurement in the ModelSpace window. 

B.  Center the selected measurement in the ModelSpace window. 

C.  Delete the selected measurement. 
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D.  When the button is toggled OFF, each new measurement replaces the prior in the 

ModelSpace and no measurement data is added to this dialog. When the button is toggled ON, 

all measurement data taken while the button is active, is displayed in this dialog, and all 

measurements are displayed in the ModelSpace (unless individual measurements are made 

invisible – see F below). 

E.  Copy selected data to the clipboard. 

F.  List of measurements in current ModelSpace 

G.  Toggle visibility of the selected measurements. 

H.  Measurement type. 

I.    Measurement value. 

J.   Move the selected measurement up in the list. 

K.  Move the selected measurement down in the list. 

Edit Parameters... (Cloud Registration) 

Window: Registration 

Menu: Cloud Constraint 

Action: Opens dialog 

Usage: The Edit Parameters... command opens the Cloud Constraint Parameters dialog, 

which allows the cloud constraint's individual behavior to override the relevant 

preferences from the Registration tab of the Edit Preferences dialog. 

�      See the Preferences command for details. 

To restore the previous values, click Reset. 

To change the cloud constraint to no longer override the preferences, click Default. 

�   For more information on the cloud registration process, see the Cloud Registration section 

of the Registration chapter. 

Edit Parameters... (Region Grow) 

Window: ModelSpace 

Menu: Create Object | Region Grow 

Action: Opens dialog 

Usage: The Edit Parameters command opens the Modeling tab within the Edit 
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Preferences dialog. 

Edit Point Properties... 

Window: Image Viewer 

Menu: Annotation 

Action: Opens dialog 

Usage: The Edit Point Properties dialog is used to change the color and location of 

existing annotation pick points. 

To edit pick point properties in the Image Viewer: 

1. Select the pick point you want to edit. 

� You must be in Pick mode in order to select pick points; in addition, the selected point must 

have at least one assigned annotation. 

2. From the Edit menu, select Edit Point Properties. The Image Point Properties dialog 

appears. 

3. Make the changes you want for the color and position of the selected pick point. 

� To edit the pick point’s color, click Color and use the color picker to select the color. 

� To edit the pick point’s position, click Position and enter values for X and Y coordinates. The 

range of values is based on the number of pixels in the image. 

4. Click OK. Your color and position changes are made. 

Edit Point/Spot Lights... 

Window: ModelSpace 

Menu: Tools | Lighting  

Action: Opens dialog 

Usage: The Edit Point/Spot Lights... command opens the Light Properties dialog, which 

is used to set lighting attributes for the selected point or spot light. 

�       For more information about lighting, see the Lighting entry in the Modeling chapter. 

Light Properties Dialog Options 

COLOR 

Select the amounts of red, green, and blue that make up the color of the light emitted. 

ATTENUATION TYPE 

Select Constant (light does not fade over distance), Linear (light fades evenly over distance), 

or Quadratic (light fades more quickly as distance from the source increases). 

ATTENUATION FACTOR 

Adjust the factor used by the Linear and Quadratic attenuation settings. 
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ORIGIN 

Adjust X, Z, and Y coordinates for the origin of the light source. 

DIAMETER (POINT LIGHT ONLY) 

Adjust the diameter of the point light sphere. It can be helpful to match the scale of your lights 

to that of the model. 

•       The diameter of a point light does not affect the light that it casts, only its visualization 

and ease of picking. 

ANGLE (SPOT LIGHT ONLY) 

Adjust the spot light's cut-off angle, which is the angle out from the spot light's direction 

beyond which the light ends. 

AXIS (SPOT LIGHT ONLY) 

Adjust the X, Z, and Y vector for the spot light’s direction. 

HEIGHT (SPOT ONLY) 

Adjust the height of the spot light. The height does not affect the light that it casts, only its 

visualization and ease of picking. 

ON/OFF STATE 

Turn the selected light ON or OFF. 

To set point/spot light parameters: 

1. Select the point or spot light you want to edit. 

2. From the Tools menu, point to Lighting, and then select Edit Point/Spot Lights.... The Light 

Properties dialog appears. 

3. Make the changes you want to the various settings. 

� To exit without saving changes, click Cancel. 

4. Click OK to complete the operation. 

Edit Properties... 

Window: ModelSpace 

Menu: Edit Object 

Action: Opens dialog 

Usage: The Object Properties dialog is used to edit the size and location of the selected 

object. 
 

To edit object properties: 

1. Select the object you want to edit. 

2. From the Edit Object menu, select Edit Properties. The Object Properties dialog appears. 

� The editable properties that appear depend on the type of object selected. 
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� If more than one object is selected, only those editable properties that are shared are 

available to be edited. In addition, if the shared properties of the selected objects differ, you 

must check Value Override within the property that you are editing in order to effect a 

change. For example, if you want to change the diameter of two selected cylinders of differing 

diameters, you must: Select both cylinders, open the Edit Properties dialog, open the 

Diameter tab, check the Value Override box, and then enter a new value. The diameters of 

both cylinders are changed to reflect the new value regardless of their original values. 

3. Make the changes you want to the size, position, or other properties of the selected object. A 

transparent preview object appears in the ModelSpace View. 

� If the selected object supports the use of parts tables, you may make selections from the 

Table and Item fields. See the Modeling chapter for more information on parts tables. 

4. Click Apply to apply the changes and continue in the Object Properties dialog. 

5. Click on Close to close the Object Properties dialog. The dialog is closed. 

Edit Properties (Limit Box Manager) 

Window: Limit Box Manager 

Menu: View 

Action: Executes command 

Usage: The Edit Properties command displays the Object Properties dialog for the selected 

limit box. 

Note:    This dialog differs from the Object Properties dialog accessed through the 

ModelSpace Edit Object menu because it only displays the properties of the selected 

limit box in the Limit Box Manager even if other objects in the ModelSpace are currently 

selected. 

Edit Redlines... 

Window: ModelSpace 

Menu: Tools | Redlining 

Action: Opens dialog 

Usage: The Redlines dialog is used to manage and load saved redlines. 
Redlines Dialog Buttons 

LOAD 

Loads the selected redline.  

�       Redlines are tied to a specific viewpoint. Loading a redline restores the viewpoint from 

which it was created. When the viewpoint changes, the redline is no longer visible. 

�       Loading a redline will toggle on Redline mode, allowing you to add to the loaded redline. 

�       The currently loaded redline set is denoted by "(active)" next to the name in the redline list. 
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�       You can only load redlines that were created in the current ModelSpace View. 

DELETE 

Deletes the selected redline. 

�       The active Redline set cannot be deleted. 

RAISE 

Move the selected redline one position higher in the list. 

LOWER 

Move the selected redline one position lower in the list. 

Edit Snap to Object Threshold... 

Window: ModelSpace 

Menu: Edit Object | Handles 

Action: Opens dialog 

Usage: The Set Handle Snapping dialog is used to set the distance at which handles snap 

to selected objects. 

�       For more information on using handles, see the Handles entry in the Modeling chapter. 

To set the Snap to Object threshold: 

1. From the Edit Object menu, point to Handles, and then select Edit Snap to Object 

Threshold.... The Set Handle Snapping dialog appears. 

2. In the Snap Handle to Object Threshold field, enter a value for the distance at which a 

handle snaps to a selected object. 

3. Click OK. The threshold is set. 

Editor... 

Window: Scan Control 

Menu: Scanner Control | Script 

Action: Opens dialog 

Usage: The Editor command launches the Scanner Script window, which is used to 

manage all scanner scripting functions. 
Scanner Script Window Commands 

SCRIPT MENU COMMANDS 

Insert... 

Insert the contents of a saved script. 
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Save 

Save the contents of the current script. 

RECORD MENU COMMANDS 

Targeted Scan 

Record the target position and scanner settings to the current script. 

Scan Around Picked Point 

Record a detailed scan to the current script at a user-specified size and spacing 

around a 3D point picked in the connected ModelSpace viewer. 

Targeted Image (HDS3000, ScanStation, and ScanStation 2 only) 

Record the target image and settings to the current script. 

CONTROL MENU COMMANDS 

Start 

Run the current script. 

Stop 

Stop the currently running script. 

Pause 

Pause the currently running script. 

Scanner Script Dialog 
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A.  Script menus. 

B.  Run Script. 

C.  Pause Script. 

D.  Stop Script. 

To add a targeted scan to the current script: 

1. In the Scan Control window, set the target box and scan settings you want to add to the 

current script. 

2. From the Record menu in the Scanner Script window, select Targeted Scan. 

To insert a saved script into the current script: 

1. From the Script menu in the Scanner Script window, select Insert.... The Select a Script 

dialog appears, displaying a list of saved scripts. 

2. Select the script you want to insert, and then click OK. The saved script is inserted into the 

Scanner Script window at the current cursor location. 

To scan around a picked point: 

1. From the Scan Control window, select Open ModelSpace Viewer or click Open Viewer to 

open a ModelSpace viewer. 

2. In the ModelSpace, pick the point around which you want to scan. 

3. From the Record menu in the Scanner Script window, select Scan Around Picked Point. The Scan 

Around Pick Point dialog appears. 

4. Make the desired adjustments, and then click OK. The scan is added to the script. 

� The Horizontal and Vertical Extent settings represent the size of the area around the pick 

that you want to scan. 

� The Horizontal and Vertical Points settings represent the number of lines to be scanned and 

the number of points that you want in each line of the scan. 

Elbow Connectors 

Window: ModelSpace 

Menu: Tools | Piping 

Action: Executes command 

Usage: The Elbow Connectors command connects two selected pipes that do not 

necessarily have intersecting centerlines. 

To connect pipes with an elbow: 

1. Pick a point on the first pipe near the end you want connected. 

2. Multi-select the second pipe near the end that you want connected. 

3. From the Tools menu, point to Piping, and then select Elbow Connectors. The pipes are 
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connected. 

Elevation 

Window: ModelSpace 

Menu: Tools | Measure  

Action: Executes command 

Usage: The Elevation command calculates distance between picked points and the origin 

of the current coordinate system along the current “up” vector. 

To measure elevation: 

1. Pick the point you want to measure. 

2. From the Tools menu, point to Measure, and then select Elevation. The elevation is 

displayed. The results are also displayed in the Output Box, if it is enabled. 

� If multiple points are being measured, the results are displayed in the order in which they were 

picked. 

Elevation Check 

Window: ModelSpace 

Menu: Tools | Registration 

Action: Opens dialog 

Usage: The Elevation Check dialog is used to measure the vertical distance between a QC 

(quality control) point and the cloud points in the vicinity. Use this command after 

Registration to verify that QC points (measured independently) on the ground are 

close in elevation to the neighboring cloud points. 
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Elevation Check Dialog 

 

A.  Import the QC points to check from an ASCII or LandXML file. 

B.  Import the QC points to check from a Leica System 1200 DB-X database. 

C.  Hide QC points with Error less than the Max Elevation Error. 

D.  Calculate the elevation for a selected QC point using a pick point. The Method becomes 

User. 

E.  Reset the selected QC point’s Method to Auto. 

F.  Delete the selected QC point. 

G.  Invoke the Save Report dialog to display information about the elevation check. 

H.  Select Use to include the QC point in the statistics. 
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I.  The statistics for the elevation check. 

J.  Measure the relative elevation of each QC point to the cloud points in the region around that 

QC point. 

K.  A QC point with an Error greater in magnitude than the Max Elevation Error is marked with 

an asterisk in the Error column. 

M.  Compute the difference in elevation between each QC point and the neighboring cloud points. 

N.  Close the dialog. 

Enable 

Window: Registration 

Menu: Constraint 

Action: Executes command 

Usage: The Enable command activates the selected constraint for use in the registration. 

�       For more information on the registration process, see the Registration entry in the Getting 

Started chapter. 

To enable a constraint: 

1. In either the ScanWorlds’ Constraints or the Constraint List tab, select the constraint you 

want to enable. 

2. From the Constraint menu, select Enable. The constraint is enabled and its status is marked 

as “ON”. 

Enable Dual-Axis Compensator 

Window: Scan Control (ScanStation, ScanStation 2) 

Menu: Scanner 

Action: Executes command 

Usage: When Enable Dual-Axis Compensator is selected, the use of the dual-axis 

compensator is toggled. 
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Enable Output Box 

Window: ModelSpace 

Menu: View 

Action: Executes command 

Usage: When Enable Output Box is selected, all command output from the current 

ModelSpace (e.g., measurement results) is written to the Output Box.  

�       The output box can be viewed at any time by selecting Show Output Box from the View 

menu. If Enable Output Box was checked before you took the measurements, the measurement 

data is displayed in the output box in the order in which the measurements were taken. 

�       See the Show Output Box command for more information. 

Enable Tilt Sensor 

Window: Scan Control (HDS6000) 

Menu: Scanner 

Action: Executes command 

Usage: When Enable Tilt Sensor is selected, the use of the tilt sensor is toggled. 

End Caps 

Window: ModelSpace 

Menu: Edit Object 

Action: Displays submenu 

Usage: Pointing to End Caps displays submenu commands used to add and remove end 

caps of different types. 

The following commands are available from the End Caps submenu: 

Add Flat Cap Closest to Pick, Add Both Flat Caps, Add Semi-Elliptical Head Closest to 

Pick, Add Both Semi Elliptical Caps, Remove Cap Closest to Pick, Remove Both Caps 

Enter Datum... 

Window: ModelSpace 

Menu: Tools | Measure | Datum 

Action: Opens dialog 

Usage: The New Datum dialog is used to enter the X, Y, and Z coordinates for the point 

through which the datum passes. 
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To enter a new datum: 

1. From the Tools menu, point to Measure, and then point to Datum and select Enter Datum. 

The Set Datum Point dialog appears. 

2. Enter values for the X, Y, and Z coordinates, and then click OK. The datum is reset to pass 

through that point, perpendicular to the horizontal plane. 

Exclusion Volume 

Window: ModelSpace 

Menu: Tools 

Action: Displays submenu 

Usage: Pointing to Exclusion Volume displays submenu commands used to create and 

manipulate an exclusion volume. 

�       An exclusion volume is an object that encloses and replaces other objects in the 

ModelSpace. It is typically used to contain clouds of points for which you need only a rough 

approximation of the volume occupied. 

The following commands are available from the Exclusion Volume submenu: 

Create, Disassemble, Collapse, Minimize, Keep Collapsed 

Exit 

Window: Navigator 

Menu: File 

Action: Executes command 

Usage: The Exit command shuts down the Cyclone program, including any open windows. 

Explode 

Window: ModelSpace 

Menu: Create Object 

Action: Executes command 

Usage: The Explode command creates individual components from a selected object. 

To explode an object: 

1. Select the object that you want to explode. 

� You can multi-select objects for explosion. 

2. From the Create Object menu, select Explode. The selected object is broken up into 
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components that can be selected and manipulated individually. 

� Extrusions are broken up into patches. 

� Polylines are broken up into line segments. 

� Mesh contours are broken up into polylines. 

� Merged point clouds are broken up into individual point clouds. 

Export 

Window: ModelSpace, Navigator, Image Viewer 

Menu: File 

Action: Opens dialog 

Usage: The Export to File dialog is used to export images, objects, and point clouds to a 

variety of common graphical, binary, and text file formats, depending on the window 

from which the export is initiated, and on the content of the export. 

Exporting Images 

Images can be exported from Cyclone to a variety of image formats, including JPEG (jpg) and 

Windows bitmaps (bmp) files. Images can be exported from the Navigator and Image Viewer 

windows. 

Exporting Geometric Objects and Point Clouds 

Geometric objects and point clouds can be exported to a variety of text and binary file formats, 

including Leica Geosystems HDS’s binary file format, Cyclone Object Exchange (COE), which 

preserves more object information during the import/export process than other file formats. For 

information on the COE import/export features, see the COE for AutoCAD and COE for 

MicroStation chapters. Geometric objects and point clouds can be exported from the ModelSpace 

and Navigator windows (ModelSpace or ModelSpace View only). 

Exporting Ortho Images 

Ortho images can be exported from Cyclone as GeoTIFF files accompanied by TWF and TFW 

parameter files. Ortho images can be exported from the ModelSpace window. 

To export an ortho image: 

1. Using orthographic projection, set the viewpoint in the ModelSpace viewer. This viewpoint will 
be used for the ortho image. 

• The ortho image will be centered in 3D on the viewer’s focus point. 

2. Adjust the visualization and graphics options of the ModelSpace View. The ortho image will 
use these settings. 

3. In the File menu, select Export…. The Export to File dialog appears. 

4. In the Export to File dialog, set Save as type to Ortho Image – Tagged Image File Format 
(*.tif) and enter the filename. 

5. Click Save. The Image Size dialog appears. 

6. Enter the ortho image settings and click OK. The ortho image and corresponding TWF and 
TFW files are exported. 
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• Programs that can read and use the additional positional information in the GeoTIFF 
specification will be able to automatically position the ortho image in 2D space. Otherwise, 
refer to the contents of the TWF and TFW parameter files. 

• Programs that can read the TWF and TFW parameter files directly will be able to 
automatically position the ortho image in 2D or 3D space. Otherwise, refer to the contents of 
the files for the parameters. 

Image Size Dialog 

 

A.  Width, Height: The dimensions of the ortho image. 

B.  Keep Aspect Ratio: When checked, changing either the Width or the Height adjusts the 

other dimension proportionately. 

C.  Anti-aliasing Quality: Select the level of anti-aliasing in the ortho image. A higher level helps 

smoothen jagged edges in the image. 

D.  OK: Click to accept the settings and export the ortho image. 

E.  Cancel: Click to cancel this operation. 

Export (Limit Box Manager) 

Window:  Limit Box Manager 

Menu: File 

Action:  Executes command 

Usage: The Export command exports limit boxes to an LBX file. 

�       If there are limit boxes selected, only the selected limit boxes are exported. 
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�       If no limit boxes are selected, all limit boxes in the ModelSpace View are exported. 

Export Calibration Info 

Window: Scan Control, Image Viewer 

Menu: Scan Control: Scanner Control | Camera Calibration 

 Image Viewer: Image | Calibration 

Action: Opens dialog 

Usage: The Export Calibration dialog is used to export camera calibration data to a text 

file. 

�       For a general overview of camera calibration, see the Camera Calibration entry in the 

Scanning with the HDS2500 chapter. 

To export camera calibration info: 

1. The Scanner Control menu, point to Camera Calibration and select Export Calibration 

Info.... The Export Calibration dialog appears. 

2. Type in a file name in the File Name field. 

3. Select a destination folder for the file, and click Save. 

Export Customizations 

Window: Navigator 

Menu: Edit 

Action: Executes command 

Usage: The Export Customizations command saves Cyclone customizations as an XML 

file. 

•       Customizations are modifications you have made to Cyclone’s default toolbars and hotkeys. 

Export Leica System 1200 

Window: ModelSpace 

Menu: File 

Action: Opens dialog 

Usage: The Export Leica System 1200 command is used to export points, lines, and 

meshes to Leica's System 1200 format. 

� This command can be used to transfer existing conditions (e.g., a decimated TIN of a roadway 

scan) to a Total Station as a final “design” for use in stake-out. 
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To export data to Leica's System 1200 format: 

1. From the File menu, select Export Leica System 1200. A folder browser appears. 

2. Select the folder that will contain the exported Leica System 1200 files and click OK. The 

Export Leica System 1200: Data Type dialog appears. 

� Click Make New Folder to create a new folder. 

3. Select the type of data that will be exported. 

� If exporting a mesh, the mesh should have TIN properties relative to the +Z axis. 

4. Click Export. The Export Options Dialog appears. 

5. Configure the Export Options, then click Export. The Leica System 1200 files are written to 

the selected folder. 

Export PCF 

Window: ModelSpace 

Menu: File 

Action: Opens dialog 

Usage: The Export PCF dialog is used to specify the parameters used in the creation of 

Alias PCF (Piping Component File) files that can be imported by Alias Piping 

Solutions software. 

� For more information about Alias Piping Solutions, visit: http://www.alias.ltd.uk 

To export selected objects to PCF: 

1. Multi-select the piping objects to be exported to PCF. 

 Select at least one piping component (e.g., cylinder, flange, valve, etc) in each piping line to 

be exported. Each piping line is exported to a separate PCF file. 

 The components in the selected piping line(s) must have proper Spec, LineID, and SKEY 

values. (See Piping Mode in the Command Reference.) 

2. From the File menu, select Export PCF. The Export PCF dialog appears. 

3. Select the folder that will contain the exported PCF files. 

4. Select the assumed Gasket Thickness. This is used during the export and import to 

introduce a space between adjacent flanges. 

5. Click OK. The selected piping lines are exported to PCF. 

Export Template 

Window: ModelSpace 

Menu: Tools | Drawing  

Action: Opens dialog 

Usage: The Save Edge Template dialog is used to export a 2D drawing for use with the Fit 

Edge command. 

�       See the Fit Edge entry in the Modeling chapter for more information. 
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To export a cross section template: 

1. Using the 2D drawing tools, draw the desired template. Alternately, select an existing (or 

imported) line drawing and use the Create Drawing from Object command to convert the 

object into a 2D drawing (see the Create Drawing from Object entry in this chapter for more 

information). 

2. Before completing the drawing (via the Create Drawing command), point to Tools, and then 

point to Drawing and select Export Template.... The Save Edge Template dialog appears. 

3. Navigate to the desired destination directory, enter a file name in the File name box, and click 

Save. The template is saved. See the Fit Edge command entry in this chapter for information 

on using the saved template. 

Extend 

Window: ModelSpace 

Menu: Edit Object 

Action: Displays submenu 

Usage: Pointing to Extend displays submenu commands used to extend one or more 

objects using other objects as references. 

The following commands are available from the Extend submenu: 

Extend to Last Selection, Extend to Ref Plane, Extend All Objects 

Extend All Objects 

Window: ModelSpace 

Menu: Edit Object | Extend 

Action: Executes command 

Usage: The Extend All Objects command extends the boundary of all selected objects to 

the planar or linear intersection with the other selected objects. 

To extend all objects: 

1. Multi-select the objects that you want to extend. 

2. From the Edit Object menu, point to Extend, and then select Extend All Objects. The 

boundaries of the selected objects are extended to the planar or linear intersection with the 

other selected objects. 

� If they are already overlapping, the boundaries of the selected objects can be retracted to the 

planar or linear intersection with the other selected objects. 
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Extend TIN to Polyline 

Window: ModelSpace 

Menu: Tools | Mesh | Polylines  

 Tools | Mesh | Breaklines 

Action: Executes command 

Usage: The Extend TIN to Polyline command re-shapes a mesh object to include the 

vertices contained in a selected polyline. 

�       The mesh to be extended must qualified to be a TIN. 

To extend a TIN to a polyline: 

1. Multi-select a polyline and the TIN to be extended. 

2. From the Tools menu, point to Mesh, then to Polyline, and then select Extend TIN to 

Polyline. The TIN is redrawn to include the vertices in the polyline, and is moved along the 

“up”direction to create new edges along the polyline. 

To extend a TIN to a breakline:  

1. Multi-select a breakline and the TIN to be extended. 

� Mesh editing can be performed only on a mesh object, as opposed to a point cloud that is 

viewed as a mesh. To create a mesh object from a point cloud, see the Create Mesh entry in 

this chapter. 

2. From the Tools menu, point to Mesh, then to Breakline, and then select Extend TIN to 

Polyline. The TIN is redrawn to include the vertices in the breakline. 

Extend to Last Selection 

Window: ModelSpace 

Menu: Edit Object | Extend 

Action: Executes command 

Usage: The Extend to Last Selection command extends selected objects to intersect with 

a reference object, which is the last object in the multi-selection. 

� This command is useful for creating piping tees or to extend a wall to a floor or ceiling. 

To extend one object to another: 

1. Multi-select the objects that you want to extend, ending with the object that you want to serve 

as the reference object. 

2. From the Extend submenu, select Extend to Last Selection. The selected objects are 

extended to the planar or linear intersection with the reference object. 
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Extend to Ref Plane 

Window: ModelSpace 

Menu: Edit Object | Extend 

Action: Executes command 

Usage: The Extend to Ref Plane command extends selected objects to intersect with the 

active Reference Plane. 

To extend objects to the Reference Plane: 

1. Multi-select the objects that you want to extend. 

2. From the Extend submenu, select Extend to Ref Plane. The selected objects are extended 

to intersect with the Reference Plane. 

Extract Cloud from Selection 

Window: ModelSpace 

Menu: Create Object 

Action: Executes command 

Usage: The Extract Cloud from Selection command creates a point cloud from a mesh 

object using the mesh vertices as points. 

�       This command is active only for mesh objects that have been created from a point cloud as 

opposed to point clouds that are merely viewed as a mesh. See the Create Mesh command for 

more information on creating a mesh object. 

�       This command does not retrieve the original point cloud used to create the selected mesh 

object; rather, it creates a new point cloud which may differ significantly from the original point 

cloud used to create the mesh object. 

� To retrieve the original cloud used to create a mesh object, use the Insert Copy of Object’s 

Points command.  

Extrude 

Window: ModelSpace 

Menu: Edit Object 

Action: Displays submenu 

Usage: Pointing to Extrude displays submenu commands used to create an extrusion 

object from a patch or from a face of an extrusion. 

�       Extrusions are created with a specified thickness along a user-specified axis or along the 

patch’s normal. 
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The following commands are available from the Extrude submenu: 

Extrude Perpendicular..., Extrude to Last Pick, Extrude Along Axis..., Unextrude 

Extrude Along Axis... 

Window: ModelSpace 

Menu: Edit Object | Extrude 

Action: Opens dialog 

Usage: The Extrude Object dialog is used to create an extrusion object along a specified 

axis from a selected patch or a picked face on an extruded object. 
Extrude Along Axis Dialog Options 

AXIS SELECTION 

Select the current X, Y, Z, or Customized axis along which you want to create an extrusion 

object. Selecting Customize uses the axis defined in the Axis Value setting. 

AXIS VALUE 

Define a custom axis along which you want to create an extrusion object. (Changing a value 

here selects Customized in the Axis Selection option.) 

MULTIPLIER 

Enter a factor by which the Axis Value is multiplied to arrive at the actual extrusion. 

To create an extrusion object along a specified axis: 

1. Select the patch or pick the extrusion object face from which you want to create an extrusion 

object. 

2. From the Edit Object menu, point to Extrude, and then select Extrude Along Axis.... The 

Extrude Object dialog appears. 

3. Choose the axis and thickness for the extrusion, and then click OK. The selected patch or 

face is extruded. 

Extrude Perpendicular... 

Window: ModelSpace 

Menu: Edit Object | Extrude  

Action: Opens dialog 

Usage: The Extrude Perpendicular command is used to create an extrusion object 

towards the viewpoint and along an axis perpendicular to a patch or a picked face 

on an extruded object. 

�       This command works with multiple selected patches or extrusion object faces. 
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To create an extrusion object along a perpendicular axis: 

1. Select the patch or pick the extrusion object face from which you want to create an extrusion 

object. 

2. From the Edit Object menu, point to Extrude, and then select Extrude Perpendicular.... The 

Set Extrusion Thickness dialog appears. 

3. Enter a value for the thickness of the extrusion object, and then click OK. The extrusion object 

is created along a perpendicular axis and towards the viewpoint. 

Extrude to Last Pick 

Window: ModelSpace 

Menu: Edit Object | Extrude  

Action: Executes command 

Usage: The Extrude to Last Pick command adds sufficient thickness to a patch or a face 

of an extruded object to reach the last picked point. 

�       This command works with multiple selected patches or extruded object faces. 

To create an extrusion object to a picked point: 

1. Select the patch or extruded object face from which you want to create an extruded object. 

2. Pick a point to define the thickness of the extrusion object. 

3. From the Edit Object menu, point to Extrude, and then select Extrude to Last Pick. The 
extrusion object is created by extruding the selected patch or extrusion object face until the 
“far” face of the extrusion object lies in the same plane as the last picked point. 

Fence 

Window: ModelSpace 

Menu: Edit 

Action: Displays submenu 

Usage: Pointing to Fence displays submenu commands used to clear a fence and to 

segment and delete portions of objects relative to the fence. 

The following commands are available from the Fence submenu: 

Clear, Delete Inside, Delete Outside, Delete Selected Inside, Delete Selected Outside, Set 

From Selection. 

� For more information on working with fences, see the Using a Fence entry in the Modeling 

chapter. 

�  
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Fence/View Toggle 

Window: Scan Control (ScanStation, ScanStation 2, HDS3000, HDS4500, HDS6000) 

Menu: Edit | Modes 

Action: Executes command 

Usage: The Fence/View Toggle command switches between Fence mode and View 

mode. 

� The main purpose of this command is to allow for a single hotkey to toggle between the two 

modes. To assign hotkeys, see the Customize Hotkeys entry in this chapter. 

Field-of-View 

Window: Scan Control 

Menu: Window 

Action: Expands Tab 

Usage: The Field-of-View command expands the Field-of-View tab in the Scanner Control 

Panel. 
Field-of-View Tab Options 

QUICKSCAN 

Click to aim your scanner manually using the scanner’s QuickScan button.  

PRESETS 

Select a preset rectangular or panoramic scan mode from the dropdown. If target settings do 

not match the presets, then it displays "Custom". 

HZ WINDOW 

Displays left and right targeting extents. 

V WINDOW 

Displays top and bottom targeting extents (relative to the scanner’s horizontal plane). 

SCANNER HZ 

Displays the current horizontal orientation of the scanner’s front window . 

Field Setup 

Window: Scan Control (ScanStation, ScanStation 2, HDS6000) 

Menu: Window 

Action: Expands Tab 

Usage: The Field Setup command expands the Field Setup tab in the Scanner Control 

Panel. 
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�       For an overview of the Field Setup process, see the Field Setup (ScanStation, ScanStation 

2)  section in the Scanning with the ScanStation, ScanStation 2 and HDS3000 chapter, or the 

Field Setup (HDS6000) section in the Scanning with the HDS6000 and HDS4500 chapter. 

�       The Field Setup procedure requires an enabled dual-axis compensator (ScanStation, 

ScanStation 2) or enabled tilt sensor (HDS6000). The scanner must be close to level. 

Field Setup Tab Options 

METHOD 

Displays the current method used to determine the position and orientation of the scanner in a 

known or assumed coordinate system.  

RESECTION 

Two or more targets with known or assumed coordinates are acquired to calculate the 

position and orientation of the scanner. 

KNOWN BACKSIGHT 

A target at a known or assumed coordinate is acquired from a scanner position over a 

known or assumed coordinate to calculate the actual position of the scanner. 

KNOWN AZIMUTH (3D POINT) 

The direction to an arbitrary target or a pick point from a scanner position over a known 

or assumed coordinate is entered to calculate the actual orientation of the scanner. 

KNOWN AZIMUTH (AIM) 

The azimuth of the direction towards which the user turns the scanner is entered to 

calculate the actual orientation of the scanner. 

OPTIONS  

Displays a pop-up menu with additional Field Setup operations. 

RECHECK BACKSIGHT… 

Re-acquires the current backsight target to see if the scanner has drifted since the 

backsight was first acquired. 

START TRAVERSE 

Copies the current Field Setup values (e.g., Station ID, Backsight ID, etc.) to the Traverse 

panel. A Traverse can then be performed to extend the initial Field Setup. 

STATION ID 

Displays the ID of the current location of the scanner. 

HI 

The height of the scanner above the ground. 

<, TARGET ID, > 

Selects the target settings to display in the panel. 
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HT 

The height of the target above the known point. 

AZIMUTH 

For Method: Known Azimuth (3D Point), the horizontal angle towards the 3D Point. For 

Method: Known Azimuth (Aim), the direction in which the scanner is aimed. 

X Y Z / N E EL 

The position of the known or assumed coordinate with the matching ID in the Known 

Coordinates ScanWorld. 

TYPE 

The type of the target to be acquired. 

ACQUIRE 

Acquires the target at the current pick point. 

ADD 

For Method: Resection, adds the current target parameters to the Resection (see the 

Resection: Target List dialog below). 

CALCULATE 

Calculates the position and orientation of the scanner based on the entered parameters. For 

Method: Resection, the Resection: Target List dialog appears (see below). For Method: 

Known Azimuth (Aim), the user is first prompted to aim the scanner at the real-world azimuth 

corresponding to the Azimuth. 

APPLY 

For Method: Known Backsight, Known Azimuth (3D Point), and Known Azimuth (Aim), 

sets the ScanWorld Default Coordinate System based on the calculated position and 

orientation of the scanner. 
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Resection: Target List Dialog 

A.  Calculate the position and orientation of the scanner. 

B.  Apply the calculated scanner position to the ScanWorld Default Coordinate System. 

C.  Display the Resection Result ModelSpace to visualize the Resection. 

D.  Invoke the Resection Report, which lists the results of the calculated Resection. 

E.  Set the viewpoint in the Scan Control on the selected target. 

F.  Invoke the Resection Compare Report, which lists differences between the acquired target 

positions relative to the known or assumed coordinates. 

G.  Acquire targets with a check-mark in the Acquire column. With at least two acquired targets, 

the remaining targets can be automatically acquired without requiring a pick point. 

H.  Create a new candidate target in the list. 

I.  Add the new target to the list. 

J.  The ID, position, and height of the scanner and targets. Error is the difference between the 

calculated positions and the known or assumed coordinates. Select Use to include the target in 

the calculation. Select Acquire to mark the target for acquisition, then push the Acquire toolbar 

button. Select the Type of target to be acquired. 

K.  The scanner parameters are displayed at the top of the list. 
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L.  The targets used by the Resection. 

M.  Calculate the position and orientation of the scanner. 

N.  Apply the calculated scanner position to the ScanWorld Default Coordinate System. 

O.  Close the dialog. 

To perform a field setup using resection: 

1. Set up the scanner. Set up at least two targets over known points. 

2. Connect to the ScanStation/ScanStation 2 and enable the dual-axis compensator, or connect 

to the HDS6000 and enable the tilt sensor. 

3. Import or add the known or assumed coordinates, using Add/Replace Coordinate, Import 

Coordinate List, or Import Coordinate List (Leica System 1200). 

4. From the Window menu, select Field Setup. The Field Setup panel appears in the control 

panel. 

5. Select Resection from the Method control. 

6. Select the Station ID from the list, or enter a new ID. 

7. Measure and enter the HI. 

8. Select the Target ID from the list of known coordinates. 

9. Measure and enter the HT. 

10. Select the target Type. 

11. Pick a cloud point on the target over the known point and push Acquire. The backsight is 

acquired. If the target already exists in the ControlSpace, the target need not be re-acquired. 

12. Push the Add button to add the target to the resection target list. 

13. Add at least one other target. 

14. Push the Calculate button to invoke the Resection: Target List dialog. 

15. In the Resection: Target List dialog, push the Calculate button. The position of the scanner 

is calculated. 

16. Optionally, Create and Add additional targets over known points for a more robust resection. 

Re-acquire targets with high Error, or exclude them from the calculation by turning OFF the 

Use checkbox. 

17. Push the Apply button to set the ScanWorld Default Coordinate System based on the 

resection calculation. 

To perform a field setup using a known backsight: 

1. Set up the scanner over a known point. Set up a target over another known point. 

2. Connect to the ScanStation/ScanStation 2 and enable the dual-axis compensator, or connect 

to the HDS6000 and enable the tilt sensor. 

3. Import or add the known or assumed coordinates, using Add/Replace Coordinate, Import 

Coordinate List, or Import Coordinate List (Leica System 1200). 

4. From the Window menu, select Field Setup. The Field Setup panel appears in the control 

panel. 

5. Select Known Backsight from the Method control. 

6. Select the Station ID from the list. 
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7. Measure and enter the HI. 

8. Select the Target ID from the list of known coordinates. 

9. Measure and enter the HT. 

10. Select the target Type. 

11. Pick a cloud point on the target over the known point and push Acquire. The backsight is 

acquired. If the target already exists in the ControlSpace, the target need not be re-acquired. 

12. Push the Calculate button to compute the actual relation of the current setup to the known or 

assumed coordinates. 

13. Push the Apply button to set the ScanWorld Default Coordinate System based on the 

calculation. 

To perform a field setup using a known azimuth or bearing to a 3D point: 

1. Set up the scanner over a known point. Set up a target. 

2. Connect to the ScanStation/ScanStation 2 and enable the dual-axis compensator, or connect 

to the HDS6000 and enable the tilt sensor. 

3. Import or add the known or assumed coordinates, using Add/Replace Coordinate, Import 

Coordinate List, or Import Coordinate List (Leica System 1200). 

4. From the Window menu, select Field Setup. The Field Setup panel appears in the control 

panel. 

5. Select Known Azimuth (3D Point) from the Method control. 

6. Select the Station ID from the list. 

7. Measure and enter the HI. 

8. Select the Target ID from the list, or enter a new ID. 

9. Measure and enter the HT. 

10. Measure and enter the Azimuth (or bearing) from the scanner to the target. 

11. Select the target Type. 

11. Pick a cloud point on the target over the known point and push Acquire. The backsight is 

acquired. If the target already exists in the ControlSpace, the target need not be re-acquired. 

� Optionally, a pick point may be used, without acquiring a target. 

12. Push the Calculate button to compute the actual orientation of the scanner towards the 

target’s (or pick point’s) position. 

13. Push the Apply button to set the ScanWorld Default Coordinate System based on the 

calculation. 

To perform a field setup using a known azimuth or bearing of the scanner: 

1. Set up the scanner over a known point. Set up a target. 

2. Connect to the ScanStation/ScanStation 2 and enable the dual-axis compensator, or connect 

to the HDS6000 and enable the tilt sensor. 

3. Import or add the known or assumed coordinates, using Add/Replace Coordinate, Import 

Coordinate List, or Import Coordinate List (Leica System 1200). 

4. From the Window menu, select Field Setup. The Field Setup panel appears in the control 

panel. 

5. Select Known Azimuth (Aim) from the Method control. 

6. Select the Station ID from the list. 

7. Measure and enter the HI. 
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8. Measure and enter the Azimuth (or bearing) of the scanner to a direction in the world. 

9. Push the Calculate button. Turn the scanner in the correct direction and push the QuickScan 

button on the scanner. The actual orientation of the scanner towards the target’s (or pick 

point’s) position is computed. 

10. Push the Apply button to set the ScanWorld Default Coordinate System based on the 

calculation. 

Fill Selected Hole (Mesh) 

Window: ModelSpace 

Menu: Tools | Mesh 

Action: Executes command 

Usage: The Fill Selected Hole command replaces gaps in a mesh with triangles. 

No new vertices are added. Triangles are created using the existing vertices that form the 

boundaries of the hole. 

�       Mesh editing can be performed only on a mesh object, as opposed to a point cloud that is 

viewed as a mesh. To create a mesh object from a point cloud, see the Create Mesh command. 

To fill selected holes: 

1. Select a hole in the mesh object to be filled. 

� To select a hole, click the border of the hole. 

2. From the Tools menu, point to Mesh, and then select Fill Selected Hole. The selected hole 

is filled in with the least number of triangles using existing vertices along the border of the 

hole. 

Fill Selected Hole (Patch) 

Window: ModelSpace 

Menu: Edit Object | Patch 

Action: Executes command 

Usage: The Fill Selected Hole command fills a hole in a selected patch. 

To fill a hole in a selected patch: 

1. Pick a point on the patch near the hole you wish to fill. You may also draw a fence around the 

hole. 

2. From the Edit Object menu, point to Patch, and then select Fill Selected Hole. The selected 

hole is filled. 
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Find High/Low Point 

Window: ModelSpace 

Menu: Tools | Measure | Find High/Low Point 

Action: Opens dialog 

Usage: The Find High/Low Point dialog is used to locate the highest or lowest point in a 

point cloud within a specified area around a picked point. Vertices can be created 

when high/low points are found. 

 

To find a high/low point: 

1. In a point cloud, pick a point near which you want to find a high or low point. 

2. From the Tools menu, point to Measure, and then select Find High/Low Point. The Find 

High/Low Point dialog appears. The points within the search range are highlighted, and the 

highest point along the “up” axis is displayed by default. 

3. Continue searching for high/low points. When finished, click Close. 

� To search for the low point within the current search range, select Low Point. 

� To increase/decrease the search range (an invisible sphere around the pick point), use the 

Search Range slider or enter a value directly. 

� To reset the search using the current high/low point as the center of the search range, click 

Pick Point. 

� To create a vertex at the current high/low point, click Create Vertex. 

Fit Edge 

Window: ModelSpace 

Menu:  Object 

Action: Opens dialog 

Usage:  The Fit Edge dialog is used to generate polylines describing a swept edge best-fit to 

a point cloud. 

 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Index 

291 

Fit Edge Dialog 

A.  Open a saved template. 

B.  Save the current template to a file. 

C.  Enter View Mode. 

D.  Enter Seek Mode. 

E.  Enter Drawing Mode. 

F.  Enter Nodal Points Mode. 

G.  Add nodal points to each vertex in the current template. 

H.  Clear the current template and all nodal points. 
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I.   Adjust the radius of the circle drawn to show the scale of the edge. 

J.  Adjust the minimum interval between consecutive samples along the edge. 

K.  Fit the template. 

To fit an edge: 

1. Select a point cloud along which you want to fit an edge. 

� For improved performance, first subselect or segment the points around the curb from the rest 

of the point cloud. 

2. From the Create Object menu, select Fit Edge.... The Fit Edge dialog appears and displays 

the selected point cloud. 

3. Manipulate the viewpoint so that the cross-section is apparent. 

4. Select the Draw Mode icon to draw a 2D template using the selected point cloud as a 

reference. 

� The template is later fit to the surface of the point cloud at intervals and used to determine the 

location of the polyline vertices. The Min Step Size slider determines the minimum interval 

between consecutive samples. A smaller Min Step Size will result in more samples, but may 

take longer to compute. A larger Min Step Size may skip some details, but may be able to 

jump over gaps in the data. 

� For 2D drawing procedures, see the Drawing entry in the Modeling chapter. Also, a complete 

list of the individual drawing commands can be found in the Drawing entry in the Commands 

chapter. 

� Panning and rotating the viewpoint does not move the template, to make it easier to align the 

data with the template. 

� To save a template, click the Save Template icon. (Templates can also be created in the 

ModelSpace using 2D drawing tools and saved via the Export Template command.) 

� To load a saved template, click the Open Template icon. 

5. Click the Nodal Points Mode icon and add nodal points to the 2D template. 

� The nodal points indicate the position at which polylines are created and swept across the 

point cloud in the form of the template. 

� To add a nodal point at each vertex in the template drawing, click the Add Nodal Points icon. 

� Hold the Alt key and click on a nodal point to delete it. 

� To clear the current template including nodal points, click the Clear All icon. 

6. Click Fit to fit the template to the selected point cloud. Preview results are displayed in the 

ModelSpace Viewer, and then the Fit Edge Results dialog appears. 

� To adjust the maximum distance between the polyline and the nearest point on the original 

point cloud, use the sliders. 

� If the preview results are not satisfactory, click Back. The Fit Edge dialog reappears. Adjust 

the template and nodal points as needed. 

7. Click Create. The polylines are created. 
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Fit Fenced 

Window: ModelSpace 

Menu: Create Object 

Action: Displays submenu 

Usage: Pointing to Fit Fenced displays submenu commands to fit a geometric object to a 

fenced point cloud. 

�       The Fit Fenced commands function identically to Fit to Cloud except that only the fenced 

portion of the point cloud is used to calculate the fit (bypassing the need to first segment the point 

cloud). Also, it cannot be used to fit a HDS Target or sphere target.  

�       If any clouds are selected, only the points from selected clouds that lie within the fence are 

used. If no clouds are selected, then any points that lie within the fence are used.  

�       Fitting steel sections additionally requires at least one pick point. See the Steel Section 

command for details. 

Fit to Cloud 

Window: ModelSpace 

Menu: Create Object 

Action: Displays submenu 

Usage: Pointing to Fit to Cloud displays submenu commands to fit a geometric object to a 

point cloud. 

�       To adjust fitting quality tolerances, specify constraints, or fit to parts tables, see the Object 

Properties entry in this chapter. 

The types of objects that can be fit are: 

Patch, Box, Cylinder, Sphere, Cone, Corner, Line Segment, Elbow, Steel Section (For steel 

section details, see the Steel Section command.), HDS Target, Sphere Target (For details on 

HDS Targets or sphere targets, see the HDS Target and Sphere Target commands). 

To fit an object: 

1. From the Object Preferences dialog, enable and set the fitting preferences for the object type 

that you want to fit. See the Object Preferences dialog for details. If no preferences are set, 

objects are simply fit as closely as possible to the selected cloud. 

� Tolerances and constraints must be enabled and set to non-zero values in the Object 

Preferences dialog in order to be active for fitting. 

2. From the Create Object menu, point to Fit to Cloud Options, and toggle ON the type of 

fitting you want to use for the current fit. 

� Tolerances, constraints, and parts tables (see To fit using parts tables following) can be used 
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in different combinations depending on the object type. Some objects do not support one or 

more of the cloud fitting options. 

3. Select the point cloud(s) you want to use to fit a geometric shape. 

� For information on preparing point clouds for modeling, see the Point Cloud Segmentation 

entry in the Modeling chapter. 

� When multiple point clouds are selected, the Multiple Point Cloud Style setting in the Fitting 

tab of the Edit Preferences dialog determines the results. If Fit Single Object (default) is 

selected, the clouds are first merged and then a single object is fit to the resulting merged 

point cloud. If Fit Multiple Objects is selected, an object is fit to each cloud individually. 

4. From the Create Object menu, point to Fit to Cloud, and then select the type of object you 

want to fit. After some computation, the object appears. 

� If the point cloud varies too much from the shape of the object you are trying to create (see 

the Fit Tolerances area of the Object Preferences entry in this chapter), a Fit Quality warning 

message appears and gives you an option to keep or cancel the fit. In this case it may help to 

further refine the point cloud (see the Point Cloud Segmentation entry in the Modeling 

chapter) and retry the fit. 

� Each object has a set of editable constraints (see the Fit Constraints area of the Object 

Preferences entry in this chapter). When used, these constraints define various attributes of 

the fit object. 

� If the shape being fit is a corner, the result is three patches with a vertex at their common 

intersection. When using the Corner command, it is not necessary to segment and fit the 

three planes individually. 

� If the shape being fit is a patch, the Adjust Patch Boundary appears. Use the slider to adjust 

the patch’s polygonal boundary. The closer the slider moves towards Tight Boundary, the 

more rigidly the boundary of the new patch adheres to the points on the edge of the point 

cloud. In some cases this adjustment may necessitate the creation of more than one patch. 

To fit an object using parts tables: 

1. From the Object Preferences dialog, enable and set the constraint and tolerance options for 

the object type that you want to fit. See the Object Preferences dialog for details. 

2. From the Object Preferences dialog, select the Catalog/Parts Table check box, and then 

make a Table selection for each object type that you want to fit. 

� Some objects do not support fitting to parts tables. 

3. From the Object Preferences dialog, enter a value in the Match Table Item Within field. This 

value determines the range of possible table matches that are checked when the item is fit. 

4. From the Create Object menu, point to Fit to Cloud Options, and toggle Show Table 

Matches, Use Fit Constraint, and Check Fit Tolerances ON if you are using those options). 

� Tolerances and constraints can be used along with parts tables in different combinations, 

depending on the object type. Some objects do not support one or more of the cloud fitting 

options. 

5. Select the point cloud(s) you want to use to fit a geometric shape. 

� For information on preparing point clouds for modeling, see the Cloud Segmentation entry in 

the Modeling chapter. 

� When multiple point clouds are selected, the Multiple Point Cloud Style setting in the Fitting 

tab of the Edit Preferences dialog determines the results. If Fit Single Object (default) is 

selected, the clouds are first merged and then a single object is fit to the resulting merged 
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point cloud. If Fit Multiple Objects is selected, an object is fit to each cloud individually. 

6. From the Create Object menu, point to Fit to Cloud, and then select the type of object you 

want to fit. The Select Table Item dialog appears, displaying possible matches. The best 

match is temporarily drawn in the ModelSpace and marked with an asterisk in the dialog. 

� Matches within the Match Table Item Within value are marked with a "+". The Match Table 

Item Within value is initially set to the corresponding value in the Object Preferences. 

� The vs Table column displays the RMS (root mean squared) error of the object's dimensions 

(from the initial fit) compared to the dimension in the table. The vs Cloud column displays the 

standard deviation of point errors relative to the object best-fit using the individual table item's 

dimensions. 

� Any enabled fitting constraints corresponding to parameters from the table are used in the 

initial fitting, but only the selected table entry is used when creating the actual object. 

� To update the dialog’s values, click Refresh. Clicking Refresh also calculates any missing vs 

Cloud values. 

� To edit the range of potential matches, enter a new value in the Match Table Items Within 

field, and then click Refresh. The new range of potential matches is shown. 

7. Select the appropriate part from the list and click OK. The selected parts table item is fit. Note 

that a dimensional Fit Constraint may be overridden by the selected part. 

� If the point cloud varies too much from the shape of the object you are trying to create (see 

the Fit Tolerances area of the Object Preferences entry in this chapter), a Fit Quality warning 

message appears and gives you an option to keep or cancel the fit. In this case it may help to 

further refine the point cloud (see the Cloud Segmentation entry in the Modeling chapter) and 

retry the fit. 

Fit to Cloud Options 

Window: ModelSpace 

Menu: Create Object 

Action: Displays submenu 

Usage: Pointing to Fit to Cloud Options displays submenu commands used to toggle 

various fitting options. 

The following objects and dialogs are available from the Fit to Cloud Options submenu: 

Show Table Matches, Use Fit Constraints, Check Fit Tolerances 

�       For details, see the individual command entries. 
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Flip Selected Edge 

Window: ModelSpace 

Menu: Tools | Mesh 

Action: Executes command 

Usage: When the Flip Selected Edge command is activated, the bisecting line (selected 

triangle edge) of a four-sided polygon (with vertices A-B-C-D) is flipped from A-D to 

B-C, connecting along the opposite diagonal. 

�       Mesh editing can be performed only on a mesh object as opposed to a point cloud that is 

viewed as a mesh. To create a mesh object from a point cloud, see the Create Mesh command. 

To flip the edge of a triangle: 

1. Select the triangle edge to be flipped by clicking on the edge. 

� Notice that the selected line is a “bisector” of a four-sided polygon. By identifying the four 

points of the polygon bisected by the selected line, you can know beforehand what the results 

will be. 

� The edge may be more obvious if viewing the mesh as wireframe. 

2. From the Tools menu, point to Mesh, and then select Flip Selected Edge. The selected edge 

is redrawn. 

Fog 

Window: ModelSpace 

Menu: Tools | Lighting 

Action: Toggles menu item ON/OFF  

Usage: The Fog command toggles the effect of more distant objects appearing dimmer. 

�       When ON, objects that are farther away appear darker, producing a sense of depth. 

Note:    Having Fog ON while modeling may make distant points difficult to see and lead to 
modeling errors. 

From Curves 

Window: ModelSpace 

Menu: Create Object 

Action: Displays submenu 

Usage: Pointing to From Curves displays submenu commands used to create polylines 

and patches from the intersections of selected objects. 

The following commands are available from the From Curves submenu: 

Polyline, Patch 
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From Fence Contents... 

Window: ModelSpace 

Menu: Tools | 2D Extraction 

Action: Executes command 

Usage: The From Fence Contents... command creates a 2D line drawing from the 

contents of a fence. 

To extract 2D lines from the contents of a fence: 

1. Make sure that the ModelSpace is in orthographic projection. (See Orthographic/Perspective 

entry in the Commands chapter.) 

2. Using the rectangular Fence tool, fence the area from which you want to extract 2D lines. 

3. From the Tools menu, point to 2D Extraction, and then select From Fence Contents.... The 

2D drawing is created and displayed in a new window. 

4. Save the new 2D drawing as a CAD file. 

� To save the 2D drawing as a CAD file, select Save as CAD file... from the File menu, and 

then use the browser that appears to select a name and location. 

� The unit of measure in the exported file is scaled to match the current unit of measure in 

Cyclone. 

From Intersections 

Window: ModelSpace 

Menu: Create Object 

Action: Displays submenu 

Usage: Pointing to From Intersections displays submenu commands used to create lines 

and vertices from the intersections of selected objects. 

The following commands are available from the From Intersections submenu: 

Curve, Vertex 

From Pick Points 

Window: ModelSpace 

Menu: Create Object 

Action: Displays submenu 

Usage: Pointing to From Pick Points displays submenu commands used to connect a 

series of picked points with a variety of lines. 

The following commands are available from the From Pick Points submenu: 

Vertex, Line Segment, Polyline, Arc (3 Points on Arc), Arc (Start, Center, End), Cubic 
Spline 
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From Selection in Fence... 

Window: ModelSpace 

Menu: Tools | 2D Extraction 

Action: Executes command 

Usage: The From Selection in Fence... command creates a 2D line drawing from the 

current selection within the rectangular fence. 

To extract 2D lines from a selection: 

1. Make sure that the ModelSpace is in orthographic projection. (See the 

Orthographic/Perspective entry in this chapter.) 

2. Select the object(s) from which you want to extract 2D lines. 

3. Using the rectangular Fence tool, fence the area from which you want to extract 2D lines. The 

fence defines the boundaries of the 2D drawing. 

4. From the Tools menu, point to 2D Extraction, and then select From Selection in Fence.... 

The 2D drawing is created and displayed in a new window. 

5. Save the new 2D drawing as a CAD file or as a new ModelSpace. 

� To save the 2D drawing as a CAD file, select Save as CAD file... from the File menu, and 

then use the browser that appears to select a name and location. 

� The unit of measure in the exported file is scaled to match the current unit of measure in 

Cyclone. 

Front 

Window: ControlSpace, ModelSpace, Registration, Scan Control (ScanStation, 

ScanStation 2, HDS3000, HDS4500, HDS6000) 

Menu: Point Cloud Rendering 

Action: Toggles menu item ON 

Usage: The Front command determines the active side of the estimated surfaces in point 

clouds. 
 
• The command affects the Shaded and One-Sided Point Cloud Rendering modes. 

Get Image 

Window: Scan Control 

Menu: Scanner Control 

Action: Executes command 

Usage: The Get Image command captures an image of the scene from the point of view of 

the currently connected scanner and displays it in the Scan Control window. 

�       This image is useful for determining the field of view of the scanner, as well as for specifying 
the areas of the scene that you want to scan. 
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�       Having a valid image in the Scan Control window is not required for targeting the scanner 
or for scanning. 

To capture an image of the scanner’s point of view: 

1. When using the HDS3000, ScanStation, or ScanStation 2 scanner, specify a target region 

from which to capture an image. For all other scanners, start at step 2. 

2. From the Image menu, select Get Image (or click the Get Image icon ). The image appears in 

the Scan Control window and is saved in the Images folder under the parent ScanWorld. 

� It may take the scanner several seconds to acquire and transfer the image before it is 

displayed. 

Get Preview 

Window: Scan Control (HDS4500, HDS6000) 

Menu: Scanner Control 

Action: Executes command 

Usage: The Get Preview command captures a preview scan of the scene and displays it in 

the Scan Control window. 

�       This preview scan is useful for determining the field of view of the scanner, as well as for 
specifying the areas of the scene that you want to scan. 

Global Color Map 

Window: ModelSpace 

Menu: Edit Object | Appearance  

Action: Toggles menu item ON/OFF 

Usage: The Global Color Map command toggles the use of global color map settings or 

the current individual color map settings. 

� This command affects all point clouds and meshes in the current ModelSpace. 

� For information on adjusting global color map override settings, see the Edit Global Color Map 

command. 

� For an overview of color mapping in Cyclone, see the Color Mapping entry in the Modeling 

chapter. 

Global Texture Map 

Window: ControlSpace, ModelSpace 

Menu: View 

Action: Toggles menu item ON 

Usage: The Global Texture Map command enables the application of texture mapping. 
 
• See the Edit Object | Appearance | Apply Color Map | Image Texture Map command. 
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Grid Settings 

Window: Scan Control 

Menu: Image 

Action: Opens dialog 

Usage: The Grid Settings dialog is used to set horizontal and vertical spacing for grid lines 

as well as the font size for grid line markers. 

Group (Command) 

Window: ModelSpace 

Menu: Edit | Group 

Action: Executes command 

Usage: The Group command creates a link between two or more objects so they can be 

manipulated simultaneously. 

�       Cyclone can group objects of any type. Selecting one object in the group selects the entire 

group. 

Group (Menu) 

Window: ModelSpace 

Menu: Edit 

Action: Displays submenu 

Usage: Pointing to Group displays submenu commands used to add or remove items to 

and from a group. 

The following commands are available from the Group submenu: 

Group, Ungroup, Remove from Group 

Handles 

Window: ModelSpace 

Menu: Edit Object 

Action: Displays submenu 

Usage: Pointing to Handles displays submenu commands used to set display and 

constraint options for handles. 

The following commands, dialogs, and submenus are available from the Handles submenu: 
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Show Handles, Handles Always Visible, Show Rotation Handles, Edit Snap to Object 

Threshold..., Constrain Motion to 

�       For Handle submenu command details, see their individual entries. 

�       For more information on using handles, see the Handles entry in the Modeling chapter. 

Handles Always Visible 

Window: ModelSpace 

Menu: Edit Object | Handles  

Action: Toggles menu item ON/OFF  

Usage: The Handles Always Visible command toggles the constant visibility of handles 

even when hidden from view by an object. 

�       When this command is checked, it allows convenient access to handles that would 

otherwise be hidden from view (behind or inside of objects). 

�       When this command is unchecked, handles that are inside or behind an object are not 

visible and cannot be selected for manipulation. 

�       This command has no effect if Show Handles is OFF. 

�       For more information on using handles, see the Handles entry in the Modeling chapter. 

Hide Point Clouds 

Window: ModelSpace 

Menu: View 

Action: Executes command 

Usage: The Hide Point Clouds command toggles visibility of point clouds. This is 

equivalent to toggling the visibility of point clouds in the Selectable/Visible tab of 

the View Properties dialog. 

Home Position 

Window: Scan Control (HDS6000) 

Menu: Scanner 

Action: Executes command 

Usage: The Home Position command turns the scanner back to its 0-azimuth position. 
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HDS Target 

Window: ModelSpace 

Menu: Create Object | Fit to Cloud 

Action: Opens dialog 

Usage: The HDS Target command fits a vertex at the center of an HDS target. When a 

HDS Target is created, it is added automatically to the ControlSpace as well. 

To fit an HDS target 

1. Segment the point cloud to which you want to fit an HDS tie-point from the surrounding cloud 

points (if any). 

2. Pick near the bright center of the point cloud subset to which you want to fit a HDS Target. 

3. From the Create Object menu, point to Fit to Cloud, and then select Tie-Point. The HDS 

Target dialog appears. 

4. Enter an identifier and a comment in the appropriate fields, and then click OK. A vertex is fit to 

the HDS Target. 

Hide Selected Clouds 

Window: ModelSpace 

Menu: View 

Action: Executes command 

Usage: The Hide Selected Clouds command hides all selected cloud points. 

�       Points hidden using this command can be recovered with the Show Hidden Clouds 

command. 

Hide Unselected Clouds 

Window: ModelSpace 

Menu: View 

Action: Executes command 

Usage: The Hide Unselected Clouds command hides all cloud points in the ModelSpace 

except those that have been selected. 

�       Points hidden using this command can be recovered with the Show Hidden Clouds 

command. 
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Image Info... 

Window: ModelSpace 

Menu: Tools | Info  

Action: Opens dialog 

Usage: The Object Info dialog is used to view available information on the current image. 

Image Resolution 

Window: Scan Control 

Menu: Image 

Action: Displays submenu 

Usage: Pointing to Image Resolution displays submenu commands to select High 

(1024x1024), Medium (512x512), or Low (256x256) resolution for image 

acquisition. 

�       This command does not apply to the HDS2500. 

Import... 

Window: ModelSpace, Navigator 

Menu: File 

Action: Opens dialog 

Usage: The Import From File dialog is used to import images, objects, and point data into 

Cyclone from a variety of common image and text file formats. 

����For instructions on importing COE files into Cyclone, see COE for AutoCAD or COE for 

MicroStation of this manual. 

Note:    Importing a file into a project via the Navigator window generally reconstructs the 

most objects (e.g., ScanWorld with Registration, Scans, ModelSpace with ModelSpace 

View). Importing a file into a ModelSpace recovers only the geometry from that file. 

�       Some ASCII files have pre-established formats and are imported directly into Cyclone; the 

data contained in the files is represented by point clouds or vertices in the resulting ModelSpace. 

Other text files do not import directly. Instead, an Import: ASCII File Format dialog is displayed, 

prompting you to define/map the format of the file so that Cyclone can read (or “parse”) it 

correctly and extract the relevant information. You can either select a pre-defined file format from 

the Format pull-down list, modify an existing file format, or define a new format. 
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Import: ASCII File Format Dialog 

 

 Click the Import icon to imports an ASCII rules file. 

 Click the Export icon to export a rules format to an external ASCII 

rules file (*.afr). 

 Click the Delete icon to remove a previously saved rule from the 

Format list. 

Format Displays previously created ASCII rules formats. 

Click Save As to save the current settings as a format. The newly 

saved format will be displayed in the Format drop-down list box. 

Fixed Width Select this check box to specify that the columns in the file to be 

imported have a fixed width; clear this check box if delimiters are 

used to represent a column break. 

Delimited Select Delimited, and then complete the available options as 

appropriate. You can select one or more delimiters. Type a Text 
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Qualifier (default is quotation mark) which parses as one item 

anything enclosed in it. 

As Point Cloud Select As Point Cloud to import the coordinates in the file as 

points in a point cloud. The reserved point cloud-specific columns 

“Red”, “Green”, “Blue”, “Gray”, “Intensity”, “NormalX”, “NormalY”, 

and “NormalZ” become available. 

Options Click the Options button to customize the ranges used for color 

and intensity when importing as a point cloud. 

# of columns Type how many columns of data are in the file to be imported. 

# Rows to skip Type the number of rows to ignore beginning with row 1 (such as 

header rows). 

Comment Marker Type a comment marker. When the marker entered into this field is 

encountered, everything else after the indicator on that row is 

ignored (not imported). The default is a semi-colon. 

Negative Value Select the format used to specify negative values in the import file. 

Unit of Measure Select the unit of measure used in the import file. 

Create line segments 

between pairs of vertices 

Select this check box to tell Cyclone to draw lines between pairs of 

vertices, which some users may use to aid in the registration 

process. 

Auto Preview Select this check box to automatically update the contents of the 

preview window when settings are changed. Click Preview to 

update the contents of the preview window. 

Preview window Displays the contents of the file to be imported and the impact of 

the different rules imposed upon it. 

To import an ASCII file as vertices: 

1. If you are in the Navigator window, select the Database, Project, ScanWorld, or ModelSpace 

into which you want to import the file. 

2. From the File menu, select Import (for both the Navigator and ModelSpace windows). 

3. In the Files of type field, select All ASCII files (or a specific text file format), then navigate to 

the location of the desired text file, and select the file to be imported. If the text file has a TXT, 

SVY, or XYZ extension, the Import: ASCII File Format dialog is displayed. 

4. If you have pre-defined ASCII file formats available, select the desired format from the 

Format pull-down list and click Import. Otherwise, follow the steps outlined below. 

� Use the Import Rules to a File icon to import *afr files if available. 

5. Select either Fixed Width or Delimited display as appropriate. 

� If you select Delimited, you are offered a variety of delimiter options. Select the delimiter(s) 

used in your file. A delimiter separates one column of data from the next. 

� If you select Fixed Width, an extra row of numbers appears beneath the column headers 

(e.g., 1-10 11-16 17-24), which represents the extents of each column. Click a pair of 

numbers to set the left-most border of that column (note that the first column is adjusted by 

selecting the second column and editing the beginning number). 

� The Number of columns field is populated automatically, based on your display choices in 

steps 3 and 4. You can change this value as necessary. 

6. If you selected Delimited display, enter a value in the Text Qualifier field (default is a 

quotation mark). Anything enclosed within the defined text qualifiers will be parsed as one 
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item. For example, you may have commas set as delimiters, but in certain cases, you may 

want commas to be imported; enclosing the comma in quotation marks will qualify it as “text” 

and when encountered, it is imported as text rather than as a qualifier. 

7. Deselect the As Point Cloud checkbox. The column names reserved for use by point cloud 

import (e.g., “Intensity”) become regular column headings. 

8. Indicate any initial rows (e.g., headers) to be skipped during the import by entering a number 

in the # Rows to skip field. 

9. If you have text in your file to be treated as commentary (hence, to be ignored upon import), 

enter the qualifier in the Treat as Comment field. As soon as the comment qualifier is 

encountered on a line in the file, the rest of the line is ignored. 

10. Select the unit of measure represented by the numbers in your data table using the Unit of 

Measure field. 

11. Check the Create line segments between pairs of vertices option to create line segments 

between consecutive pairs of vertices. 

Note:    The bottom half of the screen allows you to see the results of your 

settings/selections immediately. Columns can be resized as needed, and the dialog 

box can be widened as necessary to view additional columns. 

12. When you are satisfied with the settings, click the Save as button next to the Format field and 

enter a name for this ASCII file format. This makes the format available for future use. 

� To save this format to an external file for use on another machine, click the Export Format to 

a File icon. 

13. To complete the import process, click the Import button. Each coordinate is imported as a 

vertex into the created ModelSpace. The newly created vertices are also placed automatically 

into the ScanWorld's ControlSpace (if importing into an existing or import-created ScanWorld). 

To import an ASCII file as a point cloud: 

See To import an ASCII file as vertices for a description of the process. Additionally, select the As 

Point Cloud checkbox to enable the import of the coordinates in the ASCII file as a single point 

cloud, instead of as individual vertices. 

1. Configure the column headings based on the contents of the ASCII file. 

� If the file specifies a red-green-blue color for each point, assign the “Red”, “Green”, and “Blue” 

headings to the corresponding columns. 

� If the file specifies a grayscale value for each point, assign the “Gray” heading to the 

corresponding column. 

� If the file specifies an intensity for each point, assign the “Intensity” heading to the 

corresponding column. 

� If the file specifies a normal vector for each point, assign the “NormalX”, “NormalY”, and 

“NormalZ” headings to the corresponding columns. 

2. If needed, click the Options button to invoke the Range Options dialog. Configure the 

minimum and maximum valid values for the Color and Intensity (if needed). Values beyond 

the valid ranges are clamped to the nearest minimum or maximum value. Typical values for 

Color are 0-255. Typical values for Intensity can vary by scanner manufacturer. 
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To import an image (graphic) file into Cyclone: 

1. Select the Database or Project into which you want to import the image file, and then select 

Import... from the File menu. 

2. In the Files of type field, select All Image Formats (or select a specific graphical file format), 

then navigate to the location of the file to be imported, and select the file to be imported.  

3. Click Open. The file is imported into Cyclone. 

Import (Limit Box Manager) 

Window:  Limit Box Manager 

Menu: File 

Action:  Executes command 

Usage: The Import command imports saved limit boxes from an LBX file. 

�       The imported limit boxes are appended to the end of the current list. 

�       Limit box names and parameters may be duplicated. 

Import Calibration Info 

Window: Scan Control, Image Viewer 

Menu: Scan Control: Scanner Control | Camera Calibration 

 Image Viewer: Image | Calibration 

Action: Opens dialog 

Usage: The Import Calibration dialog is used to import camera calibration data from a text 

file. 

�       For a general overview of camera calibration, see the Camera Calibration entry in the 

Scanning with the HDS2500 chapter. 

To import camera calibration info: 

1. The Scanner Control menu, point to Camera Calibration and select Import Calibration 

Info.... The Import Calibration dialog appears. 

2. Browse to and select the calibration file. 

3. Click Open. The calibration information is imported and overwrites any existing camera 

calibration information. 
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Import Coordinate List… 

Window: Scan Control (ScanStation, ScanStation 2, HDS6000) 

Menu: Project 

Action: Opens dialog 

Usage: The Import Coordinate List dialog is used to select an ASCII file to import as known 

or assumed coordinates that will be used in the Field Setup or Traverse procedures. 

����    The known or assumed coordinates are saved in the Known Coordinates ScanWorld under 

the current Project. 

����    For more information on Field Setup and Traverse, see the Field Setup (ScanStation, 

ScanStation 2) and Traverse (ScanStation, ScanStation 2) entries in the Scanning with the 

ScanStation, ScanStation 2, and HDS3000 chapter, or the Field Setup (HDS6000) Traverse 

(HDS6000) section in the Scanning with the HDS6000 and HDS4500 chapter. 

To import known or assumed coordinates: 

1. From the Project menu, select Import Coordinate List. The Import Coordinate List dialog 

appears. 

2. Select the text file and click Open.  

� If importing a custom file format, the Import: ASCII File Format dialog appears. Configure the 

correct format and click Import. 

� Each coordinate from the file is added as a vertex with an ID and that position to the Known 

Coordinates ScanWorld. 

Import Coordinate List (Leica System 1200)… 

Window: Scan Control (ScanStation, ScanStation 2, HDS6000) 

Menu: Project 

Action: Opens dialog 

Usage: The Browse For Folder dialog is used to select a folder with a Leica System 1200 

DB-X database to import as known or assumed coordinates that will be used in the 

Field Setup or Traverse procedures. 

����    The known or assumed coordinates are saved in the Known Coordinates ScanWorld under 

the current Project. 

����    For more information on Field Setup and Traverse, see the Field Setup (ScanStation, 

ScanStation 2) and Traverse (ScanStation, ScanStation 2) entries in the Scanning with the 

ScanStation, ScanStation 2, and HDS3000 chapter, or the Field Setup (HDS6000) and 

Traverse (HDS6000) section in the Scanning with the HDS6000 and HDS4500 chapter. 

To import known or assumed coordinates from Leica System 1200 DB-X: 

1. From the Project menu, select Import Coordinate List (Leica System 1200). The Browse 

For Folder dialog appears. 

2. Select the folder containing a Leica System 1200 DB-X database and click OK.  

� Each coordinate in the Leica System 1200 DB-X database is added as a vertex with an ID and 

that position to the Known Coordinates ScanWorld. 
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Import Customizations 

Window: Navigator 

Menu: Edit 

Action: Executes command 

Usage: The Import Customizations command imports Cyclone customizations that have 

been saved as an XML file. 

•       Customizations are modifications you have made to Cyclone’s default toolbars and hotkeys. 

Import Leica System 1200 

Window: Navigator 

Menu: File 

Action: Opens dialog 

Usage: The Browse For Folder dialog opened by this command is used to select a folder 

containing the Leica System 1200 DB-X database to be imported into a Cyclone 

Project or Database. 

� Each Leica System 1200 job in the DB-X database will be imported as a ModelSpace. Points 

in the job will be imported as individual vertices. 

Import Registration... 

Window: Registration 

Menu: Registration 

Action: Opens dialog 

Usage: The Import Registration dialog is used to import one or more Registrations into the 

current Registration for the purpose of constructing a single inclusive Registration. 

�       The import process brings in all the ScanWorlds and constraints of the imported 

Registrations without duplication. 

To import a registration: 

1. From the Registration menu, select Import Registration.... The Select Registration(s) to 

Import dialog appears. The left side of the dialog contains a Navigator pane. 

2. In the Navigator pane, select the existing Registration that you want to add to the new 

Registration-in-progress, and then click the Add icon. The selected Registration appears in 

the right-hand pane. 

� All Registrations must be in the same database. 

3. Continue adding until all of the Registrations that you want to add appear in the right-hand 

window, and then click OK. Each unique ScanWorld from all of the added Registrations is 

added once, and each unique constraint is copied to the current Registration. 
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Increase Point Width 

Window: ControlSpace, ModelSpace, Registration, Scan Control (ScanStation, 

ScanStation 2, HDS3000, HDS4500, HDS6000) 

Menu: Point Cloud Rendering 

Action: Toggles menu item ON 

Usage: The Increase Point Width command increments by one pixel the thickness of each 

cloud point displayed in the ModelSpace View. 

Info (Limit Box Manager) 

Window:  Limit Box Manager 

Menu: Limit Box 

Action:  Executes command 

Usage: The Info command displays the parameters of the selected limit box. 

Info (ModelSpace viewer) 

Window: ModelSpace 

Menu: Tools 

Action: Displays submenu 

Usage: Pointing to Info displays submenu commands used to view information for selected 

objects and windows. 

The following commands and dialogs are available from the Info submenu: 

Object Info, ModelSpace Info, ScanWorld Info 

Info (Scan Control viewer) 

Window: Scan Control 

Menu: Scanner 

Action: Opens dialog 

Usage: The Info dialog displays the current scanner’s name and address. 

Insert 

Window: ModelSpace 

Menu: Create Object 

Action: Displays submenu 

Usage: Pointing to Insert displays submenu commands used to insert a variety of objects. 
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The following objects and dialogs are available from the Insert submenu: 

Vertex, Line Segment, Patch, Box, various Steel Sections, Cone, Cylinder, Sphere, Torus, 

Elbow, Reducing Elbow, Welding Neck Flange, Blind Flange, Concentric Reducer, 

Eccentric Reducer, Valve, Tee, Camera, Info Marker 

�       To edit default insertion parameters or select a default parts table, see the Object 

Preferences command. 

Object Insertion Rules 

�       The first object inserted into an empty scene is inserted at (0, 0, 0). 

�    If there is no selected object and no pick point when an object is inserted, the size and 

alignment of the new object are defined in the Creation/Initial Values area of the Object 

Preferences dialog. The object is located in front of the current view at the focal point. 

�       When an existing object is picked, the picked object provides a plane, direction, and/or 

vertex for the inserted object to base its initial position, orientation, and dimensions. For example, 

a patch readily defines a plane, a direction (plane normal), and a point (origin). The rules can be 

sophisticated (e.g., when inserting an object on a cylinder, picking near the endcap inserts the 

object aligned with the endcap, but picking away from the endcap inserts the object perpendicular 

to the cylinder's surface at the picked point). Exception: cameras are always inserted at the 

current viewpoint regardless of picks. 

�       When inserting a series of objects, the previous object provides a plane, direction, and/or 

vertex for the inserted object to base its initial position, orientation, and dimensions. Using this 

method, it is possible to build a chain of objects, such as a piping run, from scratch. 

�       The inserted object is initially selected with a pick point based on the previous selection. If 

there was no previous selection, a default pick point is provided. 

To insert an object: 

1. Pick an existing object if you want to use it as a reference, or position the ModelSpace 

viewpoint’s focal point where you want the object to appear. 

� To insert parts from a table, enable and specify the part in the Object Preferences dialog 

(see the Object Preferences entry in this chapter), and then toggle the Use Table Parts 

command ON from the Create Object menu. For more information on parts tables, see the 

Using Parts Tables section in the Modeling chapter. 

2. From the Create Object menu, point to Insert, and then select the type of object you want to 

insert. The Insertion Properties dialog appears, and a transparent preview object appears in 

the ModelSpace View. 

3. Make desired changes to the default size, position, color, or other properties of the selected 

object. The preview object is updated to reflect the current settings. 

� If parts tables are enabled for the type of object being inserted, select the desired selections 

from the Table and Item lists. 
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� To move or rotate the object from its current position, use the Move or Rotate commands. 

See the Move/Rotate command entry in this chapter for detailed instructions. 

� To cancel the insertion and close the dialog, click Cancel. 

4. Click Create. The object is inserted. 

Insert Copy of Object’s Points 

Window: ModelSpace 

Menu: Create Object 

Action: Executes command 

Usage: The Insert Copy of Object’s Points command inserts a copy of the points used in 

fitting the selected object. 

�       This command creates new points that are selectable and editable and have no relation to 

the object. 

�       If you only need to view an object’s points, use the Show Object’s Cloud command. 

Insert Point Light... 

Window: ModelSpace 

Menu: Tools | Lighting  

Action: Executes command 

Usage: The Insert Point Light... command inserts a point light in your current ModelSpace 

View. 

�       A point light source emits light in all directions from a 3D point. By default, the light does not 

dim with distance. 

�       The point light is inserted at the current pick point. If there is no pick point, the point light is 

inserted at the current viewpoint. 

�       To customize point light settings, see the Edit Point/Spot Lights command. 

�       For more information about lighting, see the Lighting entry in the Modeling chapter. 

Insert Spot Light... 

Window: ModelSpace 

Menu: Tools | Lighting  

Action: Executes command 

Usage: The Insert Spot Light... command inserts a spot light in the center of your current 

ModelSpace View. 
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�       A spot light emits light within a cone from a 3D point. The centerline of the cone determines 

the direction of the spot light source, and the tip determines the origin. The angle of the cone 

determines the spread of the spot light. 

�       If there is a pick point on an object, the object provides the location, and in most cases, the 

orientation for your spot light. If there is no pick point, the spot light is inserted at the current 

viewpoint. 

�       By default, the light does not dim with distance; the fall-off at the edge of the cone is 

immediate.  

•       To customize spot light settings, see the Edit Point/Spot Lights command. 

�       For more information about lighting, see the Lighting entry in the Modeling chapter. 

Interfering Points... 

Window: ModelSpace 

Menu: Tools | Measure 

Action: Opens dialog 

Usage: The Interfering Points dialog is used to highlight cloud points that are within a 

user-specified distance of a selected object; those points may be segmented from 

the rest of the point cloud. 

To segment interfering points: 

1. From the Tools menu, point to Measure, and then select Interfering Points. The Interfering 

Points dialog appears. 

2. Select the object and any nearby point clouds for which you want to indicate interferences. 

3. Enter a value in the Tolerance Value box, or use the Interference Tolerance slider to 

interactively adjust the distance from the selected object within which points are highlighted. 

The points within the specified tolerance are highlighted in white. 

� If the selected object defines a volume, the points contained inside the object are also 

highlighted. 

� The total number of points within the specified tolerance is displayed in the Interference 

Tolerance field. 

4. Click Segment. The highlighted points are segmented from the rest of the point cloud. 

5. Click Close. The Interfering Points dialog is closed. 

Invert 

Window: ModelSpace 

Menu: Selection | Point Cloud Sub-Selection 

Action: Executes command 

Usage: The Invert command inverts the point cloud selection set. All selected points 

become unselected; all unselected points become selected. 
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Invert Selection 

Window: ModelSpace 

Menu: Selection 

Action: Executes command 

Usage: The Invert Selection command toggles the selection status of every loaded object 

in the ModelSpace. 

�       This command is particularly useful when you want to select all but a few objects, because it 

allows you to first select the objects that you ultimately do not want selected, and then invert the 

selection. 

Isometric 

Window: ModelSpace 

Menu: Viewpoint | Standard Views  

Action: Executes command 

Usage: The Isometric command moves the current viewpoint to the standard isometric 

viewing position vector (-1, -1, 1) at a distance where the entire scene is visible. 

�       The Right Isometric command moves the current viewpoint to the standard isometric 

viewing position vector (1, -1, 1). 

Keep Collapsed 

Window: ModelSpace 

Menu: Tools | Exclusion Volume 

Action: Toggles setting ON/OFF  

Usage: The Keep Collapsed command toggles the setting to keep the sides of the selected 

exclusion volume collapsed to the minimum dimensions needed to enclose its 

contents. 

Keep Viewpoint Upright 

Window: ModelSpace, Registration 

Menu: ModelSpace: Viewpoint 

 Registration: Viewers 

Action: Toggles menu item ON/OFF  

Usage: The Keep Viewpoint Upright command toggles the setting to keep the viewpoint in 

the ModelSpace window upright. 

�       Toggling this option OFF allows you to rotate the viewpoint in any direction. 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Index 

315 

�       Cyclone lets you pan, rotate, and zoom the viewpoint in 3D. However, some users prefer 
not to rotate the view with all three degrees of freedom (roll, yaw, and pitch) turned ON, because 
it is not always clear which way is "up". Keep Viewpoint Upright disables the roll component of 
the viewer. That is, you can rotate left and right, and up and down, but you can’t view a scene 
upside-down. 

�       A scene’s "up" and "down" are defined by the current coordinate system and the Set Up 

Direction submenu. 

�       To reset the “up” direction, see the Set Up Direction command. 

Launch 

Window: ModelSpace 

Menu: File 

Action: Displays submenu  

Usage: Pointing to Launch displays submenu commands used to: open a second viewer 

for the current ModelSpace, copy selected objects to a new ModelSpace, and 

export and view the ModelSpace in a supported 3rd-party application. 

The following commands are available from the Launch submenu: 

Open New Viewer, Copy Selection to New ModelSpace, Copy Fenced to New ModelSpace, 

Update Original ModelSpace, AutoCAD..., MicroStation... 

Layers... 

Window: ModelSpace 

Menu: View 

Action: Opens dialog 

Usage: The Layers... command opens the Layers tab of the View Properties dialog, which 

is used to organize objects into layers. 

�       Layers are user-defined logical groupings of objects that can be used to simplify tasks in a 

crowded ModelSpace.  

�       For an overview of layers, see the Layers entry in the Modeling chapter. 
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View Properties Dialog – Layers Tab 

 

A.  Click to access the other View Properties tabs. 

B.  Check to make the layer’s objects visible. 

C.  Check to make the layer’s objects selectable. 

D.  Check to use the layer’s color for all the layer’s objects. 

E.  Click to use the color picker to choose a color for the layer. 

F.  Create a new layer. 

G. Designate the selected layer as the current layer. Any objects created in the ModelSpace are 

added to the current layer. 
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H.  Create a single new layer from the selected layers. (If one of the layers is the current layer, 

the new merged layer becomes the current layer.) 

I.   Assign the selected objects to the selected layer. 

J.  Select all objects in the selected layer. 

K.  Deselect all objects in the selected layer. 

L.  Delete the selected layer. 

License Manager 

Window: Navigator 

Menu: Help 

Action: Opens dialog 

Usage: This License Manager dialog is used to configure floating licenses for the current 

client. 

Cyclone License Manager Dialog 

 

A.  List of known licenses. 
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B.  Cyclone will attempt to acquire the selected licenses when launched. regardless of the Use 

selections or licenses available. 

C.  Displays the availability of each license. Yes means that there is currently a (valid) license 

available. No means that the license is either invalid or in use by some other client. 

D.  Licenses marked as Yes are floating licenses obtained from the floating license server. No 

means that the license was acquired as a node-locked (non-floating) license. N/A means that the 

license could not be acquired, so it is unknown if the license is floating or not. 

E.  Select to open the next Cyclone session with the Cyclone Viewer only (acquires no licenses), 

F.  Displays a list of current users for the selected licenses. 

G.  When selected, the License Manager does not automatically appear when a new floating 

license is available. 

Lighting 

Window: ModelSpace 

Menu: Tools 

Action: Displays submenu 

Usage: Pointing to Lighting displays submenu commands used to insert, edit, show, or 

hide lights. 

The following commands and dialogs are available from the Lighting submenu: 

Edit Point/Spot Light, Edit Environmental Lights, Insert Point Light, Insert Spot Light, Fog 

�       For more information about lighting, see the Lighting entry in the Modeling chapter. 

Limit Box 

Window: ModelSpace 

Menu: View 

Action: Executes command 

Usage: The Limit Box command creates a boundary beyond which nothing is loaded into 

the ModelSpace View. 

 

Note:    A limit box can be helpful when you want to work on a subset of objects in 

ModelSpace. It can also improve performance because Cyclone does not need to load 

or draw objects outside of the limit box. 
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Tip:      To resize the limit box, click an edge of the displayed limit box to display resizing 

handles. Use the blue handles to move the limit box. Use the orange handles to resize 

the limit box. 

Note:    Limit box parameters may also be edited from the Edit Properties dialog. 

Limit Box On/Off (Limit Box Manager) 

Window:  Limit Box Manager 

Menu: View 

Action:  Executes command 

Usage: The Limit Box On/Off command toggles the use of the limit box in the ModelSpace 

View on or off. 

Limit Box on Viewer 1 

Window:  Registration 

Menu: Viewers 

Action:  Executes command 

Usage: The Limit Box on Viewer 1 command toggles the use of the limit box in Constraint 

Viewer 1 on or off. 

Limit Box on Viewer 2 

Window:  Registration 

Menu: Viewers 

Action:  Executes command 

Usage: The Limit Box on Viewer 2 command toggles the use of the limit box in Constraint 

Viewer 2 on or off. 

Line Segment 

Window: ModelSpace 

Menu: Create Object | From Pick Points  

Action: Executes command 

Usage: The Line Segment command creates line segments that connect a series of picked 

points. 

To create a line segment 

1. Pick two points. 

2. From the Create Object menu, point to From Pick Points, and then select Line Segment. 
The line segment is created. 
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Load Image 

Window: Scan Control 

Menu: Image 

Action: Executes command 

Usage: The Load Images command is used to load previously captured camera images 

into the current Scan Control window. 

� This command does not apply to the HDS2500. 

Load Points within Fence 

Window: Scan Control (ScanStation 2, HDS4500, HDS6000) 

Menu: Scanner Control 

Action: Executes command 

Usage: The Load Points within Fence command is used to load only those points in the 

current ScanWorld’s partially-imported scans that fall within the fence. 

�       The command can be used to selectively view a subset of the entire scan without having to 

load the entire scan, which can take a significant amount of time. For example, use this command 

to load only the region of the partially-imported scan that includes a black/white target. 

To load points within the fence: 

1. Perform a scan that is only partially imported (see the ScanStation 2: Max # Points Auto-
Imported and HDS4500/HDS6000: Max # Points Auto-Imported preferences in the Scan 
tab of the Edit Preferences dialog). 

2. Set the fence to cover the area to be loaded. A larger region may take more time to load. 

3. From the Scanner Control menu, select Load Points within Fence. The points in the 
fenced region are loaded. 

• A new scan is created from each partially-imported scan that overlaps the fence. 

• The points within the fence are fully loaded without subsampling. 

Load Points within Fenced Selection 

Window: Scan Control (ScanStation 2, HDS4500, HDS6000) 

Menu: Scanner Control 

Action: Executes command 

Usage: The Load Points within Fenced Selection command is used to load only those 

points in the current ScanWorld’s partially-imported scans that fall within the fence 

and that are also selected in the Scan Control. 

�       The command can be used to selectively view a subset of the entire scan without having to 

load the entire scan or parts of other scans, which can take a significant amount of time. For 
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example, use this command to load only the region of the partially-imported scan that includes a 

black/white target. 

To load points from selected clouds within the fence: 

1. Perform a scan that is only partially imported (see the ScanStation 2: Max # Points Auto-
Imported and HDS4500/HDS6000: Max # Points Auto-Imported preferences in the Scan 
tab of the Edit Preferences dialog). 

2. Set the fence to cover the area to be loaded. A larger region may take more time to load. 

3. Select the point cloud(s) to be considered for loading. 

4. From the Scanner Control menu, select Load Points within Fenced Selection. The points 
in the fenced region are loaded from the selected scans. 

• A new scan is created from each selected, partially-imported scan that overlaps the fence. 

• The points within the fence are fully loaded without subsampling. 

Lower Active Cutplane 

Window: ModelSpace 

Menu: Tools | Cutplane  

Action: Executes command 

Usage: The Lower Active Cutplane command lowers the Cutplane by the amount 
specified in the Cutplanes dialog offset parameter (see the Add/Edit Cutplanes 
command). 

 

Make Available Offline 

Window: Navigator, ModelSpace 

Menu: Navigator: Tools 

 ModelSpace: File 

Action: Executes command 

Usage: The Make Available Offline command finds any data referenced by the selected 
object and copies that data into the selected object’s database, ensuring that all 
data in the selected object can be accessed even if the original database is 
unavailable. 

�       This procedure is relevant only for point clouds whose data reside on another database 

(e.g., a ModelSpace created in database “A” that has been reference-copied to database “B”).  

�       If you attempt to open a ModelSpace when the original database (or the source server) is 

inaccessible and you have not run this command, you will receive an error message if the point 

cloud data cannot be accessed. Use of this command gives you the option of creating a back-up 

database on a local drive so that work can continue without needing to access the original 

database. 

Note:    Executing this command may increase the size of the selected object’s database. 
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Make Circular... 

Window: ModelSpace 

Menu: Edit Object | Patch 

Action: Opens dialog 

Usage: The Make Circular command is used to make the selected patch circular while 

attempting to preserve the general dimensions of the original patch. 

�       The program uses a circumscribing circle (all of the patch's vertices are contained within the 

smallest possible circle). 

To make a patch circular: 

1.  Select the patch you want to make circular. 

2.  From the Edit Object menu, select Make Circular.... The Number of Sides dialog appears. 

3.  In the Number of Sides field, enter the number of sides you want to use to create a circular 

patch, and then click OK. The patch is transformed. 

�       This command can be used to create various geometric shapes with equilateral sides. 

Entering 3 creates a triangle, entering 4 creates a square, entering 5 creates a pentagon, etc.. 

Make Rectangular 

Window: ModelSpace 

Menu: Edit Object | Patch 

Action: Executes command 

Usage: The Make Rectangular command makes the selected patch rectangular, while 

attempting to preserve the general dimensions of the original patch. 

�       All of the original patch's vertices are contained within the smallest possible rectangle. 

To make a patch rectangular: 

1. Select the patch you want to make rectangular. 

2. From the Edit Object menu, select Make Rectangular. The patch is made rectangular. 

Manage... 

Window: Scan Control | Script 

Menu: Scanner Control 

Action: Opens dialog 

Usage: The Manage command launches the Scanner Scripts window, which is used to 

view, add, and delete scanner scripts. 
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Measure 

Window: ModelSpace 

Menu: Tools 

Action: Displays submenu 

Usage: Pointing to Measure displays submenu commands used to save, edit, and take 

various measurements. 

The following commands, submenus, and dialogs are available from the Measure submenu: 

Edit Measurements..., Save Measurements, Clear Temporary Measurement, Distance, 

Datum, Elevation, Angle, Back Angle, Centerline Length, Piping Takeoff, Surface Area, 

Volume, Mesh Volume submenu, Interfering Points, Mesh to Points Deviations, Contours 

to Mesh Deviations, Find High/Low Point 

Merge 

Window: ModelSpace 

Menu: Create Object 

Action: Executes command 

Usage: The Merge command combines two or more selected objects into one object. 

�       If the objects were created from point clouds, the merged object is refit to the original point 

clouds. 

�       Objects of different types cannot be merged. 

�       This command is useful for merging point clouds, especially after many segmenting and 

cutting operations. 

�       This command can be used to merge contour lines as well as objects, provided that the 

contours have compatible properties (e.g., same major and minor elevations).  

�       Merging fills in space between the merged objects, in the process of creating the new 

object. Use this command to create objects such as wide floors and ceilings or long pipes. This 

feature is particularly useful when filling areas not scanned directly. 

To merge objects: 

1. Multi-select the objects that you want to merge. 

2. From the Create Object menu, select Merge. The objects are merged, and the new object 

appears. 

To merge contour lines: 

1. Multi-select contour lines with similar properties that you want to merge.  

Note:    You cannot merge contour lines within the same point cloud. 

2. Select Merge from the Create Object menu. The contour lines are merged into one entity. 

Note:    Use the Edit Properties dialog (Edit Object | Edit Properties...) to modify contour 
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line properties, as well as contour label properties. 

Merge from ModelSpace... 

Window: ModelSpace 

Menu: File 

Action: Opens dialog 

Usage: The Select ModelSpace to Merge dialog combines two ModelSpaces. 

This command may be used to incorporate changes made in another ModelSpace. 

To merge ModelSpaces: 

1. Open the target ModelSpace (the ModelSpace into which you want to merge). 

2. From the File menu, select Merge from ModelSpace.... The Select ModelSpace to Merge 

dialog appears. 

3. Navigate to the object ModelSpace (the ModelSpace that want to merge into the target 

ModelSpace), and click Open. The ModelSpaces are merged. 

� Each object in the object ModelSpace now appears in the current target ModelSpace (even if 

some of the objects are identical to objects that already exist in the target ModelSpace). 

� Objects that were duplicated via the Launch | Copy Selection to New ModelSpace 

command are overwritten by the copy of the object in the ModelSpace from which you are 

merging. 

� The default data coordinate systems are used; any user coordinate systems are ignored when 

merging the ModelSpaces. To take user coordinate systems into account, use the 

Copy/Paste ModelSpace Viewer commands instead. 

Merge Sub-Scans 

Window: Navigator 

Menu: Tools 

Action: Executes command 

Usage: The Merge Sub-Scans command combines all sub-scans within the selected 

ScanWorld. This command applies to HDS3000, ScanStation, and ScanStation 2 

scans. 

����   To adjust the limit above which new sub-scans are created, use the 

HDS3000/ScanStation/ScanStation 2: Max # Points/Sub-Scan preference in the Scan tab of 

the Edit Preferences dialog. 

Note:    When working on a project that includes multiple large scans, it may be more efficient 

to merge sub-scans while subsequent scans are being captured. 
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Mesh 

Window: ModelSpace 

Menu: Tools 

Action: Displays submenu 

Usage: Pointing to Mesh displays submenu commands, submenus, and dialogs used to 

create and manipulate mesh objects. 

The following commands and submenus are available from the Mesh submenu: 

Create Mesh..., Decimate Mesh, Delete Selection, Fill Selected Hole, Add Face, Move 

Vertex, Flip Selected Edge, Polylines, Breaklines, Optimize Mesh, Verify TIN. 

Mesh to Points Deviations... 

Window: ModelSpace 

Menu: Tools | Measure 

Action: Opens dialog 

Usage: The Mesh to Points Deviations... command compares the faces in the selected 

mesh object with the points in the selected point cloud (or originating point cloud if 

no point cloud is selected), and uses the data to calculate deviations in accordance 

with user defined parameters. 

To calculate mesh to point cloud deviation: 

1. Select the mesh object whose deviation from the original point cloud you wish to measure. 

� It is recommended that you view the mesh in “Per-Face Normals” mode before executing the 

Mesh to Points Deviations... command. See the View Objects As entry in this chapter for 

more information. 

2. Select the point cloud for which to take the deviation measurements. If no point cloud is 

selected, the point cloud originally used to create the mesh is used. 

3. From the Tools menu, point to Measure, then select Mesh to Points Deviations.... 

Initialization commences, which culminates with the display of the Deviation Analysis dialog. 

4. Use the slider bar to set the threshold on which to measure deviations. As the slider is moved, 

the graphical display is adjusted continually to highlight only those triangles with deviations 

from the point cloud that fall above the threshold. 

Note:    The Minimum and Maximum fields are read only, and indicate the range for which 

deviations can be measured. 

5. Select whether to highlight faces based on Maximum or Average deviation, and whether to 

use Absolute values (no positive or negative distances) or Signed distances. 

Note:    Deviation analysis results are displayed in the Details field. 

6. When finished, click OK. The Deviation Analysis dialog is closed. 
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MicroStation... 

Window: ModelSpace 

Menu: File | Launch 

Action: Opens dialog 

Usage: The MicroStation... command launches the current ModelSpace View in 

MicroStationΕ2 using the Cyclone Object Exchange (COE) intermediary 

functionality. 

�       When this command is initiated, objects in the current ModelSpace View are first transferred 

to a COE file, which is then loaded into MicroStation. See COE for MicroStation for information on 

working with COE files. 

�       Before executing this command, it is important to verify that MicroStation and Leica 

Geosystems HDS's COE Data Transfer for MicroStation are properly installed on your 

workstation. 

To launch MicroStation from a ModelSpace View: 

1. From the File menu, point to Launch, and then select MicroStation. 

� You may be prompted to locate the MicroStation executable (USTATION.EXE). If this occurs, 

navigate to the folder containing the file and select it. 

2. If you want to open an existing file, navigate to the appropriate folder and select the desired 

file; if you are opening a new drawing, enter a new file name. 

3. Click Open. MicroStation is launched. 

� You can open a temporary file by clicking CANCEL; a file will be created in your system’s 

TEMP directory. To save any work done in a temporary file, be sure to save your drawing from 

MicroStation. 

Minimize 

Window: ModelSpace 

Menu: Tools | Exclusion Volume  

Action: Executes command 

Usage: The Minimize command orients and shrinks the sides of the selected exclusion 

volume to the minimum dimensions required to enclose its contents. 
 

To minimize the volume of an exclusion volume:  

1. Select the exclusion volume. 

2. From the Tools menu, point to Exclusion Volume, and then select Minimize. The exclusion 

volume is oriented and collapsed to the minimum volume required to contain its original 

contents. 
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Minimize (Limit Box Manager) 

Window:  Limit Box Manager 

Menu: View 

Action:  Executes command 

Usage: The Minimize command resizes the limit box to the minimum volume required to 

contain the currently selected objects (if any) or to contain all objects (if there is no 

selection).  The orientation of the limit box is adjusted as required to produce the 

minimum possible volume. 

Minimize Limit Box 

Window: ModelSpace 

Menu: View 

Action: Executes command 

Usage: The Minimize Limit Box command resizes the limit box to the minimum volume 

required to contain the currently selected objects (if any) or to contain all objects (if 

there is no selection). The orientation of the limit box is adjusted as required to 

produce the minimum possible volume. 

�       To obtain the minimum possible limit box size without changing limit box orientation, use the 

Collapse Limit Box command 

Miter Connectors... 

Window: ModelSpace 

Menu: Tools | Piping 

Action: Displays dialog 

Usage: The Miter Connectors... command displays the Number of Miter Segments 

dialog, which is used to determine the number of segments to be used to connect 

two selected pipes with a mitered elbow connector. 

To create a mitered elbow connection: 

1. Pick a point on the first pipe near the end you want connected. 

2. Multi-select the second pipe near the end that you want connected. 

3. From the Tools menu, point to Piping, and then select Miter Connectors.... The Number of 

Miter Segments dialog appears. 

4. Enter the number of sweep segments you want to represent the elbow and click OK. The 

mitered elbow appears. 
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ModelSpace 

Window: Navigator 

Menu: Create 

Action: Executes command 

Usage: The ModelSpace command creates a new ModelSpace in the selected location. 

�       A ModelSpace can be created in a database, project directory, or ScanWorld. 

�       The contents of the ModelSpace are determined by the settings in the Initialization tab 

within the Edit Preferences dialog. See the Preferences command. 

To create a new ModelSpace: 

1. In the Navigator window, select the database, ScanWorld, or Project into which you want to 

add a new ModelSpace. 

2. From the Create menu, select ModelSpace. The ModelSpace is created in the selected 

container. 

ModelSpace Info 

Window: ModelSpace 

Menu: Tools | Info  

Action: Opens dialog 

Usage: The ModelSpace Info dialog is used to view available information on the current 

ModelSpace. 

�       The type of information varies with the contents of the ModelSpace. 

�       When the Automatically Update box is checked, the ModelSpace information changes 

when the ModelSpace changes. If the box is unchecked, the contents of the ModelSpace Info 

dialog do not change. 

ModelSpace View 

Window: Navigator 

Menu: Create 

Action: Executes command  

Usage: The ModelSpace View command creates a new ModelSpace View for the selected 

ModelSpace. This command is active only when an existing ModelSpace is selected 

in the Navigator window. 

�       Views created using this command are stored in the ModelSpace folder from which they 

were created. 
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�       Multiple views can be created from the same ModelSpace using this command. 

�       ModelSpace View names can be changed; right click on the ModelSpace View in the 

Navigator window, select Rename, then type in the new name. 

ModelSpaceViews 

A ModelSpace View is a collection of settings applied to a ModelSpace, including the initial 

viewing position and settings for graphical viewing parameters that override the object’s default 

parameters. Multiple ModelSpace Views can be saved and restored for a given ModelSpace to 

provide ready access to particular aspects of a ModelSpace, or to provide a custom modeling 

environment for a modeler in a large, multi-person project.  

All changes made to objects within the ModelSpace are immediately reflected in all of the 

ModelSpace’s Views. Multiple users may share a single view; one user's changes to the shared 

View are visible to the other users of that View.  

� To save ModelSpace Views, use the Save View As dialog. 

 Note:  The View must be saved at least once before changes to the View are made persistent 

and before the View is available to other users. 

� To restore saved ModelSpace Views, use the Switch to Views dialog or open them from the 

Navigator window. 

To open a saved ModelSpace View: 

1. From the View menu, select ModelSpace Views.... The Switch to View dialog appears. 

2. From the list of saved ModelSpace Views, select the ModelSpace View you want to restore. 

3. Click OK. The selected ModelSpace View replaces the current view. 

Window: ModelSpace 

Menu: Edit Object 

Action: Opens dialog 

Usage: The Move/Rotate dialog is used to rotate selected objects or move selected objects 

a specified distance along a specified axis. 

Mouse Modifiers 

Window: ControlSpace, ModelSpace, Scan Control (ScanStation, ScanStation 2, 

HDS3000, HDS4500, HDS6000) 

Menu: Edit 

Action: Displays submenu 

Usage: Pointing to Mouse Modifiers displays submenu commands used to toggle the 

effects of certain keyboard and mouse buttons. 
 
• The following modifiers are available from the Mouse Modifiers submenu: 
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Shift Key, Ctrl Key, Alt Key, Right Button, Middle Button 

• While toggled ON, the corresponding key or mouse button is considered to be pushed when 
the primary (left) mouse button is clicked. 

• Mouse Modifiers have no effect on keyboard hotkeys. 

Move/Rotate... 

Window: ModelSpace 

Menu: Edit Object 

Action: Opens dialog 

Usage: The Move/Rotate dialog is used to rotate selected objects or move selected objects 

a specified distance along a specified axis. 

To rotate selected objects: 

1. Select the object(s) you want to move. 

2. From the Edit Object menu, select Move/Rotate.... The Move/Rotate dialog appears. 

3. Select the Rotate tab. A graphical indicator appears in the ModelSpace viewer to illustrate the 

rotation angle and axis at the current settings. 

� If multiple objects are selected, each object receives a unique identifier (such as Cylinder 1, 

Cylinder 2, etc.) to aid in differentiating objects and points on those objects. 

� Significant points (i.e., the end points of a cylinder) as well as current and subsequent pick 

points are numbered and displayed on the selected objects. These numbers can be used as 

references to move objects. 

� If multiple objects are selected, you may specify a subset of the selected objects to be 

affected by the move from the Apply to list. 

4. Click the arrow icon to the right of the Axis of Rotation row. The Axis of Rotation subdialog 

appears. 

5. Specify the axis around which you want to rotate using the available axes, points or picks, and 

then click OK. The Axis of Rotation subdialog closes. 

6. Click the arrow icon to the right of the Center of Rotation row. The Center of Rotation 

subdialog appears. 

7. Specify the center point around which you want to rotate using the available points or picks, 

and then click OK. The Center of Rotation subdialog closes. 

8. From the Rotate tab, click the arrow icon to the right of the Angle of Rotation row. The 

Angle of Rotation subdialog appears. 

9. Specify the angle you want to rotate using the available axes, points or custom values, and 

then click OK. The Angle of Rotation subdialog closes. 

10. Click Rotate. The object is rotated according to the specified axis, center, and angle. 

� To rotate the object from its new position according to the current settings, click Rotate again. 

11. When you are finished rotating the object, click Close to exit the dialog. 
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To move selected objects: 

1. Select the object(s) you want to move. 

2. From the Edit Object menu, select Move/Rotate. The Move/Rotate dialog appears, and a 

graphical indicator appears in the ModelSpace viewer to illustrate the move axis and offset of 

the current settings. 

� If multiple objects are selected, each object receives a unique identifier (such as Cylinder 1, 

Cylinder 2, etc.) to aid in differentiating objects and points on those objects. 

� Significant points (i.e., the end points of a cylinder) as well as current and subsequent pick 

points are numbered and displayed on the selected objects. These numbers can be used as 

references to move objects. 

� If multiple objects are selected, you may specify a subset of the selected objects to be 

affected by the move from the Apply to list. 

3. Click the arrow icon to the right of the Direction of Move row. The Direction of Move 

subdialog appears. 

4. Specify the direction for the move using axes, points or picks, and then click OK. The 

Direction of Move subdialog closes. 

5. Click the arrow icon to the right of the Distance of Move row. The Distance subdialog 

appears. 

6. Specify the direction for the move using points, picks, or custom distance, and then click OK. 

The Distance subdialog closes. 

7. Click Move. The object is moved the specified distance along the specified axis. 

8. When you are finished moving the object, click Close to exit the dialog. 

Move Vertex 

Window: ModelSpace 

Menu: Tools | Mesh 

Action: Executes command 

Usage: The Move Vertex command translates the selected vertex from its initial position to 

a new position within a mesh. 

�       Mesh editing can be performed only on a mesh object, as opposed to a point cloud that is 

viewed as a mesh. To create a mesh object from a point cloud, see the Create Mesh command. 

To move a vertex: 

1. To select the vertex to be moved, pick a point on the mesh near the vertex you wish to move. 

2. Multi-select the point to which you want to move the vertex. 

� If the destination point is another vertex, select a point on the mesh near the target vertex. 

To move the vertex to a point on another object, pick a point on that object. 

3. From the Tools menu, point to Mesh, and then select Move Vertex. The vertex is translated 

to either the target vertex or the picked point on another object. 
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Move Viewpoint 

Window: ModelSpace 

Menu: Viewpoint 

Action: Displays submenu 

Usage: Pointing to Move Viewpoint displays submenu commands used to move your 

viewpoint 90 degrees to the left, right, up, or down while maintaining your point of 

focus. 

�       To rotate your point of focus, see the Turn Viewpoint command. 

The following commands are available from the Move Viewpoint submenu: 

Left, Right, Up, Down 

Multi-Pick Mode 

Window: ModelSpace 

Menu: Edit | Modes 

Action: Executes command 

Usage: The Multi-Pick Mode command enters Multi-Pick mode and selects the Multi-Pick 

mode cursor. 

� Multi-Pick mode is used to select multiple objects without holding SHIFT. 

Multi-Pick/View Toggle 

Window: ModelSpace 

Menu: Edit | Modes 

Action: Executes command 

Usage: The Multi-Pick/View Toggle command switches between Multi-Pick mode and 

View mode. 

� The main purpose of this command is to allow for a single hotkey to toggle between the two 

modes. To assign hotkeys, see the Customize Hotkeys entry in this chapter. 

New (Limit Box Manager) 

Window: Limit Box Manager 

Menu: Limit Box 

Action: Executes command 

Usage: The New command creates a new limit box and automatically sizes it to the objects 

selected in the ModelSpace. The new limit box is aligned to the current UCS axes. 
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�       If no objects are selected, the new limit box is auto-sized to all objects in the ModelSpace. 

�       If more than one pick point is present, the limit box is initialized to the minimum bounding 

box of the pick points. This is useful for quickly isolating cloud data with a few picks. 

New Scanner Position 

Window: Scan Control 

Menu: Project 

Action: Executes command 

Usage: The New Scanner Position command resets the Scan Control window settings and 

prepares a new ScanWorld for the next scan. 

To reset for a new scanner position: 

1. After repositioning the scanner (or if you simply want to scan into a new ScanWorld), select 

New Scanner Position from the Project menu. 

� The New Scanner Position command is also available as the New Position button in the 

control panel on the right-hand side of the Scan Control window. 

2. The following occur automatically: 

� A new ScanWorld is prepared within the same project to contain the subsequent scans and 

images acquired from the scanner. 

� The current image in the Scan Control window is cleared. 

� If an attached ModelSpace viewer (opened from the Scan Control window to view incoming 

scan data) is open, it is detached and a new one is opened; the previous ModelSpace viewer 

remains open. 

Object Coordinate System 

Window: ModelSpace 

Menu: Edit Object | Handles | Constrain Motion to 

Action: Executes command 

Usage: The Object Coordinate System command constrains the movement of objects 

relative to the specified axis of the coordinate system defined by the object itself. 

�    For more information on using user coordinate systems, see the Save/Edit Coordinate 

Systems command. 

�       Some handles may not be able to move according to the constraints (e.g., rotation and 

other custom handles). 

�    For more information on using handles, see the Handles entry in the Modeling chapter. 
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Object Info... 

Window: ModelSpace 

Menu: Tools | Info  

Action: Opens dialog 

Usage: The Object Info dialog is used to view available information on the selected object. 

�       The type of information displayed depends on the type of object selected. 

To view object information: 

1. Select the object(s) about which you want information. 

2. From the Tools menu, point to Info and then select Object Info. The Object Info dialog 

appears. 

� When more than one object is selected, information is displayed for each object in its own 

Object Info dialog. 

� When the Automatically Update box is checked, the object information changes when the 

object changes. If the box is unchecked, the contents of the Object Info dialog for that object 

do not change. 

3. Click Close. 

Object Info... (Navigator Window) 

Window: Navigator 

Menu: View 

Action: Opens dialog 

Usage: The Object Info command displays relevant information for the selected object 

(ModelSpace, ScanWorld, Registration, Database, etc.). 

�       The information displayed varies, depending on the type of object selected. 

Object Preferences... 

Window: Navigator, ModelSpace 

Menu: Edit 

Action: Opens dialog 

Usage: The Object Preferences dialog is used to set catalog/parts table, fit tolerances, fit 

constraints, picking and object creation/initial value preferences. 

�       For an overview of fitting and inserting objects using tolerances, constraints, and tables, see 

the Modeling chapter.) 
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Object Preferences Dialog Options 

General Settings 

OBJECT TYPE 

Select the type of object for which you want to adjust default properties. Each type of object 

has a unique set of editable properties, which appear when the object is selected in the 

Object Type field. 

LEVEL 

Select User Default, Session, or View. The User Default preferences are restored the next 

time Cyclone is run. Session preferences are in effect until Cyclone is closed, and are applied 

whenever a new ModelSpace View is created. View preferences affect the current 

ModelSpace View only. 

DEFAULTS 

Reset the selected object type's preferences in the dialog to the hard-wired settings. 

Auto-Picking 

•       Select the Automatically Pick checkbox to enable auto-picking, and then make a selection 

from the drop-down list, which displays points that can be automatically picked for the selected 

object type. 

Catalog/Parts Table Settings 

����For more information on parts tables, see the Using Parts Tables section in the Modeling 

chapter. 

•       Select the Catalog/Parts Table checkbox to enable table control. The table control lists the 

known tables for the selected object type. 

TABLE 

Select the appropriate table for the selected object type. 

ITEM 

Select the desired part from the selected table. This is the default part used in insertion; it has 

no bearing on fitting to a cloud. 

MATCH TABLE WITHIN 

Enter a value to determine the range of possible table matches that are evaluated and marked 

when an item is fit. 

Fit Tolerances Settings 

•       Select the Fit Tolerances checkbox to access tolerance settings for the selected object 

type and enable fit tolerances for use in fitting objects. 
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�       If a fit that you are trying to make is beyond one or more of these limits, a warning message 

appears. 

MEAN ERROR 

Assign a value for the maximum allowable mean of the signed point-to-surface distances for 

all points. The sign of the distance depends on which side of the surface the point lies. 

STD DEVIATION 

Ass ign  a  va lue  f o r  t he  maximum allowable s tandard  dev ia t ion  o f  t he  signed 

point-to-surface distances. 

MEAN ABSOLUTE ERROR 

Assign a value for the maximum allowable mean of the unsigned point-to-surface distances for 

all points. 

ABSOLUTE STD DEVIATION 

Ass ign  a  va lue  f o r  t he  maximum allowable s tandard  dev ia t ion  o f  t he  unsigned 

point-to-surface distances. 

MAXIMUM ABSOLUTE ERROR 

Assign a value for the maximum allowable unsigned distance between a point and the 

surface. 

Fit Constraints Settings 

•       Select the Fit Constraints checkbox to access constraint settings for the selected object 

type and enable fit constraints for use in fitting objects. 

�       Each constraint may be Unspecified, Initial, or Fixed. The value of an Unspecified 

constraint is found by the fitting algorithm. An Initial value can help the fitter as a hint of what the 

value might be. The fitter uses a Fixed constraint as the final value of that parameter. 

�       The editable fitting constraints vary for each object type. 

Creation/Initial Values Settings 

•       Select the Creation/Initial Values checkbox to access and enable creation and initial 

values settings for the selected object type. 

�       All object types support the optional setting of various default parameters for use when an 

object of that type is inserted. Some values may be overridden by the operation that creates the 

object. 

�       Most object types support a default Insulation Thickness, to represent insulation on piping, 

spray-on fire retardant on a steel section, etc., where the dimensions of the object are augmented 

by the thickness of the insulation or other such covering. The insulation thickness is accounted for 
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when inserting, fitting, and editing an object. When displaying the object's attributes, as text or 

graphically, the dimensions are shown with the additional insulation thickness. 

To edit object preferences: 

1. From the Edit menu, select Object Preferences. The Object Preferences dialog appears. 

2. Select the object type you want to edit from the Object Type field. 

� Preferences that are not supported by the selected object type are disabled. 

3. Select the level at which your changes take effect. 

� To select a level, select User Default, Session, or View from the Level drop-down list (see 

Level following). The View level is not available when the dialog is opened from the Navigator 

window. 

4. Click the check box next to each preference you wish to enabled when fitting, creating, or 

picking objects, and then click OK. 

� To accept current changes and continue editing preferences for other object types, click 

Apply. 

One-Sided 

Window: ControlSpace, ModelSpace, Registration, Scan Control (ScanStation, 

ScanStation 2, HDS3000, HDS4500, HDS6000) 

Menu: Point Cloud Rendering 

Action: Toggles menu item ON/OFF 

Usage: The One-Sided command toggles the hiding of cloud points estimated to be on 

surfaces facing away from the viewer. 
 
• Only point clouds with valid surface normal vector estimates respond to the One-Sided 

render mode. 
• The Point Cloud Rendering | Front and Point Cloud Rendering | Back commands affect 

which side is hidden. Front hides points on surfaces facing the original scanner. Back hides 
points on surfaces facing away from the original scanner. 

Open 

Window: Navigator 

Menu: File 

Action: Executes command 

Usage: The Open command launches the selected ModelSpace View, Registration, 

ControlSpace, scan, or image in a new window. 

�       Individual scans can be viewed in a read-only ModelSpace environment using the Open 

command. In order to edit ModelSpace data, you must create and open a new ModelSpace View. 
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Open ModelSpace Viewer 

Window: Scan Control 

Menu: Scanner 

Action: Executes command 

Usage: The Open ModelSpace Viewer command opens a new ModelSpace viewer for the 

incoming scan data. 

�       This ModelSpace is created in the ScanWorld chosen as your destination with the Select a 

ScanWorld... command. 

�       The incoming point cloud being acquired is visible in this ModelSpace viewer, but is not 

selectable until the scan operation is completed or canceled. 

Open New Viewer 

Window: ModelSpace 

Menu: File | Launch 

Action: Executes command  

Usage: The Open New Viewer command launches a new viewer on the current 

ModelSpace View. 

�       Use this command to view the same ModelSpace View from a different viewpoint. 

Open Temporary ModelSpace View 

Window: Navigator 

Menu: File 

Action: Executes command  

Usage: The Open Temporary ModelSpace View command creates and opens a 

ModelSpace View for the selected ModelSpace. Unless it is saved, the ModelSpace 

View is deleted when closed. 

Optimize 

Window: Navigator 

Menu: Tools 

Action: Executes command 

Usage: The Optimize command performs general consistency checking, updating, and 

reorganizing of the selected object. Different objects in the Navigator optimize 

differently. 
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�       Optimizing can improve loading, browsing, and editing speed. 

Note:    Depending on the size and complexity of the object being optimized, this operation 

can be time consuming. 
Note:    When a database from an older version of Cyclone is optimized, a new ControlSpace 

is created for each ScanWorld. These ControlSpaces are populated with scanned HDS 
Targets and all objects used in registration constraints. 

Optimize Cloud Alignment 

Window: Registration 

Menu: Cloud Constraint 

Action: Executes command 

Usage: The Optimize Cloud Alignment command is used to adjust cloud constraint 

alignments for use in global registration. 

�    For more information on the cloud registration process, see the Cloud Registration entry in the 

Registration chapter. 

To optimize cloud alignments: 

1. From the Constraint List tab, select the cloud constraints to be optimized. 

2. From the Cloud Constraint menu, select Optimize Cloud Alignment. A progress dialog 

appears and displays an estimate of percentage completed and a continuously updated error 

histogram. 

� To set the optimization parameters, see the Cloud Reg Subsampling Percentage and 

Cloud Reg Max Iterations parameters in the Preferences entry in this chapter. 

� To display the continuously updated error histogram (a histogram of the error between each 

point and its closest overlapping surface), click Details. 

� To interrupt the optimization, click Stop. A confirmation dialog appears. Select Stop 

Immediately to stop and discard any results for the current optimization. The state of the 

cloud constraint is marked as not aligned; the cloud constraint must still be aligned before use 

in global registration. Select Stop Cleanly to stop the optimization and save the latest 

alignment with the cloud constraint. Select Don't Stop to continue the alignment optimization. 

3. When the optimization is complete, the Optimize Cloud Alignment Results dialog appears 

and displays results and error statistics for each cloud constraint alignment. 

� Cloud constraints that need further adjustments before use in global registration are 

highlighted. 

� If any alignment searches are halted by the Cloud Reg Max Iterations preference (see the 

Preferences entry in this chapter), a warning dialog appears. 

� If any alignment is underconstrained, (e.g., two scans of a plane in which the alignment could 

be translated along the plane without changing the quality of alignment), a warning dialog 

appears. This case may still be usable for global registration, but the alignment should be 

inspected and additional constraints should be added if possible. 
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Optimize Mesh 

Window: ModelSpace 

Menu: Tools | Mesh 

Action: Executes command 

Usage: The Optimize Mesh command may speed up working with meshes that have been 

subject to substantial editing (e.g., deleting and adding faces, moving vertices, filling 

holes, etc.) in the ModelSpace View. 

�       Mesh editing can be performed only on a mesh object, as opposed to a point cloud that is 

viewed as a mesh. To create a mesh object from a point cloud, see the Create Mesh command. 

To optimize a mesh object: 

1. Select the mesh object to be optimized. 

2. From the Tools menu, point to Mesh, and then select Optimize Mesh. 

Orthographic/Perspective 

Window: ModelSpace 

Menu: Viewpoint 

Action: Toggles menu item 

Usage: The Orthographic/Perspective command toggles the ModelSpace View from 

Perspective to Orthographic. 

�       In orthographic projection, parallel lines remain parallel, though perceived angles may 

change. It may be difficult to determine relative depth, but this view is often preferred by 

architects and engineers in top-down or side views. The real world, however, is viewed in 

perspective. 

�       In perspective projection, parallel lines may converge and relative depth may be easier to 

visualize. The real world is viewed in perspective. 

Pan (Lock) 

Window: ModelSpace 

Menu: Viewpoint | View Lock 

Action: Toggles option ON/OFF 

Usage: The Pan command toggles the ability to pan in View mode, which allows you to 

slide the viewpoint vertically or horizontally within the viewer. 

�       When ON, you cannot pan the viewpoint. 
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Pan (Reference Plane) 

Window: ModelSpace 

Menu: Tools | Reference Plane  

Action: Toggles option ON/OFF 

Usage: The Pan command toggles the pan function in Drawing mode, which allows you to 

interactively position the active Reference Plane’s origin within the plane without 

changing its orientation. 
 

To pan the Reference Plane: 

1. From the Tools menu, point to Reference Plane, and then select Pan (or click the Pan icon ). 

You are now in Drawing mode. The cursor changes to the Drawing Tool cursor and the Pan 

function is ON. 

2. In the ModelSpace, drag the Drawing Tool cursor to set the origin of the active Reference 

Plane. 

3. Release the mouse button. The Reference Plane is moved. 

Panoramic 

Window: Scan Control 

Menu: Scanner Control | Set Fence 

Action: Executes command 

Usage: Pointing to Panoramic displays submenu commands used to select a preset 

panoramic fence size. 

�       This command does not apply to the HDS2500. 

The following preset panoramic fences are available from the Panoramic submenu: 

360 x 40, 360 x 60, 360 x 80, 360 x 90, Target All 

Panoramic Rectangle Fence Mode 

Window: Scan Control 

Menu: Edit | Modes 

Action: Executes command 

Usage: The Panoramic Rectangle Fence Mode command enters Panoramic Rectangle 

Fence mode and selects the Panoramic Rectangle Fence mode cursor. 

�       This command does not apply to the HDS2500. 
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To draw a panoramic fence: 

1. From the Edit menu, point to Modes, and then select Panoramic Rectangle Fence Mode. 

The Panoramic Rectangle Fence cursor appears. 

2. Drag the cursor around the area you want to fence. 

� Drag up/down to define the vertical bounds of the fence. 

� Drag clockwise to define a fence initialized at 0 degrees. 

� Drag counter-clockwise to define a fence initialized at 360 degrees. 

Panoramic Scan Mode 

Window: Scan Control (HDS4500, HDS6000) 

Menu: Scanner Control 

Action: Executes command 

Usage: Pointing to Panoramic Scan Mode displays submenu commands used to select 

the scanning mode used for 360-degree scans. Face 1 Scan makes the scanner 

scan from the front, performing a full 360-degree turn. Face 1 and 2 Scan makes 

the scanner scan from both sides simultaneously, performing a 180-degree turn. 

The following panoramic scan modes are available from the Panoramic Scan Mode submenu: 

Face 1 Scan, Face 1 and 2 Scan 

Parallel 

Window: ModelSpace 

Menu: Edit Object | Align  

Action: Executes command 

Usage: The Parallel command aligns the one or more objects so that their axes are parallel 

to a reference object. 

To make objects parallel: 

1. Multi-select the objects you want to make parallel. 

� The last object selected is the reference object (the one to which the other aligns). 

2. From the Edit Object menu, point to Align, and then select Parallel. The objects are rotated 

to make their axes parallel to the axis of the reference object. 

� This command is useful when modeling walls of a room in order to make sure opposite pairs 

are parallel. 

� The shortest rotation possible is used to align the objects, so objects may end up pointing in 

opposite directions, though parallel. 
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Paste 

Window: ModelSpace, Navigator 

Menu: Edit 

Action: Executes command 

Usage: The Paste command pastes the contents of the Cyclone clipboard into the selected 

location. 

�       Objects pasted into a ModelSpace maintain their location and orientation relative to the 

current coordinate system in the destination ModelSpace. 

Note:    The Navigator's clipboard behaves differently from the ModelSpace clipboard; when 

Copy is selected, the selected object is marked for copying; however, it is not actually 

copied until you initiate the Paste command. Additionally, you have a choice to create a 

Full Copy or a Reference. The reference copy does not include point clouds or large 

numbers of image files. 

Paste Link 

Window: Navigator 

Menu: Edit 

Action: Executes command 

Usage: The Paste Link command pastes a link to an item on the Cyclone clipboard in the 

selected location. 

�       Links are intended to make navigation easier. They allow you to create a shortcut to any 

Project, ScanWorld, ModelSpace, or Image, as well as allowing you to reference any object in 

multiple places. 

To create a link: 

1. Select the Project, ScanWorld, ModelSpace, or Image to which you want to link. 

2. From the Edit menu, select Copy. 

3. Select a location for the link. 

� Links can be pasted into ScanWorlds, Scans, ModelSpaces, and Projects. 

4. From the Edit menu, select Paste Link. The link appears in the selected location. 

� Links are identical to their source object, and renaming a link also renames the source 

object.  

� Links can only be pasted into the same database as the source object 
 Note:  If you have copied multiple selections and then use the Paste Link command, only 

the last object selected is linked. 
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Paste Reference 

Window: Navigator 

Menu: Edit 

Action:  Executes command 

Usage:  The Paste Reference command is used to paste an object (e.g., a point cloud) with 

references to the point cloud’s data in the source database, saving time and space 

by avoiding duplication of data.  

�       When the destination database needs to access the point cloud's data, the data is retrieved 
from the source database (or another database that has that information; the database that has 
the data must be accessible on the client's local server). 

Patch 

Window: ModelSpace 

Menu: Create Object | From Curves 

Action: Executes command 

Usage: The Patch command creates a patch from a series of selected lines or curves. 

To create a patch from intersecting curves: 

1. Select a sequence of lines or curves that form the outline of the patch you want to create. 

� The lines or curves must be selected in a consistently clockwise or counter-clockwise order. 

2. From the Create Object menu, point to From Curves, and then select Patch. The patch is 

created. 

Patch (Submenu) 

Window: ModelSpace 

Menu: Edit Object 

Action: Displays submenu 

Usage: Pointing to Patch displays submenu commands used to edit a selected patch. 

The following commands, dialogs, and submenus are available from the Patch submenu: 

Make Rectangular, Make Circular..., Subtract, Fill Selected Hole 
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Pause 

Window: Scan Control (ScanStation, ScanStation 2, HDS3000, HDS6000) 

Menu: Scanner Control 

Action: Executes command 

Usage: The Pause command pauses the current scanner operation (scan or image 

acquisition). Push the Resume button to continue the operation, or the Stop button 

to discontinue the operation. 

Perpendicular 

Window: ModelSpace 

Menu: Edit Object | Align  

Action: Executes command 

Usage: The Perpendicular command aligns one or more selected objects so that their axes 

are perpendicular to a reference object. 

To make objects perpendicular: 

1. Multi-select the objects you want to make perpendicular. 

� The last object selected is the reference object (the one to which the others align). 

2. From the Edit Object menu, point to Align, and then select Perpendicular. The objects are 

rotated to make their axes perpendicular to the axis of the reference object. 

Perspective/Orthographic 

Window: ModelSpace 

Menu: Viewpoint 

Action: Toggles menu item 

Usage: The Perspective/Orthographic command toggles the ModelSpace View from 

Orthographic to Perspective. 

�       In perspective projection, parallel lines may converge and relative depth may be easier to 

visualize. The real world is viewed in perspective. 

� In orthographic projection, parallel lines remain parallel, though perceived angles may 

change. It may be difficult to determine relative depth, but this view is often preferred by 

architects and engineers in top-down or side views. The real world, however, is viewed in 

perspective. 
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Pick Mode 

Window: ModelSpace, Registration, Scan Control 

Menu: ModelSpace: Edit | Modes 

Registration: Edit | Modes 

ScanControl: Viewers 

Action: Executes command 

Usage: The Pick Mode command enters Pick mode and selects the Pick mode cursor. 

�       Pick mode is used to select and interact with objects. 

Pick/Multi-Pick/View 

Window: ModelSpace 

Menu: Edit | Modes 

Action: Executes command 

Usage: The Pick/Multi-Pick/View command cycles between Pick mode, Multi-Pick mode 

and View mode. 

 

� The main purpose of this command is to allow for a single hotkey to cycle through the modes. 

To assign hotkeys, see the Customize Hotkeys entry in this chapter. 

Pick/View Toggle 

Window: ModelSpace 

Menu: Edit | Modes 

Action: Executes command 

Usage: The Pick/View Toggle command switches between Pick mode and View mode. 

�       The main purpose of this command is to allow for a single hotkey to toggle between the two 

modes. To assign hotkeys, see the Customize Hotkeys command. 

Pipe Modeling... 

Window: ModelSpace 

Menu: Tools | Piping  

Action: Opens dialog 

Usage: The Pipe Modeling dialog is used to create pipes and piping-related objects with 

piping-specific information and preferences. 
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Pipe Modeling Dialog 

 

A.  The type of piping component to be created. 

B.  The parts table. 

C.  The specific part from the table, used to define the dimensions of the component. 

D.  The current Line Identifier (used to identify a particular pipe run). 

E.  The current Specification (used to place restrictions during piping design; in Cyclone, this is 

simply a text field). 

F.  The current Symbol Key for each object type. 
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G.  The method used to insert the component. Push the ? button for instructions on how to use 

the method. 

H.  The position of the component, typically one of the component’s end-points. Disabled for 

some Placement methods. 

I.  Define the position of the component as an offset from the pick point when the Placement 

method is Place at Delta Distance. 

J.  The insulation thickness applied to components created by this dialog. 

K.  Push to see instructions on how to use the Placement method. 

L.  The vertical angle of the component, in degrees. 0 is along the “up” axis and 90 is lying in the 

horizontal plane. Disabled for some Placement methods. 

M.  The horizontal angle of the component, in degrees. 0 is along the +Y axis (Northing) and 90 is 

along the +X axis (Easting). Disabled for some Placement methods. 

N.  The roll angle of the component about its centerline, in degrees. Disabled for some 

Placement methods and components. 

O.  Push to display a graphical preview of the component. 

P.  Push to flip the component to use the other end-point for placement. 

Q.  Push to create the component. The created component is automatically picked so that the 

next component placed will be at the component’s end-point not used for placement. If possible, 

the created component is connected (see the Connect Piping entry in this chapter) with the 

previously-selected component. 

R.  Closes the dialog. 

To model pipes: 

1. From the Tools menu, point to Piping, and then select Pipe Modeling.... The Pipe Modeling 

dialog appears. 

2. Select a type of component to place from the toolbar. 

3. Select a parts table. 

4. Select an entry from the parts table. 

5. Enter or select a Line ID from the pulldown menu. 

6. Enter or select a Spec. 

7. Select a Type (SKEY) from the pulldown menu. 

� An SKEY (symbol key) identifies a generic object (e.g., a standard Cyclone flange) as a 

specific piping component (e.g., "Slip on Flange"). The 2-4 characters at the end of the SKEY 

comprise the encoding of that SKEY. 
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� Each type of piping component has its own SKEY, and each type of piping component can be 

assigned only those SKEYs available to that type. 

� Note:    Spec, LineID, and Type (SKEY) are stored as annotations on the objects that have 

them. They are displayed in the Object Info dialog box and can be managed via the 

standard Annotations functionality (although changing the values via the Edit 

Annotations dialog is not recommended). 

8. Enter the Insulation Thickness. 

9. Select the Placement method. Push the ? button for instructions on how to use the method. 

10. Enter and edit the components’s placement parameters. 

11. Preview the component’s placement graphically. 

12. Flip the component to place the component using the other end-point, if needed. 

13. Create the component. 

14. Select the type of the next component to be placed and repeat. 

15. When finished, click Close. 

Placement Methods: 

� Place at F/F (End of Pipe) – Appends a component to another component (fitting-to-fitting). 

� Place at Delta Distance – Places a component at a distance from another component. 

� Place at Position – Places a component at a specified position. 

� Connect Fittings with Pipe – Places a pipe between two in-line fittings, such as two flanges. 

� Insert at Pick Point – Inserts a fitting into a pipe at a pick point. The pipe’s geometry is 

adjusted accordingly (possibly splitting into two segments). 

� Insert at F/F (Closest Fitting) – Inserts a fitting at the end of a pipe (fitting-to-fitting). 

� Connect Pipes with Fitting – Connects two intersecting pipes with a fitting (elbow or tee). 

Piping 

Window: ModelSpace 

Menu: Tools 

Action: Displays submenu 

Usage: Pointing to Piping displays submenu commands used to establish and edit piping 

connections and annotations. 

The following commands and dialogs are available from the Piping submenu: 

Pipe Modeling…, Piping Mode..., Elbow Connectors, Edit Elbow Bend Ratio..., Reducer 
Connectors, Eccentric Reducer Connectors, Miter Connectors..., Convert Elbow to Miter..., 
Create Branch, Connect Piping, Disconnect (Shared), Disconnect (All), Select Connected 

 

 

 

 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Index 

350 

Piping Mode... 

Window: ModelSpace 

Menu: Tools | Piping  

Action: Opens dialog 

Usage: The Piping Mode dialog is used to assign piping-specific information and 

preferences to modeled objects. 

Piping Mode Dialog 

 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Index 

351 

A.  Activate to specify the active insulation thickness applied to objects created via fitting and 

insertion while this dialog is open. The value specified overrides any insulation thickness values 

set in Object Preferences (see the Object Preferences entry in this chapter). 

B.  The current Specification (used to place restrictions during piping design; in Cyclone, this is 

simply a text field)  

C.  The current Line Identifier (used to identify a particular pipe run). 

D.  The current Symbol Key for each object type. 

E.  Activate to display the Spec, LineID, and SKEY associated with newly created objects. 

F.  Activate to copy the Spec, LineID, and SKEY from the last selected object into this dialog. The 

SKEY copied is appropriate to the type of object selected. 

G. Sets the Spec, LineID, and SKEY for the selected objects 

H.  Closes the dialog and exits Piping mode. 

To apply piping annotations: 

1. From the Tools menu, point to Piping, and then select Piping Mode.... The Piping Mode 

dialog appears. 

� While the Piping Mode dialog is open, the current Spec, LineID, and appropriate SKEY is 

assigned to piping components created via the Fit to Cloud, Region Grow, Insert Object, 

and Piping Connectors commands. For example, when an elbow is created using the Piping 

Connectors | Elbow Connectors command, it is assigned the current Spec and LineID, as 

well as the elbow SKEY. 

� Also, while the Piping Mode dialog is open, connectivity is automatically established when 

inserting a piping component via a pick point on another piping component, subject to the 

connection rules (see the Connect Piping entry in this chapter). 

� As long as the Piping Mode dialog is open, the current piping annotations are applied to new 

objects as they are inserted or created. 

2. Select the desired piping annotations. 

� To use an object's existing piping annotations to set the fields in the Piping Mode dialog, 

select Values from Selection and select the object with the needed values. (Piping 

annotations that are not assigned to the selected object are not changed.) 

Note:    Spec, LineID, and SKEYs are stored as annotations on the objects that have them. 

They are displayed in the Object Info dialog box and can be managed via the 

standard Annotations functionality (although changing the values via the Edit 

Annotations dialog is not recommended). 

3. Select a Spec from the pulldown menu. 

� To choose which Specs are displayed in the pull-down menu, right-click the Spec row and 

select Choose Lookup List for Spec from the pop-up menu. (If there are no lookup lists 
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available, see the Customize Lookup Lists or Custom Annotations entry in this chapter to 

generate custom lists.) Select the lookup list with the relevant Specs. The Spec field cannot 

be edited directly, since only certain Specs are typically available for a given project. 

4. Select a LineID from the pulldown menu. 

� Choosing a lookup list for LineID is similar to choosing a lookup list for Spec. 

� The LineID field may be edited directly; and the new value is added to the list. 

5. Select an SKEY from the pulldown menu. 

� An SKEY (symbol key) identifies a generic object (e.g., a standard Cyclone flange) as a 

specific piping component (e.g., "Slip on Flange"). The 2-4 characters at the end of the SKEY 

comprise the encoding of that SKEY. 

� Each type of piping component has its own SKEY, and each type of piping component can be 

assigned only those SKEYs available to that type. 

� To select which SKEYs are present in the pulldown (e.g., to limit the SKEYs to those 

components that will be encountered in the current project instead of all possible 

components), right-click on the row of the object type and select Customize. Next, indicate 

which SKEYs are to be available in the pulldown by checking them in the Customize SKEYs 

dialog. 

6. Select the desired piping components and click Apply. The selected piping components are 

(re)assigned the current Spec and LineID, as well as the SKEY appropriate to the type of 

piping component selected. 

7. When finished, click Close. 

� The Piping Mode dialog provides the automatic functionality only while the dialog is open. For 

example, when using cylinders and elbows to represent railing or conduit, the user should 

close the Piping Mode dialog to avoid assigning data irrelevant to such objects. 

Piping Takeoff 

Window: ModelSpace 

Menu: Tools | Measure  

Action: Executes command 

Usage: The Piping Takeoff command calculates and displays the takeoff for the selected 

piping run. 

�       The takeoff is similar to the centerline length, except that the length of an elbow or bend is 

not the arc length, but the sum of the distances from each of its endpoints to the intersection 

points of its endpoint tangents. 

To measure piping takeoff: 

1. Multi-select the sequence of piping (including the connections) you want to measure. 

2. From the Tools menu, point to Measure, and then select Piping Takeoff. The measurement 

is displayed in the Output Box. 
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Point Cloud Density 

Window: ModelSpace, Registration 

Menu: ModelSpace: View 

Registration: Viewers 

Action: Displays submenu 

Usage: Pointing to Point Cloud Density displays submenu commands used to adjust the 

automatic thinning of cloud points when rendering. Increasing the level of reduction 

can improve performance and visualization. Other computations are unaffected by 

this setting. 

  
Point Cloud Density Submenu Commands 

NO REDUCTION 

Point clouds are drawn with full level of detail. 

LOW REDUCTION 

Point clouds are drawn without some points. 

MEDIUM REDUCTION 

Point clouds are drawn somewhat sparsely. 

HIGH REDUCTION 

Point clouds are drawn sparsely. 

HIGHEST REDUCTION 

Point clouds are drawn very sparsely. 

Point Cloud Rendering 

Window: ControlSpace, ModelSpace 

Menu: View 

Action: Displays submenu 

Usage: Pointing to Point Cloud Rendering displays submenu commands used to toggle 

different ways of drawing point clouds. 
 
• The following modifiers are available from the Point Cloud Rendering submenu: 

 

Shaded, One-Sided, Front, Back, Silhouette, Increase Point Width, Decrease Point Width 
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Point Cloud Rendering (Registration) 

Window: Registration 

Menu: Viewers 

Action: Displays submenu 

Usage: Pointing to Point Cloud Rendering displays submenu commands used to toggle 

different ways of drawing point clouds. 
 
• The following modifiers are available from the Point Cloud Rendering submenu: 

 

Shaded, One-Sided, Front, Back, Silhouette, Increase Point Width, Decrease Point Width 

Point Cloud Rendering (Scan Control) 

Window: Scan Control (ScanStation, ScanStation 2, HDS3000, HDS4500, HDS6000) 

Menu: Project 

Action: Displays submenu 

Usage: Pointing to Point Cloud Rendering displays submenu commands used to toggle 

different ways of drawing point clouds. 
 
• The following modifiers are available from the Point Cloud Rendering submenu: 

 

Shaded, One-Sided, Front, Back, Silhouette, Increase Point Width, Decrease Point Width 

Point Cloud Sub-Selection 

Window: ModelSpace 

Menu: Selection 

Action: Displays submenu 

Usage: Pointing to Point Cloud Sub-Selection displays submenu commands used to 

make and refine point cloud selections to be used for segmentation, fitting, and 

other processes. 

The following commands are available from the Point Cloud Sub-Selection submenu: 

Add Inside Fence, Add Outside Fence, Remove Inside Fence, Remove Outside Fence, 

Invert, Select All 

�       For more information, see the Point Cloud Segmentation entry in the Modeling chapter. 

To make a point cloud sub-selection: 

1. Draw a rough fence containing all the points that you may want to use. 
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2. Using the Selection | Point Cloud Sub-Selection submenu commands, create a temporary 

selection. 

3. Continue to refine the temporary selection (add or subtract points) by manipulating the 

viewpoint, drawing a new fence, and using subsequent Selection | Point Cloud Sub-

Selection submenu commands. The points within the temporary subset can now be 

segmented, fit, or used for other processes. 

Point Distance 

Window: ModelSpace 

Menu: Tools | Measure | Datum 

Action: Executes command 

Usage: The Point Distance command measures the distance between a picked point and 

the datum. 
Point-Datum Distance Measurement Output 

�       Depending on the current "up" direction, one of the X, Y, and Z distances is not shown 

HORIZONTAL DISTANCE 

The distance in the horizontal plane between the picked point and the datum. 

X DISTANCE 

The distance along the X axis between the picked point and the X coordinate of the datum. 

Y DISTANCE 

The distance along the Y axis between the picked point and the Y coordinate of the datum. 

Z DISTANCE 

The distance along the Z axis between the picked point and the Z coordinate of the datum. 

To take a measurement from the picked point to the datum: 

1. Pick the point from which you want to measure. 

2. From the Tools menu, point to Measure, then point to Datum, and select Point Distance. 

The measurement is calculated and displayed in the Output dialog. 

� Datum measurements cannot be saved. However, as long as the Output dialog remains 

enabled, multiple subsequent measurements can be made and displayed. 

� If multiple points are being measured, the results are displayed in the order in which they were 

picked. 
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Pointing 

Window: Scan Control (ScanStation 2) 

Menu: Window 

Action: Expands Tab 

Usage: The Pointing command expands the Pointing tab in the Scanner Control Panel. 

�       Pointing lets you aim the scanner’s laser at a specific point or in a specific direction. 

�       The Pointing procedure supports several methods. Depending on the method, some 

controls cannot be changed. 

Pointing Tab Options 

METHOD 

Displays the current method used to aim the scanner’s laser.  

ORTHOGONAL FROM STATION 

Select a known coordinate in the Target ID field. This known coordinate is the starting 

point at which to aim the laser.  This method requires Field Setup to first be applied to 

establish the scanner’s coordinate system. 

MANUAL – POLAR 

Enter the Azimuth and Distance to the point at which to aim the laser. The elevation of 

the point remains the same when Azimuth and Distance are edited. 

MANUAL – ORTHOGONAL 

Enter the coordinates at which to aim the laser. 

PICK POINT 

In the Scan Control viewer, pick the point at which to aim the laser. 

TARGET ID 

When Method is Orthogonal from Station, selects the target  to display in the panel. The 

laser will be aimed at the target’s coordinates. 

HT 

The height of the target above the coordinate. 

AZIMUTH 

The horizontal angle towards the point at which to aim the laser. 

STEP 

The change in angle when an arrow key (see below) is pushed. 

DISTANCE 

The distance to the point at which to aim the laser. 
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X Y Z / N E EL 

The coordinate of the point at which to aim the laser. The Scan Control viewer displays a 

cross-hair at this coordinate. 

ARROWS (UP, DOWN, LEFT, RIGHT) 

Push to change the elevation (vertical change) or azimuth of the point at which to aim the 

laser. 

POINT / STOP 

Push Point for the scanner to turn and point the laser at the configured coordinate. When in 

this mode, the button text changes to Stop. Use the arrow buttons to re-aim the laser. Push 

the QuickScan button to disengage or re-engage the scanner’s base motor. Push Stop to stop 

aiming the laser. 

To point the laser: 

1. Connect to the scanner (ScanStation 2) and ensure that it is level. 

2. If desired, perform a Field Setup to establish the scanner’s coordinate system (this is required 
when using the Orthogonal from Station method). The azimuth and coordinates of the 
target point are relative to this coordinate system. 

3. If using the Orthogonal from Station method, import or add the known or assumed 
coordinate of the point, using Add/Replace Coordinate, Import Coordinate List, or Import 
Coordinate List (Leica System 1200). 

4. From the Window menu, select Pointing. The Pointing panel appears in the control panel. 

5. Select the pointing Method. 

6. If using the Orthogonal from Station method, enter the Target ID. The Target ID must 
match a known coordinate. 

7. Enter the HT of the target point (if any) relative to the coordinate at which to aim the laser. 

8. Enter the coordinate or angles of the point at which to aim the laser. 

• If using the Orthogonal from Station method, the coordinates are already known. 

• If using the Manual – Polar method, enter the Azimuth and Distance to the point. 

• If using the Manual – Orthogonal method, enter the 3D coordinate of the point. 

• If using the Pick Point method, pick the point in the Scan Control viewer. 

9. Push the Point button to activate the laser. The scanner turns to aim the laser at the 
configured point. 

10. Use the arrow buttons to adjust the azimuth and elevation. The scanner turns to aim the laser 
at the new position. 

11. Push the QuickScan button once to disengage the base motor and manually turn the 
scanner. Push the QuickScan button a second time to re-engage the base motor. 

12. Push the Stop button to stop pointing. 
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Polygonal Fence Mode 

Window: ModelSpace, ScanControl (HDS2500) 

Menu: Edit | Modes 

Action: Executes command 

Usage: The Polygonal Fence Mode command enters Polygonal Fence mode and selects 

the Polygonal Fence mode cursor. 

�       For more information on working with fences, see the Using a Fence entry in the Modeling 

chapter. 

To draw a polygonal fence: 

1. From the Edit menu, point to Modes, and then select Polygonal Fence Mode. The 

Polygonal Fence cursor appears. 

2. Click to place the first vertex. 

� Drag to adjust the vertex position. 

� To continuously add vertices as you move the mouse, press and hold CTRL, and drag the 

cursor. 

3. Continue adding vertices as needed. 

� A vertex can also be added by clicking anywhere along the line segment between existing 

vertices. 

� An existing vertex can be deleted by clicking the vertex without moving the mouse. 

� The newly drawn fence can adjusted by dragging its vertices with the Polygonal Fence 

cursor. 

� To clear the newly drawn fence, select Clear from the Fence submenu. 

Polyline (From Curves) 

Window: ModelSpace 

Menu: Create Object | From Curves 

Action: Executes command 

Usage: The Polyline command creates a polyline from a series of selected lines or curves. 

To create a polyline from intersecting curves: 

1. Select a sequence of lines or curves that are to form the polyline you want to create. 

2. From the Create Object menu, point to From Curves, and then select Polyline. The polyline 

is created. 
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Polyline (From Pick Points) 

Window: ModelSpace 

Menu: Create Object | From Pick Points  

Action: Executes command 

Usage: The Polyline command creates line segments that connect a series of picked 

points. 

To create a polyline: 

1. Multi-select a series of points. 

2. From the Create Object menu, point to From Pick Points, and then select Polyline. The 

polyline is created. 

� A polyline is drawn from point to point in the same order in which the points were picked. 

� To edit a polyline, select it and then use the vertex handles to change its shape. 

� To draw a polyline without the use of pick points, see the Draw Polyline entry in this chapter. 

Polylines 

Window: ModelSpace 

Menu: Tools | Mesh 

Action: Displays submenu 

Usage: Pointing to Polylines displays submenu commands used to manipulate polylines 

with regards to mesh objects or vice versa. 

The following commands are available from the Polylines submenu: 

Project Polyline to TIN, Extend TIN to Polyline. 

Preferences... 

Window: ModelSpace, Navigator, Registration, Scan Control, Image 

Menu: Edit 

Action: Opens dialog 

Usage: The Edit Preferences dialog is used to set a variety of Cyclone settings. 
Level Options 

SESSION 

These preferences are non-persistent and last for the duration of the current session only. The 

next time Cyclone is started, these preferences are reset to default settings. 

DEFAULT 

These preferences are persistent and apply to the current and all future sessions. They may 

be temporarily overridden by making preference changes at the Session level. 
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Units Tab Settings 

Units settings control the units used throughout Cyclone. 

LINEAR UNITS 

Select the type of unit used for linear measurements. 

IMPERIAL TYPES 

Select English or U.S. Survey. English uses the factor of 25.4 millimeters/inch, while U.S. 

Survey uses 39.37 inches/meter. 

STATION NOTATION 

Toggle station notation ON/OFF. When this preference is ON and there is an active alignment, 

alignment coordinates are displayed for pick points. 

ALIGNMENT OFFSET NOTATION 

Select a style for horizontal offset notation when using station notation. 

ANGULAR UNITS 

Select the type of unit used for angular measurements. 

COORDINATE LABELS 

Select X, Y, Z or N, E, El (Northing, Easting, Elevation) coordinate labels for all dialogs, 

menus, and other occurrences of coordinate labels. 

TEMPERATURE UNITS 

Select the unit used to display temperature measurements. 

PRESSURE UNITS 

Select the type of unit used for pressure measurements. 

Resolution Tab Settings 

Resolution settings allow you to adjust the resolution with which values are displayed throughout 

Cyclone, by setting the number of decimal digits to be displayed. For example, with a Linear 

Units of meters, setting the Decimal Digits: Distance to 2 means that all distance 

measurements are displayed to a resolution with enough decimal places to represent one 

centimeter. The Decimal Digits setting is also available for Area, Volume, Angle, Temperature, 

Pressure, Time, and Percentage. 

Most resolution settings are self-explanatory. Those that are not are described below. 

DECIMAL DIGITS: UNITLESS 

Set the number of decimal places for the display of unitless measurements such as direction 

vectors. 

STATION PLUS DIGITS 

Sets the format used for station notation. 
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Measurements Tab Settings 

Measurement settings allow you to adjust the display of measurements made in the ModelSpace 

window. 

BODY COLOR 

Use the color picker to select the color to be used for the display of measurement lines. 

LABEL COLOR 

Use the color picker to select the color to be used for the display of measurements. 

FONT NAME 

Type the name of the font you want to use to display measurements. The font must be 

currently installed on your workstation. 

FONT SIZE 

Enter a value for the font size used to display measurements. 

CALLOUT LINE LENGTH 

Enter a value for the length of callout lines. 

CALLOUT LINE ANGLE         

Enter a value for the angle of callout lines. 

TIN VOLUME: FILL COLOR         

Use the color picker to specify the color of the TIN Volume Fill lines in the ModelSpace View. 

TIN VOLUME: CUT COLOR         

Use the color picker to specify the color of the TIN Volume Cut lines in the ModelSpace View. 

Registration Tab Settings 

AUTO-ADD CONSTRAINT TOLERANCE 

Enter a value between 0.0001 meter and 1.0 meter for the tolerance used for the Auto-Add 

Constraint function. This is the maximum distance used when considering which objects are 

geometrically close to each other. 

MAX ITERATIONS 

Enter a value between 1 and 1000 for the maximum number of iterations performed by 

registration. 

CONVERGENCE CRITERIA 

Enter a value to define the smallest improvement in registration error after which the 

registration optimization ends. A smaller number may make registration take longer. 
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CLOUD REG: DEFAULT MAX SEARCH DISTANCE 

Enter a value for the maximum distance to be searched matching pick points during cloud 

registration. Setting this value above the default (four inches) may decrease the speed and 

reliability of the optimal alignment. 

CLOUD REG: DEFAULT SUBSAMPLING PERCENTAGE 

Enter a percentage to specify the percentage of each cloud used with the Optimize Cloud 

Alignment. This setting amounts to a speed versus accuracy trade-off. The default is 3%, 

which is effective and efficient for typical scan cloud sizes (i.e., point clouds with one million 

points). In general, a value of 100% may give results up to twice as accurate as a value of 3%, 

but may take approximately ten times as long. 

CLOUD REG: DEFAULT MAX ITERATIONS 

Enter a value for the number of iterations above which a warning appears when the Optimize 

Cloud Alignment function has not converged on a solution. 

CLOUD REG: DEFAULT INITIAL GUESS METHOD 

Select a method to use as the starting point for cloud registration calculations. 

Fitting Tab Settings 

MULTIPLE POINT CLOUD STYLE 

Fit Multiple Objects fits a separate object to each point cloud when more than one point 

cloud is selected. Fit Single Object fits a single object to selected multiple point clouds. 

NUMBER OF POINTS WARNING THRESHOLD 

Enter a value for the number of points above which a warning appears before a fitting 

operation begins. 

Modeling Tab Settings 

REGION GROWING: TOLERANCE 

Enter a value between 0.001 meter and 0.1 meter which defines the initial tolerance for region 

growing. 

FIT EDGE: MIN STEP SIZE 

Enter a value for the minimum interval distance to fit templates to the surface of the point 

cloud. A value of zero lets Cyclone automatically set this parameter. 

FIT EDGE: MAX STEP SIZE 

Enter a value for the maximum interval distance to fit templates to the surface of the point 

cloud. A value of zero lets Cyclone automatically set this parameter. 

FITTING: ADJUST PATCH BOUNDARY 

Select Yes to display the Adjust Patch Boundary dialog automatically when fitting a concave 

patch. 

 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Index 

363 

INTERFERENCE: TOLERANCE 

Enter a value between 0.001 meter and 10.0 meters to define the initial tolerance used when 

determining if points are interfering with other geometry in a ModelSpace when using the 

Interference Points command in the Measure submenu. 

TEXTURE MAP: TOLERANCE: MAXIMUM ERROR (PIXELS) 

Enter a value between 0.1 pixel and 100.0 pixels to set the maximum pixel error that any 

single texture map constraint can have for a valid texture map computation. 

TEXTURE MAP: TOLERANCE: OVERALL ERROR (PIXELS) 

Enter a value between 0.1 pixel and 100.0 pixels to set the highest average pixel error that the 

texture map’s constraints can have for a valid texture map computation. 

PIPING: PIPE RADIUS 

Leave Radii Unchanged leaves each pipe radius at its current value, and adjusts pipe 

centerlines so that sequential pipes are coplanar. 

Force Uniform Radius forces all pipes to have the same radius. If points are used when 

refitting the pipes, each pipe’s radius is set to the size that best fits all point clouds used in the 

fitting. Otherwise, each pipe’s radius is set to the average of the initial pipe radii. 

Refit Individual Radii optimizes each pipe’s radius if points are used when refitting the pipe. 

Otherwise, the pipe’s radius is left at its current value. 

PIPING: RE-FITTING 

Ignore Points disregards points used in the original fitting of the pipe during connection by 

elbow, and forces sequential pipes to be coplanar by minimal movement of their end points, 

so that pipes are not refit. 

Refit to Points refits pipes using points that were used in the original fitting. 

PIPING: MAX. OFFSET (LINEAR OF BRANCH CONNECTION) 

Enter a value for the greatest distance allowed between the opposing center points for a linear 

connection, and the greatest distance allowed between the center point of the branch to the 

centerline of the run when connecting piping. 

PIPING: MAX. ANGLE (LINEAR CONNECTION) 

Enter a value for the greatest angle allowed between the tangents of the opposing faces when 

connecting piping. A value of 0 means that the tangent vectors must be exactly opposite. 

PIPING: MIN. ANGLE (BRANCH CONNECTION) 

Enter a value for the smallest angle allowed for a branching connection (see Connect Piping). 

A value of 90 means that the branching angle must be exactly perpendicular. 

ModelSpace Tab Settings 

POINT CLOUD: LENGTH OF GRAPHICAL NORMALS 

Set the scale for the display of point cloud normals. 
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To toggle the display of point cloud normals, see the View Object As entry in this chapter. 

OBJECT SIZE CULL BIAS 

Set the size of objects that are too small or too far away to be loaded and drawn. The value 

that you enter is the number of square pixels, below which an object is not loaded and 

rendered. 

LAYER OF NEW OBJECT 

Original Object’s Layer places new objects on the same layer as the object from which they 

were created. 

Current Layer places new objects that are created using an existing object on the current 

layer regardless of which layer the object is on. 

PICKING 

Ignore Auto-Pick overrides and disables auto-picking, regardless of the state of the Auto-

Pick Points toggle in the Selection menu. Use Auto-Pick Instead allows auto-picking when 

the Auto-Pick Points toggle is ON, and auto-picking preferences have been set for the type 

of object you wish to pick. See the Auto-Pick Points and Object Preferences entries in this 

chapter for more details. 

VIEWER: START WITH OUTPUT BOX ENABLED 

Select Yes to have the Output Box enabled when opening a new ModelSpace window. See 

the Enable Output Box entry in this chapter for more information on Output Boxes. 

VIEWER: SAVE LAST VIEWPOINT 

Select Yes to save the current viewpoint within the ModelSpace View when closing the 

ModelSpace window. Select No if you want to retain the initial viewpoint. 

VIEWER: POINT SELECTION TRANSPARENCY 

Enter a value between 0 (not transparent) and 1 (completely transparent) to affect how 

unselected point clouds are displayed when other point clouds are selected. 

VIEWER: BACKGROUND COLOR 

Use the color picker to specify the background color of the 3D graphics viewers (including 

ModelSpace viewer, Registration Constraint viewers, etc). 

VIEWER: DRAW TEXT ON TOP 

Select Yes to always draw all graphical text on top of any 3D graphics within the ModelSpace 

View. 

VIEWER: MAX MULTI-IMAGE MEMORY 

Enter a value for the maximum amount of memory that can be used to load multi-images. 

VIEWPOINT MANIPULATION SENSITIVITY (DEFAULT) 

Enter a value between .001 and 10.0 to determine the speed of viewpoint manipulation. A 

sensitivity of 1.0 is the default; a higher value makes the viewpoint move faster and a lower 

value makes the viewpoint move slower given the same mouse motion. 
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VIEWPOINT MANIPULATION SENSITIVITY (ALTERNATE) 

Enter a value between .001 and 10.0 to determine the speed of viewpoint manipulation with 

ALT pressed and held. A sensitivity of 0.1 makes the viewpoint moves ten times more slowly 

than the default of 1.0. A higher value makes the viewpoint move faster and a lower value 

makes the viewpoint move slower given the same mouse motion.  

NAVIGATOR: DOUBLE-CLICK ACTION  

Select the desired result when double-clicking a ModelSpace object in the Navigator window. 

HEAD LIGHT TYPE 

Directional light is a light source infinitely far away, such that all the rays of light are parallel. 

Point source light (default) is a light source where all the rays of light emanate from a single 

3D point (the camera’s position). 

TIN OVERLAP THRESHOLD 

Specify the minimum distance between any two points on the horizontal plane. If two or more 

points are within this threshold of each other, the point with the lowest elevation is kept to 

make the TIN and the others are discarded. 

Scan Tab Settings 

SCAN BACKUP DIRECTORY  

Enter the path to the location of the backup scanning (*.scan and .sc2) files. These files are 

recorded while a scan is taking place and are automatically removed when the scan 

successfully completes when using the HDS2500. The data from a *.scan and *.sc2 file may 

be recovered by importing it into the Navigator. 

HDS4500/HDS6000 SCAN DIRECTORY 

Enter the path to the location of the HDS4500 and HDS6000 scanning (*.zfs) files. These files 

are recorded while a scan is taking place and are used for importing of HDS4500 and 

HDS6000 scans into the Cyclone database. 

HDS3000/SCANSTATION/SCANSTATION 2: MAX # POINTS/SUB-SCAN 

Enter a value for the maximum number of points allowed in any single sub-scan. Each time 

this limit is reached during scanning, a new sub-scan is created. This preference also applies 

to ScanStation and ScanStation 2 scans. 

SCANSTATION 2: MAX # POINTS AUTO-IMPORTED 

Enter a value for the maximum number of points for importing ScanStation 2 scans. Use the 

Re-Import Scans command to import the unimported points. 

HDS4500/HDS6000: MAX # POINTS AUTO-IMPORTED 

Enter a value for the maximum number of points for importing HDS4500 and HDS6000 scans. 

For the HDS4500, when the value is 0, a placeholder Scan is created but the scan is not 

imported to save time in the field. Use the Re-Import Scans command to import the 

unimported points. For the HDS6000, when the value is 0, a placeholder Scan is created but 
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the scan is not downloaded from the scanner to save time in the field. Use the Download 

HDS6000 Scans command to download the missing file. 

HDS4500/HDS6000: KEEP AUTO-IMPORTED ZFS FILE 

Select whether or not the HDS4500 or HDS6000 ZFS file will be kept after each scan. If set to 

Yes, only the ZFS files for scans that are completely imported (that is, those with fewer points 

than the HDS4500/HDS6000: Max # Points Auto-Imported preference) will be deleted. 

Otherwise, all ZFS files produced by scanning will be kept on disk. 

HDS6000: LEVEL TOLERANCE 

Enter a value for the maximum angle that the scanner can be from perfectly level, but still be 

considered to be “level” by Scan Control workflows (e.g., Field Setup, Traverse) that require 

the scanner to be level. 

HDS6000: TILT: MAX DRIFT 

Enter a value for the maximum tilt change that the scanner can undergo, from the start of the 

first scan in the ScanWorld, before the scanner must be re-leveled. This is to ensure that 

scans in the same ScanWorld are in a consistent coordinate system. 

SIMULATED SCANNER SPHERICAL NOISE 

Enter a value for the standard deviation of noise applied to each simulated sample.  

SIMULATED SCANNER MAXIMUM RANGE 

Enter a value for the furthest sample that the simulated scanner will take. 

SPHERE TARGET DIAMETER 

Enter a value for the diameter expected when acquiring sphere targets in the Scan Control 

window. 

SPHERE TARGET SCAN DIMENSIONS 

Select Standard, Medium, or Low resolution target scan density for fine scans used when 

acquiring sphere targets in the Scan Control window. 

RESECTION MAX ERROR 

Enter a value for the maximum error allowed for a valid resection. This affects only the content 

of the Resection Report. 

STAKEOUT: HIDE PREVIOUS SCAN 

Select whether or not to hide the previous coarse scan acquired through the Stakeout panel 

in the Scan Control window. Hiding the previous coarse scan can help improve visualization 

when acquiring several successive coarse scans during the stakeout workflow. 

Point Cloud Tab Settings 

WORK DIRECTORY 

Enter the path to the location for temporary Cyclone files. 

 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Index 

367 

INTERACTIVE: TARGET FRAME RATE 

Specify the desired frame rate to be maintained while manipulating the viewpoint. 

LOAD: MAX POINTS (MILLIONS) 

Set the maximum number of points that can be loaded at one time. 

DISPLAY: MAX POINTS (MILLIONS) 

Set the maximum number of points that can be drawn in a single view at one time. 

DISPLAY: SPACING LIMIT 

Enter an average distance between any two points displayed. 

COMPUTATION: MAX POINTS (MILLIONS) 

Enter a value for the maximum number of points that can be used in any computation. 

COMPUTATION: SPACING LIMITS 

Enter a value for the minimum average spacing between points used in various computations. 

COMPUTATION: CREATE TIN: MAX POINTS (MILLIONS) 

Enter a value for the maximum number of points used to create a TIN. 

SEGMENTATION: PREVIEW MAX POINT COUNT (THOUSANDS) 

Enter a value for the maximum number of points that will be used to indicate the points that 

will be segmented by various operations, including Segment Cloud: Cut by Intensity, 

Segment Cloud: Cut Near Ref Plane, and Measure: Interfering Points. 

POINT CACHE: MAXIMUM CACHE SIZE (MB) 

Enter a value for the maximum size of physical memory used to cache points. 

IMPORT: COMPUTE MISSING NORMAL VECTORS 

Select YES to compute missing normal vectors when importing point clouds. PTX data 

contains normals, so this setting has no effect. PTS data does not contain normals, so 

imported PTS data with this preference turned OFF cannot be used for steel fitting, cloud 

registration, and region growing smooth surfaces. 

Initialization Tab Settings 

CONTROLSPACE: COLOR MAP MODE 

Select Colors from Scanner or Intensity Map to set the color map used in subsequently-

launched ControlSpaces. Select Custom to keep the current color map when launching an 

existing ControlSpace. (This may be overridden by any global color mapping.) 

CONTROLSPACE: COLOR MAP SCHEME 

Select Multi-Hue/Rainbow or Grayscale to set the color scheme used in subsequently-

launched ControlSpaces. (This may be overridden by any global color mapping.) 
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NEW MODELSPACE VIEW: COLOR MAP MODE 

Select Colors from Scanner or Intensity Map to set the color map used in subsequently-

created ModelSpace Views. (This may be overridden by any global color mapping.) 

NEW MODELSPACE VIEW: COLOR MAP SCHEME 

Select Multi-Hue/Rainbow or Grayscale to set the color scheme used in subsequently-

created ModelSpace Views. (This may be overridden by any global color mapping.) 

NEW MODELSPACE VIEW: GLOBAL COLOR MAP 

Select Enabled to initially use global color map settings when creating a new ModelSpace 

View. 

NEW MODELSPACE VIEW: GLOBAL COLOR MAP MODE 

Select Colors from Scanner, Color Map, Elevation Map, or Single Color to be applied 

when the global color map is enabled in ModelSpace Views created thereafter. 

NEW MODELSPACE VIEW: GLOBAL COLOR MAP SCHEME 

Select Multi-Hue/Rainbow, Grayscale, a topography-based palette, or a single scaled color 

with which to display the intensity or elevation map (for the corresponding Mode) when the 

global color map is enabled in ModelSpace Views created thereafter. If the Global Color Map 

Mode is Colors from Scanner, this scheme is used when the cloud/mesh lacks per-point 

color. 

NEW MODELSPACE VIEW: GLOBAL INTENSITY MAP RANGE 

Enter an intensity range for the color map used when the global color map is enabled in 

ModelSpace Views created thereafter. 

NEW MODELSPACE VIEW: GLOBAL ELEVATION MAP START 

Enter the start elevation for the elevation map used when the global color map is enabled in 

ModelSpace Views created thereafter. 

NEW MODELSPACE VIEW: GLOBAL ELEVATION MAP DELTA 

Enter the difference in elevation represented color in the elevation map used when the global 

color map is enabled in ModelSpace Views created thereafter. 

NEW MODELSPACE VIEW: GLOBAL COLOR MAP: NUMBER OF COLORS 

Enter the total number of colors used when the global color map is enabled in ModelSpace 

Views created thereafter. 

NEW MODELSPACE VIEW: GLOBAL COLOR MAP: REPEAT COLORS OUTSIDE RANGE 

Select Yes to use a cyclic color scheme when the global color map is enabled in ModelSpace 

Views created thereafter. 
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NEW MODELSPACE VIEW: GLOBAL COLOR MAP GAMMA CORRECTION 

Enter a value for the gamma correction used when the global color map is enabled in 

ModelSpace Views created thereafter. 

NEW MODELSPACE VIEW: POINT THICKNESS 

Specify the visual width and height (in pixels) of each point in an unselected point cloud. 

Thicker points may be easier to see. 

NEW MODELSPACE VIEW: POINT THICKNESS (HIGHLIGHTED) 

Specify the visual width and height (in pixels) of each point in a selected point cloud. Thicker 

points may be easier to see and pick. 

NEW MODELSPACE: EXCLUDE POINT CLOUDS 

Select Yes to not populate a new ModelSpace with the existing point clouds available to the 

ScanWorld when creating a ModelSpace from that ScanWorld. 

NEW MODELSPACE: EXCLUDE TARGET OBJECTS 

Select Yes to not populate a new ModelSpace with the existing HDS Targets/targets available 

to the ScanWorld when creating a ModelSpace from that ScanWorld. 

NEW MODELSPACE: EXCLUDE TARGET SCANS 

Select Yes to exclude the existing HDS Target/sphere target point clouds available to the 

ScanWorld when creating a ModelSpace from that ScanWorld. 

NEW MODELSPACE: MAXIMUM # POINTS BEFORE EXCLUDING 

Enter a value for the total number of points (in a ScanWorld) above which all scans are 

excluded when creating a ModelSpace. Enter a value of 0 (default) to never exclude based on 

the number of points. Create ModelSpace: Exclude Point Clouds must be set to Yes for this 

option to take effect. 
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Edit Preferences Dialog 

 

A.  Click a tab to access tab settings. See above for descriptions of tab contents. 

B.  Select a level for changes. 

C.  Reset the selected preference tab to the default settings. 

D.  Apply changes and continue working in the Edit Preferences dialog. 

To edit preferences: 

1. From the Edit menu, select Preferences.... The Edit Preferences dialog appears. 

2. Select the level at which your changes take effect. 

� To select a level, select Default or Session from the Level drop-down list (see Level Options 

following). 

3. Select the tab that contains the settings that you want to change. 

4. Change the appropriate settings, and then click OK. 
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Print... 

Window: ModelSpace, Image Viewer, Scan Control 

Menu: File 

Action: Opens dialog 

Usage: The Print... command launches the standard Windows Print dialog to print the 

contents of the current window. 

Probe 

Window: Scan Control 

Menu: Scanner Control 

Action: Executes command 

Usage: The Probe command samples the range at the targeting cross-hair. 
 

Probe (Tab) 

HZ 

Displays horizontal angle of the probe direction. 

V 

Displays height of probe point (relative to the scanner’s horizontal plane). 

•       Hz and V can be set by entering values in the fields or by clicking ctrl+left in target mode. 

RANGE 

Displays distance from scanner to nearest object aligned to the probe point. 

PROBE BUTTON 

Click to measure Range at the Hz and V angles. 

•       To set the range manually, enter a value into the Range field. 

Project 

Window: Navigator 

Menu: Create 

Action: Executes command 

Usage: The Project command creates a new project folder in the selected location. 

�       Project folders can be created in a database, within another project folder, or in a 

ScanWorld. 
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To create a new project: 

1. In the Navigator window, select the folder into which you want to add a new project. 

2. From the Create menu, select Project. The project is created. 

Project Polyline to TIN 

Window: ModelSpace 

Menu: Tools | Mesh | Polylines 

 Tools | Mesh | Breaklines 

Action: Executes command 

Usage: The Project Polyline to TIN command wraps a polyline onto a TIN object, creating 

edges in the mesh based on the projection of the polyline vertically onto the mesh 

(although the polyline itself is unchanged); the edges are then "stretched" vertically 

to conform to the polyline's shape. 

�       If you select the Project Polyline to TIN command from the Breaklines submenu, the 

polyline is converted to a breakline on the mesh. If you select this command from the Polylines 

submenu, the polyline will only be projected onto the mesh, and the resulting line will be merely a 

geometric object.  

�       Polylines are projected along the "up" direction of the current coordinate system 

�   The mesh onto which you are projecting a polyline must be qualified to be a TIN. See the 

Verify TIN command. 

To project a polyline onto a TIN: 

1. Multi-select a polyline and the TIN mesh onto which the polyline will be projected. 

2. From the Tools menu, point to Mesh, point to Polylines, and then select Project Polyline to 

TIN. The polyline is projected onto the mesh. 

To project a polyline onto a TIN and create a breakline within the mesh: 

1. Multi-select a polyline and the TIN mesh onto which the polyline will be projected as a 

breakline. 

2. From the Tools menu, point to Mesh, point to Breaklines, and then select Project Polyline 

to TIN. The polyline is duplicated, then projected onto the TIN. Its vertices are incorporated 

into the mesh as a breakline. 

Project Setup 

Window: Scan Control 

Menu: Window 

Action: Expands Tab 

Usage: The Project Setup command expands the Project Setup tab in the Scanner Control 

Panel. 
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�       You must select a project before beginning a scan or getting an image. 

�       The Select a Project dialog is displayed automatically when you open the Scan Control 

window. Once you have selected a project, Cyclone automatically assigns ScanWorlds as you 

create new scans, and you only need to use Project Setup if you wish to manually select or 

create different projects and ScanWorlds. 

Project Setup tab Options 

PROJECT 

Displays the current project. Click the … button to select a different project or to create a new 

project. 

SCANWORLD 

Displays the current ScanWorld. Click the … button to select a different ScanWorld or to 

create a new ScanWorld. 

NEXT SCAN 

Displays the name of the next scan in the current project and ScanWorld. 

NEW POSITION 

Click to prepare a new ScanWorld for the next scan. 

OPEN VIEWER 

Click to open a new ModelSpace viewer for the incoming scan data. 

Note:    This ModelSpace is created in the ScanWorld chosen as your destination using the 

Select ScanWorld... command. 

Note:    The point cloud being acquired is visible in this ModelSpace viewer, but is not 

selectable until the scan operation is completed or canceled. 

Publish Site Map... 

Window: ModelSpace 

Menu: File 

Action: Opens dialog 

Usage: The Publish Site Map... command creates an HTML page with a snapshot of the 

current viewpoint, with hot-spots at the scanner positions. The command also 

generates datasets for use by Leica TruView. 

�       Also see the Using Cyclone Publisher document. 

To publish a site map: 

1. Set the viewpoint in the ModelSpace viewer. This viewpoint will be used for the site map 

image. 
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� Any scanner locations contained in this viewpoint will be used to generate TruView datasets.  

� If the viewpoint does not contain any scanner locations, then no TruView datasets will be 

generated, although the site map will still be generated. 

2. Adjust the visualization and graphics options of the ModelSpace View. The site map image 

will use these settings. 

3. In the File menu, select Publish Site Map…. The Browse for Folder dialog appears. 

4. In the Browse for Folder dialog, select the folder to contain the site map files (and TruView 

datasets). The Select ScanWorlds dialog appears next. 

5. In the Select ScanWorlds dialog, select the ScanWorlds for which TruView datasets will be 

generated. Selecting a ScanWorld will also generate TruView datasets for its subordinate 

ScanWorlds. 

� One TruView dataset consists of only the scans specific to the original ScanWorld. Registered 

ScanWorlds have no scans of their own. 

� The TruView dataset uses the original ScanWorld’s default point clouds. Use the Set 

ScanWorld Default Clouds or Set as Default Scan commands in the original ScanWorld to 

modify its default point clouds. 

� The coordinate system and “up” direction used in the site map are applied to each TruView. 

6. In the Site Map Settings dialog, select the options to use for the site map. 

7. Click the TruView Settings… button to customize how the TruView datasets are generated. 

8. Click the OK button. The site map is created. Any TruView datasets that were generated are 

contained in sub-folders. 

Site Map Settings Dialog 

 

A.  Width, Height: The dimensions of the site map image. 

B.  Keep Aspect Ratio: When checked, changing either the Width or the Height adjusts the 

other dimension proportionately. 
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C.  Anti-aliasing Quality: Select the level of anti-aliasing in the site map image. A higher level 

helps smoothen jagged edges in the image. 

D.  TruView Settings…: Click to invoke the TruView Settings dialog. 

E.  OK: Click to accept the settings and publish the site map and TruView datasets. 

F.  Cancel: Click to cancel this operation. 

TruView Settings Dialog 

 

A.  Image Resolution: The maximum resolution used in each of the six images generated for a 

TruView dataset. The six images form a complete cube. A higher resolution may improve image 

quality when zoomed in using TruView, but it may also result in larger files. 

B.  Min Range: Points closer to the scanner than this value are not included in the TruView 

dataset. 

C.  Max Range: Points farther from the scanner than this value are not included in the TruView 

dataset. Use this to avoid including points that are beyond the recommended range of the 

scanner, or to limit the visualization to a local region. 

D.  Encoding Error@200m: The desired precision of the 3D point at each TruView pixel. A 

higher precision may result in better measurements using TruView, but it may also result in larger 

files. 

E.  Estimated File Size: The estimated size of the files in a typical TruView dataset generated 

with these settings. The estimate updates when the settings are changed. Refer to this to gauge 
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the impact on disk space and/or speed of downloading the TruView datasets from a network 

server. 

F.  Include Background Image: When checked, the Multi-Image from a HDS3000, ScanStation, 

or ScanStation 2 ScanWorld is used as a background image wherever points from the scan are 

not available. This can help improve the visualization in TruView. 

G.  Color Map Settings…: Click to invoke the Color Map Settings dialog. 

H.  Owner Info…: Click to invoke the TruView Owner Information dialog. 

I.  OK: Click to accept the TruView settings and return to the Site Map Settings dialog. 

J.  Cancel: Click to return to the Site Map Settings dialog without accepting any changes to the 

TruView settings. 

Color Map Settings Dialog 

The Color Map Settings dialog is used to specify how point clouds will be displayed when 

generating a TruView dataset. See Edit Color Map in the Commands chapter for details. Some 

options are not available when generating a TruView dataset. 

 

A.  OK: Click to accept the TruView color map settings and return to the TruView Settings 

dialog. 

B.  Cancel: Click to return to the TruView Settings dialog without accepting any changes to the 

TruView color map settings. 
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TruView Owner Information Dialog 

The TruView Owner Information dialog is used to supply information about the owner of the 

TruView datasets to be generated. Information about the publisher of the TruView datasets is 

also entered in this dialog. The TruView datasets include this information. 

 

A.  Company: Enter the name of the company that owns the TruView dataset. 

B.  Company URL: Enter the URL (for example, “http://hds.leica-geosystems.com”) of the 

company that owns the TruView dataset. 

C.  Contact: Enter the main contact information for the company that owns the TruView dataset. 

D.  Copyright: Enter the copyright notice for the TruView dataset. 

E.  Project URL: Enter the URL of the project to which the TruView dataset belongs. 

F.  Publisher: Enter the name of the company that is generating the TruView dataset. 

G.  Publisher E-mail: Enter the e-mail address of the main contact of the company that is 

generating the TruView dataset. 

H.  Publisher URL: Enter the URL of the company that is generating the TruView dataset. 

I.  OK: Click to accept the TruView owner and publisher information and return to the TruView 

Settings dialog. 
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J.  Cancel: Click to return to the TruView Settings dialog without accepting any changes to the 

TruView owner and publisher information. 

Put at Angle... 

Window: ModelSpace 

Menu: Edit Object | Align 

Action: Opens dialog 

Usage: The Put at Angle... dialog is used to align one or more selected objects at a specific 

angle to a reference object. 

To align two objects at an angle: 

1. Multi-select the objects you want to align. 

� The last object selected is the reference object (the one to which the others align). 

2. From the Edit Object menu, point to Align, and then select Put at Angle.... The Put at Angle 

dialog appears. 

3. Enter the angle you want, and then click OK. The selected objects are rotated so that their 

axes form the specified angle with the axis of the reference object. 

Put at Distance... 

Window: ModelSpace 

Menu: Edit Object | Align 

Action: Opens dialog 

Usage: The Put at Distance dialog is used to set one object at a specific distance from a 

reference object. 

To set two objects at a specified distance: 

1. Multi-select the two objects you want to align. 

� The last object selected is the reference object (the one from which the other moves). 

2. From the Edit Object menu, point to Align, and then select Put at Distance.... The Put at 

Distance dialog appears, displaying the current distance between the objects in the Distance 

field. 

3. Enter a value in the Distance field, and then click OK. The first object selected is moved to 

the specified distance from the reference object. 

� The direction of translation depends on the types of the objects being used. 
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QuickScan (command) 

Window: Scan Control 

Menu: Scanner Control 

Action: Executes command 

Usage: The QuickScan command is used to quickly initiate a scan when your field of view 

settings do not need to be precise and your other scan control settings are already 

satisfactory. 

See also, the Station Data tab entry in the Commands chapter. 

To QuickScan: 

1. In the Scan Control Window Field-of-View tab, click the QuickScan button.  The Aim 

Scanner dialog appears. 

� The scanner motor disengages to allow you to rotate the scanner on its mount. 

2. Rotate the scanner on its mount and aim it toward the left extent of the region you want to 

scan. 

� To accept the current left extent, click the Skip button to proceed to step 4. 

� To cancel QuickScan without changing any scanner settings, click the Cancel button. 

3. Press the multi-purpose button on the scanner. The Aim Scanner dialog prompts you to aim 

the scanner toward the right extent of the region you want to scan. 

4. Rotate the scanner on its mount and aim it toward the right extent of the region you want to 

scan. 

� To accept the scanner’s current position as the right extent, click the Skip button to set the 

right extent. 

� Any dependent values (e.g., number of points) also update. 

5. Press the multi-purpose button on the scanner. 

� The target region’s right horizontal angle in the Scan tab updates. 

� Any dependent values (e.g., number of points) also update. 

� To cancel the QuickScan without changing any scanner settings, click the Cancel button. If 
any angles were changed, the values revert back to what they were before you clicked the 
QuickScan button. 

Note:    If you have previously set the scanner orientation, all horizontal angles are relative 

to the current orientation. See also, Station Data. 

Raise Active Cutplane 

Window: ModelSpace 

Menu: Tools | Cutplane  

Action: Executes command 

Usage: The Raise Active Cutplane command raises the Cutplane by the amount specified 

in the Offset command (see the Add/Edit Cutplanes entry in this chapter). 
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Raise/Lower 

Window: ModelSpace 

Menu: Tools | Reference Plane  

Action: Toggles function ON/OFF 

Usage: The Raise/Lower command toggles the raise/lower function in Drawing mode, 

which allows you to interactively raise or lower the active Reference Plane without 

changing its orientation. 

To raise/lower the Reference Plane: 

1. From the Tools menu, point to Reference Plane, and then select Raise/Lower (or click the 

Raise/Lower icon ). You are now in Drawing mode. The cursor changes to the Drawing Tool 

cursor, and the raise/lower function is ON. 

2. In the ModelSpace, drag the Drawing Tool cursor up/down to raise/lower the active 

Reference Plane. 

3. Release the mouse button. The Reference Plane is raised/lowered. 

Randomize Colors of Visible (Selected) Objects  

Window: ModelSpace 

Menu: Edit Object | Appearance  

Action: Executes command 

Usage: The Randomize Colors of Visible Objects command assigns random colors to all 

visible or selected objects. 

�       If any objects are selected, this command changes from Visible to Selected objects and 

affects only those selected objects. 

�       This command is useful when there is a large number of similarly-colored objects that you 

need to quickly distinguish from each other. 

Rectangle Fence Mode 

Window: ModelSpace 

Menu: Edit | Modes 

Action: Executes command 

Usage: The Rectangle Fence Mode command enters Rectangle Fence mode and selects 

the Rectangle Fence mode cursor. 

� For more information on working with fences, see the Using a Fence entry in the Modeling 

chapter. 

�  
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To draw a rectangular fence: 

1. From the Edit menu, point to Modes, and then select Rectangle Fence Mode. The 

Rectangular Fence cursor appears. 

2. Drag the cursor around the area that you want to fence. 

� The newly drawn fence can adjusted by dragging its sides or vertices with the Rectangular 

Fence cursor. 

� To clear the newly drawn fence, select Clear from the Fence submenu. 

Rectangular 

Window: Scan Control 

Menu: Scanner Control | Set Fence 

Action: Executes command 

Usage: Pointing to Rectangular displays submenu commands used to select a preset 

rectangular fence size. 

The following preset panoramic fences are available from the Rectangular submenu: 

40 x 40, 60 x 60, 80 x 80 

Redlining 

Window: ModelSpace 

Menu: Tools 

Action: Displays submenu 

Usage: Pointing to Redlining displays submenu commands used to create new redlines 

and manage saved redlines. 

�       Redlines are used to create 2D lines and add comments to a ModelSpace. 

�       Redlining behaves identically to 2D drawing. However, drawing is done on the active 

Reference Plane, whereas Redlining is done on an imaginary plane that is perpendicular to and 

centered in the current ModelSpace viewpoint. 

�       Redlines are part of the ModelSpace View. You can only view or edit redlines that were 

created in the current View. 

The following commands and dialogs are available from the Redlining submenu: 

Edit Redlines, Create Redlines 
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Redo 

Window: ModelSpace, Navigator, Registration, Scan Control, Image Viewer 

Menu: Edit 

Action: Executes command 

Usage: The Redo command reverses the effects of the most recent Undo command. 

�       A series of Undo commands can be reversed using a series of Redo commands unless a 

new action is performed, at which time all changes that have not been redone are discarded. 

�       Any action that can be undone with the Undo command (see the Undo entry in this 

chapter),can be redone with the Redo operation. 

Reduce Point Cloud... 

Window: ModelSpace 

Menu: Edit Object 

Action: Opens dialog 

Usage: The Reduce Point Cloud dialog is used to reduce the number of points in a cloud. 
 

Reduce Point Cloud Dialog Fields 

HORIZONTAL SAMPLING 

Enter the ratio of original-to-subsample horizontal points. 

VERTICAL SAMPLING 

Enter the ratio of original-to-subsample vertical points. 

POINT COUNT 

Enter a specific value for the number of points you want in the resulting point cloud. 

PERCENTAGE OF ORIGINAL 

Enter a percentage by which to reduce the number of points. 

ORIGINAL POINT COUNT 

Displays the number of points in the original cloud. 

To reduce the number of points in a cloud: 

1. Select the point cloud that you want to reduce. 

2. From the Edit Object menu, select Reduce Point Cloud.... The Reduce Point Cloud dialog 

appears. 

3. Select the sample rate by horizontal and vertical ratio, point count, or percentage of original, 

and then click OK. The point cloud is replaced by a subsampled version of the cloud. 
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Reducer Connectors 

Window: ModelSpace 

Menu: Tools | Piping 

Action: Executes command 

Usage: The Reducer Connectors command connects two roughly parallel selected pipes. 

To connect parallel pipes: 

1. Pick a point on the first pipe near the end you want connected. 

2. Multi-select the second pipe near the end that you want connected. 

3. From the Tools menu, point to Piping, and then select Reducer Connectors. The pipes are 

connected with a reducer. 

Reference Plane 

Window: ModelSpace 

Menu: Tools  

Action: Displays submenu 

Usage: Pointing to Reference Plane displays submenu commands used to display, hide, 

and manipulate the active Reference Plane. 

�       The Reference Plane is an infinite two-dimensional plane used for creating shapes that are 

otherwise unavailable in Cyclone, or for creating shapes where object fitting or insertion are 

impractical. It is also used as a reference for several operations such as measuring a mesh 

volume or orienting the Cutplane. 

The following commands and dialogs are available from the Reference Plane submenu: 

Add/Edit Reference Planes..., Show Active Plane, Align View to Active Plane, Edit Active 

Plane..., Set to Viewpoint, Set to UCS, Set to X-Y Plane, Set to X-Z Plane, Set to Y-Z Plane, 

Set on Object, Set Plane Origin at Pick Point, Pan, Rotate, Tilt, Raise/Lower 

�       For information on 2D drawing procedures, see the Drawing entry in the Modeling chapter. 

Region Grow 

Window: ModelSpace 

Menu: Create Object 

Action: Displays submenu 

Usage: The Region Grow submenu contains commands that are used to fit a patch, 

cylinder, or sphere to a shape within a point cloud without having to first segment the 

points. It also contains the Smooth Surfaces command, which is used to segment a 

selected smooth surface in a point cloud, and the Pipe Run command, which is used 
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to grow a series of pipes connected by elbows. 

� When region growing a patch, cylinder, or sphere, the points on the surface representing the 

selected object are replaced with the fitted geometry. 

� For the Smooth Surfaces command, the points representing the smooth surface are merely 

segmented from the point cloud; no object is inserted. 

� To set default region growing parameters (except for Smooth Surfaces), see the Region 

Growing section of the Preferences entry in this chapter. 

� Region growing can make use of parts tables to fit standard objects. To set and enable parts 

tables, see the Object Preferences, Use Parts Table, and Show Table Matches entries in this 

chapter. 

The following commands are available from the Region Grow submenu: 

Patch..., Cylinder..., Sphere..., Smooth Surface..., Pipe Run..., and Edit Parameters... 

To fit a patch using region growing:  

1. Select a point in the center of the region of the cloud that make up the interior of the Patch you 

want to segment and fit. 

� A patch can often be fit with a single pick point. However, for best results, pick three or four 

points (no more than two collinear) as far apart from each other as possible near (but not on) 

the edges of the object you want to fit. 

� If region growing is not performing adequately, pick three or more points (no more than two 

collinear). 

� When region growing, multiple clouds may be selected as long as there is at least one pick 

point. 

2. From the Create Object menu, point to Region Grow and select Patch. The Region Grow 

Patch dialog appears. 

3. Use the sliders to adjust parameters. 

� Region Thickness defines a surface thickness outside of which points are excluded from the 

fit calculation. 

� Maximum Gap to Span defines a maximum distance between any two adjacent points 

included in the fit calculation. 

� To restart the fit with the current settings, click Restart. 

4. Click OK.  

5. If the Fitting: Adjust Patch Boundary setting in the Edit Preferences dialog is set to Yes, 

the Adjust Patch Boundary dialog appears. Use the slider to adjust the patch’s polygonal 

boundary. The closer the slider moves towards Tight Boundary, the more rigidly the 

boundary of the new patch adheres to the points on the edge of the point cloud. In some 

cases this adjustment may necessitate the creation of more than one patch. 

To fit a cylinder or sphere using region growing:  

1. Select a point in the center of the region of the cloud that make up the interior of the object 

you want to segment and fit. 

� For best results, pick three or four points (no more than two collinear) as far apart from each 

other as possible near (but not on) the edges of the object you want to fit. 

� When region growing, multiple clouds may be selected as long as there is at least one pick 

point. 
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2. If region growing is not performing adequately, pick additional points as follows: 

� Cylinder: Pick six or more points (no more than three collinear). 

� Sphere: Pick four or more points (no more than three coplanar). 

3. From the Create Object menu, point to Region Grow, and select the type of object you want 

to fit. The Region Growing Sphere/Cylinder dialog appears. 

4. Use the sliders to adjust parameters for the object being fit and then click OK. 

� Region Thickness defines a surface thickness outside of which points are excluded from the 

fit calculation. 

� Maximum Gap to Span defines a maximum distance between any two adjacent points 

included in the fit calculation. 

� Details displays the fitting error. 

To region grow a smooth surface:  

1. Select a point on the surface of the flat region of the point cloud that you want to segment. 

� Select a point near the center of the region.  

� When region growing, multiple clouds may be selected as long as there is at least one pick 

point. 

2. From the Create Object menu, point to Region Grow, and then select Smooth Surface.... 

The Region Grow Smooth Surface dialog appears. 

3. Use the sliders to adjust the smooth surface parameters. 

� Region Thickness defines the smooth surface thickness outside of which points are not 

considered a part of the smooth surface. 

� Maximum Gap to Span defines the maximum distance that may exist between portions of the 

same smooth surface. 

� Details displays the number of points in the selected point cloud, along with the number of 

points conforming to the parameters set in this dialog. 

4. Click OK. The point cloud is segmented. 

� When enabled, the Limit Box can improve performance by reducing the amount of points 

processed; only those visible points are used. 

To region grow a pipe run: 

1. Pick a point on the first pipe in the run. 

2. Shift+Pick the other pipes in the run in any order, with one pick per pipe. 

� The pipes must have the same outside diameter. 

3. From the Create Object menu, point to Region Grow, and then select Pipe Run.... The 

Region Grow Pipe Run dialog appears. 

4. Use the sliders to adjust the pipe run parameters. 

� Region Thickness defines the surface thickness outside of which points are excluded from 

the fit calculation. 

� Maximum Gap to Span defines a maximum distance between any two adjacent points 

included in the fit calculation. 

� Angle Tolerance is disabled. 

� Region Size defines a distance beyond the pick points at the ends of the pipe run. Points 

within this distance are used in fitting those end pipes. This can be used to control the extents 

of end pipes. 
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� Details displays the fitting status. 

5. The Pipe menu in the dialog provides additional options. 

� Discard Last Pipe removes the pipe grown last. This can be used when you pick a 

suboptimal point or the region grower performs a poor fit. The pipe picked last is shown in red. 

� Snap Bend Ratios, when selected, uses the closest bend ratio in the set { 0.5xOD, 0.75xOD, 

1.0xOD, 1.5xOD, 2xOD, 3xOD, 4xOD, 5xOD, … } when fitting elbows. 

� Segment Points, when selected, segments the points used in the region grow from the rest of 

the cloud when the OK button is clicked. Not segmenting the points may result in better 

performance. 

� Reverse Run changes the order of the pipes in the pipe run. This can be used in conjunction 

with Discard Last Pipe to remove the pipe at either end of the pipe run. 

6. Make modifications or corrections to the region growing. Some modifications require a 

Restart instead of a Continue. 

� If the region grow algorithm fails to fit a pipe in the sequence, the Details reports which pipe  

was not found and suggests the next steps. 

� To include additional pipes in the pipe run, Shift+Pick additional points on the pipes adjacent 

to either end of the pipe run already grown, then click Continue. The additional picks must be 

in sequence. That is, pick the next pipe connected to one end, then the next pipe in that 

direction, and so on. 

7. Click OK. The pipe run is fit and added to the ModelSpace. 

Register 

Window: Registration 

Menu: Registration 

Action: Executes command 

Usage: The Register command is the step in the registration process during which the 

optimal alignment transformations are computed for each ScanWorld in the 

Registration, such that the constraints are satisfied as closely as possible. 

�       For more information on the registration process, see the Registration entry in the Getting 

Started chapter. 

Registration 

Window: Navigator 

Menu: Create 

Action: Executes command 

Usage: The Registration command creates a new Registration in the selected location. 

�       A Registration can be created in a database or project. 
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�       For more information on the registration process, see the Registration entry in the Getting 

Started chapter. 

To create a new Registration: 

1. In the Navigator window, select the database or project for your new registration. 

2. From the Create menu, select Registration. The Registration is created. 

Registration (Tools) 

Window: ModelSpace 

Menu: Tools 

Action: Displays submenu 

Usage: Pointing to Registration displays submenu commands used to add, edit, and delete 

Registration labels, as well as to add objects manually to the ControlSpace for the 

current ScanWorld. 

The following commands, dialogs, and submenus are available from the Registration submenu: 

Add/Edit Registration Label..., Remove Registration Label, Set Target Height, Copy to 

ControlSpace, Elevation Check 

Registration Diagnostics 

Window: Registration 

Menu: Registration 

Action: Opens dialog 

Usage: The Registration Diagnostics dialog shows registration status and statistics for the 

current registration. 

Re-Import Scans 

Window: Navigator 

Menu: Tools 

Action: Opens dialog 

Usage: The Re-Import Scans dialog is used to import reduced or full HDS4500 and 

HDS6000 scans as point clouds in the database, replacing the corresponding cloud 

currently in the database. Only ScanStation 2 scans that were not automatically 

imported (as per the ScanStation 2: Max # points Auto-Imported preference) and 

HDS4500 and HDS6000 scans that were not automatically imported (as per the 

HDS4500/HDS6000: Max # Points Auto-Imported preference) are considered. 
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Re-Import Scans Dialog 

 

Sampling Select the percent reduction in number of points to be imported relative to the total 

available number. 

Scan Displays the path to the scan in the Navigator. 

# Points Displays the approximate number of points that will be imported. 

Current Displays the current sampling of the scan. 

Import Select this check box to import the points. 

Archive Select this check box to move the corresponding SC2 or ZFS scan file to the Archive 

subfolder. 

Import Imports (or archives) the selected scans. 

Cancel Cancels the import. 

To re-import ScanStation 2, HDS4500, and HDS6000 scans: 

1. In the Navigator window, select the container under which ScanStation 2,  HDS4500, and/or 

HDS6000 Scans eligible for import are located. 

� The container can be a database, Project, ScanWorld, Registration, or Scan. 

� You can select multiple containers. 

2. In the Navigator window on the Tools menu, select Re-Import Scans…. 

The Re-Import Scans dialog displays. 

3. To select a Scan for import, toggle ON the corresponding Import flag. 

4. Select the Sampling level to be used when importing the Scans selected for import. 

5. To remove a specific Scan from future consideration, toggle ON the Archive flag. 

6. Click Import. The indicated Import and/or Archive actions are performed. 
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Remove Both Caps 

Window: ModelSpace 

Menu: Edit Object | End Caps  

Action: Executes command 

Usage: The Remove Both Caps command deletes both end caps from the selected object. 

To remove both end caps: 

1. Select the object from which you want to remove the caps. 

2. From the Edit Object menu, point to End Caps, and then select Remove Both Caps. The 

caps are removed. 

Remove Cap Closest to Pick 

Window: ModelSpace 

Menu: Edit Object | End Caps  

Action: Executes command 

Usage: The Remove Cap Closest to Pick command deletes the end cap nearest to the 

picked point on the selected object. 

To remove the end cap closest to the pick: 

1. Pick a point on the object near the cap that you want to remove. 

2. From the Edit Object menu, point to End Caps, and then select Remove Cap Closest to 

Pick. The cap closest to the pick point is removed. 

Remove from Group 

Window: ModelSpace 

Menu: Edit | Group 

Action: Executes command 

Usage: The Remove from Group command removes the picked object from an existing 

group. 

To remove an object from a group: 

1. Pick the group member you want to remove from the group. 

2. From the Edit menu, point to Group, and then select the Remove from Group command. 

The picked object is removed from the group and placed back into the ModelSpace. 

� If there are only two items in a group and one is removed, the single remaining item is also 

removed, and the group is destroyed (a group must have at least two items). Both objects are 

placed back into the ModelSpace. 
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Remove Inside Fence 

Window: ModelSpace 

Menu: Selection | Point Cloud Sub-Selection 

Action: Executes command 

Usage: The Remove Inside Fence command removes any points inside a fence from the 

sub-selection set. 

�    For more information, see the Advanced Segmentation entry in the Modeling chapter. 

Remove Outside Fence 

Window: ModelSpace 

Menu: Selection | Point Cloud Sub-Selection 

Action: Executes command 

Usage: The Remove Outside Fence command removes any points outside a fence from 

the sub-selection set.. 

�    For more information, see the Advanced Segmentation entry in the Modeling chapter. 

Remove Registration Label 

Window: ModelSpace 

Menu: Tools | Registration 

Action: Executes command 

Usage: The Remove Registration Label command deletes the registration label from the 

selected object(s). 

Note:    Removing a registration label from an object does not remove that object from the 

ControlSpace.  

To remove a registration label: 

1. Select the object(s) from which you want to remove a registration label. 

2. From the Tools menu, point to Registration, then select Remove Registration Label. The 

registration label is deleted. 

Rename 

Window: Navigator 

Menu: Edit 

Action: Executes command 

Usage: The Rename command allows you to edit the name of the selected object. 
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To rename an object in the Navigator window: 

1. Select the object you want to rename. 

2. From the Edit menu, select Rename. The object’s name is selected and ready for editing. 

3. Type a new name, and then press ENTER. 

Reset Active Alignment 

Window: ModelSpace 

Menu: Tools | Alignment and Section 

Action: Executes command 

Usage: The Reset Active Alignment command clears the active alignment. 

� Station-notation values are only supported when there is an active alignment. 

� Existing measurements are not affected. 

Reset Alignment 

Window: Registration 

Menu: Cloud Constraint 

Action: Executes command 

Usage: The Reset Alignment command resets the selected cloud constraints to the not 

aligned state and resets its current alignment transform to that specified by the initial 

cloud alignment. 

�       For more information on the cloud registration process, see the Cloud Registration entry in 

the Registration chapter.  

Reset ScanWorld Coordinate System 

Window: ModelSpace 

Menu: View | Coordinate System 

Action: Executes command 

Usage: The Reset ScanWorld Coordinate System command restores the original 

coordinate system and default "up" direction of the current ModelSpace's parent 

ScanWorld. 

Reset Target 

Window: Scan Control 

Menu: Scanner Control 

Action: Executes command 

Usage: The Reset Target command deletes any existing targeting fence and replaces it 
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with a centered rectangular 60 x 60 fence. 

Resolution (HDS2500) 

Window: Scan Control 

Menu: Scanner Control 

Action: Executes command 

Usage: Pointing to Resolution displays submenu commands used to set a standard 

interval between data points to be captured in the next scan operation. 

The following intervals are available from the Resolution submenu: 

1x1 mm, 1x1 cm, 1x1 m, 1x1 in, 1x1 ft, 1x1 yd 

�       For more information on the scanning process, see the Scanning entry in the Getting 

Started chapter. 

Resolution (ScanStation, ScanStation 2, HDS3000, HDS4500, 
HDS6000) 

Window: Scan Control 

Menu: Window 

Action: Expands Tab 

Usage: The Resolution command expands the Resolution tab in the Scanner Control 

Panel. 
 

Resolution Tab Options 

RANGE 

Enter a representative distance from the scanner location to the scene to be scanned. 

PROBE BUTTON 

Click to measure the Range in the direction of the targeting cross-hair. 

 

SAMPLE SPACING 

Displays spacing between sample points for the current Range and selected number of points. 

PRESETS 

Select a preset sample spacing from the dropdown.  If sample spacing does not match the 

presets, then it displays "Custom". Sample spacing can change by either direct editing or 

changes in the Number of Points field. 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Index 

393 

NUMBER OF POINTS 

Displays total number of points in the Horizontal and Vertical directions, based on the selected 

Range and Sample Spacing. 

Note:    The dependencies are: 1. Changing Range changes Number of Points based on 
Sample Spacing. 2. Changing Sample Spacing changes Number of Points based on 
Range. 3. Changing Number of Points changes Sample Spacing based on Range. 

Resolution (HDS4500) 

Window: Scan Control 

Menu: Scanner Control 

Action: Executes command 

Usage: Pointing to Resolution displays submenu commands used to set a standard interval 

between data points to be captured in the next scan operation.. 

 

The following intervals are available from the Resolution submenu: 

Highest – Sample at every 0.018 x 0.018 degree (20,000 samples in a 360 degree circle) 

High – Sample at every 0.036 x 0.036 degree (10,000 samples in a 360 degree circle) 

Medium – Sample at every 0.072 x 0.072 degree (5,000 samples in a 360 degree circle) 

Low (Preview) – Sample at every 0.288 x 0.288 degree (1,250 samples in a 360 degree circle) 

Resolution (HDS6000) 

Window: Scan Control 

Menu: Scanner Control 

Action: Executes command 

Usage: Pointing to Resolution displays submenu commands used to set a standard interval 

between data points to be captured in the next scan operation.. 

 

The following intervals are available from the Resolution submenu: 

Ultra-High – Sample at every 0.009 x 0.009 degree (40,000 samples in a 360 degree circle) 

Highest – Sample at every 0.018 x 0.018 degree (20,000 samples in a 360 degree circle) 

High – Sample at every 0.036 x 0.036 degree (10,000 samples in a 360 degree circle) 

Medium – Sample at every 0.072 x 0.072 degree (5,000 samples in a 360 degree circle) 

Low (Preview) – Sample at every 0.288 x 0.288 degree (1,250 samples in a 360 degree circle) 
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Restore Default Cloud from Scan 

Window: ModelSpace 

Menu: Tools | Scanner  

Action: Executes command 

Usage: The Restore Default Cloud from Scan command is used to restore the original 

point cloud to a ModelSpace, including any points hidden using the Set as Default 

Cloud command. 

To restore the original point cloud: 

1. Click any point within the point cloud. 

Note:    This command is not available if there are no points to select. 

2. From the Tools menu, select Scanner | Restore Default Cloud from Scan. The original 

point cloud is restored. 

Restore Original Scans 

Window: Navigator 

Menu: Tools 

Action: Executes command 

Usage: The Restore Original Scans command replaces the default point clouds in the 

selected ScanWorld with the original point clouds from the scans under the 

ScanWorld. 

�      This command is useful if you have unified your scan cloud data, made the unified cloud the 

default for the ScanWorld, and then want to revert to the original scan data.  

Note:   Within a ScanWorld, you are able to have a ModelSpace that is unified alongside a 

ModelSpace that is not unified. Changing the ScanWorld default clouds does not affect 

existing ModelSpaces. It only affects newly created ModelSpaces and new 

ControlSpaces if Add Cloud Constraint is used. The Add Cloud Constraint 

command will place the default ScanWorld clouds in the ControlSpace if no clouds 

already exist in the ControlSpace. 

Resume 

Window: Scan Control (ScanStation, ScanStation 2, HDS3000, HDS6000) 

Menu: Scanner Control 

Action: Executes command 

Usage: The Resume command continues the currently-paused scanner operation (scan or 

image acquisition). 
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Right Isometric 

Window: ModelSpace 

Menu: Viewpoint | Standard Views  

Action: Executes command 

Usage: The Right Isometric command moves the current viewpoint to the standard 

isometric viewing position vector (1, -1, 1) at a distance where the entire scene is 

visible. 

�       The Isometric command moves the current viewpoint to the standard isometric viewing 

position vector (-1, -1, 1). 

Rotate (Reference Plane) 

Window: ModelSpace 

Menu: Tools | Reference Plane  

Action: Toggles function ON/OFF 

Usage: The Rotate command toggles the rotate function in Drawing mode, which allows 

you to interactively rotate the active Reference Plane about its origin. 

To rotate the Reference Plane: 

1. From the Tools menu, point to Reference Plane, and then select Rotate (or click the Rotate 

icon ). You are now in Drawing mode. The cursor changes to the Drawing Tool cursor and 

the Rotate function is ON. 

2. In the ModelSpace, drag the Drawing Tool cursor to rotate the active Reference Plane. The 

Reference Plane is rotated about its origin such that the cross axis (the positive X axis) 

passes beneath the cursor. 

3. Release the mouse button. The active Reference Plane is rotated. 

Rotate (View Lock) 

Window: ModelSpace 

Menu: Viewpoint | View Lock 

Action: Toggles option ON/OFF 

Usage: The Rotate command toggles the ability to rotate the viewpoint in View mode. 

� When ON, you cannot rotate the viewpoint. 
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Save/Edit Coordinate Systems... 

Window: ModelSpace 

Menu: View | Coordinate System 

Action: Opens dialog 

Usage: The User Coordinate Systems dialog is used to save, restore, and delete user-

defined coordinate systems. 

�       Using multiple user-defined coordinate systems can be very helpful in the navigation and 

analysis of large ModelSpaces. You may find it useful to define temporary coordinate systems 

based on objects that provide necessary axes and origins of interest for use in the insertion or 

editing of objects with, for instance, the Rotate command. 

User Coordinate Systems Dialog 

 

A.  List of saved coordinate systems. Double-click to set the coordinate system. The current 

coordinate system is shown in bold-face. 

B.  Save the current coordinate system. 

C.  Delete the selected coordinate system. 

D.  Move the selected coordinate system up through the list saved coordinate systems. 

E.  Move the selected coordinate system down through the list saved coordinate systems. 
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To save the current coordinate system: 

1. From the View menu, point to Coordinate System, and then select Save/Edit Coordinate 

Systems.... The User Coordinate Systems dialog appears. 

2. Click the Save icon. The Coordinate System Name dialog appears. 

3. Enter a name for the current coordinate system, and then click OK. The current coordinate 

system is saved. 

To restore a saved coordinate system as the current coordinate system: 

1. From the View menu, point to Coordinate System, and then select Save/Edit Coordinate 

Systems.... The User Coordinate Systems dialog appears. 

2. From the list of saved coordinate systems, double-click the coordinate system you want to 

restore. The selected coordinate system is restored. 
 

To delete a saved coordinate system: 

1. From the View menu, point to Coordinate System, and then select Save/Edit Coordinate 

Systems.... The User Coordinate Systems dialog appears. 

2. Select the coordinate system you want to delete, and then click the Delete icon. The selected 

coordinate system is deleted. 

Sample Grid 

Window: ModelSpace 

Menu: Tools | Mesh 

Action: Opens dialog 

Usage: The Sample Grid command displays a dialog that indicates how the surface of the 

selected mesh(es) will be sampled over a regular grid. 

� The sampling is performed along the axis perpendicular to the active reference plane. The 

reference plane should be perpendicular to one of the major axes of the current UCS. The 

mesh(es) must be TIN relative to the reference plane. 

� If a polyline/polygon is also selected, only the area within the polyline/polygon (projected onto 

the active reference plane) is sampled. 

To Sample Grid 

1. Select the mesh(es) to be sampled. 

� To Sample Grid within a specific boundary, also multi-select a polyline or polygon object. 

2. From the Tools menu in the ModelSpace window, point to Mesh, then select Sample Grid…. 

The Sample Grid dialog appears. 

3. Change the Grid Spacing of the active reference plane. The samples will be taken on the 

reference plane grid with this spacing. 

4. Select the Create check box to create an object in the ModelSpace to represent the samples. 

Select the form of the sampling output to be generated. 

� Select Vertices to generate individual Vertex objects at each surface sample. 
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� Select Point Cloud to create a Point Cloud whose points correspond to the surface samples. 

� Select Mesh to create a Mesh whose vertices correspond to the surface samples. 

5. Select the Output Table check box to display the Sample Grid Results dialog that contains a 

table listing the individual sample points. 

6. Click OK to sample the surfaces and generate the requested output. 

� Where multiple meshes overlap, the sample with the highest elevation relative to the 

measurement direction is used. 

Sample Grid Dialog 

 

Grid 

Spacing: 

Change the Grid Spacing of the active reference plane. The samples will be taken on 

the reference plane grid with this spacing. 

Create: Select the Create check box to create an object in the ModelSpace to represent the 

samples. Select the form of the sampling output to be generated. 

Vertices: Select Vertices to generate individual Vertex objects at each surface sample. 

Point 

Cloud: 

Select Point Cloud to create a Point Cloud whose points correspond to the surface 

samples. 

Mesh: Select Mesh to create a Mesh whose vertices correspond to the surface samples. 

Output 

Table: 

Select the Output Table check box to display the Sample Grid Results dialog that 

contains a table listing the individual sample points. 

OK: Click OK to sample the surfaces and generate the requested output. 

Save/Edit Viewpoints... 

Window: ModelSpace 

Menu: Viewpoint 

Action: Opens dialog 

Usage: The User Viewpoints dialog is used to save, restore, and delete user-defined 

viewing positions. 
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User Viewpoints Dialog 

 

A.  List of saved viewpoints. Double-click to set the viewpoint. 

B.  Save the current viewpoint. 

C.  Delete the selected viewpoint. 

D.  Move the selected viewpoint up through the list saved coordinate systems. 

E.  Move the selected viewpoint down through the list saved coordinate systems. 

To save the current viewpoint: 

1. From the Viewpoints menu, select Save/Edit Viewpoints.... The User Viewpoints dialog 

appears. 

2. Click the Save icon. The User Viewpoint Name dialog appears. 

3. Enter a name for the current viewpoint and click OK. The viewpoint is saved. 

To set the current viewpoint: 

1. From the Viewpoint menu, select Save/Edit Viewpoints.... The User Viewpoints dialog 

appears. 

2. Double-click the viewpoint you want to restore. The selected viewpoint is restored. 
 

To delete a saved viewpoint: 

1. From the Viewpoint menu, select Save/Edit Viewpoints.... The User Viewpoints dialog 
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appears. 

2. Select the viewpoint you want to delete, and then click the Delete icon. The selected 

viewpoint is deleted. 

Save Measurements 

Window: ModelSpace 

Menu: Tools | Measure  

Action: Toggles menu item ON/OFF 

Usage: The Save Measurements command toggles the saving of measurements as you 

take them. 

�       When ON, the current measurement and all new measurements are saved and can be 

viewed and edited from the Measurements dialog. (See the Edit Measurements entry in this 

chapter). 

•       When OFF, each new measurement replaces the previous unsaved measurement. 

Save View 

Window: ModelSpace 

Menu: View 

Action: Executes command 

Usage: The Save View command functions identically to the Save View As... command, 

except that the view is not renamed. 

Save View As... 

Window: ModelSpace 

Menu: View 

Action: Opens dialog 

Usage: The Save ModelSpace View dialog is used to create a new ModelSpace View, 

which is a collection of overriding settings for graphical viewing parameters, 

including initial viewing position. 

�       Multiple views of a ModelSpace can be saved and restored as a convenient means of 

storing various presentations of a ModelSpace. You can save and then restore as many 

ModelSpace views as needed. 

�   For a comprehensive list of what is saved with a ModelSpace View, see the ModelSpace 

Views entry in the Modeling chapter. 
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To save the current ModelSpace View: 

1. When you have a ModelSpace View that you want to save, select Save View As... from the 

View menu. The Save ModelSpace View dialog appears. 

� To specify a name for the view, enter the name you want in the ModelSpace View Name 

field. 

2. Click OK. The ModelSpace View is saved and remains the active ModelSpace View. Any 

further changes to this View are persistent. 

� Saved ModelSpace views are stored with their ModelSpace in the Navigator window. 

� To open a ModelSpace View in a new ModelSpace window, double-click the view you want 

from the Navigator window. 

� To open a different ModelSpace View in the current ModelSpace window, use the 

ModelSpace Views... command. 

Scan 

Window: Scan Control 

Menu: Scanner Control 

Action: Executes command 

Usage: The Scan command begins a scan of the targeted area using the current settings.  

�   Scanning progress is displayed in the Progress bar in the bottom of the window. By default, 

sample points are displayed in the connected ModelSpace viewer (see the Open ModelSpace 

Viewer entry in this chapter) as they are acquired (see the Show Incoming Points command). 

�       Scans are saved in the Scans folder under the destination ScanWorld. 

�   For an overview of the scanning process, see the Scanning entry in the Getting Started 

chapter. 

Scan Filter 

Window: Scan Control 

Menu: Window 

Action: Expands Tab 

Usage: The Scan Filter command expands the Scan Filter tab in the Scanner Control 

Panel. 

� Points sampled by the scanner that fall outside the specified range and/or intensity 

parameters are discarded without being recorded to the database. 
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Scan Filter Tab Options 

RANGE 

To specify minimum or maximum range, click the checkboxes.  Ranges can be entered 

directly using the fields, or by selecting points in the ModelSpace viewer. 

INTENSITY 

To specify minimum or maximum intensity, click the checkboxes. Ranges can be entered 

directly using the fields, or by selecting points in the ModelSpace viewer. Any point with 

intensity less than the minimum intensity is rejected; any point with intensity greater than 

maximum intensity is rejected. Intensities are from 0 to 1. More energy returned to the scanner 

for a given sample results in a higher intensity. 

Scanner 

Window: ModelSpace 

Menu: Tools 

Action: Displays submenu 

Usage: Pointing to Scanner displays submenu commands, submenus, and dialogs to used 

to manage scan data, set and restore point clouds, and create and use a simulate 

scanner. 

The following commands, submenus, and dialogs are available from the Scanner submenu: 

ScanWorld Explorer, Set As Default Cloud, Restore Default Cloud from Scan, Set 

ScanWorld Default Clouds, Show Incoming Points, Create Simulated Scanner, Update 

Simulated Scanner Position 

Scanner Diagnostics 

Window: Navigator 

Menu: View 

Action: Opens dialog 

Usage: The Scanner Diagnostics... command displays scanner diagnostics related to the 

selected object. 

�       When Cyclone connects to an HDS3000, ScanStation, or ScanStation 2, Cyclone queries 

the scanner for the scanner’s initialization diagnostics. Cyclone stores the diagnostics with the 

scanner object, marked with the current date and time. 

����When Cyclone starts a scan or acquires an image, the initialization diagnostics obtained at the 

time of connection are stored with the destination ScanWorld. Also, the current scanner 

parameters are retrieved from the scanner and stored with the resulting Scan/Image. 
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Scanner Laser Mode 

Window: Scan Control (HDS6000) 

Menu: Scanner Control 

Action: Displays submenu 

Usage: Pointing to Scanner Laser Mode displays submenu commands (Normal Power 

and Low Power) used to configure the power of the laser. Normal Power may 

detect darker surfaces farther away, and the minimum range is 30 cm. Low Power 

is useful when objects are closer to the scanner than 30 cm, because its minimum 

range is 0 cm. However, Low Power may not detect darker surfaces. The maximum 

range is the same in each mode. The sampling noise may be slightly different for 

each mode. 

Scanner Range Mode 

Window: Scan Control (HDS4500) 

Menu: Scanner Control 

Action: Displays submenu 

Usage: Pointing to Scanner Range Mode displays submenu commands (Normal and 

Close-In) used to configure the power of the laser, resulting in different minimum 

and maximum ranges. Normal achieves the maximum range of the scanner, but 

there is a minimum range within which samples are ignored. Close-In is useful 

when objects are closer to the scanner than the Normal mode’s minimum range, 

because it decreases the laser power and has a shorter minimum range. However, 

Close-In has half the maximum range of Normal. The sampling noise may be 

slightly different for each mode. 

Scanner Speed 

Window: Scan Control (HDS4500, HDS6000) 

Menu: Scanner Control 

Action: Displays submenu 

Usage: Pointing to Scanner Speed displays submenu commands (Default and Low) used 

to configure the rotational speed of the scanner. Low speed turns the scanner more 

slowly, but the scan makes less audible noise and the scan may be more stable. 

Some scanner resolutions support only one speed, in which case this setting is 

ignored. 
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Scanners... 

Window: Navigator 

Menu: Configure 

Action: Opens dialog 

Usage: The Configure Scanners dialog is used to add and remove scanners. 

To add a scanner: 

1. From the Configure menu, select Scanners.... The Configure Scanners dialog appears. 

2. Click Add. The Add Scanner dialog appears. 

3. From the Scanner Model list, select the model of the scanner that you are adding. 

4. In the Scanner Name field, type a logical name for the scanner you are adding. 

5. In the IP Address field, enter the IP Address for the scanner you are adding. 

� The IP Address is printed on the scanner. 

6. Click OK. The scanner is added. 

� To close the Configure Scanners dialog and return to the Navigator window, click Close. 

 Note: The Cyclone Scan Control interface with the HDS4500 is via firewire connection and 

no IP Address is entered. 

To remove a scanner: 

1. From the Configure menu, select Scanners.... The Configure Scanners dialog appears. 

2. From the list of scanners, select the scanner that you want to remove, and then click Remove. 

The scanner is removed. 

� To close the Configure Scanners dialog and return to the Navigator window, click Close. 

To toggle scanner visibility: 

� Scanners with visibility toggled OFF are not displayed in the Navigator window, but are not 

removed. 

1. From the Configure menu, select Scanners.... The Configure Scanners dialog appears. 

� To toggle visibility, select/deselect the box below the Visibility icon next to the appropriate 

scanner. 

� To close the Configure Scanners dialog and return to the Navigator window, click Close. 

ScanWorld 

Window: Navigator 

Menu: Create 

Action: Executes command 

Usage: The ScanWorld command creates a new ScanWorld in the selected location. 

�       A new ScanWorld can be created in a database, or project. 
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To create a new ScanWorld: 

1. In the Navigator window, select the database or project into which you want to add a new 

ScanWorld. 

2. From the Create menu, select ScanWorld. The ScanWorld is created. 

ScanWorld Explorer… 

Window: ModelSpace 

Menu: Tools | Scanner 

Action: Opens dialog 

Usage: The ScanWorld Explorer dialog is used to show and hide all scanners and scans 

registered in the current ScanWorld. 

� The ScanWorld Explorer contains three tabs: Scanners, Original Scans,  and Unified 

Clouds. The different tabs contain a number of columns containing information about the 

scanners used, scans taken, and unification of point clouds.  

� To customize the ScanWorld Explorer dialog, right-click the column header. Customization 

options appear. 

ScanWorld Explorer Dialog - Scanners Tab 

 

A.  Opens separate dialog where information about the selected scanner is displayed 

B.  Aligns the viewpoint in the ModelSpace View window so it matches the viewpoint of the 

selected scanner 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Index 

406 

C.  Refresh All 

D.  Customize columns 

E.  Segments the selected scan based on each point's distance to the scanner 

F.  The name of the ScanWorld containing the scan 

G.  Make / Model / ID column 

H. Displays IP address for the selected scanner 

I.  Scanner position in ModelSpace 

J.   Display a scanner object in ModelSpace representing the selected scanner  

K.  Display boundary of the maximum Field of View of the selected scanner. 

L.  Set Field of View color for the selected scanner 

ScanWorld Explorer Dialog Original Scans 

 

A.  Opens separate dialog where information about the selected scanner is displayed 

B.  Aligns the viewpoint in the ModelSpace View window so it matches the viewpoint of the 

selected scanner 
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C.  Refresh All 

D.  Customize columns 

E.  Segments the selected scan based on each point’s distance to the scanner 

F.  Displays the name of the scan 

G.  Displays the actual dimensions of the selected scan 

H.  Displays the number of points contained within the selected scan 

I.  Toggles display of selected scan's point cloud in ModelSpace 

J.   Toggles display of the Field of View boundary for the selected scan 

K.  Displays Field of View’s Near Extent for the scan 

L.  Displays Field of View’s Far Extent for the scan 

ScanWorld Explorer Dialog Unified Clouds 

 

A.  Opens separate dialog where information about the selected scanner is displayed 

B.  Aligns the viewpoint in the ModelSpace View window so it matches the viewpoint of the 

selected scanner 
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C.  Refresh all 

D.  Customize columns 

E.  Segments the selected scan based on each point’s distance to the scanner 

F.  Displays the name of the unified cloud. 

G.  Displays the number of points contained within the selected unified cloud 

H. Toggles the display of the selected unified cloud 

To segment a scan at a user-specified distance from its scanner: 

1. Invoke the ScanWorld Explorer. 

2. Select the Scanners or Original Scans tab. 

3. Select one or more ScanWorld in the left pane. 

� If no ScanWorlds are selected in the left pane, all ScanWorlds are considered to be selected. 

4. Select one or more items in the Scanners or Original Scans tab. 

� If no items are selected in the right pane, all Scans for the ScanWorlds selected in the left 

pane are considered to be selected. 

5. Click the Segment Scans by Distance toolbar icon. The Segment Scans by Distance 

dialog appears. 

6. Enter the Distance at which the Scans will be segmented. Each cloud will be segmented 

based on its points’ distances to the scanner that scanned the cloud. 

� Unified clouds, fine/coarse target scans, and merged clouds are not affected. 

7. Select the action that will be applied to the segmented points. 

� Select Keep Points to keep all points. 

� Select Delete Points Beyond Distance to delete all points further than the user-specified 

distance. 

� Select Delete Points Within Distance to delete all points closer than the user-specified 

distance. 

8. Click OK. The clouds corresponding to the selected clouds are segmented. Depending on the 

options, some of the segmented portions may be deleted. 

ScanWorld Info 

Window: ModelSpace 

Menu: Tools | Info  

Action: Opens dialog 

Usage: The ScanWorld Info dialog is used to view available information about the 

ScanWorld(s) from which the current ModelSpace is derived. 

�       The data contained in this dialog is a snapshot of the state of the ScanWorld at the time the 

dialog is displayed; to update the information, close the dialog and execute the command again.  
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Sections Manager 

Window: ModelSpace 

Menu: Tools | Alignment and Section 

Action: Opens dialog 

Usage: The Sections Manager dialog is used to generate, edit, and manage cross-sections 

along alignments. 

Seek Mode 

Window: ModelSpace 

Menu: Edit | Modes 

Action: Executes command 

Usage: The Seek Mode command initiates Seek mode and displays the Seek mode cursor, 

which is used to reset the focal point. 

�       The viewpoint rotates around and zooms in/out from a focal point. The focal point is a point 

that is a certain distance in front of the center of the viewpoint. 

To reset the focal point: 

1. From the Edit menu, point to Modes, and then select Seek Mode. The cursor changes to the 

Seek Mode cross-hair. 

2. Pick the point that you want as your new focal point. The viewpoint is adjusted and the focal 

point is set. 

Segment Cloud 

Window: ModelSpace 

Menu: Create Object 

Action: Displays submenu 

Usage: Pointing to Segment Cloud displays submenu commands for subdividing a cloud of 

points into smaller subsets. 

The following commands and dialogs are available from the Segment Cloud submenu: 

Cut by Fence, Cut by Intensity..., Cut Near Ref Plane..., Trim Edges, Cut Sub-Selection 

�       For more information on the segmentation process, see the Segmentation entry in the 

Modeling chapter. 
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Segment by Polyline 

Window: ModelSpace 

Menu: Tools | Mesh 

Action: Executes command 

Usage: The Segment by Polyline command splits faces in the selected mesh wherever the 

selected line or polyline crosses it. 

� If a line is selected, the line is extended infinitely in each direction for purposes of this 

command, effectively dividing the mesh into two pieces. 

� If a polyline is selected, it is automatically closed into a polygon for purposes of this 

command. 

� The crossing is determined using the projection of the selected line or polyline to the active 

Reference Plane. 

� The mesh must be a TIN relative to the active Reference Plane. 

To Segment Faces on a mesh: 

1. Select the mesh(es) to be segmented. 

2. Multi-select the line, polyline, or polygon object that defines the boundary to use. 

3. From the Tools menu, point to Mesh, then select Segment by Polyline. The mesh 

is segmented using the projection of the selected line, polyline, or polygon to the 

active Reference Plane. 

Segment Polyline 

Window: ModelSpace 

Menu: Create Object 

Action: Executes command 

Usage: The Segment Polyline command segments the selected polyline(s) into subsets. 

To segment a polyline: 

1. Draw a fence around the portions of the polyline that you want to segment. (See the Using a 

Fence section in the Modeling chapter.) 

2. From the Create Object menu, point to Segment Polyline. The polyline is segmented 

where it crosses the fence.  

� The resultant separate polylines can be selected independently. 
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Select a Project... 

Window: Scan Control 

Menu: Project 

Action: Opens dialog 

Usage: The Select a Project dialog is used to select a destination project folder for scan 

and image data acquired from the scanner. 

�       You must select a project folder before beginning a scan or getting an image. 

�       The Select a Project dialog can also be accessed by clicking the button to the right of the 

Project box in the Scan Control panel. 

To select a project for your scan data: 

1. From the Project menu, select Select a Project.... The Select a Project dialog appears. 

� You can create a new project for your scan data by clicking Create; you can then select the 

created project 

2. Navigate to an existing project, and then click OK. Your destination project is selected. 

Select a ScanWorld... 

Window: Scan Control 

Menu: Project 

Action: Opens dialog 

Usage: The Select a ScanWorld... command opens the Select a ScanWorld dialog, which 

is used to select a destination ScanWorld for scans and images acquired from the 

scanner. 

�       If you do not select a ScanWorld before beginning a scan or getting an image, a ScanWorld 
is automatically created in the parent project.  

�       The Select a ScanWorld dialog can also be accessed by clicking the button to the right of 
the ScanWorld box in the Scan Control panel. 

To select a ScanWorld for your scans and images: 

1. From the Project menu, select Select ScanWorld.... The Select a ScanWorld dialog 

appears. 

� You can create a new ScanWorld for your scan data by clicking Create; you can then select 

the created ScanWorld. 

2. Navigate to an existing ScanWorld, and then click OK. Your destination ScanWorld is 

selected. 

� Only ScanWorlds within the parent project can be selected. 
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Select All 

Window: ModelSpace, Image Viewer 

Menu: Selection 

Action: Executes command 

Usage: The Select All command selects every selectable object currently loaded in the 

ModelSpace. 

� In the Image Viewer window, this command selects all annotation pick points. 

� To deselect all objects, press ESC. 

Note:    An object will not be selected if the object has not yet been loaded, nor if the Object 
Type has been set “not selectable” in the View Properties dialog. See the Set Object 
Visibility entry in this chapter for more information. 

Select All (Point Cloud Sub-Selection) 

Window: ModelSpace 

Menu: Selection | Point Cloud Sub-Selection 

Action: Executes command 

Usage: The Select All command selects all selectable point clouds in the ModelSpace. 

Select Connected 

Window: ModelSpace 

Menu: Tools | Piping  

Action: Executes command 

Usage: The Select Connected command selects all of the piping components connected to 

the selected piping component  

�       This command can be useful for setting or copying the piping annotations for a selected 

pipe run, putting the selected pipe run on a layer, changing the material of the selected pipe run 

to distinguish it from the other pipe runs, etc.. 

Select Fenced 

Window: ModelSpace 

Menu: Selection 

Action: Executes command 

Usage: The Select Fenced command selects every object and point cloud within or 

overlapping the drawn data fence. 
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�       For more information on working with fences, see the Using a Fence entry in the Modeling 

chapter. 

Self-Test 

Window: Scan Control (HDS4500) 

Menu: Scanner 

Action: Executes command 

Usage: The Self-Test command performs an operational safety check on the scanner’s 

laser. 

Servers... 

Window: Navigator 

Menu: Configure 

Action: Opens dialog 

Usage: The Configure Servers dialog is used to add, remove, and toggle visibility of 

servers. 

To add a server: 

1. From the Configure menu, select Servers.... The Configure Servers dialog appears. 

2. Click Add. The Add Server dialog appears. 

3. In the Server Name field, type the Microsoft Network name for the server to be added, and 

then click Add. The Configure Servers dialog reappears displaying the newly added server. 

4. Click Close. The server is created. 

To remove a server: 

1. From the Configure menu, select Servers.... The Configure Servers dialog appears. 

2. From the list of servers, select the server that you want to remove, and then click Remove. 

The server is removed. 

� To close the Configure Servers dialog and return to the Navigator window, click Close. 

To toggle server visibility: 

1. From the Configure menu, select Servers.... The Configure Servers dialog appears. 

� To toggle visibility, select/deselect the box below the Visibility icon next to the desired server. 

� To close the Configure Servers dialog and return to the Navigator window, click Close. 
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Set Active Alignment 

Window: ModelSpace 

Menu: Tools | Alignment and Section 

Action: Executes command 

Usage: The Set Active Alignment command enables station notation on the selected 

point, relative to the active alignment. 

� Station-notation values are only supported for alignments that lie completely in the horizontal 

plane. 

� For more information about alignments and the sections process, see the Sections Manager 

chapter. 

Note:    Station Notation in Preferences must be set to On to display station notation. 

To enable use of station notation for a selected alignment: 

1. Select an alignment. 

� If you change the “Up” direction, all station-notations are relative to the new “up” direction, 

except for existing measurements. The alignment must be perpendicular to the current up 

direction for station notation to be available. 

2. From the Tools menu, point to Alignment and Section and then select Set Active 

Alignment 

� All station-notation values will be relative to the selected alignment (except in Sections 

Manager). 

� Existing measurements are not affected. 

� The active alignment may be hidden. 

� If the active alignment is deleted, the active alignment is reset. 

Set as Default Cloud 

Window: ModelSpace  

Menu: Tools | Scanner  

Action: Executes command 

Usage: The Set as Default Cloud is used to remove unwanted or unintended point 

samples from a selected point cloud within the current ScanWorld and any 

subsequent ScanWorld derived from the current ScanWorld. 

�       Invoking this command prevents unwanted points from appearing as part of the point cloud, 

even when a new ModelSpace is created, or when the “original” point cloud is shown via the 

ScanWorld Explorer dialog. 

Note:    Points are not actually deleted from the database when this command is activated; 

rather, they are hidden, and can be restored using the Restore Default Cloud from 

Scan command. 
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Set Atmospheric Correction... 

Window: Scan Control 

Menu: Scanner Control 

Action: Opens dialog 

Usage: The Atmospheric Correction dialog is used to adjust the range of each sampled 

point to compensate for current temperature and pressure conditions while 

scanning. 

To make atmospheric corrections: 

1. From the Scanner Control menu, select Set Atmospheric Correction.... The Atmospheric 

Correction dialog appears. 

2. Edit the appropriate settings and click OK. Atmospheric corrections are applied to adjust the 

range of each sampled point for subsequent scans within the session. 

� To set temperature and range settings, select the appropriate radio button and enter values in 

the Ambient Temperature and Atmospheric Pressure fields. The ppm Total (parts per 

million) is calculated. 

� To set ppm Total directly, click the ppm radio button, and then enter a value in the ppm Total 

field. 

� To reset temperature or pressure defaults, click the appropriate Default button. 

Set Datum to Pick Point 

Window: ModelSpace 

Menu: Tools | Measure | Datum 

Action: Executes command 

Usage: The Set Datum to Pick Point command sets the datum point at the picked point. 

To set the datum at the picked point: 

1. Pick the point where you want to locate the datum point. 

2. From the Tools menu, point to Measure, and then point to Datum and select Set Datum to 

Pick Point. The datum is relocated. 

Set Distance to Next Vertex... 

Window: ModelSpace 

Menu: Tools | Drawing  

Action: Opens dialog 

Usage: The Distance to Next Vertex dialog is used in Drawing mode to set the distance 

between a vertex that has been plotted and the next vertex to be plotted. 

�       After plotting at least one drawing vertex, the distance to the next vertex plotted can be set 

using the Distance to Next Vertex dialog. The next vertex plotted will be exactly that distance 
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away from the previous vertex. Some shapes and steps may not support this distance (e.g., 

plotting the last vertex in a square). 

Set from Active Ref Plane (Cutplane) 

Window: ModelSpace 

Menu: Tools | Cutplane  

Action: Executes command 

Usage: The Set from Active Ref Plane command aligns the active Cutplane to the active 

Reference Plane. 

�       For information on Cutplane attributes, see the Add/Edit Cutplanes command. 

Set From Points... 

Window: ModelSpace 

Menu: View | Coordinate System 

Action: Opens dialog 

Usage: The Set Coordinate System from Pick Points dialog is used to set any or all of 

the following: a reference point, the azimuth (horizontal orientation), and the “up” 

direction (vertical orientation). 

To set the reference point only: 

1. In Pick mode, click the point to use as the reference point. 

2. From the View menu, point to Coordinate System, and then select Set from Points. The Set 

Coordinate System From Pick Points dialog appears. 

� Setting the reference point does not affect the current orientation of the coordinate axes. 

3. Enter the coordinate for the reference point, and then click OK. The new coordinate is applied. 

To set the reference and azimuth: 

1. In Pick mode, click the point to use as the reference point. 

2. Mult-select the point you want to use for azimuth reference. 

3. From the View menu, point to Coordinate System, and then select Set from Points. The Set 

Coordinate System from Pick Points dialog appears. 

� The pick points are displayed in the ModelSpace View along with a number indicating the 

order in which the points were picked. Drop-down lists are available in each field in the dialog 

to choose the appropriate reference pick point. 

4. In the Reference Point fields, enter the coordinate for the reference point. 

5. In the Azimuth Point field, enter a value for the degrees to the azimuth point from the 

reference point. 

6. Click OK. The new coordinates are applied, and the horizontal axes are rotated. 

� Setting the origin and azimuth does not affect the current “up” direction or axis. 
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To set the reference, azimuth, and “up” direction: 

1. In Pick mode, click to use as the reference point. 

2. Click the point you want to use for azimuth reference. 

3. Mult-select a pair of points known to be in vertical alignment for the “up” direction reference. 

(Pick points used for either an azimuth or reference (origin) can also be used as part of an “up 

direction pair”). 

� These point pairs can come from a Leica Geosystems HDS dual-target pole or another 

structural feature. 

4. If there are any points with known elevation, multi-select them as well to aid in vertical 

accuracy. 

5. From the View menu, point to Coordinate System, and then select Set from Points. The Set 

Coordinate System from Pick Points dialog appears. 

� The pick points are displayed in the ModelSpace View along with a number indicating the 

order in which the points were picked. Drop-down lists are available in each field in the dialog 

to choose the appropriate reference pick point. 

6. In the Reference Point fields, enter the coordinate for the reference point. 

7. In the Azimuth Point field, enter a value for the degrees to the azimuth point from the 

reference point. 

8. In the Top Point and Bottom Point fields, select the corresponding pick points from the drop-

down lists. 

9. If known elevation points have been picked, select the appropriate pick points from the drop-

down list in the Elevation Point 1 and 2 fields, and then enter a value for the elevations. 

10. Click OK. The new coordinates are applied, and the horizontal and vertical axes are rotated. 

Set from Reference Plane 

Window: ModelSpace 

Menu: View | Coordinate System 

Action: Executes command 

Usage: The Set from Reference Plane command aligns the coordinate system of the 

ModelSpace to the active reference plane. 

Set from Selection 

Window: ModelSpace 

Menu: Edit | Fence 

Action: Executes command 

Usage: The Set from Selection command uses the selected linear object (such as an arc, 

circle, polyline, polygon, etc.) to define a data fence.  

�       For more information on working with fences, see the Using a Fence entry in the Modeling 
chapter. 
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To create a fence from a linear object: 

1. Select the linear object you wish to use to define a data fence. 

� Linear objects can be created by a variety of methods including via the 2D drawing tools. If an 
arc or other open curvilinear object is selected, the end points are connected for purposes of 
defining the data fence. 

2. From the Edit menu, point to Fence, and then select Set from Selection. The fence is 

created. 

� The resulting data fence can be used in all fencing operations. 

Set Grid Spacing... 

Window: ModelSpace 

Menu: Edit Object | Snapping Grid 

Action: Opens dialog 

Usage: The Set Grid Spacing dialog is used to set the interval by which a handle can be 

moved or a vertex can be placed (in Drawing mode) when using the snapping grid. 

To set grid spacing: 

1. From the Edit Object menu, point to Snapping Grid, and then select Set Grid Spacing.... 

The Set Grid Spacing dialog appears. 

2. In the Grid Spacing field, enter a value for the interval by which a handle can be moved when 

Snap to Grid is ON. 

3. Click OK. The grid spacing is set. 

Set Half-Space at Pick 

Window: ModelSpace 

Menu: Tools | Cutplane 

Action: Displays submenu 

Usage: Pointing to Set Half-Space at Pick displays submenu commands to specify the 

active Cutplane as a half-space, based on the last pick point. 

See also: View Half-Space and Add/Edit Cutplanes 

To set the Cutplane half-space a the pick point: 

1. Pick the point through which the active Cutplane will pass. 

2. From the Tools menu, point to Cutplane, and then point to Set Half-Space at Pick and 

select the axis you want (X, Y, or Z Axis), in the direction you want (along the positive or 

negative axis). The active Cutplane is set on the pick point, perpendicular to the selected axis. 

The direction of the axis is the side that is hidden. 

� The active Cutplane and the View Half-Space option are automatically enabled. 
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Set Home ScanWorld 

Window: Registration 

Menu: ScanWorld 

Action: Executes command 

Usage: The Set Home ScanWorld command designates the Home ScanWorld for the 

current Registration. 

�       The Home ScanWorld defines the reference coordinate system for the ScanWorld created 

from a successful Registration. 

�       By default, the first ScanWorld added to the Registration is set as the Home ScanWorld. 

���The Home ScanWorld is displayed in bold type with red axis in its icon. 

To set the Home ScanWorld: 

1. From the ScanWorlds’ Constraints tab or the ModelSpaces tab, select the ScanWorld that 

you want to be the Home ScanWorld. 

� There must already be ScanWorlds added to the Registration before a Home ScanWorld can 

be chosen. 

2. From the ScanWorld menu, select Set Home ScanWorld. The Home ScanWorld is set and 

is displayed in bold type. 

Set Limit Box by Cursor 

Window: ModelSpace 

Menu: View 

Action: Executes command 

Usage: The Set Limit Box by Cursor command lets the user drag the cursor to 

interactively define the extents of the limit box, centered around the current focal 

point. The limit box is aligned to the current viewpoint. 
 
• To set the focal point at a selected point, use the Seek mode. 

• To cancel setting the limit box with the cursor, click the right mouse button at any time. 

Set Limit Box by Fencing 

Window: ModelSpace, Registration 

Menu: ModelSpace: View 

 Registration: Viewers 

Action: Executes command 

Usage: The Set Limit Box by Fencing command lets the user drag the rectangular fence 

to interactively define the extents of the limit box anywhere in the window. The 
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center of the limit box is determined automatically in 3D. The limit box is aligned to 

the current viewpoint. 
 
• If the center of the fence falls over an object or cloud point, the center of the limit box is set to 

that coordinate, and the limit box is a cube. Otherwise, the limit box’s depth is set to contain 
the objects within the fence. 

• To cancel setting the limit box with the fence, click the right mouse button while dragging the 
fence. 

Set Object Visibility... 

Window: ModelSpace 

Menu: View 

Action: Opens dialog 

Usage: The Set Object Visibility... command opens the Selectable/Visible tab of the View 

Properties dialog, which is used to set the visible and selectable properties for 

classes of objects. 

•       To make a class of objects visible, select the check box in the Visible column next to the 

object type. 

•       To make a class of objects selectable, select the check box in the Selectable column next 

to the object type. 

�       Settings in the Selectable/Visible tab interact with Layers settings. For an object to be 

visible,both its layer and its class must be visible; otherwise, it is not drawn. 

Set Offset... 

Window: ModelSpace 

Menu: Tools | Cutplane  

Action: Opens dialog 

Usage: The Cutplane Offset dialog is used to set the increment by which the active 

Cutplane is raised and lowered using the Raise Active Cutplane and Lower 

Active Cutplane commands in the Cutplanes submenu. 

To set the offset for the active Cutplane: 

1. From the Tools menu, point to Cutplane, and then select Set Offset.... The Cutplane Offset 

dialog appears. 

2. In the Offset field, enter a value for the distance by which the Raise Active Cutplane and 

Lower Active Cutplane commands raise/lower the active Cutplane. 

� A positive value indicates that the offset is in the same direction as the Cutplane’s normal 

vector. 

3. Click OK. The offset is set. 
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Set on Object (Cutplane) 

Window: ModelSpace 

Menu: Tools | Cutplane  

Action: Executes command 

Usage: The Set on Object command aligns the active Cutplane with the axis of the picked 

object, through the pick point. 

Set on Object (Reference Plane) 

Window: ModelSpace 

Menu: Tools | Reference Plane  

Action: Executes command 

Usage: The Set on Object command aligns the active Reference Plane with a picked 

object. 

�       The type of picked object and the location of the pick point determine various orientations 

for the active Reference Plane. The rules can be sophisticated; for example, a pick near the end 

of a cylinder centers the active Reference Plane at the closest endpoint and perpendicular to the 

centerline; otherwise, the active Reference Plane is aligned parallel to the cylinder’s centerline 

and perpendicular to the tangent of the cylinder surface at the pick point. 

Set Origin 

Window: ModelSpace 

Menu: View | Coordinate System 

Action: Executes command 

Usage: The Set Origin command sets the coordinate system's origin at the picked point. 

To set the origin: 

1. In Pick mode, click the point where you want to locate the origin. 

2. From the View menu, point to Coordinate System, and then select Set Origin. The origin is 

relocated to the pick point. 

� Setting the origin does not affect the orientation of the coordinate axes. 
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Set Path 

Window: ModelSpace 

Menu: Tools | Animation 

Action: Executes command 

Usage:  The Set Path command designates the selected spline or spline loop and optional 

Camera objects as the active path from which an animation can be created or 

restored. 

�    For an overview of the animation process, see the Animation chapter. 

Set Plane Origin at Pick Point 

Window: ModelSpace 

Menu: Tools | Reference Plane  

Action: Executes command 

Usage: The Set Plane Origin at Pick Point command sets the origin of the active 

Reference Plane at the picked point. 

To set the Reference Plane to a picked point: 

1. Pick the point at which you want to set the origin of the active Reference Plane. 

2. From the Tools menu, point to Reference Plane, and then select Set Plane Origin at Pick 

Point. The Reference Plane is moved to pass through the pick point without changing its 

orientation or axes, centered at the pick point. 

Set Points Selectable 

Window: Registration 

Menu: Viewers 

Action: Toggles menu item ON/OFF  

Usage: The Set Points Selectable command toggles the ability to select point clouds in the 

ModelSpace viewers. 

Set Rotational Spacing... 

Window: ModelSpace 

Menu: Edit Object | Snapping Grid 

Action: Opens dialog 

Usage: The Set Rotational Spacing dialog is used to set the angular interval by which an 

object can be rotated using its rotation handle when Snap to Grid is ON. 
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To set rotational spacing: 

1. From the Edit Object menu, point to Snapping Grid, and then select Set Rotational 

Spacing.... The Set Rotational Spacing dialog appears. 

2. In the Rotational Spacing field, enter a value for the angular interval by which an object can 

be rotated when Snap to Grid is ON. 

3. Click OK. The rotational spacing is set. 

Set Scan Filters... 

Window: Control 

Menu: Scanner Control 

Action: Opens dialog 

Usage:  The Set Scan Filters dialog is used to set range and/or intensity parameters outside 

of which points sampled by the scanner are discarded without being recorded to the 

database. 

To set scan filters: 

1. From the Scanner Control menu, select Set Scan Filters.... The Set Scan Filters dialog 

appears. 

2. Set range and intensity parameters. 

� To set range parameters, select the Min and/or Max check boxes and enter values for the 

low/high end of the range you want recorded to the database. Next, select Rectangular 

(HDS2500 only) or Spherical to designate distance measurements as either point-to-point 

distances directly to the scanner (spherical) or as a plane in front of the scanner (rectangular). 

� To set intensity parameters, select the Min and/or Max check boxes and enter values for the 

low/high intensities of points you want recorded to the database. 

3. Click OK. The dialog closes and filters are set for any subsequent scans using the current 

Scan Control window. 

Set ScanWorld Coordinate System 

Window: ModelSpace 

Menu: View | Coordinate System 

Action: Executes command 

Usage: The Set ScanWorld Coordinate System command sets the current ModelSpace 

View’s coordinate system and “up” direction as the default for its parent ScanWorld.  

� After setting the ScanWorld coordinate system, all new ModelSpaces derived from the 

ScanWorld are set to the new coordinate system and “up” direction. Also, if set as the Home 

ScanWorld in a Registration, the ScanWorld's default coordinate system and "up" direction is 

used as the default coordinate system of the ScanWorld created from that Registration. 
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Set Selectable... 

Window: ModelSpace 

Menu: Selection 

Action: Opens dialog 

Usage: The Set Selectable... command opens the Selectable/Visible tab of the View 

Properties dialog, which is used to set the visible and selectable properties for 

classes of objects. 

•       To make a class of objects selectable, select the check box in the Selectable column next 

to the object type. 

•       To make a class of objects visible, select the check box in the Visible column next to the 

object type. 

� Settings in the Selectable/Visible tab interact with Layers settings. For an object to be 

selectable, both its layer and its class must be selectable. 

Set ScanWorld Default Clouds 

Window: ModelSpace 

Menu: Tools | Scanner  

Action: Executes command 

Usage: The Set ScanWorld Default Clouds command designates the current point clouds 

as the default point clouds that are loaded whenever a new ModelSpace is created 

from the parent ScanWorld. 

�      This command is useful after deleting unwanted points from the point clouds, or after using 

the Unify Clouds command. 

•     To revert to the original scan clouds as the default, use Restore Original Scans command. 

To set a default point cloud: 

1. After creating two or more point clouds through segmentation, select a single point cloud. 

2. From the Tools menu, point to Scanner, and then select Set ScanWorld Default Clouds. 

The selected point cloud is loaded whenever a new ModelSpace is created from the parent 

ScanWorld. 
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Set Slice from Picks 

Window: ModelSpace 

Menu: Tools | Cutplane 

Action: Displays submenu 

Usage: Pointing to Set Slice from Picks displays submenu commands to specify the active 

Cutplane as a slice, based on the last two pick points. 

See also: View Slice and Add/Edit Cutplanes 

To set the Cutplane slice from pick points: 

1. Pick the point through which one plane of the Cutplane slice will pass. 

2. Shift+Pick the second point through which the other plane of the Cutplane slice will pass. 

3. From the Tools menu, point to Cutplane, and then point to Set Slice from Picks and select 

the axis to use (X, Y, or Z Axis). The active Cutplane is set perpendicular to the selected axis, 

and its slice planes are positioned to pass through the two pick points. 

� The active Cutplane and the View Slice option are automatically enabled. 

Set Slice Thickness... 

Window: ModelSpace 

Menu: Tools | Cutplane  

Action: Opens dialog 

Usage: The Set Slice Thickness dialog is used to set the thickness of the slice used in the 

Slice command (see the Slice entry in this chapter).  

�       When the Slice command is toggled ON, all geometry beyond the slice is hidden. 

To set slice thickness: 

1. From the Tools menu, point to Cutplane, and then select Set Slice Thickness.... The Set 

Slice Thickness dialog appears. 

2. In the Slice Thickness field, enter a value. 

3. Click OK. The slice thickness is adjusted. 

Set Target Height 

Window: ModelSpace 

Menu: Tools | Registration 

Action: Executes command 

Usage: The Set Target Height command displays the Set Target Height dialog. Set the 

height of the target above its base point (e.g., if the target had been placed a known 

height above a known survey point), for use in registration. 
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Set to { X-Y, X-Z, Y-Z} Plane 

Window: ModelSpace 

Menu: Tools | Reference Plane  

Action: Executes command 

Usage: The Set to { X-Y, X-Z, Y-Z} Plane command orients the active Reference Plane to 

the chosen coordinate system axes and centers the Reference Plane’s origin at the 

focal point of the viewpoint. 

Set to Object 

Window: ModelSpace 

Menu: View | Coordinate System 

Action: Executes command 

Usage: The Set to Object command aligns the coordinate system of the ModelSpace to the 

selected object. 

Set to UCS 

Window: ModelSpace 

Menu: Tools | Reference Plane | Set to UCS 

Action: Executes command 

Usage: The Set to UCS command aligns the active reference plane to the current user 

coordinate system of the ModelSpace. 

Set to Viewpoint 

Window: ModelSpace 

Menu: Tools | Reference Plane  

Action: Executes command 

Usage: The Set to Viewpoint command sets the active Reference Plane perpendicular to 

the current viewpoint, centered on the focal point. 

Set Up Direction 

Window: ModelSpace 

Menu: View 

Action: Displays submenu 

Usage: Pointing to Set Up Direction displays submenu commands used to set the “up” 

direction to one of the major axes.  
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The following commands are available from the Set Up Direction submenu: 

X Axis, Y Axis, Z Axis 

Set Using One Axis 

Window: ModelSpace 

Menu: View | Coordinate System 

Action: Displays submenu 

Usage: The Set Using One Axis command displays submenu commands used to reset the 

orientation of the X, Y, or Z coordinate system axis to match the axis of a selected 

object. 

The following commands are available from the Set Using One Axis submenu: 

X Axis, Y Axis, Z Axis 

 

To set a coordinate system axis: 

1. Select the object to which you want to align the chosen axis. 

� The direction in which the axis is oriented is based on the location of the pick point on the 

reference object. The axis is oriented towards the end of the reference object nearest the pick 

point. 

2. From the View menu, point to Coordinate System, and then point to Set Using One Axis 

and select the axis you want (X, Y, or Z Axis). The axis in the command you select is aligned 

exactly to the axis of the reference object, and the other two axes are made perpendicular to 

the set axis. 

� Multiple user-defined coordinate systems can be saved and restored. (See the Save/Edit 

Coordinate System entry in this chapter). 

� To specify new orientations for all three coordinate system axes, see the Set Using Two Axes 

(X then Y, etc.) entry in this chapter. 

Set Using Two Axes 

Window: ModelSpace 

Menu: View | Coordinate System 

Action: Displays submenu 

Usage: Pointing to Set Using Two Axes displays submenu commands that are used to 

reset the orientation of the specified axes to match the axes of two selected objects. 

The following commands are available from the Set Using Two Axes submenu: 

X then Y Axis, X then Z Axis, Y then X Axis, Y then Z Axis, Z then X Axis, Z then Y Axis 
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To set two coordinate system axes: 

1. Select the object to which you want to align the first axis in the command. 

� The first axis in the command you select is aligned exactly to the axis of the first object you 

select. 

� The directions in which the axes are oriented are based on the locations of the pick points on 

the reference objects. Each axis is oriented towards the end of the reference object nearest 

the pick point. 

2. Multi-select a second object to which you want to align the second axis in the command. 

� The second axis in the command that you select is aligned as closely as possible to the axis 

of the second reference object while still being perpendicular to the first axis set by the 

command. The remaining axis is made perpendicular to the other two axes. 

3. From the View menu, point to Coordinate System, and then point to Set Using Two Axes 

and select the pair of axes you want (X then Y Axis, X then Z Axis, etc.). The coordinate 

system axes are set. 

� Multiple user-defined coordinate systems can be saved and restored (See the Save/Edit 

Coordinate System entry in this chapter). 

Set Weight... 

Window: Registration 

Menu: Constraint 

Action: Opens dialog 

Usage: The Set Constraint Weight dialog is used to set the relative weight of individual 

constraints used in registration. 

�       The weight value can be set from 0.0 to 1.0, with 0.0 indicating that the constraint has no 

effect on the registration. A constraint set to 0.5 has half the influence of a constraint set to 1.0. 

Note:    The practice of decreasing the weight of all constraints with higher than average error 

is not recommended as it can lead to lower overall registration accuracy. Decreasing 

the weight of a constraint should only be done if you have reason to believe that the 

measurement of one or both of the objects in the constraint is less accurate than other 

measured objects. 

To set a constraint’s weight: 

1. In the ScanWorlds’ Constraints tab of the Registration window, select the constraint you 

want to adjust. 

2. From the Constraint menu, select Set Weight.... The Set Constraint Weight dialog appears. 

3. Enter a value between 0.0 and 1.0 in the Weight field, and then click OK. The weight is 

adjusted. 
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Shaded 

Window: ControlSpace, ModelSpace, Registration, Scan Control (ScanStation, 

ScanStation 2, HDS3000, HDS4500, HDS6000) 

Menu: Point Cloud Rendering 

Action: Toggles menu item ON/OFF 

Usage: The Shaded command toggles the lighting of point clouds, similar to meshes. 
 
• Only point clouds with valid surface normal vector estimates respond to the Shaded render 

mode. 
• The Point Cloud Rendering | Front and Point Cloud Rendering | Back commands affect 

which side of the cloud is lit. Front shades points on surfaces facing the original scanner. 
Back shades points on surfaces facing away from the original scanner. 

Shortcut 

Window: Navigator 

Menu: Create 

Action: Executes command 

Usage: The Shortcut command creates a shortcut to the selected object in the Shortcuts 

top-level folder. 

�       A shortcut provides quick access to often-used projects, ScanWorlds, ModelSpaces, and 

Registrations that may be several layers down in the database structure. 

To create a shortcut: 

1. In the Navigator window, select the object for which you need a shortcut. 

2. From the Create menu, select Shortcut. The shortcut is added to the Shortcuts folder. 

Shortcut in Windows 

Window: Navigator 

Menu: Create 

Action: Displays submenu 

Usage: The Shortcut in Windows command displays a submenu that creates a Windows 

shortcut to the selected object on the Windows Desktop, Start Menu, Quick Launch 

Bar or as a Windows Favorite. A shortcut provides quick access to often-used 

projects, Scan Worlds, ModelSpaces, and Registrations that may be several levels 

down in the database structure.  When the shortcut is selected, Cyclone will launch, 

locate the target of the shortcut and open the appropriate dialog or viewer for it.. 
 

� Windows shortcuts created with this command are different from Cyclone shortcuts created 
in the Cyclone Navigator. Windows shortcuts may be placed anywhere within the Windows 
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operating system and function outside of Cyclone to launch Cyclone and browse to their 
target objects. Cyclone shortcuts are located only within the Cyclone Navigator and only 
function within Cyclone. 

To create a shortcut in Windows 

1. In the Navigator window, select the object to which you want to create a Windows shortcut. 

2. From the Create menu, select Shortcut in Windows | [submenu command]. The shortcut is 

added to the indicated location. 

� The shortcut name is based on the name of the object the shortcut points to. 

� If there is already an existing shortcut with the same name, it will be overwritten with the new 

shortcut. You are prompted to confirm or cancel. 

Show Active Plane 

Window: ModelSpace 

Menu: Tools | Reference Plane  

Action: Toggles menu item ON/OFF  

Usage: The Show Active Plane command toggles the display of the active Reference 

Plane. 

Show All (Limit Box Manager) 

Window: Limit Box Manager 

Menu: View 

Action: Executes command 

Usage: The Show All command toggles visibility of limit boxes between only the activated 

limit box and all limit boxes.. 

����When all limit boxes are visible, the active limit box is displayed is highlighted with thick lines 

and limit box selected in the list is displayed with dashed lines 

Show Annotation Keys 

Window: ModelSpace 

Menu: Tools | Annotations 

Action: Toggles menu item ON/OFF 

Usage: The Show Annotation Keys command toggles the display of annotation keys in the 

window. When checked, annotations keys are shown with the annotation values; 

when not checked, annotation keys are not shown, although the annotation values 

are still displayed. 
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Show Annotation Points 

Window: Image Viewer 

Menu: Annotation 

Action: Toggles menu item ON/OFF 

Usage: The Show Annotation Points command toggles the display of annotation points. 

� When checked, the annotation points are displayed on the image. 

Show Annotations 

Window: Image Viewer, ModelSpace 

Menu: Image Viewer: Annotation 

ModelSpace:  Tools | Annotations 

Action: Toggles menu item ON/OFF 

Usage: The Show Annotations command toggles the display of annotations. When 

checked, annotations are shown in the window; when not checked, annotations 

are not shown.  

Note:    The visibility of text added to the ModelSpace using Cyclone’s drawing tools is also 

toggled using this command. 

Note:    Use the Add/Edit Annotations command to make individual annotations visible; an 

annotation must be individually visible and the Show Annotations command must be 

ON for the annotation to actually be displayed. 

Show Constraint 

Window: Registration 

Menu: Constraint 

Action: Executes command 

Usage: The Show Constraint command displays the objects involved in the selected 

constraint in the Constraint Viewer panes. 

�       For complete registration procedures, see the Registration entry in the Getting Started 
chapter. 

To display a constraint: 

1. From either the Constraint List or the ScanWorlds’ Constraints pane, select the constraint 

you want to view. 

2. From the Constraint menu, select Show Constraint. The objects involved in the constraint 

are displayed in the Constraint Viewer panes of the Registration window. 

� The objects involved in the constraint are selected and centered in each ModelSpace’s pane. 

� When a cloud constraint is selected, the ControlSpaces referenced by the cloud constraint 
appear in the two Constraint viewers, and the two viewers are synchronized so that the view 
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navigation in one viewer is matched in the other viewer. All pick points from the cloud 
constraint appear as well. Note that any of these pick points are editable, and the Update 
Initial Cloud Alignment command can be used to modify the alignment. 

Show Constraint Viewer 1 (2) 

Window: Registration 

Menu: Viewers 

Action: Toggles menu item ON/OFF  

Usage: The Show Constraint Viewer 1 and Show Constraint Viewer 2 commands toggle 

the display of the two Constraint viewer windows. 

Show Coordinate System Axes 

Window: ModelSpace 

Menu: View | Coordinate System 

Action: Toggles menu item ON/OFF 

Usage: The Show Coordinate System Axes command toggles the visibility of the 

coordinate axes in the ModelSpace viewer. 

�       When checked, the coordinate system axes are displayed. 

�       Depending on the coordinate system and viewpoint, the origin may or may not be visible. 
The axes may also be hidden behind objects. 

�       The coordinate axes X, Y, and Z are always displayed in red, green, and blue respectively. 

Show Current Transform 

Window: Registration 

Menu: ScanWorld 

Action: Opens dialog 

Usage: The Show Current Transform dialog displays the current transform for the 

selected ScanWorlds as computed by the latest registration. 

�       The transform is a rigid six degrees of freedom transformation consisting of three rotation 

degrees of freedom (roll, pitch, and yaw) and three translation degrees of freedom (X, Y, Z 

offset). 

To show the current transform 

1. From the ScanWorlds’ Constraints or the ModelSpaces tab, select the ScanWorlds whose 

transforms you want to view. 

2. From the ScanWorld menu, select Show Current Transform. The Show Current 
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Transform dialog appears, displaying the current transform. 

Show Datum 

Window: ModelSpace 

Menu: Tools | Measure | Datum 

Action: Toggles menu item ON/OFF 

Usage: The Show Datum command toggles the visibility of the current datum point. 

�       The datum is represented visually by a callout line and a “Datum” label at the reference 

point of the datum. 

Show Diagnostics... 

Window: Registration 

Menu: Cloud Constraint 

Action: Opens dialog 

Usage: The Cloud Constraints Diagnostics dialog is used to view alignment accuracy 

data for the selected cloud constraint. 

�       For more information on the cloud registration process, see the Cloud Registration entry in 

the Registration chapter. 

Cloud Constraint Diagnostics Fields 

CLOUD/MESH #  

The name of the constraint. 

TRANSLATION 

The translation vector for the alignment of the second cloud onto the first cloud. 

ROTATION 

The rotation axis and angle for the alignment of the second cloud onto the first cloud. 

OBJECTIVE FUNCTION VALUE 

The value of the overlap error function being minimized during alignment. 

OVERLAP POINT COUNT 

The number of overlapping points between the two ScanWorlds. 

RMS 

The root mean square value of the absolute errors of between overlapping points. 

AVG 

The average value of the absolute errors between overlapping points. 
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MIN 

The minimum value of the absolute errors between overlapping points. 

MAX 

The maximum value of the absolute errors. 

STD DEV 

The standard deviation of the absolute errors between overlapping points. 

OVERLAP CENTER 

An estimate of the center of mass of all the overlapping points in the coordinate system of the 

first ScanWorld 

FILTER PARAMETERS 

The user preferences used during alignment. 

STOPPING CRITERIA 

The user preferences used during alignment. 

To view cloud constraint diagnostics: 

1. From the Constraint List tab, select the cloud constraints you want to inspect. 

2. From the Cloud Constraint menu, select Show Diagnostics.... The Cloud Constraints 

Diagnostics dialog appears displaying alignment accuracy data (see the following 

descriptions). 

� If more than one alignment has been performed, accuracy data is displayed for each 

alignment, starting from the most recent. 

� To view a temporary ModelSpace containing the overlapping points, click Show Overlap. 

From the first ScanWorld, overlapping points are colored blue and non-overlapping points are 

colored dark blue. From the second ScanWorld, overlapping points are colored green and 

non-overlapping points are colored dark green. 

� To save the diagnostics as a text file, click Save... and use the dialog that appears to specify a 

name and location for the text file. 

� To print the diagnostic, click Print.... A standard print dialog launches. 

� To view a graphical histogram of the errors of the overlapping clouds with lines indicating user 

preferences, click Histogram. See the Error Histogram entry in the Registration chapter for 

details. 

Show Grid 

Window: Scan Control 

Menu: Image 

Action: Toggles menu item ON/OFF 

Usage: The Show Grid command toggles the display of the targeting grid in the Scan 

Control window. 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Index 

435 

Show Handles 

Window: ModelSpace 

Menu: Edit Object | Handles  

Action: Toggles menu item ON/OFF  

Usage: The Show Handles command toggles the visibility of object handles. 

�       Handles allow you to manipulate an object’s position and shape in various ways. 

�   For more information on using handles, see the Handles entry in the Modeling chapter. 

Show Hidden Clouds 

Window: ModelSpace 

Menu: View 

Action: Executes command 

Usage: The Show Hidden Clouds command displays cloud points that have been hidden 

using the Hide Selected Clouds or Hide Unselected Clouds command.. 

Show Images 

Window: Scan Control 

Menu: Image 

Action: Executes command 

Usage: The Show Images command toggles visibility of camera images in the Scan 

Control window. 

� Having a valid image in the Scan Control window is not required for targeting the scanner or 

for scanning. 

Show Incoming Points 

Window: ModelSpace 

Menu: Tools | Scanner 

Action: Toggles menu item ON/OFF  

Usage: The Show Incoming Points command toggles the display of scan data as they are 

captured. 

�       It can be helpful to toggle this command OFF if modeling is being done in the same 

ModelSpace viewer. 
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Show ModelSpace 

Window: Scan Control 

Menu: Scanner Control 

Action: Toggles menu item ON/OFF  

Usage: The Show ModelSpace command toggles the display of the destination 

ModelSpace in the active Scan Control window. 

�       When ON, any changes are displayed in the active Scan Control window when the window 

is refreshed. The ModelSpace is displayed from the scanner's point of view in that ModelSpace. 

�       In order to use this command, the destination ModelSpace viewer must be opened. (See 

the Open ModelSpace Viewer command) 

Show Object’s Cloud 

Window: ModelSpace 

Menu: View 

Action: Toggles menu item ON/OFF  

Usage: The Show Object’s Cloud command toggles the display of the point cloud(s) that 

were used to create the selected object. 

�       Viewing an object’s points provides access to the points for visual comparison or 

verification. 

�       When an object or its source points have changed significantly, this command is not 

available. 

To view an object’s point cloud: 

1. Select the object whose point cloud(s) you want to make visible. 

2. From the View menu, select Show Object’s Cloud. 

� If you want to be able to select and edit a copy of the point cloud used to create an object, use 

the Insert Copy of Object’s Points command instead. 

Show Output Box 

Window: ModelSpace 

Menu: View 

Action: Toggles menu item ON/OFF 

Usage: When Show Output Box is selected, the Output Box is displayed until closed by 

the user.  
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�       Each new measurement is recorded consecutively in the Output Box; the data in this dialog 

is easily copied and pasted into other applications. 

�       Selecting Show Output Box automatically turns the Enable Output Box option ON. 

Note:    The Output Box can be docked to the side of the ModelSpace window. 

Show Pick Points 

Window: ModelSpace 

Menu: Selection 

Action: Toggles menu item ON/OFF 

Usage: The Show Pick Points command toggles the display of pick points as white points. 

�       The points can be used later to create vertices, line segments, polylines, arcs, and splines. 

�       Pick points need not be visible to be used by other commands. 

Show Pick Polyline 

Window: ModelSpace 

Menu: Selection 

Action: Toggles menu item ON/OFF 

Usage: The Show Picked Polyline command toggles the display of a polyline along the 

current series of pick points. 

�       This command does not create a polyline. It displays the order of the pick points. 

�       This may be useful for keeping track of the order of picks for operations like creating a cubic 

spline or a polyline from pick points. 

Show Point Clouds 

Window: Registration 

Menu: Viewers 

Action: Toggles menu item ON/OFF  

Usage: The Show Point Clouds command toggles the display of point clouds in the 

Constraint viewers in the Registration viewer. 
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Show Rotation Handles 

Window: ModelSpace 

Menu: Edit Object | Handles  

Action: Toggles menu item ON/OFF  

Usage: The Show Rotation Handles command toggles the display and availability of 

object rotation handles. 

�       Rotation handles allow you to rotate an object around any of its principal axes. 

�       For more information on using handles, see the Handles entry in the Modeling chapter. 

Show Scanners 

Window: Navigator 

Menu: View 

Action: Toggles menu item ON/OFF  

Usage: The Show Scanners command toggles the display of the Scanners folder in the 

Navigator. 

Show Servers 

Window: Navigator 

Menu: View 

Action: Toggles menu item ON/OFF  

Usage: The Show Servers command toggles the display of the Servers folder in the 

Navigator. 

Show Shortcuts 

Window: Navigator 

Menu: View 

Action: Toggles menu item ON/OFF  

Usage: The Show Shortcuts command toggles the display of the Shortcuts folder in the 

Navigator. 

Show Table Matches 

Window: ModelSpace 

Menu: Create Object | Fit to Cloud Options 

Action: Toggles menu item ON/OFF 

Usage: The Show Table Matches command enables/disables the use of parts tables when 
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fitting objects. 

�       In order to use parts tables when fitting, Catalog/Parts Table and Table must be selected 

within the Object Preferences dialog. See the Object Preferences entry in this chapter. 

�   For an overview of fitting objects in Cyclone, see the Modeling entry in the Getting Started 

chapter. 

Show Traverse Report... 

Window: Registration 

Menu: Registration 

Action: Opens dialog 

Usage: The Traverse Report dialog is used to view the parameters and accuracy of a 

Registration created through Traverse. 

�       For more information on the traverse process, see the Traverse (ScanStation, ScanStation 

2) entry in the Scanning with the ScanStation, ScanStation 2, and HDS3000 chapter, or the 

Traverse (HDS6000) section in the Scanning with the HDS6000 and HDS4500 chapter. 

To view the traverse report: 

1. From the Registration menu, select Show Traverse Report.... The Traverse Report dialog 

appears, displaying the parameters and quality of the traverse. 

Silhouette 

Window: ControlSpace, ModelSpace, Registration, Scan Control (ScanStation, 

ScanStation 2, HDS3000, HDS4500, HDS6000) 

Menu: Point Cloud Rendering 

Action: Toggles menu item ON/OFF 

Usage: The Silhouette command affects the transparency of each cloud point based on 

the orientation of that point’s estimated surface relative to the viewer, such that 

outlines of surfaces inherent in the point cloud are revealed.. 
 
• Only point clouds with valid surface normal vector estimates respond to the One-Sided 

render mode. 
• Points that are on estimated surfaces facing the viewer are opaque. Points gradually become 

more transparent as the estimated surface is oriented to be perpendicular to the viewer. 
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Slice 

Window: ModelSpace 

Menu: Create Object 

Action: Displays submenu 

Usage: Pointing to Slice displays submenu commands to cut selected object(s) using a 

patch, ref plane, or all selected objects. 

The following commands are available from the Slice submenu: 

by Last Selection, by Ref Plane, All in Selection 

Snap to Grid 

Window: ModelSpace 

Menu: Edit Object | Snapping Grid  

Action: Toggles menu item ON/OFF 

Usage: The Snap to Grid command toggles the snapping grid ON/OFF. 

�       The snapping grid is used to control object movement when using handles. 

�       For 2D drawing, the snapping grid is aligned to the active Reference Plane’s origin and 

axes. 

�       For object manipulation, the snapping is an invisible 3D grid aligned with the coordinate 

system and spaced by the given spacing relative to the origin, along all three axes. 

�       When ON, objects/vertices jump to the next grid increment as you move them/draw them, 

and objects jump to the next interval when rotated using rotation handles. When OFF, objects 

move independently of grid settings. 

�   To adjust grid spacing, see the Set Grid Spacing command. 

�   To adjust rotational spacing, see the Set Rotational Spacing command. 

Snapping Grid 

Window: ModelSpace 

Menu: Edit Object  

Action: Displays submenu 

Usage: Pointing to Snapping Grid displays submenu commands used to toggle the 

snapping grid ON/OFF and edit grid settings. 
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The following commands are available from the Snapping Grid submenu: 

Set Grid Spacing..., Set Rotational Spacing..., Snap to Grid 

�       The snapping grid is used to control object movement when using handles. 

�       For 2D drawing, the snapping grid is aligned to the active Reference Plane’s origin and 

axes. 

�       For object manipulation, the snapping is an invisible 3D grid aligned with the active 

coordinate system and spaced by the given spacing in all three directions. 

�       When ON, objects/vertices jump to the next grid increment as you move them/draw them, 
and objects jump to the next interval when rotated using its rotation handle. When OFF, objects 
move independently of grid settings. 

Snapshot... 

Window: ModelSpace, Scan Control, Image Viewer 

Menu: File 

Action: Opens dialog 

Usage: The Save Snapshot to File dialog is used to save an image of the current 

ModelSpace, Scan Control, or Image. 

To save a snapshot of the current window: 

1. From the File menu, select Snapshot.... The Save Snapshot to File dialog appears. 

2. Select the file format you want from the Save as type box. 

3. Navigate to the desired destination directory, type a name for the file, and then click Save. 

Your image is saved. 

Sphere Target 

Window: ModelSpace 

Menu: Create Object | Fit to Cloud 

Action: Executes command 

Usage: The Sphere Target command fits a 6” diameter sphere target to the selected point 

cloud. When the sphere target is created, it is added automatically to the 

ControlSpace as well. 

To fit a sphere target: 

1. Pick the point cloud near the center of the area to which you want to fit a sphere target. 

� It is assumed that the pick is on the surface of the target. 

� It is not necessary to segment the point cloud prior to fitting. 
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2. From the Create Object menu, point to Fit to Cloud, and then select Sphere Target. A 

sphere is fit to the spherical target. 

Stakeout 

Window: Scan Control (ScanStation, ScanStation 2, HDS6000) 

Menu: Window 

Action: Expands Tab 

Usage: The Stakeout command expands the Stakeout tab in the Scanner Control Panel. 

�       The Stakeout procedure requires Field Setup to first be applied to establish the scanner’s 

coordinate system. 

�       The Stakeout procedure is optimally executed with at least two personnel: one person to 

operate the scanner, and one person to set up and move the target until it is over the stakeout 

point. 

Stakeout Tab Options 

METHOD 

Displays the current method used to determine the position of a specified point.  

ORTHOGONAL FROM STATION 

Select a known coordinate in the Target ID field. This known coordinate is the stakeout 

point. 

 

 

MANUAL – POLAR 

Enter the Azimuth and horizontal Distance to the stakeout point. The elevation of the 

stakeout point is relative to the HI measurement mark on the scanner. 

MANUAL – ORTHOGONAL 

Enter the coordinates of the stakeout point. 

TARGET ID 

Selects the target settings to display in the panel. 

HT 

The height of the target above the stakeout point. 

AZIMUTH 

The horizontal angle towards the stakeout point. 

X Y Z / N E EL 

The position of the stakeout point. 
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TYPE 

The type of the target to be acquired. 

RODMAN INSTRUCTIONS 

Displays the instructions to relay to the rodman to reposition the target based on the target’s 

current position. 

D CROSS 

The distance to move the target left or right (facing the scanner) from its current position. 

D LENGTH 

The distance to move the target towards or away from the scanner. 

D HEIGHT 

The distance to move the target up or down from its current position. 

COARSE TARGET SCAN 

Performs a coarse scan around the current pick point to pick up at least one point on the 

target.. 

ACQUIRE TARGET 

Acquires the target at the current pick point. The Rodman Instructions are updated to reflect 

the new offsets. 

To perform a stakeout: 

13. Connect to the scanner (ScanStation, ScanStation 2, or HDS6000) and ensure that it is level. 

14. Perform a Field Setup to establish the scanner’s coordinate system. The azimuth and 
coordinates of the target point are relative to this coordinate system. 

15. If using the Orthogonal from Station method, import or add the known or assumed 
coordinate of the stakeout point, using Add/Replace Coordinate, Import Coordinate List, 
or Import Coordinate List (Leica System 1200). 

16. From the Window menu, select Stakeout. The Stakeout panel appears in the control panel. 

17. Select the stakeout Method. 

18. Enter the Target ID. For the Orthogonal from Station method, the Target ID must match a 
known coordinate. The Target ID is also applied to the acquired target. 

19. Enter the HT of the target relative to the stakeout point. 

20. Select the Type of the target to be acquired to establish the offsets to the stakeout point. 

21. Enter the position of the stakeout point. 

• If using the Orthogonal from Station method, the stakeout coordinates are already known. 

• If using the Manual – Polar method, enter the Azimuth and Distance to the stakeout point. 

• If using the Manual – Orthogonal method, enter the 3D coordinate of the stakeout point. 

22. Set up the target in the general area of the stakeout point. 

23. Perform a preliminary scan using the primary Scan command. 

24. Pick a point in the preliminary scan that is close to the target. Click Coarse Target Scan to 
perform a coarse scan to acquire at least one point on the target. Repeat as needed. 
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25. Pick a point in the coarse scan that is on the target. Click Acquire Target to perform a fine 
scan on the target, followed by a target fit. The Rodman Instructions, d Cross, d Length, 
and d Height are updated based on the target’s current position relative to the stakeout point. 

26. Move the target in the indicated directions by the indicated offsets. Repeat the process as 
needed until the target is over the stakeout point. 

Standard Viewpoints 

Window: ModelSpace 

Menu: Viewpoint 

Action: Displays submenu 

Usage: Pointing to Standard Viewpoints displays submenu commands used to view your 

ModelSpace from standard viewpoints including: top, bottom, left, right, front, back, 

isometric, and right isometric. 

The following commands are available from the Standard Viewpoints submenu: 

Top, Bottom, Left, Right, Front, Back, Isometric, Right Isometric 

�    The Standard Viewpoints submenu commands are self-explanatory. Also see the Isometric 

and Right Isometric commands. 

Station Data (HDS3000) 

Window: Scan Control 

Menu: Window 

Action: Expands Tab 

Usage: The Station Data command expands the Station Data tab in the Scanner Control 

Panel. 
 

Station Data Tab Options 

HOME SCANWORLD 

Select a Home ScanWorld (optional) from the dropdown. This ScanWorld is the repository of 

targets that can be selected in Station ID and in the Set Horizontal from Target dialog. This 

ScanWorld also receives any new targets of known coordinates introduced during the geo-

referencing process. 

STATION ID 

Enter an identifier for the station position or select an existing identifier from the dropdown. 

HI 

Enter the measured height of the scanner above a known point. 
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•€€The scanner has a turret on the body to which a height is measured, from the ground point 

over which the scanner is centered. 

X, Y, Z 

Enter coordinates of the ground point. 

SET HZ BUTTON 

Opens the Aim Scanner dialog (used to set scanner horizontal/compass direction). 

HZ FROM TARGET BUTTON 

Opens the Set Horizontal from Target dialog. 

APPLY BUTTON 

Applies settings to the current ScanWorld’s default coordinate system. 

DEFAULT BUTTON 

Resets all settings to defaults. 

Steel Section 

Window: ModelSpace 

Menu: Create Object | Fit to Cloud 

Action: Displays submenu 

Usage: Pointing to Steel Section displays submenu commands used to fit a specified steel 

section to a picked point cloud. 

The following steel shapes are available from the Steel Section submenu: 

Angle, Channel, Tee, Rectangular Tube, Wide Flange 

�       For information on preparing point clouds for modeling, see the Segmentation entry in the 

Modeling chapter. 

�       For information on using parts tables, fit tolerances, and fit constraints, see the Object 

Preferences command and the Modeling entry in the Getting Started chapter. 

To fit a steel section to the selected point cloud: 

1. From the Object Preferences dialog, enable and set any desired fit constraints, fit tolerances, 

or parts tables for the steel type that you want to fit. See the Object Preferences entry in this 

chapter for details. If no preferences are set, the selected steel shape is fit directly to the 

selected cloud. 

� To enable fit constraints, fit tolerances, or parts tables: From the Create Object menu, point to 

Fit to Cloud Options, and toggle Show Table Matches, and/or Check Fit Tolerances ON. 

2. Using one of the methods described below, select one, two, or three points on the cloud of 

points you want to use to fit a steel section. 
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� All picks must be on major faces: the tops and bottoms of flanges and the sides of webs. 

Picks should not be on the edges of flanges or the top or bottom of webs or on the exposed 

cross section. 

Method 1: Pick a point anywhere on the interior (not near the edge) of a face. 

Method 2: Pick two points anywhere on the interior (not near the edge) of two perpendicular 

faces. 

Method 3: Pick two points on the same face widely spaced and approximately along the steel 

section’s axis. 

Method 4: Pick three points on the same face. The first two points should be picked as in 

Method 2 above, and the third point can be anywhere on the same face provided that it is not 

in a line with the first two picks. 

Note:    For tee shapes whose orientation is ambiguous, the first pick is assumed to be on 

the web. 

� When multiple point clouds are selected, the Multiple Point Cloud Style setting in the Fitting 

tab of the Edit Preferences dialog determines the results. If Fit Single Object (default) is 

selected, the clouds are first merged and then a single object is fit to the resulting merged 

point cloud. If Fit Multiple Objects is selected, an object is fit to each cloud individually. 

3. From the Create Object menu, point to Fit to Cloud, and then point to Steel Section and 

select the type of steel section you want to fit. Unless you are fitting to a parts table item, the 

steel shape appears. 

� If the point cloud varies too much from the shape of the object you are trying to create, a Fit 

Quality warning message appears and gives you an option to keep or cancel the fit (see the 

Fit Tolerances area of the Object Preferences entry in this chapter). In this case it may help to 

further refine the point cloud (see the Cloud Segmentation entry in the Modeling chapter) and 

retry the fit. 

4. If parts tables are enabled, the Select Table Item dialog appears displaying possible 

matches. The best match is temporarily drawn in the ModelSpace and marked with an 

asterisk in the dialog. 

� Matches within the set range are marked with a “+” sign. 

� The vs Table column displays the RMS (root mean squared) error of the object's dimensions 

(from the initial fit) compared to the dimension in the table. The vs Cloud column displays the 

standard deviation of point errors relative to the object best-fit using the individual table item's 

dimensions. The remaining columns indicate the per-dimension difference versus the initial 

fit's dimensions. 

� Any enabled fitting constraints corresponding to parameters from the table are used in the 

initial fitting, but then the closest match in the table is used when creating the actual object. 

� To show matches from a different table, select a new table from the Table field, and then click 

Refresh. New potential matches are shown. Clicking Refresh without changing the table 

calculates any missing vs Cloud values. 

� To edit the range of potential matches, enter a new value in the Match Table Items Within 

field, and then click Refresh. The new range of potential matches is shown. 
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5. Select the appropriate part from the list and click OK. The select parts table item is fit. 

Subtract From Patch 

Window: ModelSpace 

Menu: Edit Object | Patch 

Action: Executes command 

Usage: The Subtract from Patch command is used to create a hole in a selected patch. 

To create a hole in a patch: 

1. Draw a fence, or draw and select a polyline or polygon in the shape of the hole you wish to 

create. 

� The hole's edges cannot be self-intersecting and cannot cross the boundary of the patch. 

Also, holes cannot intersect each other. 

2. Select the patch in which you want to create a hole. 

3. From the Edit Object menu, point to Patch, and then select Subtract. The hole is created. 

Surface Area 

Window: ModelSpace 

Menu: Tools | Measure  

Action: Executes command 

Usage: The Surface Area command calculates and displays the total surface area of the 

selected object. 

To measure surface area: 

1. Select the object you want to measure. 

2. From the Tools menu, point to Measure, and then select Surface Area. The measurements 

results are displayed in square units. The measurement results are also displayed in the 

Output Box, if it is enabled. 

Surface Deviation 

Window: ModelSpace 

Menu: Tools | Measure 

Action: Opens dialog 

Usage: The Surface Deviation command displays a dialog used to specify what output is 

generated after measuring the differences in elevation between a TIN mesh and a 

reference surface. 

� The deviation is measured along the axis perpendicular to the active reference plane. The 

reference plane must be perpendicular to one of the major axes of the current UCS. The 
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mesh(es) must be TIN relative to the reference plane. 

� The reference surface may be the second TIN mesh selected, or the active reference plane if 

only one TIN mesh is selected. 

� If a polyline/polygon is also selected, only the area within the polyline/polygon (projected onto 

the active reference plane) is measured. 

To measure surface deviation: 

1. Select the TIN whose surface is to be subtracted from the reference surface. 

� To measure surface deviation against the active reference plane, select only one TIN. 

� To measure surface deviation against another reference TIN, select a second TIN surface to 

act as the reference surface. 

� To measure surface deviation within a specific boundary, multi-select a polyline or polygon 

object. 

2. From the Tools menu in the ModelSpace window, point to Measure, then select Surface 

Deviation… The Measure Surface Deviation dialog appears. 

3. Change the Grid Spacing of the active reference plane. The deviations will be measured on 

the reference plane grid with this spacing. 

4. Select the form of the measurement output to be generated. 

� Generate Contours: check this to generate contours representing the cut/fill regions. Set the 

Major Interval and # Minors/Major parameters. The contour elevations represent the 

differences in elevation in the current UCS. 

� Output Table: check this to display the Measure Surface Deviation Results dialog, which 

contains a table listing the individual deviation measurements. This measurement cannot be 

saved if this option is not selected. 

� Generate Points: check this to generate points whose coordinates and elevation in the 

current UCS correspond to the individual deviation measurements. 

5. Click OK. The surface deviation is computed and the requested output is generated. 
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Measure Surface Deviation Dialog 

 

Grid 

Spacing: 

Change the Grid Spacing of the active reference plane. The deviations will be 

measured on the reference plane grid with this spacing. 

Generate 

Contours: 

Select this check box to generate contours representing the cut/fill regions. Set the 

Major Interval and # Minors/Major parameters. The contour elevations represent 

the differences in elevation in the current UCS. 

OutputTable: Select this check box to display the Measure Surface Deviation Results dialog, 

which contains a table listing the individual deviation measurements. This 

measurement cannot be saved if this option is not selected. 

Generate 

Points: 

Select this check box to generate points whose coordinates and elevation in the 

current UCS correspond to the individual deviation measurements. 

Contours: If you select the Generate Contours check box to generate contours representing 

the cut/fill regions, set the Major Interval and # Minors/Major parameters. The 

contour elevations represent the differences in elevation in the current UCS. 

Switch Alignment Start/End 

Window: ModelSpace 

Menu: Tools | Alignment and Section 

Action: Executes command 

Usage: The Switch Alignment Start/End is used to switch the assignment of the start 

station from one end of the selected alignment to the other. 

�   For more information about alignments and the sections process, see the Sections Manager 

chapter. 
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Synchronize Viewers 

Window: Registration 

Menu: Viewers 

Action: Toggles menu item ON/OFF  

Usage: The Synchronize Viewers command toggles the synchronization of the two 

Constraint viewers for simultaneous view navigation. 

�       When ON, viewpoint changes in one Constraint viewer are tracked in the second viewer. 

This is useful when adding pick point hints to create or update the initial alignment hints for cloud 

constraints. 

Target All 

Window: Scan Control 

Menu: Scanner Control 

Action: Executes command 

Usage: The Target All command targets the entire image in the Scan Control window. 

�       Using the Target All command allows you to target the whole field of view in the Scan 

Control window without having to draw a target box manually. 

To target the whole field of view in the Scan Control window: 

1. From the Scanner Control menu, select Target All. (or click the Target All icon ). The scan 

target appears in the Scan Control window. 

Texture Map Browser 

Window: ModelSpace 

Menu: Edit Object | Appearance 

Action: Opens dialog 

Usage: The Texture Map Browser invokes the Texture Map Browser dialog, which 

provides access to the texture maps of the selected point cloud or mesh. 
 
• For information on the texture mapping process, see the Texture Mapping chapter. 

Texture Map Browser (Scan Control) 

Window: Scan Control (ScanStation, ScanStation 2, HDS2500, HDS3000, HDS4500, 

HDS6000) 

Menu: Project 

Action: Opens dialog 

Usage: The Texture Map Browser invokes the Texture Map Browser dialog, which 
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provides access to the texture maps of the selected point cloud or mesh, in the 

attached ModelSpace viewer (launching the viewer is needed). 
 
• For information on the texture mapping process, see the Texture Mapping chapter. 

Tilt 

Window: ModelSpace 

Menu: Tools | Reference Plane  

Action: Toggles function ON/OFF 

Usage: The Tilt command toggles the tilt function in Drawing mode, which allows you to 

interactively tilt the active Reference Plane around one of its major in-plane axes. 

To tilt the Reference Plane: 

1. From the Tools menu, point to Reference Plane, and then select Tilt (or click the Tilt icon ). 

You are now in Drawing mode. The cursor changes to the Drawing Tool cursor and the Tilt 

function is ON. 

2. In the ModelSpace, drag the Drawing Tool cursor to tilt the active Reference Plane. 

� The initial click in the ModelSpace determines which axis is tilted. Click close to the axis you 

want to tilt. The active Reference Plane is tilted around the other major axis. 

3. Release the mouse button. The Reference Plane is tilted. 

TIN Volume 

Window: ModelSpace 

Menu: Tools | Measure 

Action: Opens dialog 

Usage: The TIN Volume command displays a dialog that indicates how the prismoidal 

volume between a TIN mesh and a reference surface will be computed. 

� The volume is measured along the axis perpendicular to the active reference plane. The 

reference plane must be perpendicular to one of the major axes of the current UCS. The 

mesh(es) must be TIN relative to the reference plane. 

� The reference surface may be the second TIN mesh selected, or the active reference plane if 

only one TIN mesh is selected. 

� If a polyline/polygon is also selected, only the area within the polyline/polygon (projected onto 

the active reference plane) is measured. 

To measure TIN Volume: 

1. Select the TIN whose surface is to be subtracted from the reference surface. 

� To measure TIN Volume against the active reference plane, select only one TIN. 

� To measure TIN Volume against another reference TIN, select a second TIN surface to act as 

the reference surface. 

� To measure TIN Volume within a specific boundary, multi-select a polyline or polygon object. 
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2. From the Tools menu in the ModelSpace window, point to Measure, then select TIN 

Volume…. The Measure TIN Volume dialog appears. 

3. Click OK. The prismoidal TIN volume is computed. 

� The “Cut” (regions where the TIN is “above” the reference surface) and “Fill” (regions where 

the TIN is “below” the reference surface) are indicated graphically. 

Toggle ScanWorld Leveled 

Window: Registration 

Menu: ScanWorld 

Action: Toggles ScanWorld property 

Usage: The Toggle ScanWorld Leveled command toggles the “leveled” property of the 

selected ScanWorld. A ScanWorld known to be “leveled” is registered such that its 

“up” vector remains the same. This command should be used with care, since an 

incorrect property may adversely affect the registration results. 

�       The name of a ScanWorld known to be leveled is followed by “(Leveled)” in the Registration 

viewer. 

To toggle the leveled property of a ScanWorld: 

1. In the ScanWorlds’ Constraints or ModelSpaces tab, select one or more ScanWorlds. 

2. From the ScanWorld menu, select Toggle ScanWorld Leveled. The property is toggled for 

each selected ScanWorld. 

Traverse 

Window: Scan Control (ScanStation, ScanStation 2, HDS6000) 

Menu: Window 

Action: Expands Tab 

Usage: The Traverse command expands the Traverse tab in the Scanner Control Panel. 

�       For an overview of the Traverse process, see the Traverse (ScanStation, ScanStation 2) 

section in the Scanning with the ScanStation, ScanStation 2, and HDS3000 chapter, or the 

Traverse (HDS6000) section in the Scanning with the HDS6000 and HDS4500 chapter. 

�       The Traverse procedure requires an enabled dual-axis compensator (ScanStation, 

ScanStation 2) or enabled tilt sensor (HDS6000). The scanner must be close to level. 

Traverse Tab Options 

REGISTRATION 

Displays the current Registration that represents the Traverse.  

OPTIONS  
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Displays a pop-up menu with additional Traverse operations. 

RECHECK BACKSIGHT… 

Re-acquires the backsight target to see if the scanner has drifted since the backsight was 

first acquired. 

REPORT… 

Displays the Traverse Report dialog, which displays the parameters and quality of the 

traverse. 

DISPLAY… 

Launches the ModelSpace for Traverse ModelSpace viewer with a top-down view of the 

current Traverse. 

APPEND CURRENT STATION 

Re-opens a closed Traverse and adds the current ScanWorld to the Traverse. This can 

used if the Traverse is closed prematurely. 

MODIFY CURRENT STATION… 

Displays the Modify Traverse Info dialog, which is used to edit existing Station, 

Backsight, and Foresight settings. 

REMOVE CURRENT STATION 

Removes the current ScanWorld from the Traverse. This can be used if the ScanWorld 

has been erroneously added to the Traverse. 

CLOSE WITH LAST STATION 

Closes the Traverse using the last ScanWorld added to the Traverse. 

OPEN REGISTRATION… 

Launches the Registration viewer for the current Traverse. 

<, STATION / BACKSIGHT / FORESIGHT, > 

Selects the target settings to display in the panel. 

ID 

The ID of the Station or Target (Backsight or Foresight). The ID is used to match against 

known, assumed, or acquired coordinates during Traverse. 

HI / HT 

The Height of Instrument (Station) or Height of Target (Backsight or Foresight). 

X Y Z / N E EL 

The position of the known or assumed coordinate with the matching ID in the Known 

Coordinates ScanWorld. 

TYPE 

The type of the target to be acquired. 
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ACQUIRE 

Acquires the target (Backsight or Foresight) at the current pick point. 

ADD 

Adds the ScanWorld to the Traverse. The Station, Foresight, and Backsight settings must be 

entered and the Foresight and Backsight targets must be in the ScanWorld’s ControlSpace. 

CLOSE 

Adds the ScanWorld to the Traverse and then closes the current Traverse. The Station, 

Foresight, and Backsight settings must be entered and the Foresight and Backsight targets 

must be in the ScanWorld’s ControlSpace. 

To perform a traverse: 

1. Set up the scanner over a known point. Set up one target over another known point and 

another target over the next scanner position. 

2. Connect to the ScanStation/ScanStation 2 and enable the dual-axis compensator, or connect 

to the HDS6000 and enable the tilt sensor. 

3. Import or add the known or assumed coordinates, using Add/Replace Coordinate, Import 

Coordinate List, or Import Coordinate List (Leica System 1200). 

4. From the Window menu, select Traverse. The Traverse panel appears in the control panel. 

5. Select Station in the pull-down. 

6. Select the station ID from the list. 

7. Measure and enter the HI. 

8. Select Backsight in the pull-down, or push the > button to advance to the Backsight entry. 

9. Select the backsight ID from the list. 

10. Measure and enter the HT. 

11. Select the target Type. 

12. Pick a cloud point on the target over the known point and push Acquire. The backsight is 

acquired. If the target already exists in the ControlSpace, the target need not be re-acquired. 

13. Select Foresight in the pull-down, or push the > button to advance to the Foresight entry. 

14. Select the foresight ID from the list, or enter a new ID. 

15. Measure and enter the HT. 

16. Select the target Type. 

17. Pick a cloud point on the target over the known point and push Acquire. The foresight is 

acquired. If the target already exists in the ControlSpace, the target need not be re-acquired. 

18. Push the Add button. The ScanWorld is added to the Traverse. 

� To end the traverse, push the Close button instead. The foresight ID must be that of a known 

coordinate. 

� If you want to close the traverse but push Add instead of Close, click on the options button 

next to the Registration field and select Close with Last Station from the pop-up menu. 

� To edit the settings for this position, click on the options button next to the Registration field 

and select Modify Current Station. 

19. Move the scanner to the next position, advance to the next ScanWorld, and repeat. The 

previous station ID is now the backsight ID, and the previous foresight ID is now the station 

ID. 
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� If you have closed the traverse already but need to add another station to the traverse and 

continue the traverse, click on the options button next to the Registration field and select 

Append Current Station from the pop-up menu. 

Trim Edges 

Window: ModelSpace 

Menu: Create Object | Segment Cloud  

Action: Executes command 

Usage: The Trim Edges command creates a new segment of the selected point cloud that 

consists of all the points near the cloud’s boundary. 

�       For an overview of the segmentation process, see the Segmentation entry in the Modeling 

chapter. 

To trim the edges of the selected cloud: 

1. Select the cloud whose edges you want to trim. 

2. From the Create Object menu, point to Segment Cloud, and then select Trim Edges. The 

points along the boundary of the cloud are segmented. 

Turn Viewpoint 

Window: ModelSpace 

Menu: Viewpoint 

Action: Displays submenu 

Usage: Pointing to Turn Viewpoint displays submenu commands used to rotate your 

ModelSpace View 90 degrees to the left, right, up, or down, changing the point of 

focus. 

�       To move your viewpoint 90 degrees to the left, right, up, or down while maintaining your 

point of focus, see the Move Viewpoint command. 

The following commands are available from the Turn Viewpoint submenu: 

Left, Right, Up, Down 

Undo 

Window: ModelSpace, Navigator, Registration, Scan Control, Image Viewer 

Menu: Edit 

Action: Executes command 

Usage: The Undo command reverses the most recent action. 
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�       Most user actions in Cyclone can be reversed once performed (there are some exceptions). 

�       Cyclone provides for theoretically unlimited undo events. An undo event is possible after 

you perform an action or provide some input that makes a change in the object database. 

�    Once you’ve undone an action, you can move forward in the history and redo the action (see 

the Redo command), until there are no more actions to redo (you get back to where you started 

undoing). However, if you undo, and then perform a new action instead of a redo, all events that 

have not been redone are discarded. 

� Due to Cyclone’s concurrent modeling feature, someone else may change an object in your 

ModelSpace, which may break your chain of undo and redo events if the events affect a 

common object. 

Unextrude 

Window: ModelSpace 

Menu: Edit Object | Extrude  

Action: Executes command 

Usage: The Unextrude command removes the selected extrusion, leaving only the original 

patch. 

To unextrude an extrusion: 

1. Select the extrusion you want to unextrude. 

� It does not matter which side of the extrusion is picked - the original patch is always the result. 

2. From the Edit Object menu, point to Extrude, and then select Unextrude. The extrusion is 

deleted, leaving only the original patch. 

Unfreeze Registration 

Window: Registration 

Menu: Registration 

Action: Executes command 

Usage: The Unfreeze Registration command allows constraints in a previously frozen 

registration to be modified. 

�       After modifying constraints, a new registration must be performed, and a new 

ScanWorld/frozen registration must be created in order to affect changes. 

�       For more information on the registration process, see the Registration entry in the Getting 

Started chapter. 
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Note:    The Unfreeze Registration command removes the created ScanWorld from above 

the Registration. The operation is disabled if a ModelSpace exists under the created 

ScanWorld. To unfreeze the Registration, first delete the ModelSpace under the created 

ScanWorld in the Navigator. 

Ungroup 

Window: ModelSpace 

Menu: Edit | Group 

Action: Executes command 

Usage: The Ungroup command restores a group to its original components. 

�       To remove a single component without affecting the rest of the group, see the Remove from 

Group command. 

To restore the original components of a group: 

1. Select the group. 

2. From the Edit menu, point to Group, and then select Ungroup. The components are restored 

and may be selected individually. 

Unify Clouds 

Window: ModelSpace 

Menu: Tools 

Action: Displays dialog 

Usage: The Unify Clouds command displays the Unify Clouds dialog, which combines 

multiple point clouds into a single efficient cloud. 

�       The Unify Clouds command is typically used in a ModelSpace containing a registered set 

of scans and a large number of point clouds, performance is improved by the cloud unification 

process. 

�       After the point clouds are unified, you will generally want to use the Set ScanWorld Default 

Clouds command to designate the point cloud as the default point cloud that is loaded whenever 

a new ModelSpace is created from the parent ScanWorld. 

To unify clouds: 

1. From the Tools menu, select Unify Clouds. A warning prompt appears. 

2. Click Unify. The Unify Clouds dialog appears. 

3. Select unification options, and then click Unify. 

 Note: Any points not included in the unification process are removed from the ModelSpace 

when the cloud is unified. 
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� To reduce the number of points in the resulting unified cloud, select Reduce Cloud: Average 

Point Spacing and enter a value for the average distance between any two points. 

4. Click Unify. The point clouds are combined into a single efficient cloud. 

Unify ModelSpace 

Window: Navigator 

Menu: Tools 

Action: Displays dialog 

Usage: The Unify ModelSpace... command displays the Unify Clouds dialog, which 

combines multiple point clouds into a single cloud in the selected ModelSpace or 

ModelSpace View. 

�       In a ModelSpace containing a registered set of scans and a large number of point clouds, 

performance is improved by the cloud unification process. 

�       After the point clouds are unified, you will generally want to use the Set ScanWorld Default 

Clouds command to designate the point cloud as the default point cloud that is loaded whenever 

a new ModelSpace is created from the parent ScanWorld. 

To unify a ModelSpace: 

1. In the Navigator window, select the ModelSpace or ModelSpace View containing the clouds 

you want to unify. 

2. From the Tools menu, select Unify ModelSpace. A warning prompt appears. 

3. Click Unify. The Unify Clouds dialog appears. 

4. Select unification options, and then click Unify. 

 Note: Any points not included in the unification process are removed from the ModelSpace 

when the cloud is unified. 

� To reduce the number of points in the resulting unified cloud, select Reduce Cloud: Average 

Point Spacing and enter a value for the average distance between any two points. 

5. Click Unify. The point clouds in the selected ModelSpace or ModelSpace Views are combined 

into a single efficient cloud. 

Update Constraint 

Window: Registration 

Menu: Constraint 

Action: Executes command 

Usage: The Update Constraint command removes any constraints that have been 

deactivated (constraint objects have been made invisible in the ControlSpace) from 

the current Registration. 
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�       In order to update constraints for a completed (frozen) Registration, the Registration must 

be reactivated by invoking the Unfreeze Registration command. 

�       For more information on the registration process, see the Registration entry in the Getting 

Started chapter. 

Update Initial Cloud Alignment 

Window: Registration 

Menu: Cloud Constraint 

Action: Executes command 

Usage: The Update Initial Cloud Alignment command recomputes the correspondences 

between the current pick points used in the selected Cloud Constraint and resets 

the initial cloud alignment. 

�       This command is useful if the Optimize Alignment function is unsuccessful because of an 

inaccurate initial alignment hint. 

�       For more information on the cloud registration process, see the Cloud Registration entry in 

the Registration chapter. 

To update initial cloud alignments: 

1. From the Constraint List tab, select the cloud constraint to update, then select Show 

Constraint from the Constraint menu. The ControlSpaces of the constrained ScanWorlds 

are opened in the Constraint viewers, and the pick points of the cloud constraint are 

displayed. 

2. Modify the set of pick points, adding or removing pick points as needed. 

3. From the Cloud Constraint menu, select Update Initial Cloud Alignment. The pick points 

and transformation of the cloud constraint are updated to match the new pick points, if 

possible. 

Update Original ModelSpace 

Window: ModelSpace 

Menu: ModelSpace: File | Launch 

 Navigator: File 

Action: Executes command  

Usage: Executing this command copies edited objects back to the ModelSpace from which 

the current ModelSpace was originally created. 

Note:    This command is active only for ModelSpaces created via the File | Launch | Copy 

Selection to New ModelSpace or Copy Fenced to New ModelSpace commands. 

To update the original ModelSpace from a subordinate ModelSpace View: 
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1. From the File menu, point to Launch and then select Update Original ModelSpace. A dialog 

appears. 

2. Choose whether or not to mark the current ModelSpace for deletion after the current and 

original ModelSpaces have been merged. 

� If you select Yes, the current ModelSpace is marked for deletion and the original ModelSpace 

is updated to reflect changes. 

� If you select No, the current ModelSpace is left intact, and the original ModelSpace is updated 

to reflect changes. 

� If you select Cancel, the update process is aborted and you are returned to the current 

ModelSpace. 

� The updated source ModelSpace contains all objects that were either edited or created in the 

descendant ModelSpace, i.e., objects from the source ModelSpace that have not changed are 

not duplicated in the resulting merged ModelSpace. 

To update the original ModelSpace from the Navigator window: 

1. Select the ModelSpace that was created using the File | Launch | Copy Selection to New 

ModelSpace command. 

2. From the File menu, select Update Original ModelSpace. A dialog appears. 

3. Choose whether or not to mark the current ModelSpace for deletion after the current and 

original ModelSpaces have been merged. 

� If you select Yes, the current ModelSpace is marked for deletion and the original ModelSpace 

is updated to reflect changes. 

� If you select No, the current ModelSpace is left intact, and the original ModelSpace is updated 

to reflect changes. 

� If you select Cancel, the update process is aborted and you are returned to the current 

ModelSpace. 

� The updated source ModelSpace contains all objects that were either edited or created in the 

descendant ModelSpace, i.e., objects from the source ModelSpace that have not changed are 

not duplicated in the resulting merged ModelSpace. 

Update Simulated Scanner Position 

Window: ModelSpace 

Menu: Tools | Scanner  

Action: Executes command 

Usage: The Update Simulated Scanner Position command changes the position of the 

simulated scanner to match the current viewpoint of the ModelSpace from which it 

was launched. 

� For general information on the Scan Control window, see the Scanning entry in the 

Scanning with the ScanStation, ScanStation 2, and HDS3000 chapter. 
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Use Fit Constraints 

Window: ModelSpace 

Menu: Create Object | Fit to Cloud Options 

Action: Toggles menu item ON/OFF 

Usage: The Use Fit Constraints command enables/disables user-specified constraints 

used to fit a geometric object to a segmented point cloud in the ModelSpace viewer. 

�       In order to use fit constraints, the Fit Constraints box must be selected and the desired 

constraints must be set within the Object Preferences dialog. See the Object Preferences 

command. 

�       For an overview of fitting objects in Cyclone, see the Modeling entry in the Getting Started 

chapter. 

Use Parts Table 

Window: ModelSpace 

Menu: Create Object 

Action: Toggles menu item ON/OFF 

Usage: The Use Parts Table command enables/disables the use of object-specific parts 

tables when inserting objects in the current ModelSpace viewer. 

�       When enabled, object types that have Catalog/Parts Table selected in the Object 

Preferences dialog present controls to select a table and part when inserting that object type. 

�       When disabled, no tables are used by any operation. 

User Coordinate System 

Window: ModelSpace 

Menu: Edit Object | Handles | Constrain Motion to 

Action: Executes command 

Usage: The User Coordinate System command constrains the movement of objects 

relative to the specified axis of the user coordinate system. 

�    The User Coordinate System command works in conjunction with axis constraints. For 

information on constraining object motion to an axis, see the Constrain Motion to entry in this 

chapter. 

�    For more information on using user coordinate systems, see the Save/Edit Coordinate 

Systems command. 

联系人：李滨 电话：13910106639 Email:19519399@qq.com



Index 

462 

�    Some handles may not be able to move according to the constraints (e.g., rotation and other 

custom handles). 

�    For more information on using handles, see the Handles entry in the Modeling chapter. 

User Feedback... 

Window: All windows 

Menu: Help  

Action: Opens dialog 

Usage: The User Feedback dialog is provided for users to provide Leica Geosystems HDS 

with feedback on the use of Cyclone in your work sessions, such as suggestions for 

future enhancements. 

To submit user feedback: 

1. From the Help menu, select User Feedback.... The User Feedback dialog appears. 

2. Enter personal data (name, company, email, phone, etc.) in the appropriate fields. It is 

important that you provide this data so we can contact you to follow up if necessary. The Date 

and Time fields are populated automatically with the current date and time. 

3. Enter a summary of the feedback being reported in the Summary field, followed by a detailed 

narrative in the Detailed Description field. Provide as much detail as possible. 

4. Click Create Feedback to open a Save dialog; enter a file name for the .txt file (or you can 

accept the default, feedback.txt), select the folder into which you want to save the file, and 

click Save. The report is created and saved to the designated file and location. 

5. E-mail the newly created .txt file to support@hds.leica-geosystems.com. 

Verify Camera Calibration 

Window: Scan Control 

Menu: Scanner Control | Camera Calibration 

Action: Opens dialog 

Usage: The Verify Camera Calibration dialog is used to test the accuracy of the current 

camera calibration. 

�    For a general overview of camera calibration, see the Camera Calibration entry in the 

Scanning with the HDS2500 chapter. 

�    This command is only available for the HDS2500. 

To Verify Camera Calibration: 

1. Place the scanner in a dimly lit room (unlit is preferable) 5-10 meters from the wall that the 

scanner is facing. 

2. Open the Scan Control window and connect to the scanner. 
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3. From the Scanner Control menu, point to Camera Calibration and select Verify Camera 

Calibration.... A progress dialog appears, describing accuracy as the process tests 50 points. 

� To cancel at any time during the process, click Cancel. For a reliable evaluation, testing at 

least 20 points before canceling is recommended. 

� Acceptable accuracies for HDS2500 camera calibration are average errors of around 2 pixels. 

Max errors of 8 pixels may be common and acceptable, depending on the scene. 

Verify TIN 

Window: ModelSpace 

Menu: Tools | Mesh 

Action: Executes command 

Usage: The Verify TIN command checks to see if the selected mesh conforms to the 

definition of a Triangulated Irregular Network (TIN). 

�       A TIN is a mesh in which there are no vertically overlapping faces. 

�       TIN verification can only be performed on a mesh object as opposed to a point cloud that is 

currently viewed as a mesh. To create a mesh object from a point cloud, see the Create Mesh 

command. 

Vertex (From Intersections) 

Window: ModelSpace 

Menu: Create Object | From Intersections 

Action: Executes command 

Usage: The Vertex command creates a vertex at the planar or linear intersection of either 

three selected planar objects or two linear objects. 

To create a vertex at the intersection of objects: 

1. Select three planar objects or two linear objects. 

� Objects such as cylinders that define a centerline are considered linear. 

2. From the From Intersections submenu, select Vertex. The vertex is created. 

� When creating a vertex at the intersection of three planes: Even if the selected objects are not 

physically touching, the vertex is created at the planar intersections of the selected objects. 

� When creating a vertex at the intersection of lines: If the lines do not intersect, the vertex is 

placed at the midpoint of the closest approach of the linear objects. 
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Vertex (From Pick Points) 

Window: ModelSpace 

Menu: Create Object | From Pick Points 

Action: Executes command 

Usage: The Vertex command creates a vertex at a picked point. 

To create a vertex at a picked point: 

1. Pick one or more points. 

2. From the Create Object menu, point to From Pick Points, and then select Vertex. A vertex 

is created at each pick point. 

View All 

Window: ModelSpace, Registration 

Menu: ModelSpace: Viewpoint 

 Registration: Viewers 

Action: Executes command 

Usage: The View All command adjusts the viewpoint so that the entire scene is visible in 

the current window. 

View Half-Space 

Window: ModelSpace 

Menu: Tools | Cutplane  

Action: Toggles menu item ON/OFF 

Usage: The View Half-Space command hides all geometry below the active Cutplane. 

�       This can be useful to see "inside" the surfaces that are left visible. 

�       To toggle whether the geometry above/below the Cutplane is hidden, use the Flip 

command in the Cutplanes dialog. 

View Interim Results 

Window: Registration 

Menu: Registration 

Action: Executes command 

Usage: The View Interim Results command creates a temporary ModelSpace to display 

an interim registration of the selected ScanWorlds, Constraints, ModelSpaces, or 

ControlSpaces. 
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�   For more information on the cloud registration process, see the Cloud Registration entry in the 

Registration chapter.  

�   The View Interim Results command allows for the visual inspection of the current state of 

registration for any selected subset of registration objects (ScanWorlds, Constraints, 

ModelSpaces, or ControlSpaces), without having to first freeze the ScanWorld and create a 

ModelSpace (see Create ScanWorld/Freeze Registration and Create ModelSpace commands). 

To view interim results: 

1. Select the ScanWorlds, ControlSpaces, ModelSpaces, and/or Constraints to view. 

2. From the Registration window, select View Interim Results.... A ModelSpace appears, 

displaying the content from the selected items. 

� When a ScanWorld is selected, the contents of the ScanWorld (as defined by preferences set 

in the Initialization tab of the Edit Preferences dialog) are shown in the temporary 

ModelSpace. The current registration transformation for the ScanWorld determines its relative 

position in the new ModelSpace. 

� When a ModelSpace or ControlSpace is selected, its contents are shown in the temporary 

ModelSpace. The current registration transformation for the space's ScanWorld determines its 

relative position in the new ModelSpace. 

� When a constraint is selected, all objects referenced by the selected constraint are shown in 

the temporary ModelSpace. The current registration transformations for the objects' 

ScanWorlds determine their relative positions in the new ModelSpace. 

� When a single cloud constraint is selected, the ControlSpaces of the constraint are shown, 

using the current cloud constraint alignment to determine their positions relative to each other 

in the temporary ModelSpace. This is the recommended method for visually checking the 

alignment of the cloud constraints before attempting global registration. Similarly, the initial 

alignment of a cloud constraint (in not aligned state) can be visually inspected before running 

the Optimize Cloud Alignment command on it. 

3. When finished, close the temporary ModelSpace viewer. A dialog appears with options for 

saving the temporary ModelSpace. 

View Lock 

Window: ModelSpace 

Menu: Viewpoint 

Action: Displays submenu 

Usage: Pointing to View Lock displays submenu commands used to temporarily disable the 

ability to pan, zoom, or rotate the ModelSpace viewpoint. 

The following commands are available from the View Lock submenu: 

Pan, Zoom, Rotation, Clear Locks 
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View Mode 

Window: ModelSpace, Registration, Scan Control  

Menu: ModelSpace: Edit | Modes 

Registration: Edit | Modes 

ScanControl: Viewers 

Action: Executes command 

Usage: The View Mode command enters View mode and selects the View mode cursor, 

which is used to manually adjust the ModelSpace viewpoint. 

View ModelSpace 

Window: Registration 

Menu: ScanWorld 

Action: Executes command 

Usage: The View ModelSpace command is used to display a ScanWorld’s ModelSpace in 

one of the Constraint viewer windows. 

To view a ModelSpace: 

1. From the ModelSpaces tab, select the ModelSpace you want to view. 

2. From the ScanWorld menu, select View ModelSpace. The ModelSpace appears in one of 

the two Constraint viewer windows. 

� The first ModelSpace that you open appears in the subwindow on the bottom left side of the 

Registration window. The next appears on the right, and then each subsequently viewed 

ModelSpace is alternately loaded into the left and right windows. 

� The Constraint viewer windows are used to view and select the objects to add a manual 

constraint, and to verify existing constraints. 

View Object As... 

Window: ModelSpace 

Menu: View 

Action: Opens dialog 

Usage: The View Object As... command opens the View As tab of the View Properties 

dialog, which is used to set various viewing and rendering properties. 
 

Dialog Options 

APPLY TO 

Select the class of object to which you want to apply changes. Each class of object has its 

own set of editable properties. 
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RESET 

Click this button to reset the “view as” properties for the selected class. 

COLOR MAP (POINT CLOUDS AND MESH OBJECTS ONLY) 

Click this button to invoke the Color Map Parameters dialog. See Edit Color Map in the 

Commands chapter. 

APPLY 

Click this button to apply any changes to the "view as" properties for the selected class. 

View As Options 

Choose one from the list of available options. (The list varies depending on the object class 

selected in the Apply To field.) 

LOD - FULL RANGE 

When selected, the full set of low-, medium-, and high-resolution level of detail (LOD) is 

displayed. 

LOD - HIGHEST COMPLEXITY 

When selected, only high resolution LOD is displayed for maximum rendering detail. 

LOD - LOWEST COMPLEXITY 

When selected, only low resolution LOD is displayed for faster rendering. 

WIREFRAME (MESH OBJECTS ONLY) 

When selected, mesh objects are displayed in wireframe mode, rather than as a solid. 

PER-FACE NORMALS (MESH OBJECTS ONLY) 

When selected, each triangle contained within a mesh object is shaded separately based on 

its normal. 

RAW POINTS (POINT CLOUDS ONLY) 

When selected, points are displayed with no meshing. 

BASIC MESH (POINT CLOUDS ONLY) 

When selected, the cloud is displayed as a mesh with as many triangles as possible. 

COMPLEX MESH (POINT CLOUDS ONLY) 

When selected, the cloud is displayed as a mesh with only those triangles that are likely to 

form the actual surface. 

CENTERLINE 

When selected, only the object’s centerline is displayed. 

CENTER POINT (SPHERES ONLY) 

When selected, only the centerpoint of the sphere is displayed. Centerpoints are displayed 

graphically as a vertex. 
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Other Options 

Choose any or all of the available options by checking the box. (The list varies depending on the 

object class selected in the Apply To field.) 

SHOW OBJECT’S CLOUD 

Select this option to display the point cloud that defines the object. 

POINT NORMALS (POINT CLOUDS ONLY) 

Select this option to display normals associated with scan points. 

SHOW OBJECT’S CENTERLINE 

Select this option to display an object’s centerline. 

SHOW SOLID VALVE (VALVES ONLY) 

Select this option to display valves as solid objects rather than as wireframe objects. 

W/O OBJECT’S CENTER POINT (SPHERES ONLY) 

Select this option to view spheres as solids without displaying center point vertices. 

SHOW ELEVATION LABEL (CONTOURS ONLY) 

Select this option to display labels for contour lines containing elevation data. 

SHOW CONTENTS WITH POINTS (EXCLUSION VOLUMES ONLY) 

Select this option to display both objects and points within an exclusion volume. 

View Slice 

Window: ModelSpace 

Menu: Tools | Cutplane  

Action: Toggles menu item ON/OFF 

Usage: The View Slice command toggles whether or not the active Cutplane slices through 

the data, hiding all geometry beyond the specified thickness of the Cutplane slice. 

(See the Set Slice Thickness entry in this chapter). 

�       The results resemble a cross-section that can be used for quick 2D plots directly from point 

clouds and surfaces. 

Virtual Surveyor... 

Window: ModelSpace 

Menu: Tools 

Action: Opens dialog 

Usage: The Virtual Surveyor command is used to select a file for Virtual Surveyor data 

input/output and then proceed to the Virtual Surveyor dialog. 
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�    For information on the Virtual Surveyor process, see the Virtual Surveyor chapter. 

Volume 

Window: ModelSpace 

Menu: Tools | Measure  

Action: Executes command 

Usage: The Volume command calculates and displays the volume of the selected object. 

�       To measure a volume of a mesh, use the Mesh Volume command instead. 

To measure an object’s volume: 

1. Select the object whose volume you want to measure. 

2. From the Tools menu, point to Measure, and then select Volume. The measurements results 

are displayed in cubic units. The measurement results are also displayed in the Output Box, if 

it is enabled. 

Zoom 

Window: ModelSpace 

Menu: Viewpoint 

Action: Displays submenu 

Usage: Pointing to Zoom displays submenu commands used to zoom the viewpoint in or 

out, or zoom into a fence. 

The following commands are available from the Zoom submenu: 

In, Out, Into Fence, Into Selection 

Zoom Submenu Commands 

IN 

Zooms in so objects near the center of the ModelSpace View appear approximately 1.5 to 2 
times larger. 

OUT 

Zooms out so objects near the center of the ModelSpace View appear approximately 1.5 to 2 
times smaller. 

INTO FENCE 

Zooms in until the data fence fills the field of view. 

INTO SELECTION 

Zooms in until the current selection fills the field of view. 
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Zoom (Lock) 

Window: ModelSpace 

Menu: Viewpoint | View Lock 

Action: Toggles option ON/OFF 

Usage: The Zoom command toggles the ability to zoom the viewpoint in or out while in 

View mode. 

�       When ON, you cannot zoom the viewpoint. 
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